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Bio-Rad™ Teknisk support
Bio-Rad Tech support nordic:

Telefon: 1-800-424-6723, valgmulighed 2 / +45 4452 1000

E-mail: Techsupport.nordic@bio-rad.com (kun USA/Canada)

Hvis du har brug for teknisk hjælp uden for USA og Canada, skal du kontakte den lokale tekniske support eller
klikke på linket Contact us (Kontakt os) på www.bio-rad.com.

Meddelelse
Ingen dele af denne udgivelse må gengives, kopieres eller sendes i nogen form eller på nogen måde,
elektronisk eller mekanisk, herunder fotokopiering, optagelse eller lagring i søge- eller registreringssystemer,
uden skriftlig tilladelse fra Bio-Rad Laboratories, Inc..

Bio-Rad forbeholder sig retten til at ændre sine produkter og tjenester når som helst. Denne vejledning kan
ændres uden varsel. Selvom den er udarbejdet for at sikre nøjagtig information, påtager Bio-Rad sig intet
ansvar for fejl eller udeladelser eller for eventuelle skader, der måtte opstå fra anvendelse eller brug af denne
information.

BIO-RAD er et varemærke tilhørende Bio-Rad Laboratories, Inc.

SYBR er et varemærke tilhørende Thermo Fisher Scientific Inc.

EvaGreen er et varemærke tilhørende Biotium, Inc.

Alle her anvendte varemærker tilhører deres respektive ejer.

Copyright © 2022 ved Bio-Rad Laboratories, Inc. Alle rettigheder forbeholdes.

http://www.bio-rad.com/


Tilsigtet anvendelse

Tilsigtet anvendelse
CFX Opus Dx Real-Time PCR-systemTMmed CFX Maestro Dx Software, Security EditionTM er beregnet
til udførelse af fluorescensbaseret PCR til detektion og kvantifikation af nukleinsyresekvenser. Systemet
og den tilhørende software er beregnet til in vitro-diagnostisk brug af uddannet laboratoriepersonale.
Systemerne er beregnet til anvendelse med diagnostiske nukleinsyretest fra tredjeparter, som er
produceret og mærket til diagnostiske formål.

Symbolleksikon

Fabrikant Partinummer

Udløbsdato Til In Vitro-diagnostisk brug

Temperaturgrænse Katalognummer

Se brugsanvisningen Antal tests

Til brug med Serienummer

Kun receptpligtig brug Indeholder latex
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CE-mærkning – Forordning
(EU) 2017/746 IVDR

Oversættelser
Produktdokumenter kan leveres på flere sprog på elektroniske medier.
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Sikkerhed og overholdelse af lovgivningen
Systemerne CFX Opus 96 Dx, CFX Opus 384 Dx, og CFX Opus Deepwell Dx Real-Time PCR (omtales i
denne vejledning som CFX Opus Dx-system) opvarmes og afkøles meget hurtigt under drift. Bio-Rad
anbefaler på det kraftigste, at du følger sikkerhedsspecifikationerne, der er anført i dette afsnit og i denne
vejledning.

Advarselsmærkater om sikkerhed
Advarselsmærkater, som er placeret på CFX Opus Dx-system og i denne vejledning, advarer brugeren
om kilder til personskade eller fare. Tabel 1 definerer hver advarselsmærkat om sikkerhed.

Ikon Betydning

Betjening af CFX Opus Dx-system, inden denne vejledning er blevet læst, kan
udgøre en risiko for personskade. Brug af dette instrument på en måde, der ikke er
specificeret i denne vejledning eller af Bio-Rad, kan resultere i, at instrumentets
beskyttelsesfunktioner forringes eller deaktiveres.

Der er ingen biofarer eller radioaktive farer forbundet med selve CFX Opus Dx-
system. Disse farer kan kun blive et problem, når de introduceres i systemet via de
prøver, der testes. Ved håndtering af biologisk farlige prøver eller radioaktive
prøver skal de anbefalede forsigtighedsregler og retningslinjer, der er specifikke for
laboratoriet og stedet, overholdes. Disse retningslinjer skal omfatte rengørings-,
overvågnings- og bortskaffelsesmetoder for det eller de farlige stoffer, der arbejdes
med.

Derudover er der som identificeret ovenfor en lille risiko for eksplosion eller for læk
af væsker eller dampe fra prøvebeholderen/-beholderne. Når du arbejder med
farlige materialer, er risikoen for kvæstelse fra udstødt materiale forstærket med
risikoen for, at selve det farlige materiale spredes i og omkring instrumentet.
Brugere bør tage passende forholdsregler for en sådan situation.

Tabel 1. Generelle sikkerhedsadvarsler
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Sikkerhed og overholdelse af lovgivningen

Ikon Betydning

CFX Opus Dx-system fungerer ved temperaturer, der er høje nok til at forårsage
alvorlige forbrændinger. Lad altid prøveblokken vende tilbage til stuetemperatur,
inden låget åbnes og prøverne tages ud. Selv efter at prøveblokken er afkølet, kan
omgivelserne og varmepladen forblive varme i nogen tid. I situationer, hvor der ikke
er tilstrækkelig tid til at lade instrumentet køle af, anbefales det at bruge
beskyttelsesudstyr såsom termiske handsker eller "ovnhandsker".

Det er udelukkende samleren af et system, der indeholder et CFX Opus Dx-
system, der har ansvaret for det.

CFX Opus Dx-system kan blive varmt nok under normal drift til at få væsker i
prøverne til at koge eller fordampe, hvilket vil skabe et tryk i prøvebeholderne. Det
er muligt, at der opstår fejl i prøvebeholderen/-beholderne. Det kan føre til lækager,
at væske sprøjtes ud eller eksplosive brud og udledning af dampe eller væsker i og
omkring instrumentet.

Brugere skal, for at undgå personskade, altid betjene instrumentet med lukket låg
eller bære beskyttelsesbriller, termiske handsker og andet personligt
beskyttelsesudstyr under betjening. Åbning af instrumentet, mens prøverne stadig
er varme, såsom efter en afbrudt kørsel, kan medføre, at beholdere under tryk
lækker, eller at væske sprøjtes ud. Lad altid prøverne køle af, før låget åbnes.

Brugere bør aldrig køre en reaktion med et låg eller en tætning, der er åben, løs,
punkteret eller på anden måde beskadiget, da det øger sandsynligheden for
lækage eller en eksplosion.

Brugere bør aldrig køre en reaktion med flygtige reagenser, der kan øge
sandsynligheden for lækage eller en eksplosion.

Tabel 1. Generelle sikkerhedsadvarsler, fortsat
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Sikkerhed og overholdelse af lovgivningen

Sikkerhed og overholdelse af lovgivningen

Overholdelse af sikkerhed
CFX Opus Dx-system er blevet testet og vurderet til at være i overensstemmelse med alle gældende krav
i følgende standarder for sikkerhed og elektromagnetisme:

n IEC 61010-1:2010-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 1:
Grundlæggende krav

n IEC 61010-2-010:2019-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del
2-010: Særlige krav til laboratorieudstyr til opvarmning af materialer

n IEC 61010-2-081:2019-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del
2-081: Særlige krav til automatisk og halvautomatisk laboratorieudstyr til analyse og andre formål

n IEC 61010-2-101:2018-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del
2-101: Særlige krav til in vitro-diagnostisk (IVD) medicinsk udstyr

n CAN / CSA-C22.2 NR. 61010-1-12:2018-sikkerhedskrav til elektrisk udstyr til måling, styring og
laboratoriebrug, Del 1: Grundlæggende krav

n CAN / CSA-C22.2 NR. 61010-2-010:19-sikkerhedskrav til elektrisk udstyr til måling, styring og
laboratoriebrug, Del 2-010: Særlige krav til laboratorieudstyr til opvarmning af materialer

n CAN / CSA-C22.2 NR. 61010-2-081:19-sikkerhedskrav til elektrisk udstyr til måling, styring og
laboratoriebrug, Del 2-081: Særlige krav til automatisk og halvautomatisk laboratorieudstyr til
analyse og andre formål

n CSA-C22.2 NO. 61010-2-101:19-sikkerhedskrav til elektrisk udstyr til måling, styring og
laboratoriebrug, Del 2-101: Særlige krav til in vitro-diagnostisk (IVD) medicinsk udstyr

n EN 61010-1:2010-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 1:
Grundlæggende krav

n EN 61010-2-010:2014-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 2-
010: Særlige krav til laboratorieudstyr til opvarmning af materialer

n EN 61010-2-081:2015-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 2-
081: Særlige krav til automatisk og halvautomatisk laboratorieudstyr til analyse og andre formål

n EN 61010-2-101:2017-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 2-
101: Særlige krav til in vitro-diagnostisk (IVD) medicinsk udstyr
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Sikkerhed og overholdelse af lovgivningen

n UL 61010-1:2012-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 1:
Grundlæggende krav

n UL 61010-2-010:2019-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 2-
010: Særlige krav til laboratorieudstyr til opvarmning af materialer

n UL 61010-2-081:2019-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 2-
081: Særlige krav til automatisk og halvautomatisk laboratorieudstyr til analyse og andre formål

n UL 61010-2-101:19-sikkerhedskrav til elektrisk udstyr til måling, styring og laboratoriebrug - Del 2-
101: Særlige krav til in vitro-diagnostisk (IVD) medicinsk udstyr

Elektromagnetisk kompatibilitet (EMC)
CFX Opus Dx-system er blevet testet og vurderet til at være i overensstemmelse med alle gældende krav
i følgende standarder for elektromagnetisk kompatiblitet:

n IEC 61326-1:2012-elektrisk udstyr til måling, styring og laboratoriebrug - EMC-krav - Del 1:
Grundlæggende krav. Testet som en klasse A-enhed

n IEC 61326-2-6:2012-elektrisk udstyr til måling, styring og laboratoriebrug - EMC-krav - Del 2-6:
Særlige krav til — In vitro-diagnostisk (IVD) medicinsk udstyr

n EN 61326-1:2013-elektrisk udstyr til måling, styring og laboratoriebrug - EMC-krav - Del 1:
Grundlæggende krav. Testet som en klasse A-enhed

n EN 61326-2:-6:2013-elektrisk udstyr til måling, styring og laboratoriebrug - EMC-krav - Del 2–6:
Særlige krav til — In vitro-diagnostisk (IVD) medicinsk udstyr

n FCC afsnit 15, underafsnit B, afsnit 15.107 og 15.109. Testet som en klasse A digital enhed

n CAN ICES-003v6:2019 Standard for interferensfremkaldende udstyr, informationsteknologisk udstyr
(inklusive digitale apparater) - Grænser og målemetoder. Testet til klasse A grænser

FCC-advarsler og -bemærkninger
n ADVARSEL:Ændringer eller modifikationer af denne enhed, som ikke udtrykkeligt er godkendt af

Bio-Rad, kan annullere brugerens bemyndigelse til at betjene udstyret.

n Bemærk: Dette udstyr er blevet testet og vurderet til at overholde grænserne for en digital enhed i
klasse A i henhold til del 15 i FCC-reglerne. Disse grænser er beregnet til at give rimelig beskyttelse
mod skadelig interferens, når udstyret betjenes i et erhvervsmiljø. Dette udstyr genererer, anvender
og kan udstråle radiofrekvent energi, og hvis det ikke installeres og anvendes i overensstemmelse
med vejledningen, kan det forårsage skadelig interferens med radiokommunikation. Anvendelse af
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dette udstyr i beboelsesområder vil sandsynligvis forårsage skadelig interferens. I sådanne tilfælde
vil det være brugerens ansvar at korrigere interferensen for egen regning.

n Angående FCC-overholdelse: Selvom dette instrument er blevet testet og fundet at overholde del
15, underdel B i FCC-reglerne for digitalt udstyr i klasse A, skal det bemærkes, at denne overholdelse
er frivillig, eftersom instrument er kvalificeret som “fritaget udstyr” i henhold til 47 CFR 15.103(c), for
så vidt angår de nævnte FCC-bestemmelser, der var gældende på fremstillingstidspunktet.

n Bemærkning vedrørende kabler: Dette instrument blev testet for EMC-overholdelse ved hjælp af
specialdesignede USB-kabler, der leveres sammen med instrumentet. Disse kabler, eller af Bio-Rad-
godkendte alternativer, skal bruges med dette instrument for at sikre fortsat overholdelse af EMC-
emissionsgrænserne.
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Miljøkrav
CFX Opus Dx-systems er designet til at blive betjent sikkert under de miljømæssige forhold anført i
følgende tabel.

Parameter Specifikation

Miljøforhold Kun til indendørs brug

Driftshøjde Op til 2000 meter over havets overflade

Omgivelsesrumtemperatur 15-31 °C*

Transport- og opbevaringstemperatur –20° til 60 °C**
–4 til 140 °F

Relativ luftfugtighed 20 til 80 % (ikke-kondenserende)***

Driftseffekt 100 til 240 VAC ±10 %, 50/60 Hz, 850 Wmaks.

Udsving i netspændingen ±10 %

Maks. strømforbrug < 850 watt

Sikringer 10 A, 250 V, 5 x 20 mm, flink (antal 2)

Overspændingskategori II

Forureningsgrad 2

*Betjening af instrumentet uden for dette temperaturområde opfylder muligvis ikke
ydeevnespecifikationerne. En rumtemperatur fra 5-40 °C anses for sikker.

**Opbevar og transporter instrumentet i dets forsendelsesbeholder for at opfylde disse
temperaturbetingelser.

***Betjening af instrumentet ved 4 ⁰C bør begrænses til 18 timer under disse betingelser. Fastholdelse
ved 4 ⁰C kan udføres i op til 72 timer, hvis luftfugtigheden er mindre end 60 % (ikke-kondenserende).

Tabel 2. Miljøkrav for CFX Opus Dx Real-Time PCR-system
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Risikofaktorer
CFX Opus Dx-system er designet til at fungere sikkert, når det bruges på den måde, som producenten har
angivet. Hvis systemet eller en af dets tilknyttede komponenter bruges på en måde, der ikke er
specificeret af producenten, kan instrumentets iboende beskyttelse forringes. Bio-Rad er ikke ansvarlig
for personskader eller skader forårsaget af brugen af dette udstyr på nogen uspecificeret måde eller ved
modifikationer af instrumentet, der ikke udføres af Bio-Rad eller en autoriseret repræsentant. Service på
CFX Opus Dx-system bør kun foretages af uddannet Bio-Rad personale.

Biologiske risikofaktorer
CFX Opus Dx-system er et laboratorieprodukt. Ved tilstedeværelse af biologisk farlige prøver skal
nedenstående retningslinjer og eventuelle lokale retningslinjer, der er specifikke for laboratoriet og stedet,
imidlertid følges.

Bemærk: Der undslipper ikke biologisk farlige stoffer under normal brug af dette instrument.

Generelle forholdsregler

n Bær altid en laboratoriekittel, laboratoriehandsker og sikkerhedsbriller med sideskærm eller
øjenværn.

n Hold hænderne væk fra øjne, næse og mund.

n Beskyt alle sår og hudafskrabninger fuldstændigt, inden der arbejdes med potentielt smittefarlige
materialer.

n Vask hænderne omhyggeligt med sæbe og vand, når du har arbejdet med potentielt smittefarligt
materiale, inden du forlader laboratoriet.

n Tag armbåndsure og smykker af, inden du går i gang med arbejdet.

n Opbevar alle smittefarlige eller potentielt smittefarlige materialer i brudsikre, tætte beholdere.

n Tag beskyttelsesudstyr af, inden du forlader laboratoriet.

n Når du er iført handsker, må du ikke skrive, tage telefonen, tænde for lyset eller røre ved noget, som
andre personer uden handsker kan komme til at røre ved.

n Skift hyppigt handsker. Fjern handskerne straks, når de er blevet synligt kontamineret.

n Materialer, der ikke kan dekontamineres korrekt, må ikke udsættes for potentielt infektiøse
materialer.

n Efter afslutning af en procedure, der involverer biologisk farlige materialer, skal arbejdsområdet
dekontamineres med et passende desinficeringsmiddel (for eksempel en 1:10 fortynding af
klorblegemiddel til husholdningsbrug).
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Overfladedekontaminering

ADVARSEL! For at forhindre elektrisk stød skal instrumenter altid slukkes og frakobles
før dekontaminering.

Følgende områder kan rengøres med et hvilket som helst bakteriedræbende, virusdræbende eller
svampedræbende desinfektionsmiddel til hospitalsbrug:

n Udvendigt låg og kabinet

n Indre prøveblokoverflade og prøveblokbrønde

n Kontrolpanel og skærm

For yderligere oplysninger om at klargøre og anvende desinfektionsmidlet henvises til producentens
anvisninger. Skyl altid prøveblokken og prøveblokbrøndene flere gange med vand efter anvendelse af
desinfektionsmiddel. Aftør prøveblokken og prøveblokbrøndene grundigt efter vask.

Vigtigt: Undgå at bruge slibe- eller skuremidler eller stærke alkaliske opløsninger. Disse stoffer kan
ridse overfladerne og beskadige prøveblokken og dermed medføre reduceret nøjagtighed i
forbindelse med termisk kontrol.

Bortskaffelse af biologisk farlige materialer

Bortskaf følgende potentielt kontaminerede materialer i overensstemmelse med lokale og nationale
laboratoriebestemmelser:

n Kliniske prøver

n Reagenser

n Brugte reaktionsbeholdere eller andre forbrugsartikler, der kan være kontaminerede

Kemiske risikofaktorer
CFX Opus Dx-system indeholder ingen potentielt farlige kemiske materialer.

Eksplosions- eller brandfare
CFX Opus Dx-system udgør ikke nogen særlig fare for så vidt angår brand eller eksplosion, når det
anvendes på korrekt vis som anvist af Bio-Rad Laboratories.
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Transport

Elektriske risikofaktorer
CFX Opus Dx-system udgør ingen særlig elektrisk fare for operatører, hvis det installeres og anvendes
korrekt uden fysiske modifikationer, og hvis det er tilsluttet til en strømkilde med den korrekte angivelse.

Transport
Inden du flytter eller sender CFX Opus Dx-system, skal der foretages dekontamineringsprocedurer. Flyt
eller send altid systemet i en separat beholder i det medfølgende emballeringsmateriale fra Bio-Rad, som
beskytter instrumentet mod skader.

Kontakt dit lokale Bio-Rad-kontor for oplysninger om transport af systemet og for at anmode om passende
emballeringsmateriale.

Batteri
CFX Opus Dx-system bruger et 3 V lithium-metal knapcellebatteri til at opretholde tidsindstillinger i
tilfælde af vekselstrømstab. Hvis tiden ikke forbliver indstillet, efter der er blevet slukket for enheden, kan
det være et tegn på, at batterierne er ved at løbe tør.

ADVARSEL! Forsøg ikke selv at skifte batterierne. De kan ikke serviceres af brugeren.
Kontakt i stedet Bio-Rads tekniske support for assistance.

Kun gældende for delstaten Californien i USA

n Perkloratmateriale - Lithiumbatterier indeholder perkloratmateriale. Særlig håndtering kan være
påkrævet. Se www.dtsc.ca.gov/hazardouswaste/perchlorate.

Bortskaffelse
CFX Opus Dx-system indeholder elektriske materialer. Disse må ikke bortskaffes som usorteret affald og
skal indsamles separat i henhold til EU-direktiv 2012/19/EU om affald af elektrisk og elektronisk udstyr –
WEEE-direktivet. Kontakt dit lokale Bio-Rad-kontor vedrørende landespecifikke anvisninger inden
bortskaffelse.

Garanti
CFX Opus Dx-system og dets tilknyttede tilbehør er dækket af en Bio-Rad-standardgaranti. Kontakt dit
lokale Bio-Rad-kontor for at få nærmere oplysninger om garantien.
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Kapitel 1 Indledning
Bio-Rads højtydende PCR-amplifikationssystem omfatter de seneste teknologiske fremskridt, hvilket
giver større nøjagtighed og reproducerbarhed i forbindelse med nukleinsyreamplifikation ved genomiske
forsøg.

Bio-Rads CFX Maestro Dx Software, Security Edition er kompatibel med følgende instrumenter og
indeholder optimerede kørselsfiler for Bio-Rads PrimePCR primer- og probeassays.

n CFX Opus 96 Dx Real-Time PCR-systemet (fremover henvist til som CFX Opus 96 Dx i denne
vejledning)

n CFX Opus 384 Dx Real-Time PCR-systemet (fremover henvist til som CFX Opus 384 Dx i denne
vejledning)

n CFX Opus Deepwell Dx Real-Time PCR-system (omtales i denne vejledning som CFX Opus
Deepwell Dx)
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Ved hjælp af CFX Maestro Dx Software, Security Editionn (fremover henvist til som CFX Maestro Dx SE i
denne vejledning) er det muligt at fortolke komplekse data og udarbejde effektive studier til genanalyse.
Med et par enkelte klik kan du oprette studier og fortolke et genekspressionsstudie med værktøjer som for
eksempel t-test, ensidet ANOVA, PrimePCR-kontrolanalyse og værktøjet til valg af referencegen.
Derefter kan du klargøre dine resultater til publikationer og andet med CFX Maestro Dx SE’s værktøjer til
datavisualisering og anmærkning, som kan tilpasses.

Bemærk: Visningen for nogle skærmbilleder i CFX Maestro kan se anderledes ud end dem, der er
vist i denne brugervejledning. Visningen i softwaren er korrekt, og funktionaliteten er den samme.

Vigtigt: Cybersikkerhed er beskyttelsen af aktiver i cyberspace mod cyberangreb. Cybersikkerhed
er Bio-Rads evne til at sikre sine medarbejdere, informationer, systemer og virksomhedens
omdømme i cyberspace. Cyberspace er den altid tilgængelige, teknologisk forbundne verden, som
består af mennesker, organisationer, information og teknologi.

Hurtige reaktioner er vigtige i forbindelse med cybersikkerhedsproblemer! Hvis du har en mistanke om, at
der kan være et cybersikkerhedsproblem i forbindelse med dit instrument, eller om, at cybersikkerheden
er blevet krænket på din lokation, skal du straks kontakte din Bio-Rad-repræsentant for at få teknisk
support.
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Hovedfunktioner i CFX Maestro Dx Software, Security
Editionn

CFX Maestro Dx SE kan bruges til følgende:

n Analysere data med søjlediagrammer, klyngeoversigter eller punktdiagrammer til hurtig fortolkning
og forståelse af dine resultater.

n Tilpasse din datarepræsentation og eksportere grafer med høj opløsning til udgivelse og
udarbejdelse af rapporter.

n Undersøge RNA-kvalitet og fejlsøge på eksperimenter med PrimePCR-analysekontroller.

n Vælge det bedst egnede referencegen og analysere dets stabilitet med værktøjet til valg af
referencegen.

n Udføre statistisk analyse, herunder ensidet variansanalyse (ANOVA) i genekspressionsanalyse.

Denne brugervejledning forklarer disse funktioner, og hvordan de bruges.

Få mere at vide
Når du har installeret CFX Maestro Dx SE og har konfigureret det tilknyttede Bio-Rad PCR-instrument,
har du adgang til denne vejledning samt detaljerede CFX Maestro Dx SE hjælpemner i menuen Help
(Hjælp) i enhver visning.

Tip: Klik på Bio-Rad-logoet i øverste højre hjørne af et hvilket som helst CFX Maestro Dx SE-vindue
for at gå til Bio-Rads hjemmeside. Denne hjemmeside indeholder links til tekniske notater, manualer,
videoer, produktoplysninger og teknisk support. De indeholder desuden et stort antal tekniske
ressourcer vedrørende mange forskellige metoder og programmer med relation til PCR, real-time
PCR og genekspression.
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Kapitel 2 Installation af CFX Maestro Dx Software,
Security Editionn

Dette kapitel beskriver, hvordan CFX Maestro Dx Software, Security Editionn installeres. For information
om opsætning af real-time PCR-instrumenter, der understøttes af Bio-Rad, henvises til den relevante
vejledning.

CFX Maestro Dx SE er nødvendig for at kunne analysere real-time PCR-data fra systemerne CFX Opus
96 Dx, CFX Opus 384 Dx og CFX Opus Deepwell Dx Real-Time PCR. Du kan også bruge softwaren til at
styre disse systemer i softwarestyret tilstand.

CFX Opus Dx-systemer leveres med et USB-kabel i tilbehørsposen. Brug USB-kablet til at tilslutte
computeren, der kører CFX Maestro Dx SE, til CFX Opus Dx-systemet.

Fjern indpakningsmaterialet, og gem det til fremtidig brug. Hvis et element mangler eller er beskadiget,
skal det lokale Bio-Rad-kontor kontaktes.
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Systemkrav
Tabel 3 indeholder en liste med minimums- og anbefalede systemkrav for den computer, der kører
CFX Maestro Dx SE.

System Minimum Anbefalet

Operativsystem Microsoft Windows 10 (kun
64-bit), build 1511 eller nyere,
med de nyeste
sikkerhedsopdateringer.

Microsoft Windows 10 (kun 64-bit), build
1511 eller nyere, med de nyeste
sikkerhedsopdateringer.

Bemærk:Windows 11 understøtter også CFX Maestro Dx Software, Security Edition.

Vigtigt: Secure Boot (Sikker bootstart) skal deaktiveres på computere, der kører CFX Maestro Dx SE.
Computere, der kører CFX Maestro Dx SE, skal konfigureres således, at de ikke genstarter automatisk
efter en system- eller sikkerhedsopdatering, hvis en kørsel er i gang. Kontakt din systemadministrator
for hjælp.

Indgange 2 USB 2.0
højhastighedsindgange

2 USB 2.0 højhastighedsindgange

Harddiskplads 128 GB 128 GB

Processorhastighed 2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Skærmopløsning 1024 x 768 med true-color-
tilstand (ægte farver)

1280 x 1024 med true-color-tilstand (ægte
farver)

PDF-læser Adobe PDF Reader eller Windows PDF
Reader fra en af de understøttede Microsoft
Office-pakker:

n 2016

n 2019

Lokalisering Understøttede Microsoft
Windows 64-bit
operativsystemer på engelsk,
kinesisk og russisk

Understøttede Microsoft Windows 64-bit
operativsystemer på engelsk, kinesisk og
russisk

Tabel 3. Krav til computeren for CFX Maestro Dx SE
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Bemærk: Hvis du planlægger at køre CFX Automation Control-softwaren på den samme computer
som CFX Maestro Dx SE, skal skærmopløsningen indstilles til 1280 x 1024 med true-color-tilstand
(ægte farver).
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Installation af CFX Maestro Dx SE softwaren
Vigtigt: Du skal frakoble alle tilsluttede instrumenter fra CFX Maestro Dx SE-computeren, før du
installerer og opgraderer softwaren. Det er ikke nødvendigt at slukke for instrumentet under
installation af softwaren. Kontrollér, at alle kørsler er gemt, og at der ikke kører nogen eksperimenter.

Bemærk: Kontrollér, at Secure Boot (Sikker bootstart) er deaktiveret, inden installationen
påbegyndes. Sørg for, at computeren er konfigureret således, at den ikke genstarter automatisk efter
en system- eller sikkerhedsopdatering, hvis en kørsel er i gang. Kontakt din systemadministrator for
hjælp.

Sådan installeres CFX Maestro Dx SE-softwaren

1. Om nødvendigt frakobles alle tilsluttede instrumenter fra computeren.

Find og frakobl instrumentets USB-kabel fra computeren med CFX Maestro Dx SE installeret. Den
ende, der er tilsluttet til CFX Opus Dx-system, behøver ikke at blive frakoblet.

2. Log på computeren med CFX Maestro Dx SE installeret med administratorrettigheder.

3. Tilslut CFX Maestro Dx SE-softwarens USB-drev til computerens USB-indgang.

4. Naviger til og åbn USB-drevet med CFX Maestro Dx SE-softwaren i Windows Stifinder.

USB-drevet indeholder versionsnoter og følgende mapper:

n CFX

n Drivere

n Firmware

n Lynvejledning

CFX-mappen indeholder CFX Maestro Dx SE installationsprogrammet
(CFXMaestroDxSetup.exe). sammen med andre filer.

5. Åbn CFX-mappen, og dobbeltklik på CFXMaestroDxSetup.exe for at starte installationsprogrammet.

6. Følg installationsinstruktionerne på skærmen.

Når dette er gennemført, vises ikonet Bio-Rad CFX Maestro Dx Software, Security Edition på
computerens skrivebord.

Tip: CFX Maestro-installationsprogrammet installerer brugervejledningen til CFX Maestro Dx
Software, Security Edition. Du kan finde disse vejledninger ved at navigere til menuen Help
(Hjælp) og vælge Open User Guides (Åbn brugervejledninger).

7. USB’en med softwaren kan skubbes ud, når installationen er færdig.
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Registrering af tilsluttede instrumenter
Under installationen installerer installationsprogrammet til CFX Maestro Dx SE automatisk
instrumentdrivere på CFX Maestro Dx SE-computeren. CFX Maestro Dx SE registrerer tilsluttede
instrumenter, når du starter softwaren.

Sådan registreres tilsluttede instrumenter

1. Hvis det ikke allerede er gjort, skal den firkantede ende (han) af det medfølgende USB-kabel (type B)
sættes i USB-indgangen (type B) bag på instrumentets base.

2. Indsæt den anden ende (port) i en USB-indgang på CFX Maestro Dx SE-computeren.

3. Hvis instrumentet ikke allerede kører, skal du trykke på tænd/sluk-knappen på instrumentet for at
tænde det.

4. Start CFX Maestro Dx SE.

Softwaren registrerer automatisk det tilsluttede instrument og viser dets navn i ruden Detected
Instruments (Registrerede instrumenter) i startvinduet.

Bemærk: Hvis instrumentet ikke vises i ruden Detected Instruments (Registrerede instrumenter),
skal du kontrollere, at USB-kablet er isat korrekt. For at geninstallere driverne skal du vælge Tools >
Reinstall Instrument Drivers (Værktøjer > Geninstaller instrumentdrivere) i startvinduet i
CFX Maestro Dx SE.
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Softwarefiler
Tabel 4 indeholder en liste over filtyperne i CFX Maestro Dx SE.

Filtype Filtypenavn Detaljer

Protokol .prcl Indeholder detaljerede oplysninger om protokollens
opsætning til udførelse af en PCR-kørsel.

Plade .pltd Indeholder detaljerede oplysninger om pladens
opsætning til udførelse af en PCR-kørsel.

Data .pcrd Indeholder resultaterne fra kørsel og PCR-analyse.

PrimePCR-kørsel .csv Indeholder protokol og pladelayout til PrimePCR-plader.

Genstudie .mgxd Indeholder resultaterne fra flere PCR-kørsler og
genekspressionsanalyser.

Stand-Alone (ikke-
softwarestyret)
prædatafil

.zpcr Indeholder fluorescensaflæsninger fra stand-alone (ikke-
softwarestyret) instrumentdrift, konverteret til en datafil.

LIMS .plrn Indeholder oplysninger om pladeopsætningen og
protokollen, der er nødvendige for at kunne køre en
LIMS-kompatibel kørsel.

JSON .json En skrivebeskyttet fil, der kun genereres af CFX Opus
Dx-systemer. Denne fil indeholder de data fra
kørselsfilen, der vises i detaljeruden i filbrowseren, når en
kørselsfil er valgt. Denne fil genereres, når en kørsel er
afsluttet. Den eksporteres sammen med .zpcr-filen og
gemmes sammen med datafilerne, hvis Save Location
(Placeringen, hvor filen gemmes) enten er et USB-drev
eller en delt netværksmappe.

Tabel 4. Filtyper i CFX Maestro Dx SE
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Kapitel 3 Administration af brugerkonti i
CFX Maestro Dx Software, Security Edition

Brugere logger ind på CFX Maestro Dx Software, Security Edition ved at bruge deres Windows-
brugernavn og adgangskode. Den person, der installerede CFX Maestro Dx SE, tildeles automatisk rollen
som administrator og kan oprette og administrere brugerkonti og roller. Alle andre brugere skal tildeles en
brugerkonto for at kunne logge ind og bruge softwaren.

Vigtigt: Hver bruger skal have enWindows-konto og adgangskode på CFX Maestro Dx SE-
computeren, før en brugerkonto og rolle kan tildeles brugeren. Brugere kan være medlem af gruppen
Windows Users (Windows-brugere) eller gruppenWindows Administrators (Windows-
administratorer). Medlemmer af Windows-brugergruppen har kun adgang til deres egne filer og
mapper i CFX Maestro Dx SE. Medlemmer af Windows-administratorgruppen har adgang til alle
brugeres filer og mapper.

Dette kapitel beskriver, hvordan man opretter Microsoft Windows-brugere for at føje disse brugere til
CFX Maestro Dx SE. Dette kapitel beskriver yderligere, hvordan du tilføjer CFX Maestro Dx SE-brugere
og administrerer brugerroller og rettigheder.
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Opstart af CFX Maestro Dx Software, Security Editionn
Bemærk: Hver bruger skal logge ind med deres Windows-brugernavn og adgangskode.

Sådan startes CFX Maestro Dx SE

1. Dobbeltklik på genvejsikonet til CFX Maestro Dx SE på CFX Maestro Dx SE-computerens skrivebord
for at starte programmet.

2. Indtast din Windows-adgangskode i dialogboksen Login, og klik på OK.

CFX Maestro Dx SE åbnes i startvinduet. Titellinjen viser den indloggede brugers Windows-
brugernavn, og menulinjen viser en blå mærkat, der angiver, at softwaren er i overensstemmelse
med 21 CFR, del 11 (se nedenfor).
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Tilføjelse af Microsoft Windows-brugere til computeren med
CFX Maestro Dx Software, Security Editionn

Alle brugere skal logge på CFX Maestro Dx SE med deres Windows-brugernavn og adgangskode. For at
kunne foretage nøjagtig revisionssporing kanWindows-brugerkonti ikke tilføjes via dialogboksen Start >
Settings > Accounts (Start > Indstillinger > Konti). Windows-brugerkonti skal tilføjes via konsollen
Computer Management (Computeradministration).

Vigtigt:Ændringer i Windows-brugerens egenskaber (herunder User name (Brugernavn) og Full
name (Fulde navn)), efter at du har oprettet den tilknyttede CFX Maestro Dx SE-bruger, ugyldiggør
CFX Maestro Dx SE-brugeren. Sørg for, at oplysningerne er korrekte, før du gemmer Windows-
brugeren og opretter den tilknyttede CFX Maestro Dx SE-bruger.

Tip: Gennemlæs dokumentationen Microsoft Windows Administration (Administration af Microsoft
Windows), og kontakt din Windows-systemadministrator for yderligere oplysninger, inden du opretter
Windows-konti.

Sådan føjes Windows-brugerkonti til CFX Maestro Dx SE-computeren

1. Log ind på CFX Maestro Dx SE-computeren sommedlem af Windows Administrator-gruppen.

2. På skrivebordet skal du højreklikke på My Computer (Denne computer) og vælge Manage
(Administrer) for at åbne konsollen Computer Management (Computeradministration).

3. I konsollen Computer Management skal du udvide Local Users and Groups (Lokale brugere og
grupper).

4. Højreklik på mappen Users (Brugere), og vælg New User (Ny bruger) for at åbne dialogboksen af
samme navn.
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Tilføjelse af Microsoft Windows-brugere til computeren med CFX Maestro Dx Software, Security Editionn

5. I dialogboksen New User (Ny bruger) skal du udfylde følgende felter:

n User name (Brugernavn)

n Full name (Fulde navn)

n Password (Adgangskode)

n Confirm password (Gentag adgangskode)

6. Klik på Create (Opret).
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Tilføjelse og fjernelse af brugere i CFX Maestro Dx Software,
Security Editionn

Tip: Kun brugere med rolle som administrator i CFX Maestro Dx SE kan oprette og fjerne
CFX Maestro Dx SE-brugerkonti. Den person, der installerede CFX Maestro Dx SE, tildeles
automatisk rollen som administrator. Denne person kan så senere tildele administratorrollen til andre
brugere.

Bemærk: I CFX Maestro Dx SE skal mindst én bruger tildeles rollen som administrator.

Sådan føjes brugerkonti til CFX Maestro Dx SE

1. Kontrollér, at hver tiltænkt bruger er medlem af enten Windows-brugergruppen eller Windows-
administratorgruppen og har en Windows-adgangskode på CFX Maestro Dx SE-computeren.

2. Start CFX Maestro Dx SE, og log ind som administrator.

3. Vælg User > User Administration (Bruger > Brugeradministration) i startvinduet.

Dialogboksen User Administration (Brugeradministration) åbnes.
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4. I afsnittet Manage Users (Administrer brugere) skal du angive følgende oplysninger for hver bruger:

n User name (Brugernavn) — i CFX Maestro Dx SE skal dette være brugerens Windows-login-
brugernavn.

n Full name (Fulde navn) — brugerens fulde navn.

Dette navn vises i feltet Full name (Fulde navn) i revisionssporet. Dette navn skal være identisk
med det navn, der er angivet i feltet Full Name (Fulde navn), da Windows-brugeren blev oprettet.

n Role (Rolle) — den rolle, der skal tildeles brugeren.

Bemærk: Du kan kun vælge én rolle fra rullelisten. Se Administration af brugerroller i
CFX Maestro Dx Software, Security Editionn for yderligere oplysninger.

n Domain (Domæne) —Windows-domænet, hvorfra brugeren åbner softwaren.

Kontakt din Windows-systemadministrator for yderligere oplysninger.

5. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne og lukke dialogboksen User
Administration (Brugeradministration).

Sådan fjernes en CFX Maestro Dx SE-brugerkonto

1. Start CFX Maestro Dx SE, og log ind som administrator.

2. I startvinduet skal du vælge User > User Administration (Bruger > Brugeradministration) for at åbne
dialogboksen User Administration (Brugeradministration).

3. Vælg Remove (Fjern) i ruden Manage Users (Administrer brugere) for hver bruger, som skal fjernes.

4. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne og lukke dialogboksen User
Administration (Brugeradministration).

Administration af brugerroller i CFX Maestro Dx Software,
Security Editionn

Vigtigt: CFX Maestro Dx SE kræver, at mindst én bruger tildeles rollen som administrator. Du kan
dog tildele denne rolle til flere end én bruger.

CFX Maestro Dx SE har fire brugerroller. Hver bruger skal tildeles en rolle for at få adgang til softwaren.
Selvom brugere kun kan tildeles én rolle, kan du når som helst ændre en brugers rolle.

Med undtagelse af administratorrollen kan du ændre de rettigheder, der er tildelt hver rolle. Alle brugere,
der er tildelt en rolle, overtager kun rettighederne for den rolle.

Som standard er rettighederne for hver rolle som følger:

n Administrator — denne rolle har alle rettigheder. Disse rettigheder kan ikke ændres.
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n Principal (Hovedbruger) — denne rolle har alle rettigheder undtagen rettigheden til at opsætte e-mail.

n Operator (Operatør) — denne rolle har alle rettigheder undtagen rettigheden til at springe cyklusser
over og opsætte e-mail.

n Guest (Gæst) — denne rolle kan kun læse filer.

Når du tildeler roller i CFX Maestro Dx SE, skal du nøje fastlægge kravene til hver bruger. For eksempel
kan brugere, der er tildelt rollen som gæst uden rettigheden til at gemme, ikke underskrive en fil. Desuden
kan ingen af brugerrollerne modtage en e-mail, når en kørsel er afsluttet, uden rettigheden til at oprette en
e-mailkonto.

Sådan ændres en rolles rettigheder

1. Start CFX Maestro Dx SE, og log ind som administrator.

2. I startvinduet skal du vælge User > User Administration (Bruger > Brugeradministration) for at åbne
dialogboksen User Administration (Brugeradministration).

3. I afsnittet Manage Rights (Administrer rettigheder) skal du for hver rolle rydde eller markere
afkrydsningsfeltet for de ønskede rettigheder efter behov.

4. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne og lukke dialogboksen User
Administration (Brugeradministration).

Visning af din rolle og rettigheder
Tip: Brugere, som er tildelt brugerrollerne Principal (Hovedbruger), Operator (Operatør) eller Guest
(Gæst), kan kun se deres egne brugerindstillinger, rettigheder og roller. Brugere, der er tildelt
administratorrollen, kan se alle brugertilladelser og roller.

Sådan vises din aktuelle brugerrolle og rettigheder

u Vælg User > User Administration (Bruger > Brugeradministration) i startvinduet.

Kontakt CFX Maestro Dx SE-administratoren for at ændre de brugerindstillinger, rettigheder og roller,
som er angivet i vinduet User Administration (Brugeradministration).
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Kapitel 4 Sådan bruges CFX Maestro Dx Software,
Security Editionn

Vigtigt: CFX Maestro Dx Software, Security Edition bruger Microsoft Windows-brugergodkendelse
til at verificere adgangen til sikre CFX-datafiler. Kontakt din Windows-administrator for at oprette et
miljø i overensstemmelse med kravene i 21 CFR, del 11.

Med CFX Maestro Dx SE kan brugerne:

n Underskrive data og genstudiefiler.

n Beskytte datafiler med adgangskode.

n Se og udskrive revisionsspor.

Dette afsnit beskriver i detaljer, hvordan disse funktioner udføres.

Sikre filer
Som standard gemmer CFX Maestro Dx SE sikre filer i den indloggede brugers personlige mappe, som
findes på:

C:\Users\<username>\Documents\Bio-Rad\CFX_MDX\My qPCR

Du kan gemme og redigere .pcrd-filer i denne mappe. Denne mappe indeholder links til andre mapper (for
eksempel mappen Sample Files (Prøvefiler)), som indeholder filer, der er skrivebeskyttede. En
administrator kan imidlertid slette denne mappes indhold.

Tip: Din Windows-systemadministrator kan også oprette en delt mappe, og din CFX Maestro Dx SE-
administrator kan programmere softwaren til at gemme alle filer i den pågældende mappe.

I CFX Maestro Dx SE markeres plade-, protokol-, data- og genstudiefiler som sikre, når de gemmes. Du
kan oprette disse filer i CFX Maestro-softwaren eller i CFX Maestro Dx SE. Efter at de er gemt i
CFX Maestro Dx SE, kan filerne kun åbnes i CFX Maestro Dx SE.

CFX Maestro Dx SE opretter et revisionsspor for alle sikre data- og genstudiefiler (henholdsvis .pcrd- og
.mgxd-filer). Softwaren registrerer al revideret aktivitet i filens revisionsspor. Se Revisionsspor på side
305 for yderligere oplysninger.
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Kapitel 4 Sådan bruges CFX Maestro Dx Software, Security Editionn

Underskrift af sikre filer

Efter at have gemt en fil i CFX Maestro Dx SE kan brugerne tilføje en elektronisk underskrift. Brugerens
rolle skal have rettigheder til at gemme filer for at underskrive en fil. For eksempel har gæsterollen som
standard ikke rettigheder til at gemme filer, og derfor kan brugere, der er tildelt denne rolle, ikke
underskrive en fil.

I CFX Maestro Dx SE er underskrevne filer ikke defineret til skrivebeskyttet. De kan læses, ændres og
underskrives flere gange. Alle ændringer registreres i filens revisionsspor. Du kan underskrive følgende
filtyper:

n Datafiler (.pcrd)

n Genstudiefiler (.mgxd)

Bemærk: Filer skal gemmes, inden de kan underskrives. Hvis du for nylig har udført en kørsel i
CFX Maestro Dx SE, skal du først gemme den resulterende datafil.

Sådan underskrives en fil

1. Log ind på CFX Maestro Dx SE med dine Windows-brugeroplysninger.

2. Åbn den sikre data- eller genstudiefil, der skal underskrives.

3. Vælg File > Sign (Fil > Underskriv). Dialogboksen Electronic Signature (Elektronisk underskrift)
vises.

46 | CFX Maestro Dx SE-software



4. Indtast dit Windows-brugernavn og din adgangskode, og angiv en årsag til at underskrive filen.

Brugernavnet og årsagen til underskrivelse registreres i revisionssporet (se Revisionsspor på side
305 for yderligere oplysninger).

5. Klik på OK for at sende underskriften og lukke dialogboksen.

Ændring af sikre filer

I CFX Maestro Dx SE kan brugerne ændre sikre filer, herunder underskrevne og ikke-underskrevne data-
og genstudiefiler. Softwaren beder dig om at angive en årsag til ændringen, når du gemmer en ændret
sikker data- eller genstudiefil. Ændringerne registreres i filens revisionsspor.

Tip: Da softwaren ikke opretter revisionsspor for plade- eller protokolfiler, vil du ikke blive bedt om at
angive en årsag, når du gemmer ændringerne i disse filer.

Sådan gemmes en ændret data- eller genstudiefil

1. Log ind på CFX Maestro Dx SE med dine Windows-brugeroplysninger.

2. Åbn og rediger en sikker datafil eller genstudiefil.

Tip: Se Reviderbare hændelser på side 307 for en liste over reviderbare aktiviteter.
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3. Vælg File > Save (Fil > Gem). Dialogboksen Audit Trail Change Reason (Revisionsspor for årsag til
ændring) vises.

Denne dialogboks viser følgende oplysninger, der er hentet fra filens revisionsspor-overskrift for hver
ændringshændelse:

n Date (Dato) — datoen, hvor ændringen fandt sted.

n User (Bruger) —Windows-domænet og brugernavnet for den indloggede bruger.

n Comment (Kommentar) — den senest gemte kommentar.

n Signature (Underskrift) — den elektroniske signatur fra den seneste person, der underskrev
filen.

n Signature reason (Underskriftårsag) — årsagen til underskriften.

n Application (Program)— CFX Maestro Dx SE (vises som BioRadCFXManager.exe, hvilket er
korrekt).

n Application version (Programversion) — den aktuelle version af CFX Maestro Dx SE.

n Full user (Brugernavn) — den indloggede brugers fulde navn.

Bemærk: Dette navn vises i revisionssporet.
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n Machine (Maskine) — den computer, som softwaren er installeret på.

Ændringstabellen viser de reviderbare ændringer, der opstod som et resultat af ændringen. En
eventuelt kort beskrivelse af årsagen til ændringen vises også.

Tip: Du kan tilføje eller redigere beskrivelser i kolonnen Reason for Change (Årsag til ændring).

4. Gennemgå listen over ændringer. Angiv en detaljeret beskrivelse af årsagerne, hvis det er
nødvendigt.

5. Gør et af følgende:

n Klik på Save Changes (Gemændringer) for at gemmeændringerne i filen samt de ændringer, du
har foretaget i tabellen, og lukke dialogboksen.

Ændringerne i filen og årsagerne til ændringerne vises i filens revisionsspor.

n Klik på Cancel Changes (Annuller ændringer) for at gendanne filen til dens tidligere tilstand og
lukke dialogboksen.

Ændringerne gemmes ikke i filen, og revisionssporet opdateres ikke.

Brugervejledning | 49



Kapitel 4 Sådan bruges CFX Maestro Dx Software, Security Editionn

Adgangskodebeskyttelse af filer

CFX Maestro Dx SE har et ekstra sikkerhedsniveau, som gør det muligt for brugere at beskytte sikre filer
med adgangskoder. Når du indstiller adgangskoder til en sikker fil, skal du overveje følgende betingelser:

Betingelse Handling

Der kræves ingen adgangskode. Alle brugere kan åbne, ændre og gemme den sikre fil,
baseret på deres tilladelser.

Filen kræver adgangskode for at
kunne gemmes.

Alle brugere kan åbne den sikre fil, og brugere, der
kender adgangskoden til at gemme filen, kan ændre og
gemme den sikre fil.

Filen kræver adgangskode for at
kunne åbnes.

Kun brugere, der kender adgangskoden til at åbne filen,
kan åbne, ændre og gemme den sikre fil.

Filen kræver adgangskode til
både at åbne og gemme filen.

Nogle brugere kan åbne den sikre fil, og en undergruppe
af disse brugere kan ændre og gemme filen.

Enhver bruger kan - afhængigt af sin rolle - udføre handlingen Save As (Gem som) for at oprette en ny
sikker fil med et andet navn eller gemme en fil med samme navn på en anden placering, så længe en af
følgende betingelser er gældende:

n Den sikre fil er ikke adgangskodebeskyttet.

n Brugeren har adgangskoden til at åbne filen.

Tip: Den nye fil gemmes uden adgangskodebeskyttelse. Den originale fil bevarer sine
adgangskoder.

En bruger kan - afhængigt af sin rolle - ændre og gemme den originale fil, så længe en af følgende
betingelser er gældende:

n Filen er ikke adgangskodebeskyttet.

n Brugeren har adgangskoden til at åbne filen og adgangskoden til at gemme filen.

Bemærk: Brugerens rolle skal omfatte rettigheden til at gemme filer for at kunne beskytte en fil med
adgangskode. For eksempel kan brugere med gæsterettigheder ikke gemme filer og kan derfor heller
ikke definere adgangskoder for en fil.

Vigtigt: Kun CFX Maestro Dx SE-brugere med rolle som administrator kan nulstille eller fjerne
adgangskoder.
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Sådan beskyttes en fil med adgangskode

1. Log ind på CFX Maestro Dx SE med dine Windows-brugeroplysninger.

2. Åbn den sikre fil.

3. Vælg File > File Passwords (Fil > Filadgangskoder). Dialogboksen File Passwords
(Filadgangskoder) vises.

4. Indtast adgangskoderne i feltet Save Password (Adgangskode for at gemme filen) og Open
Password (Adgangskode for at åbne filen).

Tip: Som standard vises adgangskoder som stjerner, når de skrives. Vælg Show Password (Vis
adgangskode) for at få vist adgangskoden, mens du skriver den.

Vigtigt: Når du indtaster adgangskoder, skelnes der mellem store og små bogstaver.
CFX Maestro Dx SE sætter ikke begrænsninger på adgangskoder. Din systemadministrator kan
fortælle dig om bedste praksis for krav til adgangskoder på installationsstedet.

5. Klik på Set Passwords (Indstil adgangskoder) for at definere de ønskede adgangskoder, og luk
derefter dialogboksen.

6. Vælg File > Save (Fil > Gem) for at gemme filændringerne.
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Sådan fjernes adgangskoder

Vigtigt: Du skal være en CFX Maestro Dx SE-bruger med rolle som administrator for at kunne fjerne
adgangskoder.

1. Klik på Remove Passwords (Fjern adgangskoder) i dialogboksen Password Required (Adgangskode
påkrævet).

Dialogboksen CFX Maestro Dx SE-login vises.

2. Angiv Windows-brugernavn og adgangskode for rollen som CFX Maestro Dx SE-administrator, og
klik derefter på OK.

Den originale datafil vises.

Vigtigt: Du skal gemme filen for at fjerne adgangskoderne.

3. Vælg File > Save (Fil > Gem) for at gemme filændringerne.
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Sådan ændres adgangskoder

Vigtigt: Kun CFX Maestro Dx SE-brugere med rolle som administrator kan ændre adgangskoder.

1. Åbn den sikre fil.

2. Vælg File > File Passwords (Fil > Filadgangskoder). Dialogboksen File Passwords
(Filadgangskoder) vises.

Tip: Adgangskoderne for at gemme og åbne filen samt funktionen Vis adgangskode er
deaktiveret.

3. Klik på Reset Passwords (Nulstil adgangskoder).

Dialogboksen CFX Maestro Dx SE-login vises.
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4. Angiv Windows-brugernavn og adgangskode for rollen som CFX Maestro Dx SE-administrator, og
klik derefter på OK.

Dialogboksen File Passwords (Filadgangskoder) vises.

5. Gør et af følgende:

n For at nulstille adgangskodebeskyttelsen skal du indtaste en ny adgangskode i det relevante felt.

n For at fjerne adgangskodebeskyttelsen skal du fjerne markeringen i adgangskodefelterne.

6. Klik på Set Passwords (Indstil adgangskoder) for at gemmeændringerne til adgangskoden og lukke
dialogboksen.
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Kapitel 5 Arbejdsområdet
CFX Maestro Dx Software, Security Edition indeholder en grænseflade til følgende: opsætning af plader,
udvikling af PCR-protokoller, kørsel af disse på CFX Opus Dx Deepwell Dx instrumenter og analyse af
data fra PCR-kørsler.

CFX Maestro Dx SE omfatter fem primære arbejdsområder:

n Startvinduet

n Startup Wizard (Guiden Opstart)

n Vinduet Protocol Editor (Protokoleditor)

n Vinduet Plate Editor (Pladeeditor)

n Vinduet Data Analysis (Dataanalyse)

Dette kapitel indeholder en kort beskrivelse og en visning af hvert arbejdsområde.
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Startvinduet
CFX Maestro Dx SE åbnes i startvinduet og viser Startup Wizard (Guiden Opstart), og her kan du opsætte
et eksperiment, foretage eller gentage en kørsel eller analysere en eksisterende kørsel. I startvinduet kan
du desuden se program- og instrumentlogfiler, oprette og administrere brugere samt få adgang til
adskillige nyttige redskaber. Der findes flere oplysninger i Kapitel 6, Startvinduet.
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Startup Wizard (Guiden Opstart)

Startup Wizard (Guiden Opstart)
Brug Startup Wizard (Guiden Opstart) til hurtig opsætning og kørsel af brugerdefinerede eksperimenter,
eller vælg og kør et PrimePCR-eksperiment. Du kan også bruge denne guide til at gentage en kørsel eller
analysere kørselsdata.
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Vinduet Protocol Editor (Protokoleditor)
I Protocol Editor (Protokoleditor) kan du oprette, åbne, gennemgå og redigere en protokol. Du kan også
ændre lågets temperatur for den åbne protokol. Funktionerne i Protocol Editor (Protokoleditor) er
nærmere beskrevet i Kapitel 7, Oprettelse af protokoller.
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Vinduet Plate Editor (Pladeeditor)

Vinduet Plate Editor (Pladeeditor)
I Plate Editor (Pladeeditor) kan du oprette, åbne, gennemgå og redigere en plade. Funktionerne i Plate
Editor (Pladeeditor) er nærmere beskrevet i Kapitel 8, Klargøring af plader.
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Vinduet Data Analysis (Dataanalyse)
I vinduet Data Analysis (Dataanalyse) er der mulighed for at se og sammenligne kørselsdata, foretage
statistiske analyser, eksportere data og oprette rapporter, der er klar til offentliggørelse. Funktionen Data
Analysis (Dataanalyse) er nærmere beskrevet i Kapitel 10, Oversigt over dataanalyse og Kapitel 11,
Detaljerede oplysninger om dataanalyse.
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Kapitel 6 Startvinduet
CFX Maestro Dx Software, Security Edition indeholder en grænseflade til udvikling af PCR-protokoller,
kørsel af dem på CFX Dx-systemer og analyse af data fra PCR-kørsler.

Dette kapitel indeholder en introduktion til CFX Maestro Dx SE og en forklaring af de funktioner, som er
tilgængelige fra startvinduet.
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Startvinduet
CFX Maestro Dx SE åbnes i startvinduet og viser Startup Wizard (Guiden Opstart), og her kan du opsætte
en kørsel, foretage en kørsel, gentage en kørsel eller analysere en eksisterende kørsel. I startvinduet kan
du desuden se program- og instrumentlogfiler, oprette og administrere brugere samt få adgang til
adskillige nyttige redskaber.

1. Softwarens titellinje viser navnet på softwaren og den bruger, der er logget på.

2. Menulinjen giver hurtig adgang til kommandoerne i menuerne File (Fil), View (Vis), User
(Bruger), Run (Kørsel), Tools (Værktøjer), Window (Vindue) og Help (Hjælp).

3. Kommandoerne i værktøjslinjen giver hurtig adgang til menupunkterne.

4. Venstre rude viser de instrumenter, der er forbundet til CFX Maestro Dx SE-computeren, og
indeholder knapper, som anvendes til betjening af låget og visning af instrumenternes status.

5. Hovedruden viser arbejdsvinduet. Standardarbejdsvinduet på startskærmen er Startup Wizard
(Guiden Opstart).

FORKLARING
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Startvinduet

6. Statuslinjen viser navne på de tilsluttede instrumenter og den bruger, der er logget på.

Kommandoer i menuen File (Fil)
New (Ny) – åbner en dialogboks, hvorfra du kan vælge at oprette en ny protokol, en ny plade eller et nyt
genstudie.

Open (Åbn) – åbner en dialogboks, hvorfra du kan vælge at navigere til og åbne en eksisterende protokol,
en eksisterende plade, en eksisterende datafil, et eksisterende genstudie eller en eksisterende LIMS-fil,
der køres fra et separat instrument (separat kørsel) eller PrimePCR-kørselsfil.

Recent Data Files (Seneste datafiler) – viser en liste over senest åbnede PCR-filer.

Repeat a Run (Gentag en kørsel) – åbner Windows Stifinder på placeringen for gemte PCR-filer, hvor du
kan finde en kørsel, der skal gentages.

Exit (Afslut) – lukker CFX Maestro Dx SE.

Kommandoer i menuen View (Vis)
Application Log (Programlogfil) – viser en logfil over softwarebrug fra den første installation til dags dato.

Run Reports (Kørselsrapporter) – viser en liste over rapporter fra tidligere kørsler.

Startup Wizard (Guiden Opstart) – viser Startup Wizard (Guiden Opstart) i hovedvinduet.

Run Setup (Kørselsopsætning) – viser vinduet Run Setup (Kørselsopsætning) i hovedvinduet.

Instrument Summary (Instrumentoversigt) – viser vinduet Instrument Summary (Instrumentoversigt) i
hovedvinduet.

Detected Instruments (Registrerede instrumenter) – kan skiftes mellem at vise og skjule tilsluttede
instrumenter i venstre rude. Softwaren viser som standard tilsluttede instrumenter i venstre rude.

Toolbar (Værktøjslinje) – kan skiftes mellem at vise og skjule værktøjslinjen øverst på skærmen.
Softwaren viser som standard værktøjslinjen.

Statuslinje – kan skiftes mellem at vise og skjule statuslinjen nederst på skærmen. Softwaren viser som
standard statuslinjen.

Show (Vis) – åbner en dialogboks, hvorfra du kan:

n se eller blokere statuslogfilen.

n åbne og se CFX Maestro Dx SE-datamappen.

n åbne og se brugerens datamappe.

n åbne og se LIMS-filmappen.
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n åbne og se PrimePCR-mappen.

n se kørselshistorikken.

n se egenskaber for alle tilsluttede instrumenter.

Kommandoer i menuen User (Bruger)
Select User (Vælg bruger) – åbner skærmen Login, hvor du kan vælge en bruger fra rullelisten User
Name (Brugernavn) og logge på programmet.

Change Password (Skift adgangskode) – åbner dialogboksen Change Password (Skift adgangskode),
hvor brugerne kan ændre deres adgangskode.

Bemærk: Denne indstilling er deaktiveret for CFX Maestro Dx SE. Brugere skal ændre deres
Windows-adgangskode for at ændre deres CFX Maestro Dx SE-adgangskode.

User Preferences (Brugerpræferencer) – åbner dialogboksen User Preferences (Brugerpræferencer),
hvor brugerne kan ændre standardindstillingerne for følgende:

n Afsendelse og modtagelse af e-mailbesked ved afslutningen af kørslen

n Lagring af datafiler

n Oprettelse af protokoller via Protocol Editor (Protokoleditor) eller Protocol AutoWriter
(Automatisk protokolskriver)

n Oprettelse af plader

n Analyse af data

n Udførelse af genekspressionsanalyse

n Bestemmelse af datakvalitet

n Eksport af CFX instrumentdata

User Administration (Brugeradministration) – åbner dialogboksen User Administration
(Brugeradministration), hvor administratorerne kan oprette brugere, ændre rolletilladelser og tildele roller
til brugere.

Bio-Rad Service Login – kun til brug for Bio-Rads tekniske servicepersonale. Undlad at bruge denne
kommando.

Kommandoer i menuen Run (Kør)
User-defined Run (Brugerdefineret kørsel) – åbner vinduet Run Setup (Kørselsopsætning), i hvilket det
er muligt at indstille en brugerdefineret protokol og plade og derefter køre et PCR-eksperiment på det
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udvalgte instrument.

PrimePCR Run (PrimePCR-kørsel) – åbner fanen Start Run (Start kørsel) i vinduet Run Setup
(Kørselsopsætning) med standard-PrimePCR-protokollen og -pladelayoutet indlæst baseret på det valgte
instrument.

End-Point Only Run (Kun slutpunktskørsel) – åbner fanen Start Run (Start kørsel) i vinduet Run Setup
(Kørselsopsætning) med standardslutpunktsprotokollen og -pladelayoutet indlæst baseret på det valgte
instrument.

Qualification Run (Kvalificeringskørsel) – åbner fanen Start Run (Start kørsel) i vinduet Run Setup
(Kørselsopsætning) med standardkvalificeringsprotokollen og -pladelayoutet i Bio-Rad indlæst for det
valgte instrument.

Kommandoer i menuen Tools (Værktøjer)
Master Mix Calculator (Mastermix-beregner) – åbner Master Mix Calculator (Mastermix-beregneren),
hvor du kan oprette en reaktionsblanding og udskrive beregningerne.

Protocol AutoWriter (Automatisk protokolskriver) – åbner dialogboksen Protocol AutoWriter
(Automatisk protokolskriver), hvor du nemt kan oprette en ny protokol.

Ta Calculator (Ta-beregner) – åbner Ta Calculator (Ta-beregner), hvor du nemt kan beregne
hybridiseringstemperaturen for primerne.

Dye Calibration Wizard (Guide til farvestofkalibrering) – åbner Dye Calibration Wizard (Guide til
farvestofkalibrering), hvor du kan kalibrere et instrument til en ny fluorofor.

Reinstall Instrument Drivers (Geninstaller instrumentdrivere) – geninstallerer de drivere, som
kontrollerer kommunikationen med Bio-Rads real-time PCR-systemer.

Zip Data and Log Files (Zip data- og logfiler) – åbner en dialogboks, hvor du kan vælge filer, der skal
pakkes og gemmes i en zippet fil, som kan gemmes eller sendes via e-mail.

Batch Analysis (Batchanalyse) – åbner dialogboksen Batch Analysis (Batchanalyse), hvor du kan
indstille parametre til analyse af mere end én datafil ad gangen.

Options (Valgmuligheder) – åbner en dialogboks, hvor du kan:

n Konfigurere indstillingerne for e-mailserveren

n Konfigurere eksportindstillinger for LIMS, Seegene og andre datafiler

Tip: Du kan også vælge at starte Seegene Viewer automatisk ved eksport, hvis du vælger
at eksportere dine data i Seegene-format.

n Vælg det sprog, som brugergrænsefladen viser (engelsk, kinesisk, russisk)

Vigtigt: Du skal genstarte CFX Maestro Dx SE for at vise det valgte sprog.

Brugervejledning | 65



Kapitel 6 Startvinduet

Vigtigt: Dit operativsystems sprog skal svare til det sprog, du vil have vist på
brugergrænsefladen for CFX Maestro Dx SE.

Kommandoer i menuen Help (Hjælp)
Tip: Menuen Help (Hjælp) er tilgængelig på menulinjen i alle vinduer i CFX Maestro Dx SE.

Contents (Indhold) — viser fanen Contents (Indhold) i hjælpsystemet i CFX Maestro Dx SE.

Index (Indeks) — viser fanen Index (Indeks) i hjælpsystemet i CFX Maestro Dx SE.

Search (Søg) — viser fanen Search (Søg) i hjælpsystemet i CFX Maestro Dx SE.

Open User Guide (Åbn brugervejledning) — åbner en PDF med denne vejledning.

Additional Documentation (Yderligere dokumentation) — giver adgang til betjeningsvejledningen til
CFX Opus Dx Real-Time PCR-systemerne.

Release Notes (Versionsnoter) — åbner dokumentet Release Notes (Versionsnoter) for den installerede
version af CFX Maestro Dx SE.

Video Resources (Videoressourcer) — åbner et websted med videoressourcer til Bio-Rad som for
eksempel instruktionsvideoer.

qPCR Applications and Technologies Web Site—åbner Bio-Rads websted for qPCR Applications &
Technologies (qPCR-programmer og -teknologier), hvor du kan lære mere om real-time PCR (qPCR).

PCR Reagents Web Site—åbner Bio-Rads websted for PCR- og qPCR-reagenser, hvor du kan bestille
PCR-reagenser, supermixes, farvestoffer og kits.

PCR Plastic Consumables Web Site—åbner Bio-Rads websted for PCR Plastics and Consumables
(PCR-plast- og forbrugsvarer), hvor du kan bestille PCR-plader, pladeforseglinger, rør og hætter og andet
tilbehør i plast.

Software Web Site—åbner Bio-Rads websted for PCR Analysis-softwaren, hvor du kan bestille den
opdaterede version af Bio-Rads CFX Maestro Dx SE.

About (Om) – viser oplysninger om copyright og version for CFX Maestro Dx SE.

Kommandoer på værktøjslinjen

– åbner Windows Stifinder, hvor du kan navigere til og åbne en datafil eller en genstudiefil.

– åbner Master Mix Calculator (Mastermix-beregneren).
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– åbner vinduet Run Setup (Kørselsopsætning).

– åbner vinduet Run Setup (Kørselsopsætning) med standard-PrimePCR-protokollen og -
pladelayoutet indlæst baseret på det valgte instrument.

– åbner Startup Wizard (Guiden Opstart).
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Startup Wizard (Guiden Opstart)
Når CFX Maestro Dx SE starter, viser arbejdsruden Startup Wizard (Guiden Opstart). I Startup Wizard
(Guiden Opstart) kan du:

n Vælge et instrument fra listen med registrerede instrumenter og opsætte en brugerdefineret eller
PrimePCR-kørsel

n Åbne og gentage en kørsel

n Åbne en datafil for at analysere resultater fra en enkelt kørsel eller en genstudiefil med resultater fra
flere genekspressionskørsler

Disse opgaver er nærmere beskrevet i de efterfølgende kapitler.

Statuslinje
I venstre side af statuslinjen nederst i hovedvinduet i softwaren vises aktuel status for registrerede
instrumenter. I højre side af statuslinjen vises navnet på den aktuelle bruger samt dato og klokkeslæt.
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Ruden Detected Instruments (Registrerede instrumenter)
I ruden Detected Instruments (Registrerede instrumenter) vises alle instrumenter, som er forbundet til
CFX Maestro Dx SE computeren. Hvert instrument vises som standard som et ikon og dets serienummer vises
som dets navn.

Fra denne rude kan du:

n Se egenskaber og kalibrerede farvestoffer for det valgte instrument.

Der findes flere oplysninger om instrumentegenskaberne i Visning af et instruments egenskaber på
side 72.

n Se status for et tilsluttet instrument

n Åbne det motoriserede låg på det valgte instrument

n Lukke det motoriserede låg på det valgte instrument

n Se status for alle tilsluttede instrumenter

Sådan vises status for et tilsluttet instrument

u Vælg det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter), og gør et af
følgende:

n Klik på View Status (Vis status) i afsnittet Selected Instrument (Valgt instrument).

n Højreklik, og vælg View Status (Vis status) i den menu, som vises.

Dialogboksen Run Details (Kørselsdetaljer) åbnes og viser fanen Run Status (Kørselsstatus). Status
for det valgte instrument vises neden for ruden med kørslens status, for eksempel:
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Sådan åbnes eller lukkes låget på et instrument

u Vælg det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter), og gør et af
følgende:

n Klik på Open Lid (Åbn låg) eller Close Lid (Luk låg) i afsnittet Selected Instrument (Valgt
instrument).

n Højreklik, og vælg den relevante handling i den menu, som vises.

n Åbn dialogboksen Run Details (Kørselsdetaljer), vælg fanen Run Status (Kørselsstatus), og klik
på Open Lid (Åbn låg) eller Close Lid (Luk låg).

Sådan vises statussen for alle registrerede instrumenter

u Gør et af følgende:

n Klik på View Summary (Vis oversigt) i afsnittet All Instruments (Alle instrumenter) i ruden
Detected Instruments (Registrerede instrumenter).

n Vælg View > Instrument Summary (Vis > Instrumentoversigt) på menulinjen.

Dialogboksen Instrument Summary (Instrumentoversigt) vises.

Tip: Hvis systemet kun registrerer ét tilsluttet instrument, vises afsnittet All Instruments (Alle
instrumenter) ikke i ruden Detected Instruments (Registrerede instrumenter). Vælg View >
Instrument Summary (Vis > Instrumentoversigt) for at se instrumentoversigten for et enkelt
instrument.
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Betjeningselementer i værktøjslinjen Instrument Summary (Instrumentoversigt)

Tabel 5 indeholder en liste over betjeningselementer og funktioner i værktøjslinjen Instrument Summary
(Instrumentoversigt).

Knap Knapnavn Funktion

Create a new Run (Opret
en ny kørsel)

Opretter en kørsel på den valgte blok ved
at åbne vinduet Run Setup
(Kørselsopsætning).

Stop Stopper den igangværende kørsel på
valgte blokke.

Pause Sætter den igangværende kørsel på
valgte blokke på pause.

Resume (Genoptag) Genoptager kørslen på valgte blokke.

Flash Block Indicator (Lad
blokindikator blinke)

Blinker med LED-indikatoren på låget af
de valgte blokke.

Open Lid (Åbn låg) Åbner den valgte bloks motoriserede låg.

Close Lid (Luk låg) Lukker den valgte bloks motoriserede låg.

Hide Selected Blocks
(Skjul valgte blokke)

Skjuler de valgte blokke på listen
Instrument Summary
(Instrumentoversigt).

Show All Blocks (Vis alle
blokke)

Viser de valgte blokke på listen Instrument
Summary (Instrumentoversigt).

Show (Vis) Vælger, hvilke blokke der skal vises på
listen. Vælg en af mulighederne for at vise
alle registrerede blokke, alle inaktive
blokke, blokke der kører med den aktuelle
bruger, eller alle igangværende blokke.

Tabel 5. Betjeningselementer i værktøjslinjen Instrument Summary (Instrumentoversigt)
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Visning af et instruments egenskaber
I ruden Detected Instruments (Registrerede instrumenter) kan du se detaljerede oplysninger om et valgt
instrument, herunder dets egenskaber, status for forsendelsesskruen (kun CFX Connect- og CFX Touch-
instrumenter) og en liste over kalibrerede farvestoffer (fluoroforer).

Sådan vises instrumentegenskaber

u Højreklik på det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter), og
vælg Properties (Egenskaber) i den viste menu.

Fanen Properties (Egenskaber)

Fanen Properties (Egenskaber) viser tekniske oplysninger om det valgte instrument, herunder model,
serienumre på komponenter og firmwareversioner. Instrumentets standardnavn (serienummeret) vises
mange steder, herunder i ruden Detected Instruments (Registrerede instrumenter) og i overskriftslinjen i
dialogboksen Instrument Properties (Instrumentegenskaber). Du kan omdøbe instrumentet for lettere at
identificere det.

Bemærk: Du kan ikke ændre CFX Opus-instrumentets navn ved hjælp af CFX Maestro.

Fanen Calibrated Dyes (Kalibrerede farvestoffer)

Fanen Calibrated Dyes (Kalibrerede farvestoffer) viser de kalibrerede fluoroforer og plader for det valgte
instrument.

For at se detaljerede oplysninger om en kalibrering skal du klikke på Info-knappen i kolonnen Details
(Detaljerede oplysninger).
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Inden du starter
Dette afsnit beskriver opgaver, du muligvis skal udføre, før du bruger CFX Maestro Dx SE. Disse
omfatter:

n Oprettelse af et reaktions-mastermix

n Kalibrering af nye farvestoffer

Oprettelse af et reaktions-mastermix
Brug CFX Maestro Dx SE’s Master Mix Calculator (Mastermix-beregneren) til nemt at beregne det
påkrævede volumen af hver komponent i mastermixet. Du kan udskrive beregningstabellen for mastermix
på standardprinteren og gemme beregningerne for hver målsekvens (target) til senere brug.

Sådan oprettes et reaktions-mastermix ved brug af Master Mix Calculator (Mastermix-
beregneren)

1. For at åbne Master Mix Calculator (Mastermix-beregneren) skal du gøre et af følgende:

n Vælg Tools > Master Mix Calculator (Værktøjer > Mastermix-beregner).

n Klik på Master Mix Calculator (Mastermix-beregner) i værktøjslinjen.

Master Mix Calculator (Mastermix-beregneren) vises.
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2. Vælg en detektionsmetode i afsnittet Reaction (Reaktion):

n SYBR®Green/EvaGreen®

n Probes (Prober)

3. Klik på Create New (Opret ny) i afsnittet Target (Målsekvens) for at oprette en ny målsekvens
(target). Der vises et nyt navn på målsekvensen (target) på rullelisten med målsekvenser.

4. (Valgfrit) Sådan ændres navnet på standardmålsekvensen (target):

a. Fremhæv navnet på målsekvensen (target) på rullelisten med målsekvenser.

b. Angiv et nyt navn i feltet Target (Målsekvens).

c. Tryk på Enter-tasten.

5. Juster start- og slutkoncentrationerne for forward primer og revers primer samt eventuelle prober.

6. I afsnittet Master Mix Setup (Opsætning af mastermix) justeres værdierne for følgende:

n Number of reactions (Antal reaktioner), der skal køres
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n Reaction volume per well (Reaktionsvolumen pr. brønd)

n Template volume (Volumen af prøve) pr. brønd

n Supermix concentration (Supermix-koncentration) pr. brønd

n Excess reaction volume (Overskydende reaktionsvolumen) pr. brønd

7. (Valgfrit) Udfør trin 2-6 for så mange målsekvenser (targets), som der er behov for.

8. Vælg den målsekvens (target), der skal beregnes, i afsnittet Choose Target to Calculate (Vælg
målsekvens, der skal beregnes).

Tip: Du kan beregne én, flere eller alle målsekvenser (targets) på én gang.

De beregnede volumener af de påkrævede komponenter for hver valgt målsekvens (target) vises i
mastermix-tabellen.

9. Klik på Set as Default (Angiv som standard) for at indstille de mængder, der blev angivet i afsnittet
Target (Målsekvens) og Master Mix Setup (Opsætning af mastermix), som nye standardværdier.

10. Klik på OK for at gemme indholdet af dialogboksen Master Mix Calculator (Mastermix-beregner).

Sådan udskrives tabellen over mastermix-beregninger

u For at udskrive en tabel over mastermix-beregninger skal du klikke på Print (Udskriv).

Beregningstabellen udskrives på standardprinteren.

Sådan gemmes tabellen over mastermix-beregninger som en PDF

u Skift standardprinteren ud med en PDF-driver, og klik på Print (Udskriv) på Master Mix Calculator
(Mastermix-beregneren).

Sådan slettes målsekvenser (targets)

u Vælg målsekvensen (target) i rullelisten med målsekvenser, og klik på Remove (Fjern).

Vigtigt: Hvis en målsekvens (target) fjernes fra listen med målsekvenser, fjernes den også fra
de mastermix-beregninger, den anvendes i. Vær forsigtig, når du sletter en målsekvens.

Kalibrering af nye farvestoffer
Systemerne CFX Opus 96 Dx og CFX Opus Deepwell Dx er kalibreret fra fabrikken til arbejde med
almindeligt anvendte fluoroforer i plader med hvide og klare plader. CFX Opus 384 Dx er kalibreret fra
fabrikken til arbejde med almindeligt anvendte fluoroforer i udelukkende hvide plader. Tabel 6 indeholder en
liste over de fluoroforer og kanaler, som hvert enkelt instrument er kalibreret til.
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Bemærk: Systemerne CFX Opus 96 Dx, CFX Opus 384 Dx og CFX Opus Deepwell Dx indeholder
desuden en kanal beregnet til FRET-kemi. Denne kanal kræver ikke kalibrering til specifikke
farvestoffer.

Vigtigt: Hvis du foretager en brugerdefineret kalibrering af et farvestof, der i forvejen er kalibreret fra
fabrikken, bruger instrumentet den brugerdefinerede kalibrering i stedet for fabrikskalibreringen.

Fluoroforer Kanal Excitering, nm Detektion, nm Instrument

FAM, SYBR®
Green I

1 450-490 515-530 CFX Opus 96
Dx-, CFX Opus
384 Dx- og
CFX Opus
Deepwell Dx-
systemer

VIC, HEX, CAL
Fluor Gold 540, Cal
Fluor Orange 560

2 515-535 560-580 CFX Opus 96
Dx-, CFX Opus
384 Dx- og
CFX Opus
Deepwell Dx-
systemer

ROX, Texas Red,
CAL Fluor Red 610,
TEX 615

3 560-590 610-650 CFX Opus 96
Dx-, CFX Opus
384 Dx- og
CFX Opus
Deepwell Dx-
systemer

CY5, Quasar 670 4 620-650 675-690 CFX Opus 96
Dx-, CFX Opus
384 Dx- og
CFX Opus
Deepwell Dx-
systemer

Quasar 705, Cy5.5 5 672-684 705-730 Kun CFX Opus
96 Dx-systemer

FRET-kemi (ikke-fabrikskalibreret)

Tabel 6. Fabrikskalibrerede fluoroforer, kanaler og instrumenter
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Fluoroforer Kanal Excitering, nm Detektion, nm Instrument

Ikke-
fabrikskalibreret
farve

FRET 450-490 560-580 CFX Opus 96
Dx-, CFX Opus
384 Dx- og
CFX Opus
Deepwell Dx-
systemer

Sådan kalibreres nye farvestoffer på CFX-systemer

1. Vælg det ønskede instrument i startvinduet i ruden Detected Instruments (Registrerede
instrumenter).

2. Vælg Tools > Calibration Wizard (Værktøjer > Guiden Kalibrering) for at åbne guiden Dye Calibration
(Farvestofkalibrering).

Fluoroforer, der allerede er kalibreret på det ønskede instrument, vises i tabellen Calibrated
Fluorophores (Kalibrerede fluoroforer).

3. Vælg den fluorofor, der skal kalibreres, fra rullelisten i afsnittet Calibrate New or Existing
Fluorophores (Kalibrer ny eller Eksisterende fluoroforer).
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Hvis navnet på fluoroforen ikke findes på listen, kan du indtaste navnet i tekstfeltet for at føje det til
listen.

Vigtigt: Vær forsigtig, når du navngiver brugerdefinerede kalibrerede fluoroforer. Hvis du
opretter en brugerdefineret kalibrering af farvestoffer til en fluorofor med samme navn som en
fabrikskalibreret fluorofor, bruges den brugerdefinerede fluorofor (og ikke den fabrikskalibrerede
fluorofor) af instrumentet under kørslen.

4. Vælg en Plate type (Pladetype) for fluoroforen.

Hvis pladetypen ikke findes på listen, skal du indtaste navnet i tekstfeltet for at tilføje det til listen.

5. Vælg en Channel (Kanal) for fluoroforen.

6. Vælg en Plate column (Pladekolonne) for fluoroforen.

7. (Valgfrit) Indtast en farve, der skal knyttes til fluoroforen.

8. Klik på Add to Plate (Føj til plade) for at tilføje fluoroforen.

9. (Valgfrit) Gentag trin 3-8 for at tilføje alle de fluoroforer, du planlægger at kalibrere for pladen.

10. Klik på View Plate (Vis plade), når du er færdig med at tilføje fluoroforer, for at åbne vinduet Pure Dye
Plate Display (Pladevisning til rent farvestof).

Brug dette vindue som guide i forbindelse med pipettering af farvestoffer i pladen.

11. Klargør en 96-, 384- eller deep well-brønd til kalibrering af farvestof:

a. Pipettér farvestofopløsningen ned i hver af brøndene i henhold til det mønster, der vises i Pure
Dye Plate Display (Pladevisning til rent farvestof).

b. For hver fluorofor fyldes fire brønde med 50 µl (plade med 96 brønde eller deep well-plads) eller
30 µl (plade med 384 brønde) 300 nM farvestofopløsning. Bemærk, at mindst halvdelen af
pladen indeholder blindbrønde.

c. Forsegl pladen med den forseglingsmetode, du vil anvende til analysen.

12. Placer kalibreringspladen i blokken, og luk låget.

13. Klik på Calibrate (Kalibrer) i guiden Dye Calibration (Farvestofkalibrering), og klik derefter på OK for
at bekræfte, at pladen befinder sig i blokken.

14. Når CFX Maestro Dx Software, Security Editionn afslutter kalibreringskørslen, vises der en
dialogboks. Klik på Yes (Ja) for at afslutte kalibreringen og åbne Dye Calibration Viewer
(Farvestofkalibreringsfremviseren).

15. Klik på OK for at lukke vinduet.
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Indstilling af brugerpræferencer
Tip: Det er ikke nødvendigt at udføre disse trin for at kunne bruge CFX Maestro Dx SE. Det er ikke et
problem at springe dette afsnit over eller udføre disse opgaver på et andet tidspunkt.

I CFX Maestro Dx SE kan hver bruger tilpasse sit arbejdsmiljø. For eksempel kan du gøre følgende i
menuen Users > User Preferences (Brugere > Brugerpræferencer):

n Opsætte e-mailbeskeder ved afslutning af kørslen.

Bemærk: Denne funktion er kun tilgængelig for brugere, hvis rolle har fået tildelt denne
rettighed. Se Administration af brugerroller i CFX Maestro Dx Software, Security Editionn på side
43 for yderligere oplysninger.

n Ændre standardindstillingerne for

o Den placering, hvor filer gemmes

o Kørselsopsætningsfiler

o Præfiks til filnavn

n Indstille de standardparametre, der skal bruges ved oprettelse af en ny protokol og plade.

n Indstille standardparametre for dataanalyse og genekspression.

n Tilpasse standardkvalitetskontrolparametrene.

n Tilpasse parametre for dataeksport.

I menuen Tools (Værktøjer) kan du gøre følgende:

n Oprette en mastermix.

n Kalibrere farvestoffer til et specifikt instrument.

Bemærk: Mastermix og farvestofkalibrering er tilgængelige for enhver, som logger på softwaren.

Dette afsnit forklarer, hvordan disse opgaver udføres.

Opsætning af e-mailbeskeder

Du kan oprette forbindelse mellem CFX Maestro Dx SE og en udgående e-mailserver for at sende
e-mailbeskeder ved kørslens afslutning til en liste med brugere. Du kan også vedhæfte en datafil og en
analyserapport til listen over brugere. For yderligere oplysninger om forbindelsen mellem CFX Maestro
Dx SE og din SMTP-server henvises til Tilslutning af Security Edition til en SMTP-server på side 81.

Bemærk: En brugers mulighed for at få adgang til e-mailopsætningsfunktionen afhænger af
brugerens rolle og de rettigheder, brugeren har fået tildelt af administratoren. Se Administration af
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brugerroller i CFX Maestro Dx Software, Security Editionn på side 43 for nærmere oplysninger om
administration af brugere og disses roller.

Sådan opsættes e-mailbeskeder

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

Dialogen User Preferences (Brugerpræferencer) vises med fanen Email (E-mail).

Bemærk: Systemet giver besked, hvis det registrerer, at der ikke er konfigureret en gyldig
SMTP-server for CFX Maestro Dx SE. Klik på Configure Outgoing Email (Konfigurer udgående
e-mail) for at åbne dialogboksen Options (Valgmuligheder) og konfigurere SMTP-serveren til e-
mail. Se Tilslutning af Security Edition til en SMTP-server på side 81 for yderligere oplysninger.

2. Indtast e-mailadressen for hver af de personer, der skal have besked, når kørslen er gennemført, i
tekstfeltet To (Til). Alle modtagerne får en e-mail, så snart kørslen er gennemført.

Bemærk: Du skal angive hver enkelt e-mailadresse på en separat linje. Tryk på Enter eller
Return efter hver adresse.

3. (Valgfrit) Indtast e-mailadressen for hver af de personer, der skal have en kopi af e-mailbeskederne,
når kørslen er gennemført, i tekstfeltet cc.

4. (Valgfrit) Alle modtagere får som standard en kopi af datafilen som vedhæftet fil. Fjern markeringen
af dette afkrydsningsfelt, hvis der ikke skal vedhæftes en kopi af datafilen.

5. (Valgfrit) Vælg Attach Analysis Report (Vedhæft analyserapport) for at vedhæfte en PDF med
analyserapporten til e-mailen.

6. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Bemærk: Du kan muligvis konfigurere systemet til at sende en e-mail-meddelelse til din mobiltelefon
afhængigt af din tjenesteudbyder. Kontakt din mobiltelefontjenesteudbyder for at få specifikke
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oplysninger om e-mailadressen for din mobiltelefon. Indtast din telefons e-mailadresse (for eksempel
5552221234@din_tjenesteudbyder_EmailDomæne.net) i tekstfeltet på skærmen User Preferences
(Brugerpræferencer).

Sådan redigeres en modtagers e-mailadresse

u Rediger e-mailadressen efter behov, og klik på OK.

Sådan fjernes en e-mailmodtager

1. Vælg e-mailmodtageren, og tryk på tasten Delete (Slet).

2. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Tilslutning af Security Edition til en SMTP-server

Vigtigt: Visse kommercielle webmail-tjenesteudbydere har øget sikkerheden for e-mails. Hvis du
bruger disse konti, skal du aktivere indstillingen Allow less secure apps (Tillad mindre sikre apps) i
kontoindstillingerne for den relevante konto for at aktivere afsendelse af e-mail i CFX Maestro Dx SE.
Se sikkerhedsoplysningerne for din webmail-tjenesteudbyder for yderligere oplysninger.

Hvis du bruger Google Gmail eller Microsoft Office 365 SMTP-server til at sende e-mails, skal du aktivere
en 2-faktorgodkendelse og generere en "app-adgangskode" i dine Gmail- eller Office 365-
kontoindstillinger. For godkendelse i dialogboksen Maestro Email Setup (Maestro e-mailopsætning) skal
du kopiere og indsætte "app-adgangskoden" i feltet Password (Adgangskode) i stedet for den almindelige
e-mailadgangskode.

Du skal oprette forbindelse mellem CFX Maestro Dx SE og din e-mailserver, før softwaren kan sende en
e-mailbesked.

Sådan oprettes der forbindelse mellem CFX Maestro Dx SE og en e-mailserver

1. Gør et af følgende:

n Vælg User > User Preferences (Bruger > Brugerpræferencer), og klik på Configure Outgoing
Email (Konfigurer udgående e-mail) på fanen Email (E-mail).

n Vælg Tools > Options (Værktøjer > Valgmuligheder).

Dialogboksen Options (Valgmuligheder) vises med fanen Email (E-mail).
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2. Angiv følgende oplysninger for din virksomhed:

n SMTP Server Name (SMTP-servernavn) – navnet på den udgående e-mailserver i din
virksomhed.

n Port – din SMTP-servers portnummer. Dette er normalt 25.

n Use SSL (Brug SSL) – mulighed for anvendelse af Secure Sockets Layer (SSL). Visse SMTP-
servere kræver denne indstilling. Fjern markeringen i afkrydsningsfeltet, hvis det ikke kræves af
din virksomhed.

n Use Default “From” Address (Brug standard "Fra"-adresse) – navnet på e-mailserveren i din
virksomhed. Visse SMTP-servere kræver, at alle sendte e-mails har en "fra"-adresse, som er fra
et bestemt domæne, f.eks. navn@dinvirksomhed.com. Hvis dette er tilfældet, skal du fjerne
markeringen i afkrydsningsfeltet og angive en gyldig e-mailadresse.

n Authentication Required (Godkendelse kræves) – hvis websitet kræver kontogodkendelse,
skal dette afkrydsningsfelt være markeret.

n User Name (Brugernavn) – navnet på den godkendte konto. Dette kræves kun, hvis
Authentication Required (Godkendelse kræves) er valgt.
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n Password (Adgangskode) – adgangskoden til den godkendte konto. Dette kræves kun, hvis
Authentication Required (Godkendelse kræves) er valgt.

Vigtigt: Hvis du bruger Google Gmail eller Microsoft Office 365 SMTP-server til at sende e-
mails, skal du aktivere en 2-faktorgodkendelse og derefter generere en "app-adgangskode" i
dine Gmail- eller Office 365-kontoindstillinger. For godkendelse i dialogboksen Maestro Email
Setup (Maestro e-mailopsætning) skal du kopiere og indsætte "app-adgangskoden" i feltet
Password (Adgangskode) i CFX Maestro Dx SE i stedet for den almindelige e-
mailadgangskode.

For at verificere at indstillingerne for SMTP-serveren er korrekte, skal du angive en gyldig e-
mailadresse i tekstfeltet Test Email Address (Test e-mailadresse) og klikke på Test Email (Test e-
mail).

Bemærk: Visse SMTP-servere tillader ikke vedhæftede filer, og andre tillader vedhæftede filer
op til en bestemt størrelse. Hvis du vil sende datafiler og/eller rapporter via e-mail ved hjælp af
CFX Maestro Dx SE, skal du vælge Test Attachment (Test vedhæftet fil) og indstille Attachment
Size in MB (Størrelse på vedhæftet fil i MB) til 5 megabyte (MB) eller mere.

3. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Ændring af standardindstillinger for filer

På fanen Files (Filer) i dialogboksen User Preferences (Brugerpræferencer) kan du ændre følgende:

n Standardplaceringen, hvor filer gemmes i CFX Maestro Dx SE

n Standardfiler til kørselsopsætning

n Standardparametre for filnavngivning

Sådan ændres standardindstillingerne for filer

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Files (Filer) i dialogboksen User Preferences (Brugerpræferencer).
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3. Naviger til og vælg en standardmappe, hvor nye filer skal gemmes, i afsnittet Default Folder for File
Creation (Standardmappe til filoprettelse). Du kan vælge en forskellig placering for hver filtype:

n Protocol (Protokol)

n Plate (Plade)

n Data File (Datafil)

n Gene Study (Genstudie)

4. I afsnittet File Selection for Run Setup (Filvalg til kørselsopsætning) skal du navigere til og vælge de
protokol- og pladefiler for targets (målsekvenser), som skal vises, når vinduet Experiment Setup
(Eksperimentopsætning) åbnes.

5. Definer præfiks og/eller suffiks for datafiler i afsnittet Data File (Datafil). Vælg en ny værdi fra
rullelisten for hver enkelt del. Det er desuden muligt at angive tilpassede præfiks- og suffiksværdier i
tekstfelterne Prefix (Præfiks) og Suffix (Suffiks).

CFX Maestro Dx SE viser en forhåndsvisning af filnavnet neden for valgfelterne.

6. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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Indstilling af standardparametre for protokoller

Sådan indstilles standardparametre for protokoller for Protocol Editor (Protokoleditor) og
Protocol AutoWriter (Automatisk protokolskriver)

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Protocol (Protokol) i dialogboksen User Preferences (Brugerpræferencer).

3. Angiv værdierne for følgende indstillinger, som vises i Protocol Editor (Protokoleditor), i afsnittet
Protocol Editor (Protokoleditor):

n Sample volume (Prøvevolumen) – volumenet for hver af prøverne i brøndene (i µl).

n Lid Shutoff temperature (Lågets slukketemperatur) – den temperatur i ºC ved hvilken
varmelegemet i låget slukker under en kørsel.

4. Angiv værdierne for følgende indstillinger, som vises i Protocol AutoWriter (Automatisk
protokolskriver), i afsnittet Protocol AutoWriter (Automatisk protokolskriver):

n Annealing temperature (Hybridiseringstemperatur) – temperaturen i ºC til eksperimenter, der
bruger iProof DNA-polymerase, iTaq DNA-polymerase elle andre polymeraser.

n Amplicon length (Amplikonlængde) – længden af amplikonet i bp.

5. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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Indstilling af standardparametre for plader

Ændringer, der foretages på fanen Plate (Plade), er tilgængelige for alle brugere af softwaren. Ændringer,
der foretages under opsætningen af pladen, bliver tilgængelige for brugerne, når de er blevet gemt og
pladefilen lukket.

I dialogboksen User Preferences (Brugerpræferencer) kan du gøre følgende:

n Indstille standardparametre for plader.

n Tilføje nye navne på målsekvenser (targets), prøver og biologiske grupper i de respektive biblioteker.

n Slette navne på målsekvenser (targets), prøver og biologiske grupper fra de respektive biblioteker.

Sådan indstilles standardparametre for plader

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Plate (Plade) i dialogboksen User Preferences (Brugerpræferencer).
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3. Angiv værdierne for følgende indstillinger for en ny pladefil. Disse værdier vises i vinduet Plate Editor
(Pladeeditor):

n Pladetype

n Pladestørrelse

n Units (Enheder) – startkoncentrationen af target (målsekvensen) for brønde, som indeholder
standarder.

CFX Maestro Dx SE bruger disse enheder til at oprette en standardkurve under Quantification
(Kvantifikation) på fanen Data Analysis (Dataanalyse).

n Scientific notation (Videnskabelig notation) – når dette er valgt, viser CFX Maestro Dx SE
koncentrationsenhederne i videnskabelig notation.

n Scan mode (Scanningstilstand) – antallet eller typen af kanaler, der skal scannes under en
kørsel.

n Fluorophores (Fluoroforer) – de standardfluoroforer, der vises i betjeningselementerne for
brøndisætning i Plate Editor (Pladeeditor).

n Libraries (Biblioteker) – navnene på målsekvenser (targets), prøver og biologiske grupper, der
typisk anvendes i eksperimenterne:

o Target names (Navne på målsekvenser) – navnene på målgener og -sekvenser.

o Sample names (Prøvenavne) – navnene på eksperimentprøver eller identificerende
kendetegn for prøverne (f.eks. Mouse1, Mouse2, Mouse3).

o Biological group names (Navne på biologiske grupper) – navnene på grupper af
ensartede prøver, der har samme behandlingsstatus eller -betingelser (f.eks., 0Hr, 1Hr,
2Hr).

4. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Sådan føjes et nyt navn til en målsekvens (target), prøve eller biologisk gruppe

u Indtast navnet på målsekvensen (target), prøven eller den biologiske gruppe i det relevante felt under
Libraries (Biblioteker), og klik på OK.

Sådan slettes et navn på en målsekvens (target), prøve eller biologisk gruppe

u Vælg navnet i det relevante felt under Libraries (Biblioteker), og tryk på tasten Delete (Slet) og
derefter på OK.

Vigtigt: Navne, du fjerner fra biblioteket, fjernes fra softwaren og er ikke længere tilgængelige for
brugerne. For at gendanne standardnavnene i CFX Maestro Dx SE skal du klikke på Restore
Defaults (Gendan standardindstillinger). Alle præferencer for alle faner kan tilbagestilles til de
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oprindelige fabriksindstillinger ved at klikke på Restore Defaults (Gendan standarder) i dialogboksen
User Preferences (Brugerpræferencer). Vær forsigtig, når du sletter standardnavne i CFX Maestro
Dx SE, og når du klikker på denne knap.
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Indstilling af standardparametre for dataanalyse

Sådan indstilles standardparametre for dataanalyse

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Data Analysis (Dataanalyse) i dialogboksen User Preferences (Brugerpræferencer).

3. Vælg den tilstand, der skal bruges til at analysere data (enten Fluorophore (Fluorofor) eller Target
(Målsekvens)), i afsnittet Analysis Mode (Analysetilstand).

4. Indstil standardparametrene for de nedenstående valgmuligheder i afsnittet PCR Quantitation (PCR-
kvantifikation):

n Baseline Setting (Baselineindstilling) – den baselinemetode, der skal anvendes i
analysetilstand.

n Cq Determination Mode (Cq-bestemmelsestilstand) – den tilstand i hvilken Cq-værdierne
beregnes for hver enkel fluorescenskurvelinje (enten Regression (Regression) eller Single
Threshold (Enkel tærskel)).

n Threshold Calc. Mode (Tærskelberegningstilstand) – slutpunktsmålmængden.

Standard er Auto (Automatisk). Det betyder, at softwaren automatisk beregner slutpunktsmålet.
For at indstille en specifik tærskel skal du fjerne markeringen i afkrydsningsfeltet Auto
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(Automatisk) og indtaste den ønskede slutpunktsmængde beregnet i relative
fluorescensenheder (RFU). Maksimumværdien er 65.000,00 RFU'er. Datafilerne for
efterfølgende kørsler vil anvende denne tærskelindstilling.

n Baseline Calc. Mode (Baselineberegningstilstand) – baselineværdien for alle kurvelinjer.

Standard er Auto (Automatisk). Det betyder, at softwaren automatisk beregner baseline for alle
kurvelinjer. For at indstille en specifik baselineværdi skal du fjerne markeringen i
afkrydsningsfeltet Auto (Automatisk) og indtaste minimum- og maksimumværdier for
cyklusområdet (1 til 9999). Datafilerne for efterfølgende kørsler vil anvende dette cyklusområde.

n Log View (Logvisning) – bestemmer, hvordan softwaren viser amplifikationsdataene:

o On (Til) – amplifikationsdataene vises i en semilogaritmisk graf.

o Off (Fra) (standardindstilling) – amplifikationsdataene vises i en lineær graf.

5. Vælg antallet af slutcyklusser til gennemsnitsberegning under udførelse af slutpunktsberegningerne i
afsnittet End Point (Slutpunkt):

n PCR – antallet af slutcyklusser til gennemsnitsberegning af kvantifikationsdata (standard er 5).

n End Point Only run (Kun slutcyklusserpunktskørsel) – antallet af slutcyklusser til
gennemsnitsberegning af slutpunktsdata (standard er 2).

6. Vælg den Peak Type (Kurvetoptype), der skal detekteres, i afsnittet Melt Curve (Smeltekurve) (enten
Positive (Positiv) eller Negative (Negativ)).

7. Vælg, hvordan brøndbetegnelserne skal vises, i afsnittet Well Selector (Brøndvælger) (efter Sample
Type (Prøvetype), Target Name (Navn på målsekvens) eller Sample Name (Prøvenavn)).

8. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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Indstilling af standardparametre for genekspressionsdatafiler

Sådan indstilles standardparametrene for en ny genekspressionsdatafil

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Gene Expression (Genekspression) i dialogboksen User Preferences
(Brugerpræferencer).

3. Angiv værdierne for følgende indstillinger:

n Relative to (I forhold til) – indtegner genekspressionsdataene i forhold til en kontrol (startende
ved 1) eller i forhold til nul:

o Zero (Nul) – softwaren ignorerer kontrollen. Dette er standard, hvis der ikke er tildelt en
kontrolprøve i vinduet Experiment Settings (Eksperimentindstillinger).

o Control (Kontrol) – softwaren beregner dataene i forhold til den kontrolprøve, som er tildelt i
vinduet Experiment Setup (Eksperimentopsætning).

n X-axis (X-akse) – indtegner prøven eller målsekvensen (target) på x-aksen.

n Y-axis (Y-akse) – indtegner lineær skala, log2- eller log10-skala på y-aksen.

n Scaling (Skalering) – skaleringsindstillingen for grafen (standardindstillingen er Unscaled (Ikke
skaleret)):

o Highest (Højeste) – softwaren skalerer grafen efter det højeste datapunkt.

o Lowest (Laveste) – softwaren skalerer grafen efter det laveste datapunkt.

o Unscaled (Ikke skaleret) – softwaren viser dataene uden skalering i grafen.

n Mode (Tilstand) – analysetilstanden, enten relativ mængde (∆Cq) eller normaliseret ekspression
(∆∆Cq).

n Error Bar (Fejllinje) – datavariabilitet vist som enten standardafvigelse (Std. Dev.) eller
middelfejlen på middelværdien (Std. Error Mean).

n Error Bar Multiplier (Multiplikator for fejllinjer) – standardafvigelsesmultiplikator, der bruges til
at indtegne fejllinjerne (standarden er 1).

Du kan øge multiplikatoren til 2 eller 3.

n Sample Types to Exclude (Prøvetyper, der skal udelades) – de prøvetyper, der skal udelades
fra analysen.

Du kan vælge at udelade to eller flere prøver fra analysen. For at udelade alle prøvetyper skal du
fjerne markeringen i afkrydsningsfelterne for alle markerede prøvetyper.
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4. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Tilpasning af regler for kvalitetskontrol

I CFX Maestro Dx SE er det muligt at indstille regler for kvalitetskontrol, der anvendes på data i vinduet
Data Analysis (Dataanalyse). Softwaren validerer dataene iht. de indstillede regler.

Bemærk: Som standard er alle regler for kvalitetskontrol aktiveret.

Tip: Du kan nemt udelade brønde, der ikke består en kvalitetskontrolparameter, fra analysen i
kvalitetskontrolmodulet i vinduet Data Analysis (Dataanalyse).

Sådan tilpasses regler for kvalitetskontrol

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen QC (Kvalitetskontrol) i dialogboksen User Preferences (Brugerpræferencer).
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Hvor:

n NTC – ingen skabelonkontrol

n NRT – ingen revers transkriptasekontrol

n Efficiency (Effektivitet) – reaktionseffektivitet

n Std Curve R^2 (Standardkurve R^2) – R-kvadratværdi for standardkurven

n Replicate group Cq Std Dev (Replikatgruppe Cq standardafvigelse) – standardafvigelse
beregnet for hver replikatgruppe

3. Gør et af følgende for hver kvalitetskontrolregel:

n Hvis du vil bruge standardværdien, skal du ikke gøre noget.

n Hvis du vil ændre værdien, skal du klikke på det tilhørende tekstfelt Value (Værdi), indtaste en ny
værdi og trykke på tasten Enter.

n Hvis du vil deaktivere reglen, skal du fjerne markeringen i afkrydsningsfeltet Use (Brug).

4. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Tilpasning af parametre for dataeksport

Du kan eksportere CFX Maestro Dx SE-data i følgende formater:

n Tekst (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Vigtigt: Din computer skal have Microsoft Excel installeret, for at du kan eksportere data til et
Microsoft Excel-regneark.

Du kan angive typen af data, som skal eksporteres, og tilpasse det eksporterede data-output.
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Sådan tilpasses parametre for dataeksport

1. Vælg User > User Preferences (Bruger > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Custom Export (Tilpasset eksport) i dialogboksen User Preferences
(Brugerpræferencer).

3. Vælg et format, som dataene skal eksporteres i, på rullelisten Export Format (Eksportformat).

4. Markér eller fjern markeringen i afkrydsningsfelterne for den type af data, der skal eksporteres, i
afsnittet Data to Export (Data som skal eksporteres). De valgte elementer vises i listefeltet Exported
Columns (Eksporterede kolonner).

Bemærk: Kørselsoplysningerne er som standard inkluderet i overskriften. Fjern markeringen i
dette afkrydsningsfelt, hvis kørselsoplysningerne ikke skal medtages.

5. Du kan ændre outputvisningsrækkefølge for de valgte elementer.

Fremhæv elementet i listefeltet Exported Columns (Eksporterede kolonner), og klik på pileknapperne
til venstre for listen for at flytte det op eller ned.

6. Kolonnenavnene for outputtet af de valgte elementer kan eventuelt ændres:

a. Klik på Customize Column Names (Tilpas kolonnenavne).

Dialogboksen Column Name Customizer (Tilpasning af kolonnenavne) vises.
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b. Skriv et nyt navn i feltet Custom Name (Tilpasset navn) for hvert standardkolonnenavn, som skal
ændres.

c. Gør et af følgende:

n Klik på OK for at gemmeændringerne og vende tilbage til fanen Custom Export (Tilpasset
eksport). Det nye navn vises i parentes ved siden af standardkolonnenavnet i listefeltet
Exported Columns (Eksporterede kolonner).

n Klik på Cancel (Annuller) for at rydde ændringerne og vende tilbage til fanen Custom Export
(Tilpasset eksport).

7. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan tilbagestilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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En protokol er et sæt af trin, der udføres i en specifik rækkefølge. I CFX Maestro Dx Software, Security
Editionn er alle trinnene forbundet med valgmuligheder på instrumentet. For eksempel instruerer trinnene
instrumentet i at kontrollere blokkens og lågets temperatur, anvende en temperaturforskel hen over
blokken, tage en pladeaflæsning eller udføre en smeltekurveanalyse. Hver valgmulighed er angivet for
forskellige plade- og kørselstyper.

CFX Maestro Dx SE tilbyder to muligheder for oprettelse af protokoller: Protokol Editor (Protokoleditor) og
Protocol AutoWriter (Automatisk protokolskriver).

Protocol Editor (Protokoleditor) indeholder følgende funktioner:

n Standardbetjeningselementer for protokoller til hurtig oprettelse af protokoller

n Mulighed for hurtigt at beregne en gradient for det valgte antal rækker

n Mulighed for hurtigt at beregne kørselstid for den valgte pladetype

n Mulighed for at redigere protokoltrin

n Mulighed for at gemme protokoller med henblik på genanvendelse

n Mulighed for at udskrive protokollen til en standardprinter

Protocol AutoWriter (Automatisk protokolskriver) genererer automatisk en tilpasset PCR-protokol med
hot-start, første denaturering, hybridisering og forlængelsestrin ved brug af de angivne parametre. Du kan
derefter se en grafisk repræsentation af den foreslåede protokol og redigere, køre eller gemme
protokollen.
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Parametre og områder for protokoltrin
Brug oplysningerne i Tabel 7 til at ændre standardindstillingerne for trinene i din protokol.

Temperaturtrin

Måltemperaturen er en værdi på mellem 4,0 og 100,0 °C, indstillet i tiendedele af en grad. Systemet
varmer op til denne temperatur og holder denne temperatur i en bestemt tid (holdetiden).

Gradienttrin

Gradientområdet er forskellen mellem de nedre og øvre temperaturer i et gradienttrin. Det maksimalt
tilladte interval er 24 °C. Den laveste temperatur i en gradient kan have en værdi mellem 30,0 og 99,0 °C,
indstillet i tiendedele af en grad. Den maksimale øvre temperatur er 100 °C. Reaktionsblokken varmes op
til den ønskede temperaturgradient hen over blokken og holder temperaturen i en bestemt holdetid.

Vigtigt: Instrumentet beregner gradientværdien. Når du indtaster en værdi i gradientberegnerens
øverste og nederste felt, beregner og tildeler softwaren automatisk temperaturerne for de resterende
felter. Når du indtaster en temperatur i et hvilket som helst felt mellem det øverste og nederste felt,
beregner instrumentet automatisk de resterende felter. Du kan ikke manuelt indtaste en
temperaturværdi i hvert felt.

Parameter Område Beskrivelse

Ramp rate
(Rampehastighed)

n For CFX Opus 96 Dx-systemer:
0,1-5 °C pr. sek.

n For CFX Opus 384 Dx-
systemer:
0,1–2,5 °C pr. sek.

n For CFX Opus Deepwell Dx-
systemer:
0,1–2,5 °C pr. sek.

Indstiller hastigheden, hvorved
reaktionsblokken varmes op til den
ønskede temperatur.

Vises kun sommulighed ved
temperaturtrin.

Increment (Forøgelse) Et tal fra –10,0 til 10,0 °C pr. cyklus
i tiendedele af en grad

Indstiller en given ændring i
måltemperaturen for et temperaturtrin ved
hver cyklus, hvor et positivt tal øger
temperaturen, og et negativt tal sænker
temperaturen.

Vises kun sommulighed ved
temperaturtrin.

Tabel 7. Parametre og -områder for protokoltrin
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Parameter Område Beskrivelse

Extend (Forlæng) En tid fra –60 til 60 sek. pr. cyklus Instruerer termocykleren om at forlænge
holdetiden med hver cyklus. Et positivt tal
øger holdetiden, og et negativt tal
reducerer holdetiden.

Muligt ved både temperatur- og
gradienttrin.

Beep (Bip) QC Parameters (Parametre for
kvalitetskontrol)

Indstiller en bippelyd for at signalere, at
reaktionsblokken har nået
måltemperaturen.

Vises kun sommulighed ved
temperaturtrin.

Plate read (Plade
aflæst)

QC Parameters (Parametre for
kvalitetskontrol)

Tilføjer en pladeaflæsning til det valgte
trin.

Muligt ved både temperatur- og
gradienttrin.

Tabel 7. Parametre og -områder for protokoltrin, fortsat
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Vinduet Protocol Editor (Protokoleditor)
Brug Protocol Editor (Protokoleditor) til at oprette, gennemgå og redigere en protokol. Som standard viser
Protocol Editor (Protokoleditor) en generisk totrins real-time-protokol for en plade med 96 brønde.

1. Menulinjen giver hurtig adgang til menuerne File (Fil), Settings (Indstillinger) og Tools
(Værktøjer).

2. Værktøjslinjen giver hurtig adgang til at gemme og udskrive protokoller, bestemme hvor et trin
skal indsættes, angive prøvevolumen og se estimeret protokolkørselstid.

3. Hovedvinduet viser en grafisk gengivelse af protokollen.

4. Den nederste rude viser protokoloversigten.

5. Den venstre rude viser betjeningselementerne for protokollen, som du kan tilføje for at tilpasse
protokollen.

FORKLARING

Kommandoer i menuen File (Fil)
Save (Gem) – gemmer den aktuelle protokol.
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Save As (Gem som) – gemmer den aktuelle protokol med et nyt navn og på en ny placering.

File Passwords (Filadgangskoder) giver brugere mulighed for at indstille deres adgangskoder for lagring
og åbning af filer.

Tip: Se Adgangskodebeskyttelse af filer på side 50 for yderligere oplysninger.

Close (Luk) – lukker Protocol Editor (Protokoleditor).

Kommandoer i menuen Settings (Indstillinger)
Lid Settings (Lågindstillinger) – åbner dialogboksen Lid Setting, hvor du kan ændre eller indstille lågets
temperatur.

Kommandoer i menuen Tools (Værktøjer)
Gradient Calculator (Gradientberegner) – åbner en dialogboks, hvor du kan vælge bloktypen til et
gradienttrin. Standard er 96 brønde.

Run time Calculator (Kørselstidsberegner) – åbner en dialogboks, hvor du kan vælge pladetypen og
scanningstilstand med henblik på at beregne den estimerede kørselstid i vinduet Run Setup
(Kørselsopsætning). Standard er 96 brønde, alle kanaler.

Kommandoer på værktøjslinjen

– gemmer den aktuelle protokolfil.

– udskriver det valgte vindue.

– brug denne kommando til at vælge, hvor du vil indsætte trin i forhold til det
aktuelt valgte trin.

– brug denne kommando til at angive et prøvevolumen i µl. Prøvevolumenerne
er forskellige afhængigt at bloktypen:

n For en blok med 96 brønde er området 0-50 µl.

n For en blok med 384 brønde er området 0-30 µl.

n For en blok med 96 dybe brønde er området 0-125 µl.
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– viser den estimerede kørselstid baseret på protokoltrin, rampehastighed og
den valgte bloktype.

– viser Hjælp-oplysninger om protokoller.

Betjeningselementer for protokolredigering
Venstre rude i vinduet Protocol Editor (Protokoleditor) indeholder betjeningselementer, som du kan bruge
til at oprette protokoller.

Hvert af disse betjeningselementer består af et sæt af parametre, som repræsenterer et trin i protokollen.
Du kan redigere de enkelte parametre og tilføje eller fjerne dem for at tilpasse protokollen. Dette afsnit
beskriver valgmulighederne for de enkelte betjeningselementer.

n Insert Step (Indsæt trin) – indsætter et trin før eller efter det valgte trin.
Du kan redigere værdierne for temperatur og holdetid enten i den
grafiske visning af protokollen eller i protokoloversigten.

n Insert Gradient (Indsæt gradient) – indsætter et gradienttrin baseret på
typen af den brøndblok, der blev valgt i gradientberegneren. Du kan
redigere gradientområdet i ruden Gradient, som vises, når der indsættes
et gradienttrin.

n Insert GOTO (Indsæt GÅ TIL) – indsætter et cyklustrin (et loop), som
giver besked til softwaren om at gentage specifikke trin i rækkefølge et
angivet antal gange. Gentagelserne begynder, så snart den første cyklus
er gennemført. For eksempel kan du bede softwaren om at udføre 39

repetitioner af trin 2-4. Efter den sidste repetition vil softwaren således have gennemført trin 2-4 i alt
40 gange. Du kan redigere retur til-trinnet (GOTO – GÅ TIL) og antallet af cyklusser enten i den
grafiske visning eller i protokoloversigten.

n Insert Melt Curve (Indsæt smeltekurve) – indsætter et smeltekurveaflæsningstrin.

n Insert Plate Read to Step (Indsæt pladeaflæsning i trinnet) – tilføjer en pladeaflæsningskommando
til det valgte trin. En pladeaflæsning måler mængden af fluorescens ved afslutningen af en cyklus.
Pladeaflæsningstrinnet er normalt det sidste trin i et GOTO-loop.

Tip: Når du tilføjer en pladeaflæsningskommando til et trin, ændres knappen til Remove Plate
Read (Fjern pladeaflæsning), når trinnet vælges.
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n Remove Plate Read (Fjern pladeaflæsning) – fjerner en pladeaflæsningskommando fra det valgte
trin.

Tip: Når der fjernes en pladeaflæsningskommando fra et trin, ændres knappen til Add Plate
Read (Tilføj pladeaflæsning), når trinnet vælges.

n Step Options (Valgmuligheder for trin) – åbner dialogboksen Step Options (Valgmuligheder for trin)
og viser de tilgængelige valgmuligheder for det valgte trin. Se Step Options (Valgmuligheder for trin)
på side 104 for nærmere oplysninger om valgmulighederne for trin.

Tip: Du kan også åbne Step Options (Valgmuligheder for trin) ved at højreklikke på trinnet i den
grafiske visning.

n Delete Step (Slet trin) – sletter det valgte trin fra protokollen.
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Step Options (Valgmuligheder for trin)

Åbn dialogboksen Step Options (Valgmuligheder for trin) for at vise de valgmuligheder, der kan tilføjes,
ændres eller slettes fra et trin.

n Plate Read (Pladeaflæsning) – når feltet er markeret, tilføjes der en pladeaflæsning til trinnet.

n Temperature (Temperatur) – indstiller måltemperaturen for det valgte trin.

n Gradient – indstiller gradientområdet for trinnet. Området er 1-24 °C.

Bemærk: En gradient kører med den laveste temperatur forrest på blokken (række H på
billedet) og den højeste temperatur bagest på blokken (række A på billedet).

n Increment (Forøgelse) – antallet af grader, som temperaturen på det valgte trin skal øges (eller
reduceres) med. Dette gradtal lægges til måltemperaturen med hver cyklus. Området er ±0,1-10 °C.

Bemærk: For at reducere temperaturen skal du sættes et minustegn (-) foran den numeriske
værdi (for eksempel -5 °C).

n Ramp Rate (Rampehastighed) – rampehastigheden for det valgte trin. Området afhænger af
blokkens størrelse.

n Time (Tid) – holdetiden for det valgte trin.
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n Extend (Forlængelse) – den tid (i sekunder), som det valgte trin skal forlænges eller forkortes med.
Denne valgmulighed lægges til holdetiden i hver cyklus. Området er ±1-60 sek.

n Beep (Bip) — når dette er valgt, lyder der et bip under trinnet.

Tip: Hvis du indtaster en værdi, der ligger uden for det tilladte område, ændrer softwaren denne
værdi til den, der ligger tættest på inden for området.
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Oprettelse af en protokol i Protocol Editor (Protokoleditor)
Du kan oprette brugerdefinerede protokolfiler med Protocol Editor (Protokoleditor). Du kan også redigere
og gemme tidligere gemte protokolfiler eller eksempler på protokolfiler, der leveres sammen med
CFX Maestro Dx SE.

For at oprette en ny protokolfil skal du gøre følgende:

n Åbn en protokolfil i Protocol Editor (Protokoleditor).

Tip: Du kan åbne en ny eller eksisterende protokol i Protocol Editor (Protokoleditor).

n Opsæt den nye protokol.

n Tilføj trin til protokollen fra ruden med protokollens kontroller.

n Rediger trinnenes egenskaber.

n Gem protokollen.

Tip: For oplysninger om oprettelse af en ny protokol ud fra en tidligere gemt protokolfil eller et
eksempel på en protokolfil henvises til Åbning af en eksisterende protokol i Protocol Editor
(Protokoleditor) på side 107.

Åbning af en ny protokolfil i Protocol Editor (Protokoleditor)
I CFX Maestro Dx SE kan du åbne en ny protokolfil på forskellige måder:

n Fra menuen File (Fil) i startvinduet

n Fra dialogboksen Run Setup (Kørselsopsætning) i startvinduet

n Fra dialogboksen Startup Wizard (Guiden Opstart) i startvinduet

Sådan åbnes en ny protokolfil fra menuen File (Fil)

u Fra startvinduet vælges File > New > Protocol (Fil > Ny > Protokol).

Vinduet Protocol Editor (Protokoleditor) åbnes med standardprotokolfilen.

Tip: For information om indstilling af standardprotokollen henvises til Ændring af
standardindstillinger for filer på side 83.

Sådan åbnes en ny protokol fra dialogboksen Run Setup (Kørselsopsætning)

1. Gør et af følgende i startvinduet for at åbne dialogboksen Run Setup (Kørselsopsætning):

n Vælg Run > User-defined Run (Kør > Brugerdefineret kørsel).

n Klik på User-defined Run (Brugerdefineret kørsel) på værktøjslinjen.
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Dialogboksen Run Setup (Kørselsopsætning) åbnes med fanen Protocol (Protokol) og viser
standardprotokolfilen.

2. Klik på Create New (Opret ny).

Vinduet Protocol Editor (Protokoleditor) åbnes og viser standard-real-time-protokollen.

Sådan åbnes en ny protokolfil fra Startup Wizard (Guiden Opstart)

1. Gør et af følgende i startvinduet for at åbne Startup Wizard (Guiden Opstart), hvis den ikke allerede
er åben:

n Vælg View > Startup Wizard (Vis > Guiden Opstart).

n Klik på Startup Wizard (Guiden Opstart) på værktøjslinjen.

2. Om nødvendigt vælges instrumenttypen på rullelisten.

3. Klik på User-defined (Brugerdefineret) som kørselstype.

Dialogboksen Run Setup (Kørselsopsætning) åbnes med fanen Protocol (Protokol) og viser
standardprotokolfilen.

4. Klik på Create New (Opret ny).

Vinduet Protocol Editor (Protokoleditor) åbnes og viser standard-real-time-protokollen.

Sådan åbnes en ny protokol fra menuen Run (Kør)

1. Gør et af følgende i startvinduet for at åbne dialogboksen Run Setup (Kørselsopsætning):

n Vælg Run > User-defined Run (Kør > Brugerdefineret kørsel).

n Klik på User-defined Run (Brugerdefineret kørsel) på værktøjslinjen.

Dialogboksen Run Setup (Kørselsopsætning) åbnes med fanen Protocol (Protokol) og viser
standardprotokolfilen.

2. Klik på Create New (Opret ny).

Vinduet Protocol Editor (Protokoleditor) åbnes og viser standard-real-time-protokollen.

Åbning af en eksisterende protokol i Protocol Editor
(Protokoleditor)
CFX Maestro Dx SE leveres med eksempler på protokolfiler, som du kan redigere og gemme som
brugerdefinerede nye protokoller. Du kan også oprette en ny protokol fra en eksisterende brugerdefineret
protokol.
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Sådan åbnes et eksempel på en protokolfil

1. Vælg File > Open > Protocol (Fil > Åbn > Protokol) i startvinduet.

Windows Stifinder åbnes som standard på placeringen for mappen med eksempler på filer i
CFX Maestro Dx SE.

2. Åbn mappen med eksempler på filer. Følgende mapper vises:

n ConventionalProtocols (Konventionelle protokoller) – indeholder eksempler på protokolfiler til
traditionel PCR-analyse.

n DataFiles (Datafiler) – indeholder eksempler på datafiler, som du kan bruge til at udforske
funktionerne i CFX Maestro Dx SE.

n MeltCalibration (Smeltekalibrering) – indeholder eksempler på protokolfiler, som du kan bruge
med softwaren til præcisionssmelteanalyse i Bio-Rad.

n Plates (Plader) – indeholder eksempler på pladefiler.

n RealTimeProtocols (Real-Time-protokoller) – indeholder eksempler på protokolfiler til real-time
PCR-analyse.

3. Åbn protokolmappen for den type kørsel, du vil udføre, enten ConventionalProtocols (Konventionelle
protokoller) eller RealTimeProtocols (Real-Time-protokoller).

4. Vælg den ønskede protokol, og klik på Open (Åbn).

Eksemplet på protokollen åbnes i vinduet Protocol Editor (Protokoleditor).

5. Vælg File > Save As (Fil > Gem som), og gem protokollen med et nyt navn eller i en ny mappe.

Sådan åbnes en eksisterende protokol

1. Gør et af følgende i startvinduet:

n Vælg File > Open > Protocol (Fil > Åbn > Protokol), naviger til og vælg den ønskede protokol, og
klik derefter på Open (Åbn).

n Åbn Startup Wizard (Guiden Opstart), og gør et af følgende:

o For at redigere den viste protokol skal du klikke på Edit Selected (Rediger valgte).

o For at redigere en anden eksisterende protokol skal du klikke på Select Existing (Vælg
eksisterende) og navigere til den ønskede fil.

Protokollen åbnes i vinduet Protocol Editor (Protokoleditor).

2. Vælg File > Save As (Fil > Gem som), og gem protokollen med et nyt navn eller i en ny mappe.
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Opsætning af en ny protokol
Tip: Hvis protokolfilen allerede indeholder de påkrævede parametre (hvis du for eksempel redigerer
en eksisterende pladefil), kan du springe dette afsnit over. Gå videre til Tilføjelse af trin i en protokol
på side 111.

Nye protokolfiler skal indeholde følgende parametre:

n Block type (Bloktype)

n Scan mode (Scanningstilstand) for den valgte bloktype

n Lid temperature (Lågets temperatur)

n Sample Volume (Prøvevolumen)
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Opsætning af bloktypen

CFX Maestro Dx SE beregner automatisk temperaturstigninger for gradienttrin baseret på bloktypen.

Bemærk: Den pladetype, der er angivet i Protocol Editor (Protokoleditor), skal være den samme som
pladen i reaktionsmodulet.

Sådan angives bloktypen

u Vælg Tools (Værktøjer) > Gradient Calculator (Gradientberegner) i vinduet Protocol Editor
(Protokoleditor), og vælg den relevante pladetype på den rulleliste, som vises.

Valg af Scan Mode (Scanningstilstand) for den valgte Block Type (Bloktype)

For at bestemme protokollens kørselstid skal du vælge den ønskede bloktype og scanningstilstand.

Sådan vælges bloktype og scanningstilstand

u Vælg Tools > Run time Calculator (Værktøjer > Beregner af kørselstid) i vinduet Protocol Editor
(Protokoleditor), og vælg den relevante pladetype og scanningstilstand på den viste rulleliste.

Tilpasning af lågets temperatur

CFX Maestro Dx SE indstiller lågets standardtemperaturer som følger:

n 96-brønds- og dybbrøndsinstrumenter - 105,0 °C

n 384-brønds-instrumenter – 95,0 °C

Du kan ændre standardindstillingerne eller slukke lågvarmeren, afhængigt af hvad der er behov for til
protokollen.

Sådan tilpasses lågets temperatur

1. Vælg Settings > Lid Settings (Indstillinger > Lågindstillinger) i vinduet Plate Editor (Pladeeditor).

Dialogboksen Lid Settings (Lågindstillinger) åbnes.

2. Gør et af følgende:

n Vælg User Defined (Brugerdefineret), og indtast en temperaturværdi i tekstfeltet.

n Vælg Turn Off Lid Heater (Sluk lågvarmer).

3. Klik på OK for at acceptere ændringerne og lukke dialogboksen
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Indstilling af prøvevolumen

CFX Maestro Dx SE indstiller som standard prøvevolumen for hver brønd til 25 µl. Prøvevolumenerne er
forskellige afhængigt af bloktypen, for eksempel:

n 0-50 µl for en blok med 96 brønde

n 0-30 µl for en blok med 384 brønde

Instrumentet anvender én af to temperaturkontroltilstande til at fastlægge, hvornår prøven når
måltemperaturen i en protokol:

n Calculated mode (Beregnet tilstand) – når prøvevolumenet er indstillet til et volumen, der ikke er
tom og er korrekt for blokken, beregner instrumentet prøvetemperaturen baseret på prøvevolumenet.
Dette er standardtilstanden.

n Block mode (Bloktilstand) – når prøvevolumenet er indstillet til nul (0) µl, registrerer instrumentet
prøvetemperaturen som den samme som den målte bloktemperatur.

Sådan indstilles prøvevolumenet for en specifik blok

u Skriv den korrekte værdi i tekstfeltet Sample Volume (Prøvevolumen) på værktøjslinjen i vinduet
Plate Editor (Pladeeditor).

Tip: Standardprøvevolumenet kan ændres i dialogboksen User Preferences (Brugerpræferencer).
SeÆndring af standardindstillinger for filer på side 83.

Tilføjelse af trin i en protokol
Sådan tilføjes et trin i en protokol

1. Åbn protokollen i vinduet Protocol Editor (Protokoleditor).

2. Find det sted, hvor det nye trin skal indsættes. Vælg Before (Før) eller After (Efter) fra rullelisten Step
(Trin) på værktøjslinjen.

3. På grafen skal du vælge det trin, som du vil indsætte det nye trin før eller efter.

4. Klik på Insert Step (Indsæt trin) i venstre rude.

5. Hvis du vil ændre temperaturen eller holdetiden, skal du klikke på standardværdien i grafen eller
protokoloversigten og indtaste en ny værdi.

6. (Valgfrit) I venstre rude kan du klikke på Step Options (Valgmuligheder for trin) for at få vist
dialogboksen Step Options (Valgmuligheder for trin) og redigere de tilgængelige indstillinger for det
valgte trin.
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Tip: Du kan åbne dialogboksen Step Options (Valgmuligheder for trin) i genvejsmenuen i enten
grafruden eller i ruden med protokoloversigten.

7. Klik på OK, og klik derefter på Yes (Ja) for at gemme protokolændringerne.

Dialogboksen Save As (Gem som) vises.

8. Skriv navnet på den nye protokolfil i dialogboksen Save As (Gem som), og klik på Save (Gem).

Indsættelse af et gradienttrin
Sådan indsættes et gradienttrin

1. Kontrollér, at pladestørrelsen for gradienten er den samme som bloktypen for instrumentet: 96-
brønds, 384-brønds eller dybbrønd.

2. Vælg pladestørrelsen for gradienten, hvis det ikke allerede er gjort:

Vælg Tools > Gradient Calculator (Værktøjer > Gradientberegner), og vælg den relevante brøndtype
på rullelisten.

3. På Værktøjslinjen vælges enten Before (Før) eller After (Efter) på rullelisten Insert Step (Indsæt trin).

4. I grafen eller oversigtsruden skal du vælge det trin, som gradienttrinnet skal indsættes før eller efter.

5. Klik på Insert Gradient (Indsæt gradient) i venstre rude. Det nye gradienttrin fremhæves i grafen og
oversigtsruden, for eksempel:

112 | CFX Maestro Dx SE-software



Oprettelse af en protokol i Protocol Editor (Protokoleditor)

Hver rækkes temperatur i gradienten vises i tabellen Gradient i højre rude.

6. For at redigere gradientens temperaturområde skal du gøre et af følgende:

n Klik på standardtemperaturen i grafen eller oversigtsruden, og indtast en ny temperatur.

n Klik på Step Options (Valgmuligheder for trin) for at indtaste gradientområdet i vinduet Step
Options (Valgmuligheder for trin).

n Rediger værdien Range (Område) i tabellen Gradient.

7. For at redigere holdetiden skal du klikke på standardtiden i grafik- eller tekstvisningen og indtaste en
ny tid.

8. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.

Indsættelse af en forekomst af trinnet GOTO (GÅ TIL)
Bemærk: Du kan ikke indsætte en forekomst af trinnet GOTO (GÅ TIL) i et GOTO-sæt. Du kan ikke
oprette indlejrede GOTO-loops.

Sådan indsættes en forekomst af trinnet GOTO (GÅ TIL)

1. Vælg Before (Før) eller After (Efter) fra rullelisten Insert Step (Indsæt trin) på værktøjslinjen.

2. På grafen skal du vælge det trin, som du vil indsætte det nye trin GOTO (GÅ TIL) før eller efter.
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3. Klik på Insert GOTO (Indsæt GÅ TIL) i venstre rude.

4. For at redigere nummeret for trinnet GOTO (GÅ TIL) eller antallet af gentagelse af GOTO (GÅ TIL)
skal du vælge standardnummeret i grafen eller oversigtsruden og indtaste en ny værdi.

5. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.

Indsættelse af et smeltekurvetrin
Tip: Du kan ikke indsætte et smeltekurvetrin i et GOTO-loop.

Bemærk: Smeltekurvetrinnet omfatter en 30-sekunders pause i begyndelsen af trinnet, som ikke er
vist i protokollen.

Sådan indsættes et smeltekurvetrin

1. Vælg Before (Før) eller After (Efter) fra rullelisten Insert Step (Indsæt trin) på værktøjslinjen.

2. På grafen skal du vælge det trin, som du vil indsætte smeltekurvetrinnet før eller efter.

3. Klik på Insert Melt Curve (Indsæt smeltekurve) i venstre rude. Det nye smeltekurvetrin fremhæves i
grafen og oversigtsruden, for eksempel:

4. For at redigere smeltetemperaturområde eller stigningstid skal du vælge standardtallet i grafen eller
oversigtsruden og indtaste en ny værdi.
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5. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.
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Tilføjelse eller fjernelse af trinnet Plate Read (Pladeaflæsning)
Tip: Når du tilføjer en pladeaflæsningskommando til et trin, ændres knappen til Remove Plate Read
(Fjern pladeaflæsning), når trinnet vælges.

Sådan tilføjes en pladeaflæsning til et trin

1. Vælg Before (Før) eller After (Efter) fra rullelisten Insert Step (Indsæt trin) på værktøjslinjen.

2. På grafen skal du vælge det trin, som pladeaflæsningstrinnet skal indsættes før eller efter.

3. Klik på Add Plate Read (Tilføj pladeaflæsning) i venstre rude for at tilføje en pladeaflæsning til det
valgte trin.

4. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.

Sådan fjernes en pladeaflæsning fra et trin

u På grafen skal du vælge det trin, som indeholder pladeaflæsningen, og klikke på Remove Plate Read
(Fjern pladeaflæsning) i venstre rude.

Ændring af Step Options (Valgmuligheder for trin)
Sådan ændres valgmuligheder for trin for et valgt trin

1. Vælg det ønskede trin i grafen eller oversigtsruden.

2. I den venstre rude skal du klikke på Step Options (Valgmuligheder for trin) for at åbne dialogboksen
Step Options (Valgmuligheder for trin).

Alternativt kan du højreklikke på det ønskede trin i en af ruderne. Vælg derefter Step Options
(Valgmuligheder for trin) i den viste menu.

3. Sådan tilføjes, ændres eller fjernes valgmuligheder:

n Indtast en værdi i det relevante tekstfelt.

n Rediger en værdi i det specifikke tekstfelt.

n Markér eller fjern markeringen i et afkrydsningsfelt.

4. Klik på OK for at gemmeændringerne og lukke dialogboksen Step Options (Valgmuligheder for trin).

5. Klik på OK og derefter på Yes (Ja) for at gemme protokollen.
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Sletning af et trin
Vigtigt: Du kan ikke fortryde denne handling. Vær forsigtig, når du sletter trin.

Sådan slettes et trin i protokollen

1. Vælg trinnet i grafen eller oversigtsruden.

2. Klik på Delete Step (Slet trin) i venstre rude for at slette det valgte trin.

3. Klik på OK og derefter på Yes (Ja) for at gemme protokollen.

Kopiering, eksport eller udskrivning af en protokol
Sådan kopieres en protokol

u Højreklik på protokoloversigten, og vælg Copy Protocol (Kopiér protokol).

Protokoloversigten kan indsættes i en .txt-, .xls-, .doc- eller .ppt-fil.

Sådan eksporteres en protokol

1. Højreklik på protokoloversigten, og vælg Export Protocol (Eksportér protokol).

Dialogboksen Save As (Gem som) vises.

2. (Valgfrit) Naviger til en mappe i Windows Stifinder, hvor protokolfilen skal gemmes.

3. Skriv et navn til den eksporterede protokolfil i File Name (Filnavn).

4. Klik på Save (Gem).

Sådan udskrives en protokol

u Højreklik på protokoloversigten, og vælg Print (Udskriv).

Protokoloversigten kan udskrives på standardprinteren.
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Oprettelse af en protokol med Protocol AutoWriter
(Automatisk protokolskriver)

Vigtigt: Bio-Rad giver ingen garanti for, at kørsel af en protokol, som er oprettet med Protocol
AutoWriter (Automatisk protokolskriver), altid vil resultere i et PCR-produkt.

Protocol AutoWriter (Automatisk protokolskriver) i CFX Maestro Dx SE genererer cyklusprotokoller
automatisk baseret på følgende inputparametre:

n Amplicon length (Amplikonlængde) – PCR-produktets forventede længde

n Annealing temperature (Hydbridiseringstemperatur) – reaktionens Ta for de anvendte primere

Hvis Ta er ukendt, kan du bruge Ta calculator (Ta-beregneren) til at beregne det automatisk baseret
på primersekvenserne.

Bemærk: Ta tilpasses fra oplysningerne om primersmeltetemperaturen (Tm), som er baseret på
det valgte enzym og protokolhastigheden.

n Enzyme type (Enzymtype) – DNA-polymeraseenzymet (iTaq, iProof DNA-polymerase eller Other
(Andet))

Hvis du bruger et andet enzym end iTag eller iProof DNA-polymerase, kan du angive yderligere
oplysninger, herunder gradientområde, hot-start-aktiveringstid (i sek.) og endelig forlængelsestid (i
sek.).

n Run speed (Kørselshastighed) – reaktionshastigheden (standard, hurtig eller ultrahurtig)

Protocol AutoWriter (Automatisk protokolskriver) optimerer protokollen afhængigt af den valgte
hastighedsindstilling. Den samlede kørselstid bestemmes af antallet af trin og cyklusser,
inkubationstiden for hvert trin og den tid, det tager at nå ensartethed ved måltemperaturen.

På baggrund af de indtastede parametre og standard-PCR-retningslinjer genererer Protocol AutoWriter
(Automatisk protokolskriver) automatisk en tilpasset PCR-protokol med hot-start, første denaturering,
hybridisering og yderligere trin. Du kan derefter se en grafisk repræsentation af den foreslåede protokol
og redigere, køre eller gemme protokollen.
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Sådan oprettes en ny protokol med Protocol AutoWriter (Automatisk protokolskriver) i
CFX Maestro Dx SE

1. Vælg Tools > Protocol AutoWriter (Værktøjer > Automatisk protokolskriver) i startvinduet.

Dialogboksen Protocol AutoWriter (Automatisk protokolskriver) åbnes.

2. Gør følgende i afsnittet Enter Target Values/Enzyme (Angiv målværdier/enzym):

n Indtast hybridiseringstemperaturen (Ta) for primerne, hvis den kendes.

Tip: Se Brug af Ta Calculator (Ta-beregneren) på side 120 for yderligere oplysninger.

Bemærk: For oplysninger om de beregninger, der anvendes i Ta calculator (Ta-
beregneren), henvises til Breslauer et al. 1986.

n Angiv amplikonlængden i basepar (bp).

n Vælg en enzymtype på listen over muligheder (iTaq DNA polymerase, iProof DNA polymerase
eller Other (Andet)).

Tip: Hvis du vælger Other (Andet) som enzymtype, aktiveres parametrene i afsnittet
Additional Parameters (Optional) (Yderligere parametre (valgfrit)).
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3. Hvis du vælger Other (Andet) som enzymtype, kan du tilføje et eller alle af de følgende parametre i
protokollen:

n Gradient range (Gradientområde)

n Hot start activation temperature (Hot-start-aktiveringstemperatur)

n Final extension time (Endelig forlængelsestid)

4. I afsnittet Type kan du flytte skyderen for at vælge en protokolhastighed (Standard, Fast (Hurtig) eller
Ultrafast (Ultrahurtig)). CFX Maestro Dx SE tilpasser den totale kørselstid.

5. Vælg den PCR-type, der skal udføres (Real-time PCR er standard).

Med Real-time PCR tilføjer CFX Maestro Dx SE et pladeaflæsningstrin til indsamling af
fluorescensdata.

6. Gennemgå protokollen i afsnittet Preview (Forhåndsvisning). Du kan foretage ændringer efter behov.

7. Gør et af følgende:

n Klik på OK for at gemme den nye protokol. Efter lagring åbnes protokollen i Startup Wizard
(Guiden Opstart). Klik på Edit Selected (Rediger valgte) for at foretage ændringer i protokollen.
Det kan for eksempel være nødvendigt at ændre lågets temperatur og prøvevolumenet.

n Klik på Cancel (Annuller) for at lukke vinduet uden at gemme protokollen.

Brug af Ta Calculator (Ta-beregneren)
Hvis hybridiseringstemperaturen for primeren er ukendt, kan du bruge Ta Calculator (Ta-beregneren) til at
beregne værdien. Du kan bruge værdien i Protocol AutoWriter (Automatisk protokolskriver) eller i Protocol
Editor (Protokoleditor) til at oprette din protokol.

Om Ta Calculator (Ta-beregneren)
Ta Calculator (Ta-beregneren) beregner Tm-værdien for hver primer såvel som Ta-værdien for protokollen
ved standardhastighed.

Ta for protokollen er baseret på de gennemsnitlige primer Tm-værdier, hvor følgende regler er anvendt:

n Hvis differencen mellem primer Tm-værdierne er > 4 °C, er Ta = (den mindste af de to primer Tm-
værdier + 2) - 4 °C

n Hvis forskellen mellem Tm-værdierne er ≤4 °C, er Ta = (gennemsnit af primer Tm-værdierne) - 4 °C
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Basepar-tællemetode

For hver primer bruger Ta-beregneren basepar-tællemetoden for sekvenser på 14 eller færre basepar
(bp).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

hvor w, x, y og z er tallene for disse baser for henholdsvis A, T, G og C i sekvensen.

Nærmeste nabo-metode

For sekvenser, der er længere end 14 bp, bruges nærmeste nabo-metoden. I nærmeste nabo-metoden er
beregningerne af smeltetemperaturen baseret på termodynamiske forhold mellem entropi (orden eller et
mål for tilfældighed i oligonukleotidet), entalpi (varme afgivet eller absorberet af oligonukleotidet), fri
energi og temperatur.

∆H = ∆G + T* ∆S

Hvor:

n ∆H = entalpiværdi, cal/mol*K

n T = temperatur, Kelvin

n ∆S = entropiværdi, cal/mol*K

n ∆G = Gibbs frie energi i cal/mol*K

Ændringen i entropi og entalpi beregnes direkte ved at addere værdierne for nukleotidpar vist i Tabel 8
(Breslauer et al. 1986).

Forholdet mellem den frie energi og koncentrationen af reaktanter og produkter i ligevægt er givet ved:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

hvor R er gaskonstanten (1,986 cal/mol*K).

Udskiftning af G i de to ligninger og løsning med hensyn til T giver

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

når det antages, at koncentrationen af DNA og DNA-primerkomplekset er lig med hinanden.

Det er blevet bestemt empirisk, at der er en ændring på 5 kcal fri energi (3,4 kcal) (Sugimoto et al. 1996)
under transitionen fra enkeltstrenget til B-formet DNA. Dette er antageligt helix-initieringsenergi. Endelig
giver tilføjelse af en justering for salt den ligning, som bruges af Ta -beregneren:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (saltmolaritet)
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Der er ikke behov for en justeringskonstant for saltkoncentrationen, da de forskellige parametre blev
bestemt ved for 1 M NaCl, og log10 af 1 er nul.

De termodynamiske beregninger antager, at hybridisering sker ved pH 7,0. Tm-beregningerne antager, at
sekvenserne ikke er symmetriske og indeholder mindst et G eller C.

Den oligonukleotide sekvens skal være mindst 14 baser lang for at kunne give rimelige Tm-værdier.
Mindre end 14 baser bruger basepar-tællemetoden (se Tabel 8 nedenfor).

Interaktion ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabel 8. Breslauer-interaktionskonstanter
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Brug af Ta-beregneren

Sådan anvendes Ta Calculator (Ta-beregneren)

1. For at åbne Ta Calculator (Ta-beregneren) skal du gøre et af følgende:

n Klik på Ta Calculator (Ta-beregneren) i Protocol AutoWriter (Automatisk protokolskriver).

n Vælg Tools > Ta Calculator (Værktøjer > Ta-beregner) i startvinduet.

Dialogboksen Ta Calculator (Ta-beregner) vises.

2. Skriv eller indsæt forward primer-sekvensen i tekstfeltet Forward Primer.

Tip: Du kan desuden bruge knapperne A, T, G og C i venstre side af dialogboksen til at indtaste
sekvensen.

3. Skriv eller indsæt reverse primer-sekvensen i tekstfeltet Reverse Primer.

4. Klik på Calculate (Beregn).
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Ta Calculator (Ta-beregneren) beregner og viser Tm for hver primer og de gennemsnitlige Tm- og Ta-
værdier, for eksempel:

Hvis primer-Tm-værdierne er mere end 4 °C fra hinanden, anvender Protocol AutoWriter (Automatisk
protokolskriver) den laveste primer-Tm-værdi + 2 °C som udgangspunkt for beregning af Ta-værdien,
hvilket kan ændres yderligere ved at modificere enzym- og reaktionshastighed.

Ta Calculator (Ta-beregneren) genererer en hybridiseringstemperatur for standardhastighed med
iTaq DNA-polymerase. Når der bruges et andet enzym, justerer hastighedsindstillingerne automatisk
Ta.

5. Gør et af følgende:

n Klik på OK, hvis Ta Calculator (Ta-beregneren) blev åbnet fra Protocol AutoWriter (Automatisk
protokolskriver). Du vender tilbage til Protocol AutoWriter (Automatisk protokolskriver).
Hybridiseringstemperaturen modificeres automatisk.

n Hvis Ta Calculator (Ta-beregneren) blev åbnet fra menuen Tools (Værktøjer), skal du registrere
beregningerne og klikke på Cancel (Annuller) for at lukke beregneren.
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En pladefil indeholder oplysninger om kørselsparametre som for eksempel scanningstilstand, fluoroforer
og brøndenes indhold. Efter kørslen sammenkæder CFX Maestro Dx Software, Security Editionn
brøndens indhold med de fluorescensdata, der blev indsamlet under kørslen, og udfører den relevante
analyse i vinduet Data Analysis (Dataanalyse). For eksempel anvendes brønde, der indeholder
standardprøvetype, til at generere en standardkurve.

CFX Maestro Dx SE tilbyder to muligheder for oprettelse af plader: Plate Editor (Pladeeditor) til real-time
PCR-kørsler og Setup Wizard (Guiden Opsætning) til normaliseret genekspressionsanalyse.

Plate Editor (Pladeeditor) indeholder følgende funktioner:

n Standardfluoroforer og prøvetyper til tildeling til pladebrønde

n Mulighed for at indstille referencemålsekvens (target) og kontrolprøve til genekspressionsanalyse

n Mulighed for at redigere pladens opsætning før, under og efter en kørsel

n Mulighed for at gemme pladefilen til genanvendelse

n Mulighed for at udskrive pladefilen på en standardprinter

Setup Wizard (Guiden Opsætning) fører brugeren gennem de trin, der skal til for at oprette et pladelayout
til normaliseret genekspressionsanalyse. Setup Wizard (Guiden Opsætning) kan bruges før, under og
efter en kørsel.
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Vinduet Plate Editor (Pladeeditor)
Du kan bruge Plate Editor (Pladeeditor) til at oprette brugerdefinerede plader eller til at redigere
eksisterende plader.

1. Menulinjen giver hurtig adgang til menuen File (Fil) og Settings (Indstillinger) samt til
valgmuligheder i værktøjerne til pladeredigering.

2. Værktøjslinjen giver hurtig adgang til vigtige pladeopsætningsfunktioner.

3. Hovedvinduet viser oversigt og valgmuligheder for plader, efterhånden som de anvendes.

4. Den højre rude viser valgmuligheder, som du kan bruge til at tilpasse pladen.

5. Den nederste rude viser pladetype og giver hurtig adgang til visningsindstillinger.

FORKLARING

Kommandoer i menuen File (Fil)
Save (Gem) – gemmer pladedatafilen på den placering, der er angivet på fanen File (Fil) i dialogboksen
User Preferences (Brugerpræferencer). SeÆndring af standardindstillinger for filer på side 83 for
yderligere oplysninger. Dette menupunkt er kun tilgængeligt, når der oprettes en ny pladefil.

Save As (Gem som) – gemmer den aktuelle pladedatafil med et nyt navn, du angiver. Dette menupunkt
er kun tilgængeligt, når der oprettes en ny pladefil.
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File Passwords (Filadgangskoder) giver brugere mulighed for at indstille deres adgangskoder for lagring
og åbning af filer.

Extract Plate (Ekstraher plade) – åbner en dialogboks, hvor du kan ekstrahere/gemme pladefilen (.pltd).
Dette menupunkt er kun tilgængeligt, når der vises eller redigeres en eksisterende pladefil.

Print (Udskriv) – udskriver den åbne pladedatafil.

Close (Luk) – lukker Plate Editor (Pladeeditor).

Kommandoer i menuen Edit (Rediger)
Undo (Fortryd) – tilbagefører en ændring af en pladefil, indtil pladen gemmes.

Redo (Annuller Fortryd) – tilbagefører den seneste Fortryd-handling, medmindre pladefilen er blevet
gemt.

Kommandoer i menuen Settings (Indstillinger)
Plate Size (Pladestørrelse) – åbner en dialogboks, hvor du kan vælge pladestørrelse til kørslen.

Bemærk: Pladestørrelsen skal være den samme som blokstørrelsen på det instrument, hvor
kørslen udføres.

Vælg 96-brønd for:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

Vælg 384-brønd for:

n CFX Opus 384Dx

Plate Type (Pladetype) – giver dig mulighed for at vælge den type brønde i pladen, som indeholder dine
prøver, enten BRWhite (BR Hvid) eller BR Clear (BR Klar). For at opnå en nøjagtig dataanalyse skal den
valgte pladetype være den samme som den pladetype, der anvendes i kørslen.

Bemærk: Du skal kalibrere nye pladetyper. Se Kalibrering af nye farvestoffer på side 75 for
yderligere oplysninger.

Number Convention (Nummerkonvention) – giver dig mulighed for at vælge eller fravælge visning af
enheder i videnskabelig notation. Standarden er visning af enheder i videnskabelig notation.

Units (Enheder) – giver dig mulighed for at vælge de enheder, der skal vises i regnearkene ved udførelse
af kvantifikation af ubekendte kontra en standardkurve.

Brugervejledning | 127



Kapitel 8 Klargøring af plader

Kommandoer i menuen Editing Tools (Redigeringsværktøjer)
Setup Wizard (Guiden Opsætning) – åbner Setup Wizard (Guiden Opsætning), hvor der kan defineres
layout- og analyseparametre for den aktuelle plade. Du kan bruge Setup Wizard (Guiden Opsætning) før,
under og efter en kørsel.

Spreadsheet View/Importer (Visning/import af regneark) – åbner dialogboksen View (Vis), der viser
pladens layout som en skabelon i regnearksformat. Du kan bruge denne dialogboks til at eksportere eller
importere pladeskabelondata i .csv-format.

Flip Plate (Vend plade) – vender pladens indhold 180o.

Kommandoer på værktøjslinjen

Tilbagefører en ændring af en plade. CFX Maestro Dx SE understøtter op
til ti fortrydelseshandlinger

Tilbagefører den seneste Fortryd-handling. CFX Maestro Dx SE
understøtter op til ti gentagelseshandlinger.

Gemmer den aktuelle pladefil.

Viser en rulleliste, hvor du kan forøge eller formindske forstørrelsen af
pladevisningen.

Viser en rulleliste, hvor du kan vælge en scanningstilstand, som
instruerer instrumentet i, hvilke kanaler det skal indsamle fluorescensdata
fra under en kørsel.

Åbner Well Groups Manager (Brøndgruppeadministrator), som kan
bruges til at oprette brøndgrupper for den aktuelle plade.

Viser en dialogboks, hvor du kan vælge farver og symboler for
amplifikationskurvelinjerne.

Åbner dialogboksen View (Vis), der viser pladens layout som en skabelon
i regnearksformat. Du kan bruge denne dialogboks til at eksportere eller
importere pladeskabelondata i .csv-format.

Åbner Setup Wizard (Guiden Opsætning), hvor der kan defineres layout-
og analyseparametre for den aktuelle plade. Setup Wizard (Guiden
Opsætning) kan bruges før, under og efter en kørsel.
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Vinduet Plate Editor (Pladeeditor)

Åbner fanen Plate (Plade) i dialogboksen User Preferences
(Brugerpræferencer), hvor du kan definere parametre for pladelayout og
oprette eller slette navne på målsekvenser (targets), prøver og biologiske
grupper. Ændringer, du foretager på fanen Plate (Plade), er tilgængelige,
næste gang du åbner Plate Editor (Pladeeditor).

Viser de nødvendige trin til opsætning af en plade og fyldning af
brøndene.
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Oprettelse af en pladefil med Plate Editor (Pladeeditor)
Der kan oprettes brugerdefinerede pladefiler med Plate Editor (Pladeeditor). Du kan også redigere og
gemme tidligere gemte pladefiler eller eksempler på pladefiler, der leveres sammen med CFX Opus Dx-
systemet.

For at oprette en ny pladefil skal du gøre følgende:

n Åbn en pladefil i Plate Editor (Pladeeditor).

n Vælg pladetypen.

Bemærk: Pladetypen for pladefilen skal være den samme som pladen i reaktionsmodulet.

n Vælg den scanningstilstand, der skal bruges i protokollen.

n Vælg den fluorofor, der skal bruges i pladen.

n Vælg prøvetype, målsekvenser (targets) og prøver.

n Vælg tekniske replikater, hvis relevant.

n Gem pladens layout.

Tip: For oplysninger om at oprette en ny plade fra tidligere gemte eller eksempler på pladefiler
henvises til Åbning af en eksisterende pladefil i Plate Editor (Pladeeditor) på side 132.

Åbning af en ny pladefil i Plate Editor (Pladeeditor)
I CFX Maestro Dx SE kan du åbne en ny pladefil på forskellige måder:

n Fra startvinduet

n Fra dialogboksen Startup Wizard (Guiden Opstart)

n Fra dialogboksen Run Setup (Kørselsopsætning)

Sådan åbnes en ny pladefil fra startvinduet

u Vælg File > New > Plate (Fil > Ny > Plade).

Vinduet Plate Editor (Pladeeditor) åbnes og viser standardpladefilen for det valgte instrument.

Tip: For information om indstilling af standardpladefilen henvises til Ændring af
standardindstillinger for filer på side 83.
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Sådan åbnes en ny pladefil fra Startup Wizard (Guiden Opstart)

1. Gør et af følgende i startvinduet for at åbne Startup Wizard (Guiden Opstart), hvis den ikke allerede
er åben:

n Vælg View > Startup Wizard (Vis > Guiden Opstart).

n Klik på Startup Wizard (Guiden Opstart) på værktøjslinjen.

2. Om nødvendigt vælges instrumenttypen på rullelisten.

3. For at oprette en ny plade skal du klikke på User-defined (Brugerdefineret) som kørselstype.

Dialogboksen Run Setup (Kørselsopsætning) åbnes med fanen Protocol (Protokol).

4. Klik på fanen Plate (Plade) og klik på Create New (Opret ny).

Vinduet Plate Editor (Pladeeditor) åbnes og viser standardpladelayoutet for det valgte instrument.

Sådan åbnes en ny pladefil fra dialogboksen Run Setup (Kørselsopsætning)

1. Gør et af følgende i startvinduet for at åbne dialogboksen Run Setup (Kørselsopsætning):

n Vælg Run > User-defined Run (Kør > Brugerdefineret kørsel).

n Klik på User-defined Run (Brugerdefineret kørsel) på værktøjslinjen.

Dialogboksen Run Setup (Kørselsopsætning) åbnes med fanen Protocol (Protokol).

2. For at oprette en ny plade skal du klikke på fanen Plate (Plade) og klikke på Create New (Opret ny).

Vinduet Plate Editor (Pladeeditor) åbnes og viser standardpladelayoutet for det valgte instrument.
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Åbning af en eksisterende pladefil i Plate Editor (Pladeeditor)
CFX Maestro Dx SE leveres med eksempler på pladefiler, som du kan redigere og gemme som en ny
plade. Du kan også oprette en ny pladefil fra en tidligere gemt pladefil.

Sådan åbnes et eksempel på en pladefil

1. Vælg File > Open > Plate (Fil > Åbn > Plade).

Windows Stifinder åbnes med placeringen af mappen med CFX Opus Dx-systemets prøvefiler.

2. Åbn mappen Sample (Prøver), og åbn derefter mappen Plates (Plader).

3. Vælg en pladefil, og klik på Open (Åbn).

Eksemplet på pladefilen åbnes i vinduet Plate Editor (Pladeeditor).

4. Vælg File > Save As (Fil > Gem som), og gem pladefilen med et nyt navn eller i en ny mappe.

Sådan åbnes en tidligere gemt pladefil

1. Gør et af følgende i startvinduet:

n Vælg File > Open > Plate (Fil > Åbn > Plade), naviger til og vælg den ønskede plade, og klik på
Open (Åbn).

n Åbn Startup Wizard (Guiden Opstart), og gør et af følgende:

o For at redigere en eksisterende pladefil skal du klikke på Select Existing (Vælg
eksisterende) og navigere til den ønskede fil.

o For at redigere den viste pladefil skal du klikke på Edit Selected (Rediger valgte).

Den ønskede plade åbnes i vinduet Plate Editor (Pladeeditor).

2. Vælg File > Save As (Fil > Gem som), og gem pladefilen med et nyt navn eller i en ny mappe.
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Opsætning af en ny pladefil
Tip: Hvis pladefilen allerede indeholder de påkrævede parametre (hvis du for eksempel redigerer en
prøve eller en eksisterende pladefil), kan du springe dette afsnit over. Fortsæt til Tildeling af valgfri
parametre til pladefilen på side 140.

Nye pladefiler kræver følgende parametre:

n Pladestørrelse

n Pladetype

n Scanningstilstand

n En fluorofor (farve)

n En prøvetype

Valg af pladestørrelse og -type

Vigtigt: Der skal vælges en pladestørrelse under pladeopsætningen. Pladestørrelsen kan ikke
ændres under eller efter en kørsel.

Softwaren anvender pladestørrelsen og -typen på alle brønde under kørslen. Kontrollér, at den valgte
pladestørrelse er den samme som den plade, der vil blive brugt i kørslen.

Bio-Rads CFX Opus Dx systemer er fabrikskalibrerede til mange kombinationer af fluorescerende
farvestof og plader. Kalibreringen er specifik for instrumentet, farvestoffet og pladetypen. Kontrollér, at
den fluorofor, som skal anvendes, er kalibreret til den valgte pladetype.

Tip: Vælg Tools > Dye Calibration Wizard (Værktøjer > Guiden Farvekalibrering) for at kalibrere en
ny kombination af farvestof og pladetype på et instrument. Der findes oplysninger om kalibrering af
farvestoffer og pladetyper i Kalibrering af nye farvestoffer på side 75.

Valg af scanningstilstand

CFX Opus 96 Dx- og CFX Opus Deepwell Dx-systemerne exciterer og detekterer fluoroforer i fem kanaler
(plus FRET). CCFX Opus 384 Dx-systemet exciterer og detekterer fluoroforer i fire kanaler (plus FRET).
Alle systemerne bruger flere scanningstilstande for dataoptagelse til at indsamle fluorescensdata under
en kørsel.

CFX Maestro Dx SE har tre scanningstilstande:

n All Channels (Alle kanaler)

o Scanner kanal 1 til 5 på CFX Opus 96 Dx- og CFX Opus Deepwell Dx-systemer

o Scanner kanal 1 til 4 på CFX Opus 384 Dx-systemer
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n SYBR®/FAM

o Scanner kun kanal 1

o Udfører en hurtig scanning

n FRET

o Scanner kun FRET-kanalen

o Udfører en hurtig scanning

Valg af fluoroforer

Vigtigt: Før kørslen påbegyndes, verificerer CFX-systemer, at de fluoroforer, der blev specificeret på
pladen, er kalibreret på det pågældende instrument. Du kan ikke køre plader, hvis de indeholder
fluoroforer, der ikke er blevet kalibreret på instrumentet.

Du skal indlæse mindst én fluorofor i pladelayoutet før kørslen. Du kan tilføje så mange fluoroforer, som
der er behov for på dette tidspunkt, men pladen skal indeholde mindst én fluorofor. De valgte fluoroforer
vises som valgmuligheder for målsekvenser (targets) under Target Names (Navne på målsekvenser).

Du kan bruge dialogboksen Select Fluorophores (Vælg fluoroforer) til at indlæse fluoroforer (eller
pladefarvestoffer) i betjeningselementerne for brøndisætning i Plate Editor (Pladeeditor). De fluoroforer,
der vises i dialogboksen Select Fluorophores (Vælg fluoroforer), afhænger af den valgte
scanningstilstand:

n All Channels (Alle kanaler)

Alle tilgængelig fluoroforer vises.

Tip: Du kan tilføje så mange fluoroforer, som der er behov for, men du kan kun anvende én
fluorofor pr. kanal i hver brønd.

n SYBR®/FAM

Kun fluoroforerne i kanal 1 vises.

n FRET

Kun fluoroforen i kanal 6 vises.

Tip: FRET-fluoroforen i kanal 6 vises kun, når FRET er den valgte scanningstilstand. Den er ikke
tilgængelig i scanningstilstanden All Channels (Alle kanaler).

Bemærk: Du kan ikke tilføje eller fjerne fluoroforer direkte i dialogboksen Select Fluorophore (Vælg
fluorofor). Du skal kalibrere nye fluoroforer på instrumentet ved hjælp af Dye Calibration Wizard
(Guiden Farvestofkalibrering). Efter kalibrering tilføjes den nye fluorofor automatisk til denne liste. Se
Kalibrering af nye farvestoffer på side 75 for yderligere oplysninger.
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Valg af prøvetyper

Vigtigt: Du skal vælge mindst én prøvetype, der skal tildeles til brøndene på pladen før kørslen.

CFX Maestro Dx SE giver mulighed for at vælge mellem fem prøvetyper:

n Unknown (Ukendt)

n Standard

n NTC (Template-fri kontrol)

n Positive Control (Positiv kontrol)

n Negative Control (Negativ kontrol)

n NRT (Revers transkriptase-fri kontrol)

Du tildeler prøvetyperne til pladebrøndene.

Opsætning af en ny plade

Sådan opsættes en ny plade

1. Åbn en ny plade i vinduet Plate Editor (Pladeeditor).

2. For at indstille pladestørrelsen skal du vælge Settings > Plate Size (Indstillinger > Pladestørrelse) og
vælge den ønskede pladestørrelse i rullemenuen.

3. For at indstille pladetypen skal du vælge Settings > Plate Type (Indstillinger > Pladetype) og vælge
enten BRWhite (BR Hvid) eller BR Clear (BR Klar) i rullemenuen.

4. Du kan også ændre nummerkonventionen og de viste enheder i menuen Settings (Indstillinger):

n For at ændre talkonventionen skal du vælge Settings > Nummer Convention (Indstillinger >
Talkonvention) og vælge Scientific Notation (Videnskabelig notation).

Tip: Scientific Notation (Videnskabelig notation) er valgt som standard. I dette tilfælde vil
valg af Scientific Notation (Videnskabelig notation) rydde standarden og indstille
nummerkonventionen til standardformat.

n For at ændre visningsenhederne skal du vælge Settings > Units (Indstillinger > Enheder) og
vælge en ny enhedsværdi.

5. For at indstille scanningstilstand skal du vælge den ønskede scanningstilstand på rullelisten Scan
Mode (Scanningstilstand) i værktøjslinjen i vinduet Plate Editor (Pladeeditor).
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6. Vælg de nødvendige fluoroforer til pladen:

a. I højre rude klikkes på Select Fluorophores (Vælg fluoroforer).

Dialogboksen Select Fluorophores (Vælg fluoroforer) åbnes. Her vises de fluoroforer, der er
tilgængelige for den scanningstilstand, du valgte i Trin 5, for eksempel:

b. For at vælge en fluorofor skal du klikke på dens afkrydsningsfelt Selected (Valgt).

Tip: For at fjerne en fluorofor fra listen skal du fjerne markeringen i det relevante
afkrydsningsfelt Selected (Valgt).

c. For at ændre visningsfarven for fluoroforen skal du klikke i dens felt Color (Farve).

Bemærk: Den valgte farve repræsenterer fluoroforen i vinduet Plate Editor (Pladeeditor)
såvel som i diagrammerne for Data Analysis (Dataanalyse).

d. Vælg den ønskede farve i dialogboksen Color (Farve), eller klik på Define Custom Colors
(Definer brugerdefinerede farver) og opret en ny farve, der skal repræsentere fluoroforen.

e. Klik på OK for at gemmeændringerne og lukke dialogboksen Select Fluorophores (Vælg
fluoroforer).
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7. Du skal vælge mindst en brønd, der kan sættes en prøvetype i. Brønd A1 er valgt som standard.

I ruden Plate (Plade) gøres et af følgende:

n For at indlæse flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække til
den sidste brønd.

n For at indlæse flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

n For at isætte en hel kolonne med samme prøvetype skal du klikke på kolonnens nummer.

n For at isætte en hel række skal du klikke på rækkens nummer.

n For at isætte hele pladen skal du klikke i øverste venstre hjørne af pladen.

For eksempel:

8. Tildel en prøvetype til den eller de valgte brønde i rullemenuen Sample Type (Prøvetype).
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9. Tildel mindst en fluorofor til alle brønde, der indeholder en prøvetype. Du kan tildele mere end én
fluorofor til en brønd eller gruppe af brønde.

Bemærk: Du kan kun tildele én fluorofor pr. kanal. Du kan ikke tildele mere end én fluorofor fra
samme kanal til den samme brønd.

Tip: Du kan knytte en målsekvens (target) til fluoroforen, eller du kan tildele fluoroforen alene til
brønden på dette tidspunkt og knytte en målsekvens (target) til fluoroforen, når du har kørt
eksperimentet.

n Hvis du kun vil tildele en fluorofor til de valgte brønde, skal du markere afkrydsningsfeltet Load
(Indlæs) i afsnittet Target Names (Navne på målsekvenser) i højre rude for den specifikke
fluorofor.

n For at knytte en målsekvens (target) til en fluorofor skal du vælge et navn på en målsekvens
(target) fra rullelisten for den specifikke fluorofor i afsnittet Target Names (Navne på
målsekvenser). Softwaren markerer automatisk afkrydsningsfeltet Load (Indlæs).

10. For brønde, der indeholder prøvetypen Standard, skal der indlæses en koncentration. Hver brønd
kan have forskellige koncentrationsværdier. Som standard indlæser CFX Maestro Dx SE en
koncentration på 1,00E+06 for alle brønde med prøvetypen Standard. Du kan ændre værdien, hvis
det er nødvendigt.

a. I ruden Plate (Plade) vælges en standardbrønd eller gruppe af brønde.

b. I afsnittet Concentration (Koncentration) skal du klikke på Load (Indlæs) for at indlæse værdien i
den eller de valgte brønde.

c. (Valgfrit) Du kan indlæse en anden koncentration ved at indtaste den nye værdi i tekstfeltet
Concentration (Koncentration) og trykke på Enter.

d. Udfør dette trin for alle brønde med prøvetypen standard.

Tip: For at isætte den samme koncentration i alle standardbrønde skal du sikre, at <All>
(Alle) vises på rullelisten under værdien Concentration (Koncentration). For at isætte den
samme koncentrationsværdi i alle brønde med en specifik fluorofor skal du klikke på
rullelisten og vælge fluoroforen.

11. Klik på OK for at gemme den nye plade.
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Højreklikmenupunkter for værktøjet Plate Editor (Pladeeditor)

Tabel 9 indeholder en liste over de menupunkter, der er tilgængelige i værktøjet Plate Editor
(Pladeeditor), når du højreklikker på en vilkårlig brønd i værktøjet. Denne menu vises også i Spreadsheet
View/Importer (Visning/import af regneark).

Element Funktion

Copy (Kopiér) Kopierer hele regnearket.

Copy as Image (Kopiér
som billede)

Kopierer regnearket som en billedfil.

Print (Udskriv) Udskriver regnearket.

Print Selection (Udskriv
valgte)

Udskriver kun de valgte celler.

Export to Excel
(Eksportér til Excel)

Eksporterer filen til et Excel-regneark.

Export to CSV
(Eksportér til CSV)

Eksporterer filen som en .csv-fil.

Export to Xml
(Eksportér til Xml)

Eksporterer filen som en .xml-fil.

Export to Html
(Eksportér til Html)

Eksporterer filen som en .html-fil.

Find Søger efter den angivne tekst.

Sort (Sortér) Sorterer regnearket ved at vælge op til tre datakolonner i vinduet
Sort (Sortér).

Tabel 9. Genvejsmenupunkter i værktøjet Spreadsheet View/Importer (Visning/import
af regneark) for plader
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Tildeling af valgfri parametre til pladefilen
En pladefil indeholder oplysninger om indholdet i hver af de brønde, der isættes med prøve til en kørsel.
Efter kørslen sammenkæder CFX Maestro Dx SE brøndens indhold med de fluorescensdata, der blev
indsamlet under protokollen, og udfører den relevante analyse i vinduet Data Analysis (Dataanalyse).

I CFX Maestro Dx SE kan du tildele parametre til hver brønd på pladen før, under og selv efter kørslen af
eksperimenter. Parametrene kan tildeles til en eksisterende pladefil eller til en ny pladefil. Disse
parametre omfatter:

n Target names (Navne på målsekvenser) – interessemålet/-målene (gener eller sekvenser) i hver af
de indlæste brønde.

n Sample names (Prøvenavne) – den identifikator eller betingelse, der svarer til prøven i hver af de
indlæste brønde, som for eksempel mouse1, mouse2 eller mouse3.

n Biological groups (Biologiske grupper) – den identifikator eller betingelse, der svarer til en gruppe
af brønde, som f.eks. 0Hr, 1Hr eller 2Hr.

Tip: Navne på målsekvenser (targets), prøvenavne og biologiske grupper skal være de samme
på tværs af brøndene for at kunne sammenligne data på fanen Gene Expression
(Genekspression) i vinduet Data Analysis (Dataanalyse). Hvert af disse navne skal skrives med
den samme anvendelse af store bogstaver, tegnsætning og mellemrum. For eksempel er "Actin"
ikke det samme som "actin", "2t" er ikke det samme som "2 timer", og "Mus 1" er ikke det samme
som "mus1". For at sikre ensartethed i navngivningen skal du indtaste navnene i afsnittet
Libraries (Biblioteker) i User > User Preferences > Plate, available (Bruger > Brugerindstillinger
> Plade, der er tilgængelig) i startvinduet.

n Technical replicates (Tekniske replikater) – hver brønd som anvendes til at analysere den
samme kombination af prøve og målsekvens (target), med andre ord replikerede qPCR-reaktioner.

n Dilution series (Fortyndingsserier) – den mængde der skal til for at ændre koncentrationen af
standardprøvetypen i en replikatgruppe for at oprette standardkurve-data til analyse.

Tildeling af en målsekvens (target) til brønde
Tip: Du kan tildele det sammemålsekvensnavn (target name) til en enkelt brønd eller til flere brønde.
Du kan også tildele flere målsekvenser (targets) til den samme brønd.

Vigtigt: Hvis du klikker på OK efter tildeling af en målsekvens (target) gemmes ændringerne, og
Undo (Fortryd) deaktiveres på værktøjslinjen Plate Editor (Pladeeditor). Vær forsigtig, når du klikker
på OK.
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Sådan tildeles en målsekvens (target) til en brønd eller en gruppe brønde

1. Kontrollér i Plate Editor (Pladeeditor), at brønden eller gruppen af brønde er tildelt en prøvetype.

Se Valg af prøvetyper på side 135 for oplysninger om tildeling af prøvetyper til brønde.

2. Vælg brønden eller brøndgruppen i ruden med pladen:

n Vælg en enkelt brønd ved at klikke på brønden.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække den til
målsekvensbrønden.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

n For at vælge en hel kolonne med samme prøvetype skal du klikke på kolonnens nummer.

n For at vælge en hel række skal du klikke på rækkens nummer.

3. Vælg et navn på rullelisten Target Name (Navn på målsekvens) i højre rude for hver valgt fluorofor.

4. Gentag Trin 3 for hver brønd eller brøndgruppe, der skal tildeles en målsekvens (target).

Tip: Du kan tildele det samme eller et andet navn på en målsekvens (target) til hver valgt
fluorofor.

5. Klik på OK for at acceptere ændringerne og gemme pladen.

Bemærk: Hvis pladen blev ændret ved en fejl, skal du klikke på Undo (Fortryd) på værktøjslinjen
i Plate Editor (Pladeeditor), inden du klikker på OK for at acceptere ændringerne.

Sådan fjernes et navn på en målsekvens (target)

u Et navn på en målsekvens (target) kan fjernes fra den valgte brønd eller brøndgruppe ved at fjerne
markeringen i afkrydsningsfeltet Load (Indlæs).

Vigtigt: Hvis du fjerner et navn på en målsekvens (target) fra en brønd, fjerner du også dens
tilknyttede fluorofor. Vær forsigtig, når du fjerner et navn på en målsekvens (target) fra en brønd.

Sådan føjes et navn på en målsekvens (target) til listen

u Et navn på en målsekvens (target) kan føjes til rullelisten på én af følgende måder:
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n Indtast et navn på rullelisten Target Name (Navn på målsekvens), og tryk på Enter.

Tip: De navne på målsekvenser (targets), du føjer til én liste, vises på alle andre lister over
målsekvenser (targets).

n Klik på det grønne +-symbol til højre for rullelisten, indtast et navn på en målsekvens (target), og
tryk på Enter.

n Klik på User Preferences (Brugerpræferencer) på værktøjslinjen, og føj navnet til biblioteket
Target Names (Navne på målsekvenser) på fanen Plate (Plade).

Vigtigt: Navne på målsekvenser (targets), du føjer til rullelisten, er kun tilgængelige for den
aktuelle plade, og kun hvis du tildeler navnet til en brønd og gemmer pladelayoutet. Hvis du ikke
tildeler navnet til en brønd og gemmer pladelayoutet, gemmes navnet ikke og er ikke tilgængeligt
til fremtidig brug. For at tilføje et navn på en målsekvens (target) permanent skal det også tilføjes
til biblioteket Target Names (Navne på målsekvenser) vha. dialogboksen User Preferences
(Brugerpræferencer). Navne, du føjer til biblioteket, er tilgængelige, når Plate Editor
(Pladeeditor) åbnes igen. Se Indstilling af standardparametre for plader på side 86 for yderligere
oplysninger.

Sådan slettes et navn på en målsekvens (target) fra listen

1. Klik på User Preferences (Brugerpræferencer) på værktøjslinjen.

Dialogboksen User Preferences (Brugerpræferencer) vises med fanen Plate (Plade) åben.

2. Vælg det navn, der skal slettes, i biblioteket Target Names (Navne på målsekvenser) på fanen Plate
(Plade), og tryk på tasten Delete.

3. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Vigtigt: Du kan ikke slette navne på målsekvenser (targets), som du har gemt med en pladefil.
Tilpassede navne, som du tilføjer på rullelisten Target Names (Navne på målsekvenser) og ikke
bruger og gemmer med pladen, fjernes automatisk fra listen. Navne, som slettes fra biblioteket
Target Names (Navne på målsekvenser), fjernes permanent fra softwaren og er ikke længere
tilgængelige for brugerne. Vær forsigtig, når du sletter navne på målsekvenser (targets).

Tildeling af et prøvenavn til brønde
Bemærk: For at kunne tildele prøvenavn skal der tildeles mindst én fluorofor til de valgte brønde.
Hvis de valgte brønde ikke har fået tildelt en fluorofor, deaktiveres rullelisten Sample Names
(Prøvenavne). Se Tildeling af en målsekvens (target) til brønde på side 140 for at få oplysninger om
tildeling af fluoroforer.

Tip: Du kan kun tildele ét prøvenavn til hver brønd eller gruppe af brønde.
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Sådan tildeles et prøvenavn til en brønd eller en gruppe af brønde

1. Sørg for, at brønden eller gruppen af brønde har fået tildelt en fluorofor i Plate Editor (Pladeeditor).

2. Vælg brønden eller gruppen af brønde i pladeruden.

3. Vælg et navn på rullelisten Sample Names (Prøvenavne) i højre rude.

Softwaren markerer automatisk afkrydsningsfeltet Load (Indlæs).

4. Gentag Trin 3 for hver brønd eller gruppe af brønde, der skal tildeles et prøvenavn til.

5. Klik på OK for at acceptere ændringerne og gemme pladen.

Bemærk: Hvis pladen blev ændret ved en fejl, skal du klikke på Undo (Fortryd) på værktøjslinjen
i Plate Editor (Pladeeditor), inden du klikker på OK for at acceptere ændringerne.

Sådan fjernes et prøvenavn

u For at fjerne et prøvenavn fra en valgt brønd eller gruppe af brønde skal du fjerne markeringen i
afkrydsningsfeltet Load (Indlæs).

Sådan føjes et prøvenavn til listen

u For at føje et prøvenavn til rullelisten skal du gøre et af følgende:

n Indtast et navn på rullelisten Sample Names (Prøvenavne), og tryk på Enter.

n Klik på det grønne +-symbol til højre for rullelisten, og indtast et navn til prøven.

n Klik på User Preferences (Brugerpræferencer) på værktøjslinjen, og føj navnet til biblioteket
Sample Names (Prøvenavne) på fanen Plate (Plade).

Vigtigt: Prøvenavne, som du føjer til rullelisten, er kun tilgængelige for den aktuelle plade, og
kun hvis du tildeler navnet til en brønd og gemmer pladens layout. Hvis du ikke tildeler navnet til
en brønd og gemmer pladelayoutet, gemmes navnet ikke og er ikke tilgængeligt til fremtidig
brug. For at tilføje et prøvenavn permanent skal det også tilføjes til biblioteket Sample Names
(Prøvenavne) ved hjælp af dialogboksen User Preferences (Brugerpræferencer). Navne, du
føjer til biblioteket, er tilgængelige, når Plate Editor (Pladeeditor) åbnes igen. Se Indstilling af
standardparametre for plader på side 86 for yderligere oplysninger.
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Sådan slettes et prøvenavn fra listen

1. Klik på User Preferences (Brugerpræferencer) på værktøjslinjen.

Dialogboksen User Preferences (Brugerpræferencer) vises med fanen Plate (Plade) åben.

2. Vælg det navn, der skal slettes, i biblioteket Sample Names (Prøvenavne) på fanen Plate (Plade), og
tryk på tasten Delete (Slet).

3. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Vigtigt: Du kan ikke slette prøvenavne, der blev gemt med en pladefil. Brugerdefinerede navne,
du tilføjer på rullelisten Sample Names (Prøvenavne) og som du ikke bruger og gemmer med
pladen, fjernes automatisk fra rullelisten. Navne, du sletter fra biblioteket Sample Names
(Prøvenavne), fjernes fra softwaren og er ikke længere tilgængelige for brugerne. Vær forsigtig,
når du sletter prøvenavne.

Tildeling af biologiske grupper til brønde
Bemærk: For at kunne tildele en biologisk gruppe skal der tildeles mindst én fluorofor til de valgte
brønde. Tildeling af en fluorofor aktiverer rullelisten Biological Groups (Biologiske grupper). Se
Tildeling af en målsekvens (target) til brønde på side 140 for at få oplysninger om tildeling af
fluoroforer.

Tip: Du kan tildele én biologisk gruppe til hver brønd eller gruppe af brønde.

Sådan tildeles en biologisk gruppe til en brønd eller gruppe af brønde

1. Sørg for, at brønden eller gruppen af brønde har fået tildelt en fluorofor i Plate Editor (Pladeeditor).

2. Vælg brønden eller gruppen af brønde i pladeruden.

3. Vælg et navn på rullelisten Biological Group (Biologisk gruppe).

CFX Maestro Dx SE markerer automatisk afkrydsningsfeltet Load (Indlæs).

4. Gentag Trin 3 for hver brønd eller gruppe af brønde, til hvilke der skal tildeles en biologisk gruppe.

5. Klik på OK for at acceptere ændringerne og gemme pladen.
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Bemærk: Hvis pladen blev ændret ved en fejl, skal du klikke på Undo (Fortryd) på værktøjslinjen
i Plate Editor (Pladeeditor), inden du klikker på OK for at acceptere ændringerne.

Sådan fjernes en biologisk gruppe

u For at fjerne en biologisk gruppe fra den valgte brønd eller gruppe af brønde skal markeringen i
afkrydsningsfeltet Load (Indlæs) fjernes.

Sådan føjes en biologisk gruppe til listen

u For at føje en biologisk gruppe til rullelisten skal du gøre et af følgende:

n Indtast et navn i rullefeltet Biological Group (Biologisk gruppe), og tryk på Enter.

n Klik på det grønne +-symbol til højre for rullelisten, og indtast et navn til den biologiske gruppe.

n Klik på User Preferences (Brugerpræferencer) på værktøjslinjen, og føj navnet til biblioteket
Biological Group Names (Biologiske gruppenavne) på fanen Plate (Plade).

Vigtigt: Navne på biologiske grupper, som føjes til rullelisten, er kun tilgængelige for den
aktuelle plade, og kun hvis navnet tildeles til en brønd, og pladernes layout gemmes. Hvis du
ikke tildeler navnet til en brønd og gemmer pladelayoutet, gemmes navnet ikke og er ikke
tilgængeligt til fremtidig brug. For at tilføje et navn permanent til en biologisk gruppe skal det
også tilføjes til biblioteket Biological Group Names (Biologiske gruppenavne) ved hjælp af
dialogboksen User Preferences (Brugerpræferencer). Navne, du føjer til biblioteket, er
tilgængelige, når Plate Editor (Pladeeditor) åbnes igen. Se Indstilling af standardparametre for
plader på side 86 for yderligere oplysninger.

Sådan slettes navnet på en biologisk gruppe fra listen

1. Klik på User Preferences (Brugerpræferencer) på værktøjslinjen.

Dialogboksen User Preferences (Brugerpræferencer) vises med fanen Plate (Plade) åben.

2. Vælg det navn, der skal slettes, i biblioteket Biological Group Names (Biologiske gruppenavne) på
fanen Plate (Plade), og tryk på Delete (Slet).

3. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Vigtigt: Du kan ikke slette navne på biologiske grupper, der blev gemt med en pladefil.
Tilpassede navne, som føjes til rullelisten Biological Group Names (Navne på biologiske
grupper), og som ikke anvendes og gemmes med pladen, fjernes automatisk fra listen. Navne,
som slettes fra biblioteket Biological Group Names (Biologiske gruppenavne), fjernes permanent
fra softwaren og er ikke længere tilgængelige for brugerne. Vær forsigtig, når du sletter
biologiske navne.
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Sådan vises alle biologiske grupper på pladen

u Klik på Show Biological Groups (Vis biologiske grupper) for at vise alle biologiske grupper på pladen.

Hver gruppe identificeres med en specifik farve, og knappen Show Biological Groups (Vis biologiske
grupper) ændres til Hide Biological Groups (Skjul biologiske grupper).

Klik på Hide Biological Groups (Skjul biologiske grupper) for at rydde farven i brøndene. Du kan også
klikke på en hvilken som helst brønd på pladen for at skjule de biologiske grupper.

Tildeling af tekniske replikatnumre til brønde
Vigtigt: Hvis der skal tildeles tekniske replikatnumre, skal de valgte brønde have identisk
brøndindhold. Det vil sige, at de valgte brønde skal have samme prøvetype og fluorofor. Hvis
relevant, skal de desuden tildeles samme navne på målsekvenser og prøver og samme biologiske
gruppe. Hvis de ikke er identiske, aktiveres denne valgmulighed ikke i CFX Maestro Dx SE.

Sådan tildeles tekniske replikatnumre til en gruppe af brønde

1. Kontrollér, at indholdet af gruppen af brønde er identisk i Plate Editor (Pladeeditor).

2. Vælg målgruppen af brønde i pladeruden.

3. For at tildele det samme replikatnummer til alle valgte brønde skal du indtaste replikatnummeret i
feltet under Replicate # (Replikatnummer) i højre rude og vælge Load (Indlæs).

4. (Valgfrit) Sådan anvendes en replikatserie på et sæt valgte brønde:
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a. Klik på Technical Replicates (Tekniske replikater) Afsnittet Replicate # (Replikatnummer)
ændres til at vise følgende valgmuligheder:

n Replicate size (Replikatstørrelse) – et tal, der repræsenterer antallet af brønde i hver
gruppe af replikater

n Starting Replicate # (Startreplikatnummer) – det første tal i replikatserien for den valgte
gruppe af replikater

Bemærk: CFX Maestro Dx SE viser som standard startreplikatnummeret som et tal, der er
større end det sidste tekniske replikatnummer, som er tildelt i pladen. Hvis det seneste
tekniske replikatnummer, der er tildelt i pladen, for eksempel er fem, vil det næste
startnummer være seks. Du kan ændre startnummeret til et andet nummer, som ikke
allerede er tildelt.

n Indlæsningsretning (Horizontal (Vandret) eller Vertical (Lodret))

b. Klik på Apply (Anvend) for at anvende parametrene på serierne og vende tilbage til skærmen
Replicate # (Replikatnummer).

5. Klik på OK for at acceptere ændringerne og gemme pladen.

Bemærk: Hvis pladen blev ændret ved en fejl, skal du klikke på Undo (Fortryd) på værktøjslinjen
i Plate Editor (Pladeeditor), inden du klikker på OK for at acceptere ændringerne.

Sådan fjernes en brønd fra en replikatserie

u Vælg den brønd eller den gruppe af brønde, som skal fjernes, og fjern markeringen i
afkrydsningsfeltet Replicate # Load (Indlæs replikatnummer).

Du kan også klikke på Clear Replicate # (Ryd replikatnummer) for at fjerne replikatnummeret fra en
valgt brønd eller gruppe af brønde.
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Sådan vises alle tekniske replikater på pladen

u Klik på Show Technical Replicates (Vis tekniske replikater) for at få vist alle tekniske replikater på
pladen.

Hver gruppe identificeres med en specifik farve, og knappen Show Technical Replicates (Vis
tekniske replikater) ændres til Hide Technical Replicates (Skjul tekniske replikater).

Klik på Hide Technical Replicates (Skjul tekniske replikater) for at fjerne farven i brøndene. Du kan
også klikke på en vilkårlig brønd på pladen for at skjule tekniske replikater.

Tildeling af en fortyndingsserie til standardprøvetyper
Som tidligere nævnt skal alle brønde med prøvetypen Standard tildeles en koncentrationsværdi. Du kan
tildele en fortyndingsserie til flere brønde med prøvetypen Standard.

Bemærk: For at tildele en fortyndingsserie til en gruppe af brønde skal brøndene være medtaget i en
teknisk replikatserie. Se Tildeling af tekniske replikatnumre til brønde på side 146 for at få
oplysninger om tilføjelse af brønde til en replikatserie.

Sådan tildeles en fortyndingsserie til en gruppe af standardprøvebrønde

1. Kontrollér i Plate Editor (Pladeeditor), at følgende krav er opfyldt:

n Prøvetypen for gruppen af brønde er Standard.

n Alle brønde i gruppen er tildelt mindst én fluorofor, og de indeholder allesammen de samme
fluoroforer.

n Alle brønde i gruppen er medtaget i den samme tekniske replikatserie.

Bemærk: CFX Maestro Dx SE aktiverer først funktionen Dilution Series (Fortyndingsserie),
når alle valgte brønde opfylder disse kriterier.

2. Vælg målgruppen af brønde i pladeruden.

3. Klik på Dilution Series (Fortyndingsserie) i afsnittet Concentration (Koncentration) i højre rude.
Afsnittet Concentration (Koncentration) skifter til visning af følgende valgmuligheder:
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n Starting concentration (Startkoncentration) – den koncentrationsværdi, serien starter fra

n Replicates from and to (Replikater fra og til) – de replikater i serien, som fortyndingsfaktoren vil
blive anvendt på

n Dilution factor (Fortyndingsfaktor) – den mængde, som koncentrationen skal ændres med
inden for hver replikatgruppe

4. Indstil værdierne for valgmulighederne, eller accepter standardindstillingerne.

5. Fortyndingsserien formindskes som standard med fortyndingsfaktoren. Vælg Increasing (Stigende)
for at forøge fortyndingsserien.

6. (Valgfrit) Fortyndingsfaktoren gælder som standard for alle fluoroforer i replikatserien. Hvis serien
indeholder mere end én fluorofor, og du vil anvende fortyndingen på en enkelt fluorofor, skal du
vælge den på rullelisten.

7. Klik på Apply (Anvend) for at anvende fortyndingsserien på gruppen af brønde og vende tilbage til
visningen Concentration (Koncentration).

8. Klik på OK for at acceptere ændringerne og gemme pladen.

Kopiering af brøndindhold til en anden brønd
Du kan kopiere indholdet i en brønd og indsætte det i en enkelt brønd eller flere brønde. Du kan dog kun
kopiere indhold fra en enkelt brønd. Du kan ikke vælge flere brønde og kopiere deres indhold.

Sådan kopieres brøndindhold til en anden brønd

1. Vælg den brønd, der skal kopieres, i pladeruden.

2. Højreklik på brønden, og vælg Copy Well (Kopiér brønd).

3. Vælg den eller de brønde, som indholdet skal indsættes i:

n For at vælge en enkelt brønd skal du klikke på brønden.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække den til
målsekvensbrønden.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

4. Højreklik, når de ønskede brønde er valgt, og vælg Paste Well (Indsæt brønd).

CFX Maestro Dx SE indsætter indholdet af den første brønd i de valgte brønde.

Brugervejledning | 149



Kapitel 8 Klargøring af plader

Tilføjelse af en bemærkning til en brønd
Du kan tilføje en beskrivende bemærkning til en brønd. Du kan se bemærkningerne for en brønd på fanen
Quantification (Kvantifikation) i vinduet Data Analysis (Dataanalyse).

Sådan tilføjes en bemærkning til en brønd

1. Vælg den eller de brønde, der skal tilføjes en bemærkning til, i ruden med pladen.

2. I afsnittet View (Vis) nederst i ruden skal du vælge Well Note (Brøndbemærkning).

Well Note (Brøndbemærkning) vises i højre rude.

3. Indtast bemærkningen i tekstfeltet, og tryk på Enter.

Teksten vises nederst i de valgte brønde.

Tip: Hvis du tidligere har oprettet en brøndbemærkning, kan du vælge den på rullelisten og
anvende den i de valgte brønde.

Rydning af brønde for alt indhold
Du kan rydde en individuel brønd, en gruppe af brønde eller hele pladen for alt indhold. Rydning af brønde
fjerner ikke de fluorescensdata, som blev indsamlet under pladeaflæsningen.

Vigtigt: Hvis en brønd ryddes, fjernes indholdet permanent fra brønden. Rydningshandlingen kan
ikke fortrydes, hvis du klikker på OK og gemmer pladen efter rydning af en brønd. Vær forsigtig, når
du rydder brønde.

Sådan ryddes brønde for alle indstillinger

1. Vælg brønden eller gruppen af brønde i pladeruden i Plate Editor (Pladeeditor):

n For at vælge en enkelt brønd skal du klikke på brønden.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække den til
målsekvensbrønden.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

n For at vælge en hel kolonne med samme prøvetype skal du klikke på kolonnens nummer.

n For at vælge en hel række skal du klikke på rækkens nummer.

2. Klik på Clear Wells (Ryd brønde) i den højre rude.
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CFX Maestro Dx SE rydder de valgte brønde for alle indstillinger.

3. Gør et af følgende:

n Hvis brøndene blev ryddet ved en fejl, skal du klikke på Undo (Fortryd) på værktøjslinjen i Plate
Editor (Pladeeditor), inden du klikker på OK for at acceptere ændringerne.

Vigtigt: Hvis du klikker på OK, inden du klikker på Undo (Fortryd), gemmes ændringerne,
og Undo (Fortryd) deaktiveres på værktøjslinjen i Plate Editor (Pladeeditor).

n Klik på OK for at acceptere ændringerne og gemme pladen.
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Ændring af eksperimentindstillinger
Brug dialogboksen Experiment Settings (Eksperimentindstillinger) til at vise eller ændre listen med
målsekvenser (targets), prøver eller biologiske grupper eller til at indstille den prøvegruppe for
genekspressionsanalyse, der skal analyseres, hvis du tildelte biologiske grupper til brønde i pladen.

I dialogboksen Experiment Settings (Eksperimentindstillinger) viser fanen Targets (Målsekvenser) en liste
med navne på målsekvenser for hver PCR-reaktion som f.eks. målsekvensgenet eller
interessegensekvenserne.

Fanen Samples (Prøver) og fanen Biological Groups (Biologiske grupper) viser en liste med navne på
prøver og biologiske grupper, der angiver kilden til målsekvensen (target), som f.eks. en prøve indsamlet
efter 1 time (1Hr) eller fra et bestemt individ (mouse1).

Sådan ændres pladeindstillinger vha. dialogboksen Experiment Settings
(Eksperimentindstillinger)

1. For at åbne dialogboksen Experiment Settings (Eksperimentindstillinger) skal du gøre et af følgende:

n Klik på Experiment Settings (Eksperimentindstillinger) i den højre rude i Plate Editor
(Pladeeditor)

n Klik på Experiment Settings (Eksperimentindstillinger) på fanen Gene Expression
(Genekspression) i vinduet Data Analysis (Dataanalyse).

Dialogboksen Experiment Settings (Eksperimentindstillinger) vises med indholdet fra fanen Targets
(Målsekvenser).
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2. Et nyt navn på en målsekvens (target), en prøve eller en biologisk gruppe kan tilføjes ved at indtaste
navnet i tekstfeltet New (Ny) på den relevante fane og derefter klikke på Add (Tilføj).

3. For at fjerne et eller flere navne på målsekvenser (targets), prøver eller biologiske grupper fra listen
skal du markere elementets afkrydsningsfelt i kolonnen Select to Remove (Markér til fjernelse) på
den relevante fane og klikke på Remove checked
item(s) (Fjern valgte elementer).

4. CFX Maestro Dx SE udelader prøvetypen NTC (template-fri kontrol) fra genekspressionsanalyse.

For at medtage NTC-prøvetyper skal du fjerne markeringen i afkrydsningsfeltet Exclude the following
sample types (Udelad følgende prøvetyper). Du kan vælge at udelade følgende prøvetyper ved at
markere det relevante afkrydsningsfelt:

n NRT (Revers transkriptase-fri kontrol)

n Negative Control (Negativ kontrol)

n Positive Control (Positiv kontrol)

n Standard

5. På fanen Targets (Målsekvenser):

a. For at vælge en målsekvens (target) som reference for analyse af genekspressionsdata skal du
vælge den i kolonnen Reference.

b. For at skjule analyseindstillinger, der anvendes på fanen Gene Expression (Genekspression) i
vinduet Analysis Settings (Analyseindstillinger), skal du fjerne markeringen i Show Analysis
Settings (Vis analyseindstillinger).

Softwaren skjuler følgende kolonner:

n Color (Farve)

n Show Chart (Vis diagram)

n Auto Efficiency (Automatisk effektivitet)

n Efficiency (%) (Effektivitet (%))

c. For at ændre farven på målsekvensen (target), som den gengives i diagrammet Gene
Expression (Genekspression), skal du klikke på dens celle i kolonnen Color (Farve), vælge en ny
farve i dialogboksen Color (Farve) og klikke på OK.

d. For at vise målsekvensen (target) med den valgte farve i diagrammet Gene Expression
(Genekspression) skal du markere afkrydsningsfeltet i kolonnen Show Chart (Vis diagram).

e. Som standard beregner CFX Maestro Dx SE automatisk den relative effektivitet for en
målsekvens (target), hvis dets data omfatter en standardkurve.
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For at bruge en tidligere fastlagt effektivitetsværdi skal du indtaste værdien i cellen i kolonnen
Efficiency (%) (Effektivitet (%)) og trykke på tasten Enter. CFX Maestro Dx SE fjerner
markeringen i feltet Auto Efficiency (Automatisk effektivitet).

6. På fanen Samples (Prøver) og Biological Groups (Biologiske grupper):

a. For at vælge en prøve eller biologisk gruppe som kontrolprøve for analysen af
genekspressionsdata skal du vælge dens afkrydsningsfelt i kolonnen Control (Kontrol).

b. For at tildele en kontrolbetingelse til en prøve eller biologisk gruppe for en kørsel skal du klikke i
dens afkrydsningsfelt i kolonnen Control (Kontrol).

c. Hvis det ikke allerede er valgt, kan du klikke på Show Analysis Settings (Vis analyseindstillinger)
for at vise eller ændre de analyseparametre, der bruges på fanen Gene Expression
(Genekspression). Softwaren skjuler kolonnerne Color (Farve) og Show Chart (Vis diagram).

7. Klik på OK for at gemme parametrene i dialogboksen Experiment Settings (Eksperimentindstillinger)
og vende tilbage til vinduet Plate Editor (Pladeeditor).
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Oprettelse af brøndgrupper
Brøndgrupper opdeler en enkelt plade i undersæt, der kan analyseres hver for sig i vinduet Data Analysis
(Dataanalyse). Når brøndgrupperne er opsat, kan du vælge en i vinduet Data Analysis (Dataanalyse) for
at analysere dataene som en uafhængig gruppe. Der kan for eksempel opsættes brøndgrupper for at
analysere flere eksperimenter, der køres i én plade, eller for at analysere hver brøndgruppe med en
forskellig standardkurve.

Bemærk: Standardbrøndgruppen er All Wells (Alle brønde).

Sådan oprettes brøndgrupper

1. For at åbneWell Groups Manager (Brøndgruppeadministrator) skal du gøre et af følgende:

n Klik på Well Groups (Brøndgrupper) på værktøjslinjen i Plate Editor (Pladeeditor).

n I vinduet Data Analysis (Dataanalyse) skal du klikke på ManageWell Groups (Administrer
brøndgrupper).

DialogboksenWell Groups Manager (Brøndgruppeadministrator) åbnes.

2. Klik på Add (Tilføj) for at oprette en ny gruppe. Rullemenuen viser gruppenavnet som Group 1
(Gruppe 1) for den første gruppe.

3. Vælg brøndene til brøndgruppen i pladevisningen ved at klikke og trække på tværs af gruppen af
brønde. Valgte brønde vises med blåt i administratoren.
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4. (Valgfrit) Navnet på en gruppe kan ændres ved at vælge navnet i rullemenuen og indtaste et nyt
navn.

5. (Valgfrit) En brøndgruppe kan slettes ved at vælge navnet på rullelisten og klikke på Delete (Slet).

6. Klik på OK for at afslutte og lukke vinduet, eller klik på Cancel (Annuller) for at lukke vinduet uden at
gemmeændringerne.

Genvejsmenupunkter for dialogboksen Well Groups Manager
(Brøndgruppeadministrator)

Tabel 10 indeholder en liste over de menupunkter, der er tilgængelige i dialogboksenWell Groups
Manager (Brøndgruppeadministrator), når du højreklikker på en vilkårlig brønd.

Element Funktion

Copy (Kopiér) Kopierer brøndindholdet, som derefter kan sættes ind i en
anden brønd eller andre brønde.

Copy as Image (Kopiér som
billede)

Kopierer brøndvælgervisningen som et billede.

Print (Udskriv) Udskriver brøndvælgervisningen.

Print Selection (Udskriv valgte) Udskriver kun de valgte celler.

Export to Excel (Eksportér til
Excel)

Eksporterer data til et Excel-regneark.

Export to CSV (Eksportér til
CSV)

Eksporterer data som et kommasepareret dokument.

Export to Xml (Eksportér til Xml) Eksporterer data som et .xml-dokument.

Export to Html (Eksportér til
Html)

Eksporterer data som et .html-dokument.

Tabel 10. Genvejsmenupunkter i dialogboksen Well Groups Manager (Brønd-
gruppeadministrator) i Plate Editor (Pladeeditor)
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Ændring af kurvelinjelayout
Du kan ændre amplifikationskurvelinjernes farve og layout under pladeopsætning og mens en kørsel er i
gang. Derefter er det nemt at se kurvelinjerne i statusvinduet i realtid, efterhånden som dataene
indsamles.

Sådan ændres kurvelinjelayout

1. Klik på Trace Styles (Kurvelinjelayout) på værktøjslinjen Plate Editor (Pladeeditor).

Dialogboksen Trace Styles (Kurvelinjelayout) vises for den åbne plade, for eksempel:

2. For at vise kurvelinjelayout efter en specifik fluorofor skal du vælge den i rullemenuen Fluorophores
(Fluoroforer).

3. Sådan ændres kurvelinjevisningen:

a. Vælg kurvelinjetypen på rullelisten Wells (Brønde).

b. Klik på dens farve i kolonnen Color (Farve).

c. Vælg en anden farve for kurvelinjen i dialogboksen Color (Farve), der åbnes, og klik på OK.

CFX Maestro Dx SE viser farveændringen for brøndtypen i gitteret.

d. (Valgfrit) Vælg et symbol for kurvelinjen på rullelisten Symbols (Symboler).

4. For at ændre den indstillede farve hurtigt skal du klikke på det relevante valg i afsnittet Color Quick
Set (Hurtig indstilling af farve).
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5. For at se brøndbetegnelserne i gitteret skal du vælge betegnelsestypen i afsnittet Well Labels
(Brøndbetegnelser).

6. Klik på OK for at gemmeændringerne, eller klik på Cancel (Annuller) for at annullere ændringerne.
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Visning, eksport og import af pladen i regnearksformat
Værktøjet Spreadsheet View/Importer (Visning/import af regneark) viser indholdet af en plade i
regnearksformat. Fremviseren giver mulighed for at vise, importere og eksportere brønddata som
beskrevet nedenfor.

Brug af regnearksfremviseren til at eksportere og importere pladedata

Fra regnearksfremviseren kan du eksportere målnavnet, prøvenavnet, det biologiske gruppenavn og
brøndnoter som en skabelon i et tabulatorsepareret format til et program som f.eks. Microsoft Excel. Du
kan også importere disse data fra et tabulatorsepareret program til en foruddefineret plade fra en
eksperimentinformationsfil.

Sådan bruges værktøjet Spreadsheet View/Importer (Visning/import af regneark)

1. Opret og gem en pladefil (se Oprettelse af en pladefil med Plate Editor (Pladeeditor)).

2. Klik på fanen Spreadsheet View/Importer (Visning/import af regneark) på værktøjslinjen Plate Editor
(Pladeeditor) for at åbne dialogboksen Plate Spreadsheet View (Visning af pladeregneark).

3. (Valgfrit) Klik på felterne Show Biological Set Name (Vis navn på biologisk sæt) og ShowWell Note
(Vis brøndbemærkning) for at vise disse kolonner i regnearksvisningen og i den eksporterede fil.

4. Klik på knappen Export Template (Eksportér skabelon) for at oprette en tom skabelon i en Excel-fil
(.csv-format). Den eksporterede fil vil have det samme layout som din plade.

Tip: Brug pladefilnavnet, når du gemmer dine pladefiler, så du nemt kan identificere filen.

5. Udfyld Excel-filens celler med dit brøndindhold.
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Bemærk: Du kan kun redigere indholdet i en hvilken som helst celle i en kolonne, der har en
stjerne (*) ved siden af kolonnenavnet (*Target Name, *Sample Name, *Biological Group Name,
*Well Note).

Bemærk: Du kan ikke føje værdier til kolonnerne Standard Curve (Standardkurve) og Quantity
(Mængde) i den eksporterede Excel-fil. Hvis du vil ændre disse data, skal du gå tilbage til
pladeeditoren og vælge Settings (Indstillinger) > Units (Enheder) på menulinjen. Når
pladekørslen er fuldført, vises data fra disse standarder i diagrammet Standard Curve
(Standardkurve) på fanen Quantification (Kvantifikation) i vinduet Data Analysis (Dataanalyse)
med de valgte enheder.

6. Importér den udfyldte Excel-fil tilbage til plateeditoren ved at klikke på knappen Import (Importér). De
importerede pladedata vises i vinduet Plate Spreadsheet View (Pladeregnearksvisning).

Vigtigt: Hvis du har flere fluoroforer, skal du udføre trin 3-5 for hver fluorofor ved hjælp af
rullemenuen Flours List (Flouroforliste) i Plate Spreadsheet View (Pladeregnearksvisning).

7. Klik på knappen OK. De nye pladedata vises nu i vinduet Plate Editor (Pladeeditor).

Tip: Du kan få vist menupunkter, som er tilgængelige i værktøjet Spreadsheet View/Importer
(Visning/import af regneark), når du højreklikker på en vilkårlig brønd i værktøjet eller på en af
tabeloverskrifterne i pladeregnearksvisningen.
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Oprettelse af et pladelayout ved brug af Setup Wizard (Guiden
Opsætning) for plader

Du kan bruge Setup Wizard (Guiden Opsætning) til at angive de oplysninger om pladelayout, som er
nødvendige for normaliseret genekspressionsanalyse, herunder:

n Navne på målsekvenser (targets)

n Prøvenavne

n Placering af målsekvenser (targets) og prøve på pladen

n Referencegen(er)

n Kontrolprøve

Setup Wizard (Guiden Opsætning) kan bruges før, under og efter en kørsel.

Anvendelse af Setup Wizard (Guiden Opsætning) for plader
Dette afsnit forklarer, hvordan et pladelayout oprettes ved hjælp af Setup Wizard (Guiden Opsætning) for
plader. For lettere at kunne se indholdet i de enkelte brønde på pladen skal du klikke på Zoom plate
(Zoom ind på pladen) øverst i Setup Wizard (Guiden Opsætning).

Vigtigt: Hvis du vender tilbage til fanen Auto layout (Automatisk layout) fra en hvilken som helst
anden fane i Setup Wizard (Guiden Opsætning), nulstilles pladelayoutet. Vær forsigtig, når du vælger
denne fane.

Tip: Du kan nulstille layoutet ved at vælge Tools > Clear Plate (Værktøjer > Ryd plade) i Setup
Wizard (Guiden Opsætning).

Sådan anvendes Setup Wizard (Guiden Opsætning) for plader

1. Åbn Plate Editor (Pladeeditor).

2. For at åbne Setup Wizard (Guiden Opsætning) skal du gøre et af følgende:

n Vælg Editing Tools > Setup Wizard (Redigeringsværktøjer > Guiden Opsætning).

n Klik på Setup Wizard (Guiden Opsætning) på værktøjslinjen i Plate Editer (Pladeeditor).

Setup Wizard (Guiden Opsætning) åbnes og viser fanen Auto layout (Automatisk layout).
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3. Gør følgende på fanen Auto layout (Automatisk layout):

a. Klik på en brønd i gitteret, og træk på tværs og ned for at angive det område på pladen, hvor du
planlægger at placere prøven.

b. Indtast antallet af målsekvenser (targets) og prøver, der skal placeres.

Tip: Antallet af målsekvenser (targets) og prøver skal være det samme som antallet af
valgte celler. Hvis det indtastede antal ikke passer til det valgte område, skal antallet eller
det valgte område på pladen ændres. Orienteringen af elementerne på pladen og
grupperingen af disse kan specificeres.

c. (Valgfrit) Rediger pladernes orientering. For eksempel kan du indstille målsekvenser (targets) i
kolonner og prøver i rækker eller gruppere efter prøver.

d. Klik på Next (Næste) for at gå videre til fanen Target names (Navne på målsekvenser).

Bemærk: Hvis pladelayoutet ikke har et regelmæssigt mønster, kan du bruge fanen Target
names (Navne på målsekvenser) til manuelt at placere målsekvenserne (targets) eller fanen
Sample Names (Prøvenavne) til manuelt at placere prøverne på pladen. Klik og træk for at
vælge flere brønde.
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4. Definer navnene på målsekvenserne (targets) for målsekvensgrupperne på fanen Target Names
(Navne på målsekvenser):

a. Gør et af følgende:

n For at omdøbe målsekvenser (targets) efter gruppe skal du indstille Select by (Vælg efter) til
Target (Målsekvens).

n For at omdøbe målsekvenser (targets) efter brønd skal du indstille Select by (Vælg efter) til
Well (Brønd).

b. Vælg en målsekvensgruppe eller -brønd i gitteret, og indtast et navn på rullelisten Target Name
(Navn på målsekvens).

Tip: Tryk på Tab for at vælge den næste gruppe eller brønd til højre, eller tryk på Enter for at
vælge den næste brønd eller gruppe nedenfor. Alternativt kan du holde Ctrl-tasten nede og
klikke på en brønd på fanerne Target name (Navn på målsekvens) og Sample name
(Prøvenavn) for at vælge flere brønde, der ikke støder op til hinanden.

c. Klik på Next (Næste) for at gå videre til fanen Sample Names (Prøvenavne).

5. På fanen Sample Names (Prøvenavne) defineres prøvenavnene for prøvegrupperne.

6. Klik på Next (Næste) for at gå videre til fanen Reference targets (Referencemålsekvenser).

7. Vælg en eller flere målsekvenser (targets) på fanen Reference targets (Referencemålsekvenser) til
brug som referencer for normaliseret genekspression, og klik på Next (Næste) for at gå videre til
fanen Control sample (Kontrolprøve).

8. Vælg en eller to prøver på fanen Control sample (Kontrolprøve) til brug som kontrol i forbindelse med
beregning af genekspression.

9. Klik på OK for at gemme pladelayoutet og gå tilbage til Plate Editor (Pladeeditor), hvor
pladeparametrene kan defineres yderligere. Se Tildeling af valgfri parametre til pladefilen på side 140
for yderligere oplysninger.

Du kan også klikke på Previous (Forrige) for at gå tilbage til en foregående fane for at foretage
ændringer.

Bemærk: Når du vender tilbage til fanen Auto layout (Automatisk layout), nulstilles
pladelayoutet. Vær forsigtig, når du klikker på Previous (Forrige).
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Kapitel 9 Kørsel af eksperimenter
Dette kapitel beskriver, hvordan du kører brugerdefinerede analyseeksperimenter eller PrimePCR™-
analyseeksperimenter ved brug af CFX Maestro Dx Software, Security Editionn.

En kørselsdatafil indeholder protokol- og pladeoplysninger for kørslen. Filen indeholder også dataene fra
de analyser, som CFX Maestro Dx SE udfører, efter at kørslen er udført.

CFX Maestro Dx SE gør det nemt at opsætte og køre brugerdefinerede eksperimenter eller PrimePCR-
eksperimenter. Vinduet Run Setup (Kørselsopsætning) fører dig gennem de almindelige trin til opsætning
af et eksperiment og ender i dialogboksen Start Run (Start kørsel), hvor du kan starte kørslen.
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Vinduet Run Setup (Kørselsopsætning)
Vinduet Run Setup (Kørselsopsætning) giver hurtig adgang til de filer og indstillinger, der er nødvendige
for at kunne sætte et eksperiment op og køre det. Hvis der skal køres et brugerdefineret eksperiment,
åbnes vinduet Run Setup (Kørselsopsætning) med fanen Protocol (Protokol). Hvis der skal køres et
PrimePCR-eksperiment, åbnes vinduet Run Setup (Kørselsopsætning) med Fanen Start Run (Start
kørsel).

Tip: Se Udførelse af PrimePCR-eksperimenter på side 183 for oplysninger om PrimePCR. Se Fanen
Start Run (Start kørsel) på side 173 for oplysninger om fanen Start Run (Start kørsel).
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1. Fanerne guider brugeren gennem klargøring og kørsel af et eksperiment:

n Fanen Protocol (Protokol) – vælg en eksisterende protokol, der skal køres eller
redigeres, eller opret en ny protokol i Protocol Editor (Protokoleditor).

n Fanen Plate (Plade) – vælg en eksisterende plade, der skal køres eller redigeres,
eller opret en ny plade i Plate Editor (Pladeeditor).

n Fanen Start Run (Start kørsel) – vis eksperimentindstillingerne, vælg en eller flere
instrumentblokke, og påbegynd kørslen.

2. Hovedvinduet viser valgmulighederne for de enkelte faner, efterhånden som de
anvendes.

3. Navigationsknapperne bruges til gå til fanen Start Run (Start kørsel).

FORKLARING

Åbning af vinduet Run Setup (Kørselsopsætning)
Sådan åbnes vinduet Run Setup (Kørselsopsætning)

u Gør et af følgende:

n Klik enten på User-defined (Brugerdefineret) eller PrimePCR på fanen Run Setup
(Kørselsopsætning) i Startup Wizard (Guiden Opstart).

n Klik enten på User-defined Run Setup (Brugerdefineret kørselsopsætning) eller PrimePCR Run
Setup (PrimePCR kørselsopsætning) på værktøjslinjen i startvinduet.

n Vælg enten Run > User-defined Run (Kørsel > Brugerdefineret kørsel) eller Run > PrimePCR
Run (Kørsel > PrimePCR-kørsel) i startvinduet.
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Fanen Protocol (Protokol)
Fanen Protocol (Protokol) viser en forhåndsvisning af den protokolfil, du planlægger at køre. En protokolfil
indeholder instruktionerne til instrumentets temperaturtrin samt de instrumentindstillinger, der styrer
rampehastigheden, prøvevolumenet og lågets temperatur.

Som standard viser softwaren den protokol, der er defineret i afsnittet File Selection for Run Setup (Filvalg
til kørselsopsætning) på fanen Files (Filer) i dialogboksen User > User Preferences (Bruger >
Brugerpræferencer). Du kan ændre standardprotokollen i dialogboksen User Preferences
(Brugerpræferencer). SeÆndring af standardindstillinger for filer på side 83 for yderligere oplysninger.

På fanen Protocol (Protokol) kan du:

n Oprette en ny protokol til kørsel

n Vælge en eksisterende protokol for at køre eller redigere den

Se Kapitel 7, Oprettelse af protokoller for yderligere oplysninger om oprettelse og redigering af
protokoller.

Sådan oprettes en ny protokol

1. Klik på Create New (Opret ny) på fanen Protocol (Protokol).

Protocol Editor (Protokoleditor) vises.
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2. Brug Protocol Editor (Protokoleditor) til at oprette den nye protokol.

3. Klik på OK for at gemme protokollen og gå tilbage til fanen Protocol (Protokol) under Run Setup
(Kørselsopsætning).

4. Gennemse de detaljerede oplysninger om protokollen, og gør et af følgende:

n Klik på Next (Næste), hvis oplysningerne er korrekte, for at gå videre til fanen Plate (Plade).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
vende tilbage til vinduet Protocol Editor (Protokoleditor). Gennemgå protokollen, gem
ændringerne, og klik derefter på Next (Næste) på fanen Protocol (Protokol) for at gå videre til
fanen Plate (Plade).

Sådan vælges en eksisterende protokol

1. Gør et af følgende på fanen Protocol (Protokol):

n Klik på Select Existing (Vælg eksisterende), og naviger til en eksisterende protokol.

n Klik på Express Load (Hurtig-udfyldelse) og vælg en protokol fra rullelisten med protokoller.

Tip: Du kan tilføje eller fjerne protokoller fra rullelisten Express Load (Hurtig-udfyldelse). Se
Tilføjelse og fjernelse af protokoller til hurtig-udfyldelse nedenfor for yderligere oplysninger.

2. Gennemse de detaljerede oplysninger om protokollen, og gør et af følgende:

n Klik på Next (Næste), hvis oplysningerne er korrekte, for at gå videre til fanen Plate (Plade).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
åbne Protocol Editor (Protokoleditor). Gennemgå protokollen, gemændringerne, og klik derefter
på Next (Næste) på fanen Protocol (Protokol) for at gå videre til fanen Plate (Plade).

Tilføjelse og fjernelse af protokoller til hurtig-udfyldelse

Du kan redigere indholdet af rullelisten Express Load (Hurtig-udfyldelse), som vises i Protocol Editor
(Protokoleditor). Protokollerne på listen gemmes i følgende mappe:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\

Sådan redigeres listen med protokoller til Express Load (Hurtig-udfyldelse)

1. Naviger til og åbn mappen ExpressLoad (Hurtig-udfyldelse).

2. Gennemgå protokolfilerne (.pcrl) i mappen.

3. Gør et af følgende:

n Slet protokoller fra mappen for at fjerne dem fra rullelisten.

n Kopiér protokoller til mappen for at tilføje dem på rullelisten.
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Fanen Plate (Plade)
Bemærk: Hvis den protokol, der vælges på fanen Protocol (Protokol), ikke indeholder et
pladeaflæsningstrin til real-time PCR-analyse, er fanen Plate (Plade) skjult. For at se fanen Plate
(Plade) skal du tilføje mindst én pladeaflæsning til protokollen.

Fanen Plate (Plade) viser en forhåndsvisning af den pladefil, du planlægger at indlæse. I en real-time
PCR-kørsel indeholder pladefilen en beskrivelse af indholdet i hver brønd, herunder dens fluoroforer,
scanningstilstanden og pladetypen. CFX Maestro Dx SE bruger disse beskrivelser til dataindsamling og
analyse.

Softwaren viser som standard den plade, der er defineret i afsnittet File Selection for Run Setup (Filvalg til
kørselsopsætning) på fanen Files (Filer) i dialogboksen User > User Preferences (Bruger >
Brugerpræferencer). Standardpladen kan ændres i dialogboksen User Preferences (Brugerpræferencer).
SeÆndring af standardindstillinger for filer på side 83 for yderligere oplysninger.

På fanen Plate (Plade) kan du

n Oprette en ny plade, som skal indsættes.

n Vælge en eksisterende plade, som skal indsættes eller redigeres.

Der findes flere oplysninger om oprettelse og ændring af plader i Kapitel 8, Klargøring af plader.
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Sådan oprettes en ny plade

1. Klik på Create New (Opret ny) på fanen Plate (Plade).

Plate Editor (Pladeeditor) vises.

2. Brug Plate Editor (Pladeeditor) til at oprette en ny plade.

3. Klik på OK for at gemme pladen og gå tilbage til fanen Plate (Plade) under Run Setup
(Kørselsopsætning).

4. Gennemse de detaljerede oplysninger om pladen, og gør et af følgende:

n Klik på Next (Næste), hvis de detaljerede oplysninger er korrekte, for at gå videre til fanen Start
Run (Start kørsel).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
vende tilbage til Plate Editor (Pladeeditor). Gennemgå pladefilen, gemændringerne, og klik
derefter på Next (Næste) på fanen Plate (Plade) for at gå videre til fanen Start Run (Start kørsel).

Sådan vælges en eksisterende pladefil

1. Gør et af følgende på fanen Plate (Plade):

n Klik på Select Existing (Vælg eksisterende), og naviger til en eksisterende pladefil.

n Klik på Express Load (Hurtig-udfyldelse) og vælg en pladefil på rullelisten.

Tip: Du kan tilføje plader til eller fjerne dem fra rullelisten Express Load (Hurtig-udfyldelse).
Der findes flere oplysninger i Tilføjelse og fjernelse af pladefiler til hurtig-udfyldelse
nedenfor.

2. Gennemse de detaljerede oplysninger om pladen, og gør et af følgende:

n Klik på Next (Næste), hvis de detaljerede oplysninger er korrekte, for at gå videre til fanen Start
Run (Start kørsel).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at åbne
vinduet Plate Editor (Pladeeditor). Gennemgå pladefilen, gemændringerne, og klik derefter på
Next (Næste) for at gå videre til fanen Start Run (Start kørsel).

Tilføjelse og fjernelse af pladefiler til hurtig-udfyldelse

Du kan redigere indholdet af rullelisten Express Load (Hurtig-udfyldelse), som vises i Plate Editor
(Pladeeditor). De plader, der vises på listen, er gemt i følgende mappe:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\

Brugervejledning | 171



Kapitel 9 Kørsel af eksperimenter

Sådan redigeres listen med pladefiler til Express Load (Hurtig-udfyldelse)

1. Naviger til og åbn mappen ExpressLoad (Hurtig-udfyldelse).

2. Gennemgå pladefilerne (.pltd) i mappen.

3. Gør et af følgende:

n Slet pladefiler fra mappen for at fjerne dem fra rullelisten.

n Kopiér pladefiler til mappen for at tilføje dem på rullelisten.
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Fanen Start Run (Start kørsel)
Fanen Start Run (Start kørsel) viser oplysninger om eksperimentet, der skal køres. Den viser også den
eller de tilsluttede instrumentblokke, som eksperimentet kan køres på.

Fanen Start Run (Start kørsel) kan bruges til følgende:

n Vise detaljerede kørselsoplysninger, herunder den valgte protokolfil, pladefil og scanningstilstand.

n Tilføje bemærkninger om kørslen.

n Vise detaljerede oplysninger om alle tilsluttede instrumenter, herunder deres kørselsstatus (kører
eller inaktiv), prøvevolumen i µl, lågets temperatur, emuleringstilstand og id eller stregkode, hvis de
er tilgængelige.

Bemærk: Du kan ændre kolonnerne, der vises i tabellen Start Run on Selected Blocks (Start
kørsel på valgte blokke). Se Redigering af detaljerede oplysninger i tabellen Selected blocks
(Valgte blokke) på side 174 for yderligere oplysninger.

n Vælge den eller de blokke, som kørslen skal udføres på.

n Åbne eller lukke låget med fjernbetjening for hvert valgt instrument.

n Starte kørslen.
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Redigering af detaljerede oplysninger i tabellen Selected blocks (Valgte blokke)

Du kan ændre kolonnerne, der vises i tabellen Start Run on Selected Block(s) (Start kørsel på valgte
blokke). Desuden kan du ændre værdierne for standardprøvevolumenet og lågets temperatur i tabellen.
Ændringerne af indstillingerne anvendes i den kørsel, der skal udføres.

Sådan tilføjes kolonner i tabellen Start Run on Selected Block(s) (Start kørsel på valgte
blokke)

u Højreklik i tabellen, og markér et element i den menu, der vises.

Sådan fjernes kolonner i tabellen Start Run on Selected Block(s) (Start kørsel på valgte
blokke)

u Højreklik i tabellen, og fjern markeringen for et element i den menu, der vises.

Sådan redigeres værdier for prøvevolumenet eller lågets temperatur for en blok

u Vælg cellen med prøvevolumenet eller lågets temperatur for den ønskede blok, og skriv en ny værdi i
cellen.

Sådan tilføjes et kørsels-ID eller en stregkode for en blok

u Vælg cellen ID/Bar Code (ID/stregkode) for den ønskede blok, og skriv et ID eller scan blokken med
en stregkodelæser.

Kørsel af et eksperiment
Vigtigt: Inden du kører et eksperiment, skal du sikre, at computerens antivirussoftware ikke starter
en scanning under kørslen. Se Installation af CFX Maestro Dx SE softwaren på side 34, eller kontakt
din systemadministrator for at få yderligere oplysninger.

Sådan køres et eksperiment

1. Verificer de detaljerede oplysninger om plade og protokol i afsnittet Run Information
(Kørselsoplysninger) på fanen Start Run (Start kørsel).

2. (Valgfrit) Tilføj bemærkninger om kørslen eller eksperimentet i tekstboksen Notes (Bemærkninger).

3. Markér afkrydsningsfeltet for en eller flere blokke, som kørslen skal udføres på.

Tip: For at køre eksperimentet på alle blokke skal du vælge Select All Blocks (Vælg alle blokke)
under tabellen Selected Blocks (Valgte blokke).

4. (Valgfrit) Klik på Flash Block Indicator (Lad blokindikator blinke) for at lade LED-indikatoren blinke på de
valgte instrumentblokke.

5. Sæt eksperimentpladerne ind i blokken:
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a. Klik på Open Lid (Åbn låg). Det motoriserede låg på hver valgt blok åbnes.

b. Sæt en eksperimentplade ind i hver valgt blok.

c. Klik på Close Lid (Luk låg).

Tip: På CFX Opus Dx-systemet trykkes på Open Lid (Åbn låg) eller Close Lid (Luk låg) på
startskærmen.

6. Klik på Open Lid (Åbn låg) og Close Lid (Luk låg) for at åbne og lukke det motoriserede låg på hver
valgt instrumentblok.

7. Gennemse de detaljerede oplysninger om kørslen, og gør et af følgende:

n Klik på Start Run (Start kørsel), hvis de detaljerede oplysninger er korrekte.

n Hvis de detaljerede oplysninger er forkerte:

o Ret de detaljerede oplysninger i tabellen Selected Blocks (Valgte blokke), og klik på Start
Run (Start kørsel).

o Vend tilbage til den relevante fane og foretag de relevante ændringer, gemændringerne, og
klik derefter på Next (Næste) for at vende tilbage til fanen Start Run (Start kørsel) og starte
kørslen.

Sådan startes en kørsel fra en tidligere kørsel

u Gør et af følgende:

n Vælg File > Repeat a Run (Fil > Gentag en kørsel) i softwarens hovedmenulinje. Naviger til og
dobbeltklik på den kørselsdatafil, som skal gentages.

n Vælg fanen Repeat Run (Gentag kørslen) i Startup Wizard (Guiden Opstart), og dobbeltklik på
datafilen for den kørsel, som skal gentages.

Du kan også klikke på Browse (Gennemse) på fanen Repeat Run (Gentag kørslen) for at
navigere til og dobbeltklikke på den kørselsdatafil, som skal gentages.
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Dialogboksen Run Details (Kørselsdetaljer)
Når du klikker på Start Run (Start kørsel), beder CFX Maestro Dx SE dig om at gemme datafilen (.pcrd),
starter kørslen og åbner dialogboksen Run Details (Kørselsdetaljer). Dialogboksen Run Details
(Kørselsdetaljer) består af tre statusfaner:

n Run Status (Kørselsstatus) – brug denne fane til at se protokollens aktuelle status, åbne eller lukke
låget, sætte en kørsel på pause, tilføje gentagelser, springe over trin eller stoppe kørslen.

n Real-time Status (Realtidsstatus) – brug denne fane til at se PCR-fluorescensdata i realtid, mens de
indsamles.

n Time Status (Tidsstatus) – brug denne fane til at få vist en fuldskærmsnedtælling for protokollen.

Fanerne er beskrevet i detaljer i de følgende afsnit.

Fanen Run Status (Kørselsstatus)
Fanen Run Status (Kørselsstatus) viser den aktuelle status for en igangværende kørsel. I denne visning
er det også muligt at kontrollere låget og ændre den igangværende kørsel.
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1. Ruden Run Status (Kørselsstatus) – viser status for den igangværende protokol.

2. Betjeningselementer for Run Status (Kørselsstatus) – giver mulighed for at betjene
instrumentet eller afbryde den igangværende protokol.

3. Ruden Run Information (Kørselsoplysninger) – viser kørselsdetaljer.

FORKLARING

Kommandoer for Run Status (Kørselsstatus)

Kommandoerne på fanen Run Status (Kørselsstatus) kan bruges enten til at betjene instrumentet fra
softwaren eller til at ændre en igangværende kørsel.

Bemærk:Ændringer, der foretages på protokoller under kørslen, som for eksempel tilføjelsen af
gentagelser, ændrer ikke den protokolfil, der er tilknyttet til kørslen. Disse handlinger registreres i
Run Log (Kørselsloggen).

– åbner det motoriserede låg på valgte instrumenter.

Vigtigt: Hvis låget åbnes under en kørsel, sættes kørslen på pause på det igangværende trin,
hvilket kan påvirke data. Kommandoer for Run Status (Kørselsstatus) på side 177.

– lukker det motoriserede låg på valgte instrumenter.

– tilføjer yderligere gentagelser til det igangværende trin af typen GOTO (GÅ TIL) i protokollen.
Denne valgmulighed er kun tilgængelig, når en forekomst af trinnet GOTO (GÅ TIL) kører.

Bemærk: Du kan tilføje yderligere gentagelser under en GOTO-cyklus, når protokollen er i
gang. CFX Maestro Dx SE anerkender den seneste ændring i antallet af gentagelser. Hvis du for
eksempel tilføjer 10 yderligere gentagelser i en GOTO-cyklus, ændrer softwaren det samlede
antal til n + 10. Hvis du derefter tilføjer yderligere fem (5) gentagelser i samme cyklus, ændrer
CFX Maestro det samlede antal gentagelser til n + 5. Den første ændring (10 gentagelser)
ignoreres. For at sikre, at softwaren udfører det målsatte antal gentagelser, skal du indtaste det
samlede antal (i dette tilfælde i alt 15 gentagelser).

– springer det igangværende trin i protokollen over.

Bemærk: Hvis du springer over under et GOTO-trin, springer systemet til næste cyklus i GOTO-
loopet. Hvis GOTO-trinnets sidste cyklus var i gang på tidspunktet, hvor der blev sprunget over,
springer systemet til næste trin.
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– får LED'en på visse instrumenter til at blinke for at identificere de valgte blokke.

– sætter protokollen på pause.

Bemærk: Denne handling registreres i Run Log (Kørselsloggen).

– genoptager en protokol, der er sat på pause.

– stopper kørslen før afslutningen af protokollen.

Bemærk: Hvis kørslen stoppes før afslutningen af protokollen, kan data blive påvirket.

Åbning af instrumentets låg under en PCR-kørsel

Hvis låget på et instrument åbnes under en PCR-kørsel, viser CFX Maestro Dx SE følgende
bekræftelsesdialogboks:

Mens dialogboksen vises, fortsætter instrumenterne med at køre protokollen. Knappen OK sætter kørslen på
pause, og instrumentets låg låses op og åbnes. Knappen Annuller lukker dialogboksen og fortsætter kørslen.
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Fanen Real-time Status (Realtidsstatus)
Fanen Real-time Status (Realtidsstatus) viser real-time PCR-data indsamlet i hver cyklus under kørslen
efter de første to pladeaflæsninger.

1. Kurvelinjeruden Amplification (Amplifikation) – viser amplifikationsdata i realtid
under kørslen.

2. Identifikator for Well group (Brøndgruppe) – hvis der blev identificeret brøndgrupper
i pladeopsætningen, kan brugeren vælge en specifik brøndgruppe for at se dens
kurvelinjer, brønde og tabeloplysninger.

Identifikator for Step number (Trinnummer) – hvis protokollen indsamler data på
mere end ét trin (for eksempel under amplifikation og smeltekurve), kan brugeren
vælge et specifikt trin og se de kurvelinjer, der blev indsamlet på det pågældende
trin.

3. RudenWell selector (Brøndvælger) – viser de aktive, inaktive og tomme brønde i
pladen.

4. Tabelruden Plate Setup (Pladeopsætning) – viser pladeopsætningen i tabelformat.

FORKLARING
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5. Rude med kørselsdetaljer – viser realtidsstatus for kørslen, herunder:

n Nuværende trin

n Nuværende gentagelse

n Nuværende temperatur

n Resterende tid

n Prøvetemperatur

n Lågets temperatur

6. Plate Setup (Pladeopsætning) – åbner dialogboksen Plate Setup (Pladeopsætning),
hvor brugeren kan ændre den aktuelle pladeopsætning under en kørsel.

På fanen Real-time Status (Realtidsstatus) kan du:

n Vise eller skjule kurvelinjer i realtid ved at vælge dem i brøndvælgerruden eller tabellen til
pladeopsætning

n Vise kurvelinjer enkelt- eller gruppevis ved at vælge dem i rullemenuen med brøndgrupper

n Redigere pladen eller udskifte pladefilen

n Anvende en PrimePCR-fil på kørslen.

Vise eller skjule realtidskurvelinjer

Som standard er alle fyldte brønde aktive og vises i pladeopsætningstabellen. Aktive brønde vises med
blåt i brøndvælgerruden. Skjulte brønde vises med lysegråt, og eventuelle ubrugte brønde vises med
mørkegråt i brøndvælgerruden.

Du kan skjule kurvelinjer fra aktive brønde under kørslen. CFX Maestro Dx SE bliver ved med at indsamle
data for alle brønde, men når du skjuler brøndene, vises deres data ikke i pladeopsætningstabellen.

Sådan skjules realtidskurvelinjer

u Klik på den aktive (blå) brønd, der skal skjules, i brøndvælgerruden.

Sådan vises realtidskurvelinjer

u Klik på den skjulte (lysegrå) brønd, der skal vises, i brøndvælgerruden.

Se Brøndvælger på side 199 for yderligere oplysninger om brøndvælgeren.
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Redigering af en pladeopsætning

Sådan redigeres en pladeopsætning

u Klik på Plate Setup (Pladeopsætning), og vælg View/Edit Plate (Vis/rediger plade).

Vinduet Plate Editor (Pladeeditor) vises og giver mulighed for at redigere pladen, mens kørslen er i
gang. Der findes flere oplysninger om redigering af plader i Kapitel 8, Klargøring af plader.

Bemærk: Du kan også redigere kurvelinjelayout i vinduet Plate Editor (Pladeeditor). Ændringer
vises i amplifikationskurvelinjeplottet på fanen Real-time Status (Realtidsstatus).

Udskiftning af en pladefil

Tip: Udskiftning af en pladefil er særligt nyttigt, hvis du starter en kørsel med en Quick Plate-fil i
ExpressLoad-mappen.

Sådan udskiftes en pladefil

u Klik på Plate Setup (Pladeopsætning), og vælg et af følgende:

n Replace Plate file (Udskift pladefil) – vælg den nye pladefil på listen i browservinduet

n Apply PrimePCR file (Anvend PrimePCR-fil) – søg efter en kørselsfil, som pladelayoutet skal
hentes fra, med Smart-søgning eller ved at klikke på Browse (Gennemse) for at finde en fil, der
blev downloadet fra Bio-Rads websted, og som ikke findes i PrimePCR-mappen

Bemærk: CFX Maestro Dx SE kontrollerer scanningstilstand og pladestørrelse for pladefilen.
Disse skal være de samme som de kørselsindstillinger, kørslen blev startet med.
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Fanen Time Status (Tidsstatus)
Fanen Time Status (Tidsstatus) viser, hvor lang tid der er tilbage, før den aktuelle kørsel er færdig.
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Udførelse af PrimePCR-eksperimenter
PrimePCR-eksperimenter bruger signalvejs- eller sygdomsspecifikke analyser, som Bio-Rad har
valideret og optimeret i laboratoriet, og som er tilgængelige i følgende formater:

n Paneler med foruddefinerede plader – plader med analyser, der er specifikke for en biologisk
signalvej eller sygdom. De omfatter PrimePCR-kontroller og referencegener.

n Brugerkonfigurerede plader – plader, der kan opsættes i et brugerdefineret layout, hvor der kan
vælges analyser for interessemålsekvenser (targets), kontroller og referencer.

n Individuelle analyser – rør, der indeholder individuelle primersæt til brug i real-time-reaktioner.

For at reducere den samlede kørselstid kan du fjerne smeltetrinnet i protokollen. Bio-Rad anbefaler på det
kraftigste, at der ikke udføres andre ændringer af en PrimePCR-kørselsprotokol. Standardprotokollen er
den, der blev brugt til analysevalidering. Enhver afvigelse fra dette kan påvirke resultaterne. Ændringer i
protokollen angives på fanen Run Information (Kørselsoplysninger) i den resulterende datafil og i
eventuelle rapporter, der oprettes.

Sådan startes en PrimePCR-kørsel

u For at starte en PrimePCR-kørsel skal du gøre et af følgende:

n I Startup Wizard (Guiden Opstart) skal du vælge PrimePCR på fanen Run setup
(Kørselsopsætning) og derefter vælge den relevante kemi (SYBR® eller Probe).

n Vælg en PrimePCR-kørsel på listen Recent Runs (Seneste kørsler) på fanen Repeat run
(Gentag kørslen) i Startup Wizard (Guiden Opstart).

n Vælg File > Open > PrimePCR Run File (Fil > Åbn > PrimePCR-kørselsfil) i startvinduet.

n Træk og slip en PrimePCR-kørselsfil i startvinduet.

Når du har valgt en PrimePCR-kørsel, åbnes.vinduet Run Setup (Kørselsopsætning) på fanen Start Run
(Start kørsel) med standard-PrimePCR-pladelayoutet indlæst, baseret på det valgte instrument.

Sådan fjernes smeltetrinnet i protokollen

u Fjern markeringen i feltet ved siden af Include Melt Step (Medtag smeltetrin) på fanen Protocol
(Protokol).
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Sådan importeres oplysninger om målsekvenser (targets) for PrimePCR-plader til et
pladelayout

1. Gør et af følgende:

n På fanen Real-time Status (Realtidsstatus) i dialogboksen Run Details (Kørselsdetaljer) vælges
Plate Setup > Apply PrimePCR File (Pladeopsætning > Anvend PrimePCR-fil).

n I vinduet Data Analysis (Dataanalyse) vælges Plate Setup > Apply PrimePCR File
(Pladeopsætning > Anvend PrimePCR-fil).

2. Klik på Browse (Gennemse) i dialogboksen PrimePCR run file (PrimePCR-kørselsfil) for at navigere
til den relevante PrimePCR-fil (.csv).

3. Vælg den ønskede PrimePCR-fil, og klik på Open (Åbn).

CFX Opus Dx-systemet importerer de ønskede oplysninger til pladelayoutet.

184 | CFX Maestro Dx SE-software



Overførsel af separate data til analyse

Overførsel af separate data til analyse
Vigtigt: Når der overføres datafiler fra CFX Opus Dx-systemet til CFX Maestro Dx SE, overføres alle
filer, der er gemt på systemet. Kontrollér, at der er tilstrækkelig plads på disken til dataene, inden de
overføres.

Når kørslen er færdig, analyserer CFX Maestro Dx SE fluorescensdataene. Hvis kørslen udføres i separat
tilstand og gemmes på selve CFX Opus Dx-systemet, skal dataene overføres til computeren med
CFX Maestro Dx SE installeret med henblik på analyse.

CFX Opus Dx-systemet kan gemme op til 100 PCR-kørsler i realtid. Når kørslen er færdig, kan separate
datafiler overføres til CFX Maestro Dx SE-computeren via e-mail, USB-drev eller ved brug af selve
softwaren.

Dette afsnit forklarer, hvordan separate datafiler kan overføres til CFX Maestro Dx SE-computeren.

Overførsel af data via e-mail
Sådan sendes en datafil via e-mail ved slutningen af en kørsel

1. Opsæt e-mailbeskeder for instrumentet.

Se Opsætning af e-mailbeskeder på side 79 eller betjeningsvejledningen til CFX Opus Dx Real-Time
PCR-systemet.

2. Sørg for, at Attach Data File (Vedhæft datafil) er valgt, når e-mailbeskeder sættes op.

De kørte data sendes pr. e-mail som en .pcrd-fil.

Overførsel af data fra CFX Opus Dx Real-Time PCR-systemet
Ved at bruge filbrowser-funktionen på CFX Opus Dx-systemet kan du overføre datafiler til et tilsluttet
USB-drev eller til en delt netværksmappe. Du kan også overføre CFX Maestro Dx SE-protokolfiler fra et
USB-drev eller et delt netværksdrev til din mappe eller fællesmappen på CFX Opus Dx-systemet og køre
dem på CFX Opus Dx-systemet.

Tip: Dette afsnit beskriver, hvordan man overfører data. For oplysninger om opsætning af Ethernet
henvises til betjeningsvejledningen for CFX Opus Dx Real-Time PCR-systemet, der kan tilgås i
CFX Maestro Dx SEmenuen Help (Hjælp).

1. På startskærmen for CFX Opus Dx-systemet skal du trykke på Files (Filer) for at se skærmbilledet
File Browser (Filbrowser).

2. På skærmen File Browser (Filbrowser) skal du navigere til den fil, du vil kopiere, og derefter trykke på
filen for at se ruden med filoplysninger.

3. Tryk på Settings (Indstillinger) i ruden med filoplysninger, og tryk derefter på Copy (Kopier).
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Dialogboksen Select Location (Vælg placering) vises.

4. Gør et af følgende i dialogboksen Select Location (Vælg placering):

n Naviger til en eksisterende mappe.

n Naviger til placeringen for at oprette en mappe, hvor filen skal gemmes, og tryk derefter på Opret
mappe

(  ) for at oprette en ny mappe på det sted.

5. Tryk på Select (Vælg) for at kopiere filen til den valgte placering, eller tryk på Cancel (Annuller) for at
vende tilbage til skærmbilledet File Browser (Filbrowser).

Bemærk: Hvis der findes en fil med samme navn på den valgte placering, vises en
meddelelsesboks. Tryk på Yes (Ja) for at overskrive den eksisterende fil eller No (Nej) for at
vende tilbage til skærmbilledet File Browser (Filbrowser).

CFX Opus Dx-systemet viser en bekræftelsesmeddelelse, når filen er kopieret.
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Overførsel af data gennem CFX Maestro Dx Software, Security
Editionn
Sådan overføres data gennem CFX Maestro Dx SE

1. Højreklik på det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter) i
startvinduet, og vælg Retrieve Data Files (Hent datafiler).

CFX Maestro Dx SE viser dialogboksen Browse For Folder (Gennemse for mappe).

2. I dialogboksen Browse For Folder (Browse for mappe) skal du navigere til den placering, hvor
datafilerne skal gemmes, og klikke på OK.

Overførselsprocessen opretter en mappe kaldet Real-Time Data (Realtidsdata) på den valgte
placering. Kørselsdataene er gemt i mappen Real-Time Data (Realtidsdata) som separate .zpcr-filer.

Overførsel af data med et USB-drev
Hvis du sætter et USB-drev i USB-indgangen på instrumentet, gemmes datafilen automatisk i USB-
drevets rodmappe, når kørslen er gennemført. Du kan også finde tidligere gemte datafiler og gemme dem
på et tilsluttet USB-drev.

Sådan overføres datafiler til et USB-drev på CFX Opus Dx-systemer

u I dialogboksen Select Location (Vælg placering) skal du trykke på USB og gå til den mappe, hvor filen
skal kopieres til, eller trykke på Cancel (Annuller) for at vende tilbage til filbrowserskærmen.

Bemærk: Hvis der findes en fil med samme navn på det valgte sted, vises en dialogboks. Tryk
på Yes (Ja) for at overskrive den eksisterende fil eller No (Nej) for at vende tilbage til
skærmbilledet File Browser (Filbrowser).

CFX Opus Dx-systemet viser en bekræftelsesmeddelelse, når filen er kopieret.
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Overførsel af data til et delt netværksdrev vha. CFX Opus Dx Real-
Time PCR-systemer
Tip: Du kan kun overføre data til og fra et delt netværksdrev via CFX Opus Dx-systemer.

CFX Opus Dx-systemer giver mulighed for at oprette forbindelse til et delt netværksdrev ved hjælp af
Ethernet. Med forbindelse kan du overføre datafiler til og fra en mappe på det delte netværksdrev.

Sådan overføres data til og fra et delt netværksdrev

u I dialogboksen Select Location (Vælg placering) skal du trykke på Network (Netværk) og gå til den
mappe, hvor filen skal kopieres til, eller tryk på Cancel (Annuller) for at vende tilbage til
filbrowserskærmen.

Bemærk: Hvis der findes en fil med samme navn på det valgte sted, vises en dialogboks. Tryk
på Yes (Ja) for at overskrive den eksisterende fil eller No (Nej) for at vende tilbage til
skærmbilledet File Browser (Filbrowser).

CFX Opus Dx-systemet viser en bekræftelsesmeddelelse, når filen er kopieret.

Oprettelse af en datafil
For at kunne analysere data, der overføres fra instrumentet til CFX Maestro Dx SE-computeren, skal den
komprimerede datafil (.zpcr-fil) konverteres til en datafil (.pcrd-fil). CFX Maestro Dx SE konverterer .zpcr-
filen til en .pcrd-fil og vælger derefter en pladefil, der har den samme scanningstilstand og pladestørrelse,
og anvender den på .pcrd-filen.

Sådan oprettes en datafil fra en separat datafil

1. Gør et af følgende i CFX Maestro Dx SE:

n Find den ønskede .zpcr-fil, og træk den over i startvinduet i CFX Maestro Dx SE.

n Vælg File > Open > Stand-alone Run (Fil > Åbn > Separat kørsel), og naviger til og vælg den
ønskede fil.

CFX Maestro Dx SE viser dialogboksen Save As (Gem som).

2. Naviger til den mappe, hvor .pcrd-filen skal gemmes, og klik på Save (Gem).

Når .pcrd-filen er blevet gemt, åbnes CFX Maestro Dx SE vinduet Data Analysis (Dataanalyse) og
viser de resulterende data.
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CFX Maestro Dx Software, Security Editionn behandler automatisk real-time PCR-data ved afslutningen
af hver kørsel og åbner vinduet Data Analysis (Dataanalyse) for at vise dataene (.pcrd-filen).

n Trække en datafil (med filtypenavnet .pcrd) til startvinduet og slippe den

n Vælge File > Open > Data File (Fil > Åbn > Datafil) i startvinduet og navigere til den ønskede .pcrd-fil

n Vælge File > Recent Data Files (Fil > Seneste datafiler) i startvinduet for at vælge fra en liste over de
ti senest åbnede datafiler

n Vælge fanen Analyze i Startup Wizard (Guiden Opstart), og vælg enten Recent Files (Seneste filer)
eller klik på Browse (Gennemse) for at finde datafilen

Vinduet Data Analysis (Dataanalyse)
Vinduet Data Analysis (Dataanalyse) indeholder flere faner, som hver viser de analyserede data for en
specifik analysemetode eller kørselsspecifikke oplysninger. Fanerne vises kun, hvis de data, som blev
indsamlet i kørslen, er tilgængelige for den pågældende type analyse.

Tip: For at vælge de faner, som skal vises, skal de vælges i rullemenuen View (Vis) i vinduet Data
Analysis (Dataanalyse). For at vende tilbage til det oprindelige fanelayout skal du vælge Settings
(Indstillinger) > Restore Default Window Layout (Gendan standard-vindueslayout).
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Værktøjslinjen Data Analysis (Dataanalyse)
Værktøjslinjen i vinduet Data Analysis (Dataanalyse) giver hurtig adgang til vigtige dataanalysefunktioner.

Tabel 11 viser funktionerne af knapperne på værktøjslinjen.

Knap Navn Funktion

Plate Setup
(Pladeopsætning)

View/Edit Plate (Vis/rediger plade) - Åbner
Plate Editor (Pladeeditor) til visning og
redigering af indholdet af brønde.

Replace Plate File (Udskift pladefil) - Vælger
en pladefil, som skal erstatte pladelayoutet.

Apply PrimePCR file (Anvend PrimePCR-fil) -
vælger en kørselsfil, der skal erstatte
pladelayoutet for en PrimePCR-kørsel.

ManageWell Groups
(Administrer
brøndgrupper)

Åbner vinduet Well Groups Manager
(Brøndgruppeadministrator) med henblik på
oprettelse, redigering og sletning af
brøndgrupper.

Well Group
(Brøndgruppe)

Vælg navnet på en eksisterende
brøndgruppe på rullelisten. Standardvalget er
All Wells (Alle brønde). Denne knap vises
kun, hvis der er oprettet brøndgrupper.

Analysetilstand Analyserer dataene i enten fluorofor-tilstand
eller målsekvenstilstand (target).

Help (Hjælp) Åbner softwarehjælpen, hvorfra du kan få
onlinehjælp og finde en digital kopi af denne
vejledning i Acrobat PDF-format.

Tabel 11. Værktøjslinjen i vinduet Data Analysis (Dataanalyse)
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Menulinjen Data Analysis (Dataanalyse)
Tabel 12 viser menulinjepunkter i vinduet Data Analysis (Dataanalyse).

Menupunkt Kommando Funktion

File (Fil) Save (Gem) Gemmer filen.

Save As (Gem som) Gemmer filen under et nyt navn.

Filadgangskoder Giver brugere mulighed for at indstille
adgangskoder til at åbne og gemme filer.

Underskriv Giver brugere mulighed for at underskrive
datafilen.

Gentag kørsel Ekstraherer protokollen og pladefilen fra den
aktuelle kørsel med henblik på genkørsel.

Close (Luk) Lukker vinduet Data Analysis (Dataanalyse).

View (Vis) Run Log (Kørselslog) Åbner vinduet Run Log (Kørselslog) for at vise
kørselsloggen for den aktuelle datafil.

Revisionsspor Åbner filens revisionsspor.

Quantification (Kvantifikation), Melt
Curve (Smeltekurve), Gene
Expression (Genekspression), End
Point (Endepunkt), Custom Data
View (Tilpasset datavisning), QC
(Kvalitetskontrol), Run Information
(Kørselsoplysninger)

Viser de analyserede data på de valgte faner i
vinduet Data Analysis (Dataanalyse). Mindst
én fane skal vælges.

Tabel 12. Punkter på menulinjen i vinduet Data Analysis (Dataanalyse)
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Menupunkt Kommando Funktion

Indstillinger Cq Determination Mode (Cq-
bestemmelsestilstand)

Giver dig mulighed for at vælge enten
tilstanden Regression eller Single Threshold
(Enkelt tærskel) for at bestemme, hvordan Cq-
værdier beregnes for hver kurvelinje.

Baseline Setting
(Baselineindstilling)

Giver dig mulighed for at vælge baseline-
subtraktionsmetoden for de valgte
brøndgrupper.

Analysetilstand Giver dig mulighed for at analysere data efter
Fluorophore (Fluorofor) eller efter Target
(Målsekvens).

Cycles to Analyze (Cyklusser, der
skal analyseres)

Giver dig mulighed for at vælge de cyklusser,
der skal analyseres.

Baseline Threshold
(Baselinetærskel)

Åbner vinduet Baseline Threshold
(Baselinetærskel) for at justere baseline eller
tærskel.

Trace Styles (Kurvelinjelayout) Åbner vinduet Trace Styles (Kurvelinjelayout).

Plate Setup (Pladeopsætning) Åbner Plate Editor (Pladeeditor) for at vise og
redigere pladen eller udskifte den aktuelle
plade med en fra en brugerdefineret pladefil
eller en PrimePCR-kørselsfil.

Include All Excluded Wells
(Medtag alle udeladte brønde)

Medtager alle udeladte brønde i analysen.

Mouse Highlighting
(Musefremhævning)

Aktiverer eller deaktiverer den samtidige
fremhævning af data med musemarkøren.

Tip: Hvis Mouse Highlighting
(Musefremhævning) er slået fra, kan du
trykke på tasten Control for at slå
fremhævning midlertidigt til.

Restore Default Window Layout
(Gendan standard-vindueslayout)

Gendanner opstillingen af vinduer til
standardindstillingen.

Tabel 12. Punkter på menulinjen i vinduet Data Analysis (Dataanalyse), fortsat
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Menupunkt Kommando Funktion

Export
(Eksportér)

Export All Data Sheets (Eksporter
alle dataark)

Giver dig mulighed for at vælge, om alle
regneark-visningerne skal eksporteres fra
hver fane til en .csv-, .txt-fil. Excel- eller .xml-
fil.

Export RDML File (Eksportér
RDML-fil)

Giver dig mulighed for at vælge enten version
1.1 eller 1.0 af RDML, hvortil filen skal
eksporteres.

Custom Export (Tilpasset eksport) Åbner vinduet Custom Export (Tilpasset
eksport), hvor du kan angive de felter, der skal
eksporteres, samt filformatet.

Export to LIMS Folder (Eksportér til
LIMS-mappe)

Åbner et vindue til lagring af data i et
forudangivet format i LIMS-mappen.

Manual Export (Manuel eksport) Åbner et vindue til identifikation af placeringen
til lagring af data fra alle regnearksvisninger til
Excel-filer, struktureret specifikt til brug af
Seegene, Inc. og Bio-Rad Laboratories.

Tip: Du kan også automatisk starte
Seegene Viewer ved eksport. Se
Kommandoer i menuen Tools (Værktøjer)
på side 65 for yderligere oplysninger.

Tools (Værktøjer) Reports (Rapporter) Åbner vinduet Report (Rapport) for denne
datafil.

Well Group Reports (Rapporter for
brøndgruppe)

Åbner vinduet Well Group Report (Rapport for
brøndgruppe) til oprettelse af rapporter for
angivne brøndgrupper.

Import Fluorophore Calibration
(Importér fluoroforkalibrering)

Vælg en kalibreringsfil, der skal anvendes på
den aktuelle datafil.

qbase+ Starter qbase+ version 2.5 direkte fra den
aktuelle .pcrd-fil, hvis installeret.

Generer LIMS PLRN-fil Gemmer datafilen som en LIMS-formateret
.plrn-fil.

Tabel 12. Punkter på menulinjen i vinduet Data Analysis (Dataanalyse), fortsat
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Fanen Details (Detaljerede oplysninger)
Hver fane i vinduet Data Analysis (Dataanalyse) viser data i diagrammer og regneark for en specifik
analysemetode og indeholder en brøndvælger, der bruges til at vælge de data, der skal vises. Når Data
Analysis (Dataanalyse) åbnes, vises fanen Quantification (Kvantifikation) som standard. Du kan bruge
amplifikationsdiagramdataene på fanen Quantification (Kvantifikation) til at bestemme de optimale
analyseindstillinger for kørslen.

Bemærk: Softwaren linker dataene i ruderne i hver af fanerne i Data Analysis (Dataanalyse). For
eksempel vil fremhævning af en brønd ved at placere musemarkøren over brønden i
brøndvælgervisningen fremhæve dataene i alle de andre ruder.

Vælgeren Step Number (Trinnummer)
CFX Opus Dx-systemerne kan indsamle fluorescensdata á flere protokoltrin. Softwaren beholder de data,
der er indsamlet på hvert trin, uafhængigt. CFX Maestro Dx SE viser trinnummeret under
standardkurvediagrammet på fanen Quantification (Kvantifikation). Hvis en protokol indeholder mindst ét
dataindsamlingstrin, viser CFX Maestro Dx SE-data fra det første indsamlingstrin.

Hvis protokollen indeholder flere end ét indsamlingstrin, kan du vælge et andet trin fra rullelisten. For
eksempel:

Hvis du vælger et trin, anvender softwaren valget på alle data, som vises i vinduet Data Analysis
(Dataanalyse).
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Visning af Well Groups (Brøndgrupper) i Data Analysis
(Dataanalyse)
Brøndene på en plade kan grupperes i undersæt med henblik på individuel analyse ved hjælp af
brøndgrupper. Når der oprettes brøndgrupper, vises navnene på disse i rullelisten Well Groups
(Brøndgrupper) på værktøjslinjen i vinduet Data Analysis (Dataanalyse).

Hvis der er oprettet brøndgrupper, viser softwaren standardbrøndgruppen All Wells (Alle brønde), når
vinduet Data Analysis (Dataanalyse) åbnes, med data for samtlige brønde med indhold vist i diagrammer
og regneark. Det er kun de brønde i brøndgruppen, som har indhold, der vises i brøndvælgeren, og det er
kun data for disse brønde, der medtages i dataanalyseberegningerne.

Tip: For at oprette, redigere eller slette brøndgrupper skal du klikke på ManageWell Groups
(Administrer brøndgrupper) på værktøjslinjen.

Bemærk: Hvis der ikke er oprettet nogen brøndgrupper, vises rullelisten Well Groups
(Brøndgrupper) ikke på værktøjslinjen.

Ændring af brøndindhold efter en kørsel
Under dataanalyse vil en ændring af den måde, som data vises på via ændring af indholdet af brønde i
Plate Editor (Pladeeditor), aldrig ændre de fluorescensdata, som blev indsamlet fra hver brønd i løbet af
kørslen. Efter at modulet har indsamlet fluorescensdata, kan disse data ikke slettes, men du kan vælge at
fjerne dem fra visning og analyser.

Sådan ændres indholdet af brønde efter en kørsel

u Klik på Plate Setup (Pladeopsætning) i vinduet Data Analysis (Dataanalyse), og vælg én af følgende
valgmuligheder:

n Edit/View Plate (Rediger/vis plade) – åbner Plate Editor (Pladeeditor), hvor du kan foretage
manuelle ændringer i layoutet.

n Replace Plate File (Udskift pladefil) – åbner browseren Select Plate (Vælg plade), hvor du kan
navigere til en tidligere gemt pladefil, som det aktuelle pladelayout skal erstattes med.

n Apply PrimePCR file (Anvend PrimePCR-fil) – åbner dialogboksen Select PrimePCR file (Vælg
PrimePCR-fil), hvor du kan navigere til en PrimePCR-kørselsfil og anvende den på
pladelayoutet.

Tip: Du kan tilføje eller redigere oplysninger om brøndens indhold før en kørsel, under en kørsel eller
efter fuldførelse af en PCR-kørsel. Du skal tildele scanningstilstand og pladestørrelse før kørslen.
Disse parametre kan ikke ændres efter kørslen.
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Indstillinger for dataanalyse
Data i diagrammet Amplification (Amplifikation) på fanen Quantification (Kvantifikation) viser den relative
fluorescens (RFU) for hver af brøndene i hver cyklus. Hver kurvelinje på diagrammet repræsenterer data
fra en enkelt fluorofor i én brønd. Disse data bruges til at bestemme Cq-værdierne for hver enkelt brønd
på basis af hver enkelt fluorofor. Softwaren anvender én af to måder til at bestemme Cq-værdierne:

n Regression – anvender en nonlineær regressionsmodel med flere variabler på de individuelle
brøndkurvelinjer og bruger derefter denne model til at beregne en optimal Cq-værdi.

n Single Threshold (Enkelt tærskel) – anvender en enkelt tærskelværdi til at beregne Cq-værdien
baseret på det punkt, hvor tærsklerne for de individuelle fluorescenskurvelinjer krydser hinanden.

Vælg Settings > Cq Determination Mode (Indstillinger > Cq-bestemmelsestilstand) for at vælge Cq-
bestemmelsestilstand.

Justering af tærsklen
I tilstanden Single Threshold (Enkelt tærskel) kan du justere tærsklen for en fluorofor ved at klikke på
tærskellinjen i diagrammet Amplification (Amplifikation) og bevæge musemarkøren lodret. Alternativt kan
du specificere en præcis tærskel for den valgte fluorofor.

Baselineindstillinger
Softwaren indstiller automatisk baseline individuelt for hver brønd. Baselineindstillingen fastlægger
metoden til subtraktion af baseline for alle fluorescenskurvelinjer. Softwaren indeholder tre muligheder for
subtraktion af baseline:

n No Baseline Subtraction (Ingen subtraktion af baseline) – viser data som relative
fluorescenskurvelinjer. Visse analyser er ikke mulige i denne analysetilstand og softwaren viser
derfor ikke fanerne Gene Expression (Genekspression), End Point (Endepunkt) og Allelic
Discrimination (Alleldiskrimination).

n Baseline Subtracted (Baseline subtraheret) – viser data som kurvelinjer med subtraheret baseline
for hver fluorofor i en brønd. Softwaren skal subtrahere baseline fra dataene for at fastlægge
kvantifikationscyklusser, konstruere standardkurver og fastlægge koncentrationen af ukendte
prøver. For at generere en baseline-subtraheret kurvelinje indpasser softwaren den bedste lige linje
gennem den registrerede fluorescens for hver brønd under baseline-cyklusserne og subtraherer
derefter de bedst tilpassede data fra de baggrunds-subtraherede data i hver cyklus.

n Baseline Subtracted Curve Fit (Baseline-subtraheret kurvetilpasning) – viser data som baseline-
subtraherede kurvelinjer, og softwaren udjævner den baseline-subtraherede kurve ved brug af et
centreret middelværdifilter. Denne proces udføres således, at hver Cq forbliver invariant.
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Foruden disse muligheder kan du også vælge Apply Fluorescent Drift Correction (Anvend korrektion for
fluorescensafvigelse). For brønde, som har unormalt afvigende RFU-værdier under de første få cyklusser af
en kørsel, udleder softwaren en anslået baseline fra tilstødende brønde, der blev genereret en horisontal
baseline for uden fejl.

Sådan ændres indstillingen for baseline-subtraktion

u Vælg Settings (Indstillinger) > Baseline Setting (Baselineindstilling).

Analysetilstand
Data kan grupperes og analyseres enten efter fluorofor eller navn på målsekvens (target). Ved gruppering
efter fluorofor vises datakurvelinjerne efter fluorofor som angivet i pladeopsætningen for den pågældende
kørsel. Data for de individuelle fluoroforer vises i amplifikations- og standardkurvediagrammerne (hvis
tilgængelige), når afkrydsningsfelterne for de relevante fluoroforer er markeret.

Ved gruppering efter målsekvens (target) vises datakurvelinjerne efter navn på målsekvens som angivet i
pladeopsætningen for den pågældende kørsel.

Sådan vælges en dataanalysetilstand

u Gør et af følgende:

n Vælg Settings > Analysis Mode (Indstillinger > Analysetilstand).

n Vælg en tilstand i rullemenuen Analysis Mode (Analysetilstand) på værktøjslinjen.
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Cyklusser, der skal analyseres
Du kan begrænse antallet af cyklusser, som skal analyseres. Du kan desuden analysere data fra et
specifikt sæt cyklusser. Det maksimale antal cyklusser, som kan analyseres, er 50.

Bemærk: Hvis cyklusser fjernes fra begyndelsen af en kørsel, kan det have en væsentlig indflydelse
på beregning af baseline.

Sådan begrænses dataanalyse til et specifikt cyklusområde

1. Vælg Settings > Cycles to Analyze (Indstillinger > Cyklusser, der skal analyseres).

Dialogboksen Cycles to Analyze (Cyklusser, der skal analyseres) vises.

2. Indtast værdier for start- og slutcyklus, og klik på OK.

Klik på Restore Defaults (Gendan standarder) i dialogboksen Cycles to Analyze (Cyklusser, der skal
analyseres) for at vende tilbage til de cyklusser, som oprindelig blev anvendt til analyse.
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Brøndvælger
BrugWell Selector (Brøndvælger) til at vise eller skjule data i diagrammerne eller regnearkene overalt i
vinduet Data Analysis (Dataanalyse). Der kan kun vælges brønde med prøve i brøndvælgeren. Softwaren
farver brøndene i Well Selector (Brøndvælger):

n Blå – angiver valgte brønde. Dataene fra de valgte brønde vises i vinduet Data Analysis
(Dataanalyse).

n Lysegrå – angiver ikke-valgte brønde. Data fra ikke-valgte brønde vises i vinduet Data Analysis
(Dataanalyse).

n Mørkegrå – angiver tomme brønde.

Sådan vises eller skjules brønddata

u I brøndvælgeren skal du gøre et af følgende:

n For at skjule en enkelt brønd skal du klikke på den. For at vise den pågældende brønd skal du
klikke på den igen.

n For at skjule flere brønde skal du trække på tværs af de brønde, der skal skjules. For at vise
disse brønde skal du trække musen på tværs af brøndene igen.

n Klik i øverste venstre hjørne af pladen for at skjule alle brønde. Klik i øverste venstre hjørne igen
for at vise alle brøndene.

n Klik på begyndelsen af en kolonne eller række for at skjule disse brønde. Klik på kolonnen eller
rækken igen for at vise brøndene.
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Genvejsmenupunkter for brøndvælger
Tabel 13 indeholder en liste over de genvejsmenupunkter, der er tilgængelige i brøndvælgervisningen.

Element Funktion

Well XX (Brønd XX) Viser kun denne brønd, fjerner denne brønd fra visningen, indstiller
farve for denne brønd eller udelader denne brønd fra analyse.

Selected Wells (Valgte brønde)
(højreklik og træk)

Viser kun disse brønde, fjerner disse brønde fra visningen, indstiller
farve for disse brønde eller udelader disse brønde fra analyse.

Copy (Kopiér) Kopierer indholdet af brønden til udklipsholderen, herunder Sample
Type (Prøvetype) og valgfrit Replicate # (Replikatnummer).

Copy as Image (Kopiér som
billede)

Kopierer brøndvælgervisningen som et billede.

Print (Udskriv) Udskriver brøndvælgervisningen.

Print Selection (Udskriv valgte) Udskriver det aktuelt markerede.

Export to Excel (Eksportér til
Excel)

Eksporterer data til et Excel-regneark.

Export to CSV (Eksportér til
CSV)

Eksporterer data som et .csv-dokument.

Export to Xml (Eksportér til Xml) Eksporterer data som et .xml-dokument.

Well Labels (Brøndbetegnelser) Ændrer brøndbetegnelser til Sample Type (Prøvetype), Target Name
(Navn på målsekvens) eller Sample Name (Prøvenavn).

Tabel 13. Genvejsmenupunkter for brøndvælger

200 | CFX Maestro Dx SE-software



Brøndvælger

Midlertidig udeladelse af brønde fra analyse
Sådan udelades brønde midlertidigt fra dataanalyse

1. Højreklik på brønden i brøndvælgeren, på en fluorescenskurvelinje eller på et punkt, der er
registreret på standardkurven. For at udelade flere brønde skal du højreklikke og trække for at
fremhæve flere brønde, kurvelinjer eller punkter.

2. Vælg det relevante genvejsmenupunkt:

n Well > Exclude Well (Brønd > Udelad brønd)

n Selected Wells > Exclude from Analysis (Valgte brønde > Udelad fra analyse)

n Selected Traces > Exclude these wells from Analysis (Valgte kurvelinjer > Udelad disse brønde
fra analyse)

Alternativt kan du rydde indholdet fra brøndene i Plate Editor (Pladeeditor) ved at klikke på knappen
Clear Wells (Ryd brønde) for at fjerne brønde permanent fra analyse.

Vigtigt: Du skal indtaste alt brøndindhold igen, hvis det ryddes.

Sådan medtages en udeladt brønd

u Højreklik på den relevante brønd i brøndvælgeren, og vælg Well (Brønd) > Include Well in Analysis
(Medtag brønd i analyse).
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Diagrammer
Hvert diagram i vinduet Data Analysis (Dataanalyse) viser dataene i en forskellig graf og indeholder
valgmuligheder til justering og eksport af dataene og diagrammets grafik.

Diagramværktøjer
Tabel 14 indeholder en liste over de genvejsmenupunkter, der er tilgængelige i de fleste diagrammer.

Element Funktion

Copy (Kopiér) Kopierer diagrammet til udklipsholderen.

Save Image As... (Gem billede
som...)

Gemmer diagrammet som en billedfil. Indstil billedets opløsning og
dimensioner, og vælg derefter filtypen (PNG, GIF, JPG, TIF eller
BMP).

Page Setup...
(Sideopsætning...)

Vælger en sideopsætning til udskrift.

Print... (Udskriv...) Udskriver diagrammet.

Set Scale to Default (Indstil
skala til standard)

Viser alle data i søjlediagrammet. Der vises rullepaneler, hvis der er
flere datapunkter/prøver, end der kan vises i diagramrammen.

Diagramindstillinger Åbner dialogboksen Chart Settings (Diagramindstillinger), hvor du kan
ændre diagrammets visningsindstillinger, herunder:

n Chart and axis titles (Titler på diagram og akser)

n Chart and axis font and size (Skrifttype og -størrelse for diagram og
akser)

n Axis scale (Akseskala)

n Legend position (Tekstposition)

Tabel 14. Genvejsmenupunkter, der er fælles for de fleste diagrammer

Der vises diagramværktøjer i hvert diagram i vinduet Data Analysis (Dataanalyse). Alle diagrammer viser
disse værktøjer:

Copy to Clipboard (Kopiér til udklipsholder) – kopierer indholdet af diagramvisningen til udklipsholderen.

Chart Settings (Diagramindstillinger) — åbner dialogboksen Chart Settings (Diagramindstillinger), hvor
du kan ændre diagrammets visningsindstillinger.

Export (Eksportér) – åbner dialogboksen Export Options (Eksportindstillinger), hvor du kan redigere
opløsningen og størrelsen på grafen og gemme den på en angiven placering som en af følgende filtyper:
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n .bmp

n .jpg

n .png

Værktøjer i søjlediagrammet

Ud over diagramværktøjerne indeholder søjlediagrammet følgende værktøjer:

Sort (Sortér) – sorterer målsekvenser (targets) og prøver alfabetisk eller i omvendt alfabetisk rækkefølge.

Color Settings (Farveindstillinger) – åbner dialogboksen Color Settings (Farveindstillinger), hvor du kan
ændre farve på målsekvenser (targets) og prøver.

Du kan finde flere oplysninger om disse værktøjer i Ændring og anmærkning af diagramvisningen på side
262.

Værktøjer i amplifikationsdiagrammet

Ud over dem, der er nævnt ovenfor, indeholder amplifikationsdiagrammet følgende værktøjer:

Trace Styles (Kurvelinjelayout) – åbner dialogboksen Trace Styles (Kurvelinjelayout), hvor kurvelinjernes
udseende i amplifikationsdiagrammet kan ændres.

Baseline Threshold (Baselinetærskel) – åbner dialogboksen Baseline Threshold (Baselinetærskel),
hvor du kan ændre standardbaseline for valgte brønde eller ændre tærsklen for hver fluorescenskurve i
amplifikationsdiagrammet.

Kopiering af diagramdata til udklipsholderen

Du kan kopiere indholdet af diagramvisningen og indsætte det i et hvilket som helst program, der kan
bruge bitmap-billedfiler.

Sådan kopieres diagramdata til udklipsholderen

1. Vælg ikonet Copy to Clipboard (Kopiér til udklipsholder) fra diagramværktøjerne.

2. Åbn et program, der kan bruge bitmap-billeder, f.eks. Microsoft Word.

3. Højreklik og vælg Paste (Sæt ind) for at indsætte bitmap-billedet fra udklipsholderen i applikationen.

Ændring af indstillingerne for diagramvisning

Brug dialogboksen Chart Settings (Diagramindstillinger) til at ændre titler, skrifttyper og -størrelser,
akseskalering og placering af beskrivelsen for det viste diagram. Eventuelle ændringer anvendes kun på
det viste diagram, og gemmes sammen med diagrammet.
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Sådan ændres indstillingerne for diagramvisning

1. Klik på Chart Settings (Diagramindstillinger) i diagramværktøjerne.

Dialogboksen Chart Settings (Diagramindstillinger) åbnes.

2. Vælg fanen Chart And Axes (Diagram og akser) for at:

n Indtaste en titel for diagrammet.

n Indtaste en ny titel for x-aksen og ændre vinklen på betegnelserne.

n Indtaste en ny titel for y-aksen.

3. Vælge fanen Fonts (Skrifttyper) for at ændre diagrammets skrifttype og skrifttypestørrelse.

Tip: Som standard skaleres skrifttypestørrelsen automatisk, når diagrammets størrelse ændres.
Vælg Change Font Size (Ændr skrifttypestørrelse) for at indstille en statisk skrifttypestørrelse for
hver betegnelsestype.

4. Vælg fanen Axes Scale (Akseskalering) for at:

n Rydde automatisk skalering for x- og y-aksen og specificere minimums- og
maksimumsværdierne for skalering.

n Vælge at vise gitterlinjer eller inddelinger på grafen.

5. Vælg fanen Legend (Beskrivelse) for at:

n Vælge at skjule diagrambeskrivelsen.

n Ændre standardposition for diagrambeskrivelsen.
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Bemærk: Når beskrivelsen er placeret til venstre eller højre for diagrammet, viser den kun de
første ti fluoroforer i diagrammet.

6. Klik på Apply (Anvend) når som helst for at vise ændringerne i diagramindstillingerne uden at gemme
ændringerne.

7. Klik på OK for at gemmeændringerne og vende tilbage til diagrammet.

Eksport af diagrammet

Brug denne dialogboks til at ændre grafens bredde, højde og opløsning for at eksportere den i et af
følgende filformater:

n .bmp

n .jpg

n .png

Den eksporterede graf kan derefter anvendes til at vise resultater i postersessioner, Microsoft
PowerPoint-præsentationer og fagskrifter.

Bemærk: Overvej følgende, når indstillingerne ændres:

n Grænser for største og mindste bredde og højde

o Ved 72 dpi: 0,1-83 tommer

o Ved 96 dpi: 0,1-62 tommer

o Ved 150 dpi: 0,1-40 tommer

o Ved 300 dpi: 0,1-20 tommer

o Ved 600 dpi: 0,1-10 tommer

o Ved alle opløsninger: 2–6.000 pixels

n Formatforhold er baseret på bredde.

Sådan eksporteres diagrammet

1. Klik på Export (Eksportér) fra diagramværktøjerne.

Dialogboksen Export Preview (Vis eksport) vises.
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2. Modificer visningsindstillingerne efter behov.

3. Klik på Export (Eksportér).

4. Gør følgende i dialogboksen Export (Eksportér):

a. (Valgfrit) Naviger til en mappe, hvor diagramfilen skal gemmes.

b. Skriv et navn til filen, og vælg en filtype på rullelisten.

5. Klik på Save (Gem) for at gemme diagramfilen.

Ændring af indstillingerne for Baseline Threshold (Baselinetærskel)

I tilstanden Single Threshold (Enkelt tærskel) kan du justere tærsklen for en fluorofor ved at klikke på
tærskellinjen i diagrammet Amplification (Amplifikation) og bevæge musemarkøren lodret. Alternativt kan
du specificere en præcis tærskel for den valgte fluorofor.

Tip: Du kan angive et cyklusområde for at fastlægge baseline for alle datafiler på fanen Data
Analysis (Dataanalyse) i User > User Preferences (Bruger > Brugerpræferencer).

Sådan justeres start og slut for en baselinecyklus for hver brønd

1. Vælg en enkelt fluorofor på fanen Quantification (Kvantifikation) under amplifikationsdiagrammet.

2. Vælg Baseline Threshold (Baselinetærskel) fra diagramværktøjerne.

Dialogboksen Baseline Threshold (Baselinetærskel) vises.
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3. Gør et af følgende i afsnittet Baseline Cycles (Baselinecyklusser):

n For at vælge en brønd skal du klikke på dens rækkenummer.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på rækkenummeret for den
første brønd og trække ned over kolonnen til den sidste brønd.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på rækkenummeret for de enkelte brønde, der skal medtages.

n For at vælge alle brønde skal du klikke i øverste venstre hjørne af tabellen.

4. Juster cyklus for Baseline Begin (Baseline start) og Baseline End (Baseline slut) for alle valgte
brønde, eller rediger cyklustallet under Begin (Start) og End (Slut) nederst på regnearket.

Tip: For at vende tilbage til de sidst gemte værdier skal du klikke på Reset All User Defined
Values (Nulstil alle brugerdefinerede værdier).

5. Klik på OK for at gemmeændringerne og vende tilbage til diagrammet.

Sådan specificeres et cyklusområde for alle datafiler

u Vælg User > User Preferences (Bruger > Brugerpræferencer) i startvinduet eller vinduet Plate Editor
(Pladeeditor), og vælg fanen Data Analysis (Dataanalyse).

Sortering af data for målsekvens (target), prøve og biologisk gruppe

Bemærk: Denne valgmulighed er kun tilgængelig på diagrammer for genekspression.

Som standard vises listerne Targets (Målsekvenser), Samples (Prøver) og Biological Groups (Biologiske
grupper) i alfabetisk rækkefølge. Brug dialogboksen Sort (Sortér) til at sortere visningen i omvendt
alfabetisk rækkefølge eller til manuelt at flytte en term til en anden placering på listen.

Sådan sorteres data for målsekvens (target), prøve og biologisk gruppe

1. Klik på Sort (Sortér) fra diagramværktøjerne.

Dialogboksen Gene Expression Chart Sorting (Sortering af diagrammet Genekspression) åbnes.
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2. Klik på Z-A i dialogboksen for at sortere listen i omvendt alfabetisk rækkefølge.

3. For at flytte en term manuelt skal du vælge den og klikke på den relevante knap mellem
diagrammerne:

n Klik på pil op eller pil ned for at flytte den valgte term én position.

n Klik på pil op med slutstreg eller pil ned med slutstreg for at flytte den valgte term til toppen eller
bunden af listen.

4. Klik på OK for at gemmeændringerne og gå tilbage til fanen Gene Expression (Genekspression).
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Ændring af indstillingerne for farver på målsekvenser (targets) og prøver

Bemærk: Denne valgmulighed er kun tilgængelig på diagrammer for genekspression.

Brug dialogboksen Color Settings (Farveindstillinger) til at ændre farven på en målsekvens (target) eller
en prøve eller til at fjerne elementet fra grafen.

Sådan ændres farveindstillingerne

1. Vælg Color Settings (Farveindstillinger) i diagramværktøjerne.

Dialogboksen Color Settings (Farveindstillinger) åbnes.

2. For at ændre visningsfarven for en målsekvens (target) eller en prøve skal du klikke på farven i
kolonnen Color (Farve).

3. Vælg en ny farve i dialogboksen Color (Farve), der vises, og klik på OK.

4. For at fjerne elementet fra genekspressionsgrafen skal du fjerne markeringen i det relevante
afkrydsningsfelt i kolonnen Show Chart (Vis diagram).

Tip: For at rydde alle elementer fra genekspressionsgrafen skal du fjerne markeringen i
afkrydsningsfeltet Show Chart (Vis diagram) i kolonneoverskriften.

5. (Valgfrit) Som standard vises søjlediagrammets farve i gradientformat. For at vise farven som
dækkende skal du markere Use Solid Colors (Brug dækkende farver).

6. Klik på OK for at gemmeændringerne og gå tilbage til fanen Gene Expression (Genekspression).
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Forstørrelse af et område i diagrammet
Sådan forstørres et område i diagrammet

u Klik og træk på tværs af diagrammet, og klik derefter på Zoom. Softwaren tilpasser størrelsen på
diagrammet og centrerer det på det valgte område.

Bemærk: Det er ikke nødvendigt at klikke på pop op-kommandoen Zoom i søjlediagrammer.

Sådan nulstilles diagrammet til fuld visning

u Højreklik i diagrammet, og vælg Set Scale to Default (Indstil skala til standard).

Kopiering af diagrammer til en Microsoft-fil
Du kan kopiere datadiagrammer til Microsoft Word, Excel eller PowerPoint. Billedets opløsning svarer til
den, der gælder for den skærm, som billedet blev hentet fra.

Sådan kopieres diagrammer til en Microsoft-fil

1. Klik på Copy To Clipboard (Kopiér til udklipsholder) i øverste højre hjørne af diagramruden i vinduet
Data Analysis (Dataanalyse).

2. Åbn en tomMicrosoft-fil, og indsæt indholdet fra udklipsholderen.

Fælles genvejsmenupunkter for diagrammer
Tabel 15 indeholder en liste over de genvejsmenupunkter, der er tilgængelige for diagrammer. Visse af
menupunkterne findes for alle diagrammer, herunder menupunkter til at ændre, hvordan data vises, eller
til nemt at eksportere data fra et diagram.

Element Funktion

Copy (Kopiér) Kopierer diagrammet til udklipsholderen.

Save Image As (Gem
billede som)

Gemmer billedet i den specificerede størrelse, opløsning og filtype, herunder
formaterne PNG (standard), JPG og BMP.

Page Setup
(Sideopsætning)

Viser indstillingerne for udskrivningsopsætning.

Print (Udskriv) Udskriver diagrammet.

Tabel 15. Genvejsmenupunkter for diagrammer
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Element Funktion

Set Scale to Default
(Indstil skala til standard)

Stiller diagrammet tilbage til dets standardvisning efter at have forstørret det.

Chart Options
(Valgmuligheder for
diagrammer)

Åbner vinduet Chart Options (Valgmuligheder for diagrammer), hvor det er
muligt at ændre diagrammet, herunder dets titel, vælge grænser for x- og
y-akserne og vise gitterlinjer og underinddelinger på akserne.

Bemærk: Menupunkter, som kun gælder for specifikke diagrammer, er beskrevet i Kapitel 11,
Detaljerede oplysninger om dataanalyse.
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Regneark
De regneark, der vises i Data Analysis (Dataanalyse), indeholder indstillinger til sortering og overførsel af
data. Sortér kolonnerne ved at bruge en af disse metoder:

n Klik på og træk en kolonne til en ny placering i den valgte tabel.

n Klik på kolonneoverskriften for at sortere dataene i stigende eller faldende rækkefølge.

Sådan sorteres op til tre kolonner med data i vinduet Sort (Sortér)

1. Højreklik i regnearket, og vælg Sort (Sortér).

2. Vælg den første kolonnetitel, der skal sorteres, i dialogboksen Sort (Sortér). Sortér dataene i
stigende eller faldende rækkefølge.

3. Vælg en anden eller tredje kolonne, der skal sorteres, og vælg Ascending (Stigende) eller
Descending (Faldende).

4. Klik på OK for at sortere dataene, eller klik på Cancel (Annuller) for at stoppe sorteringen.

Tip: Fremhæv dataene i de tilknyttede diagrammer og brøndvælgeren ved at holde musemarkøren
hen over en celle. Klik i en celle for at kopiere og indsætte indholdet i et andet softwareprogram.

Fælles genvejsmenupunkter for regneark
Tabel 16 indeholder en liste over genvejsmenupunkterne i alle regnearksvisninger.

Element Funktion

Copy (Kopiér) Kopierer indholdet af de valgte brønde til en udklipsholder. Herfra
kan indholdet indsættes i et regneark som for eksempel Excel.

Copy as Image (Kopiér som
billede)

Kopierer regnearksvisningen som en billedfil, som derefter kan
indsættes i en fil, der kan bruge billedfiler, som for eksempel tekst-,
billed- eller regnearksfiler.

Print (Udskriv) Udskriver den aktuelle visning.

Print Selection (Udskriv valgte) Udskriver det aktuelt markerede.

Export to Excel (Eksportér til
Excel)

Eksporterer data til et Excel-regneark.

Tabel 16. Genvejsmenupunkter for regneark
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Element Funktion

Export to Text (Eksportér til
tekst)

Eksporterer data til en teksteditor.

Export to CSV (Eksportér til
CSV)

Eksporterer data til en .csv-fil.

Export to Xml (Eksportér til Xml) Eksporterer data til en Xml-fil.

Export to Html (Eksportér til
Html)

Eksporterer data til en Html-fil.

Find Søger efter tekst.

Sort (Sortér) Sorterer data i op til tre kolonner.

Select Columns (Vælg kolonner) Vælger de kolonner, der vil blive vist i regnearket.

Tabel 16. Genvejsmenupunkter for regneark, fortsat
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Export (Eksportér)
CFX Maestro Dx SE har flere valgmuligheder for eksport i rullemenuen Export (Eksporter):

n Export All Data Sheets (Eksporter alle dataark)

n Eksporter RDML-filer

n Custom Export (Tilpasset eksport)

n Export to LIMS Folder (Eksportér til LIMS-mappe)

n Manual Export (Manuel eksport)

Eksport af alle dataark
Du kan eksportere alle regnearksvisninger fra samtlige faner på CFX Maestro Dx SE til individuelle filer.

Sådan eksporteres alle dataark

u Vælg Export > Export All Data Sheets (Eksporter > Eksportér alle dataark), og vælg derefter den
ønskede filtype:

n CSV (*.csv)

n Tekst (*.txt)

n Excel-projektmappe (* .xlsx)

Eksporterede analyser gemmes i flere Excel-projektmappefiler med en regnearkfane for
analysedata pr. fil. Hvis en analyse indeholder flere fluoroforer, eksporteres dataene fra hver
fluorofor til en separat regnearksfane.

n Excel-projektmappe - kombineret (* .xlsx)

Eksporterede analyser gemmes i en enkelt Excel-projektmappefil, der indeholder flere
regnearksfaner - en for hvert analysedatasæt.

n Excel 97 - 2003 (* .xls)

Vigtigt: Din computer skal have Microsoft Excel installeret, for at du kan eksportere data til
et Microsoft Excel-regneark.

n Xml (*.xml)
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Eksport af RDML-filer
RDML er en struktureret og universel datastandard til udveksling af kvantitative PCR-data (qPCR-data).
Datastandarden er en tekstfil i .xml-formatet (Extensible Markup Language). Der findes yderligere
oplysninger om RDML-data på International RDML Consortiums websted (www.rdml.org).

Vigtigt: Eksporterede RDML-filer indeholder analysedata med de baselineindstillinger, som du
anvender i vinduet Data Analysis (Dataanalyse). Du kan finde flere oplysninger om
baselineindstllinger under Baselineindstillinger på side 196.

Bemærk: Gem RDML-filen som version 1.1, hvis den anvendte version af qbase+ softwaren er
version 2.3 eller senere.

Sådan eksporteres en RDML-fil

1. Vælg Export > Export RDML Files (Eksportér > Eksportér RDML-filer), og vælg RDML v1.1 eller
RDML v1.0 på den liste, der vises.

Dialogboksen Save As (Gem som) vises.

2. Angiv et filnavn og en placering, hvor RDML-filen skal gemmes, i dialogboksen Save As (Gem som).

3. Klik på OK for at gemme den eksporterede fil.
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Oprettelse af en tilpasset eksportfil
Sådan oprettes en tilpasset eksportfil

1. Vælg Export > Custom Export (Eksport > Tilpasset eksport). Dialogboksen Custom Export (Tilpasset
eksport) vises.

2. Vælg eksportformatet på den rulleliste, der vises.

3. Vælg afkrydsningsfelterne for de elementer, som skal eksporteres.

4. (Valgfrit) Klik på Customize Column Names (Tilpas kolonnenavne) for at ændre kolonnenavne.

5. Klik på Export (Eksportér). Dialogboksen Save As (Gem som) vises.

6. Angiv et filnavn og en placering, hvor den eksporterede fil skal gemmes, i dialogboksen Save As
(Gem som).
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7. Klik på OK for at gemme den eksporterede fil.
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Eksport til en LIMS-mappe
Du kan eksportere data til et LIMS-kompatibelt filformat. Se Tillæg C, LIMS-integration for yderligere
oplysninger om oprettelse, administration og anvendelse af LIMS-filer.

Sådan eksporteres data i LIMS-format

1. Vælg Export > Export to LIMS Folder (Eksportér > Eksportér til LIMS-mappe).

Dialogboksen Save As (Gem som) vises.

2. Angiv et filnavn og en placering, hvor den eksporterede fil skal gemmes, i dialogboksen Save As
(Gem som).

3. Klik på OK for at gemme den eksporterede fil.

Eksport af Seegene-formaterede data
Du kan eksportere data alle regnearksvisninger til Excel-filer, struktureret specifikt til brug af Seegene,
Inc.

Tip: Du kan også automatisk starte Seegene Viewer, når eksporten er afsluttet. Se Kommandoer i
menuen Tools (Værktøjer) på side 65 for yderligere oplysninger.

Sådan eksporteres data i et Seegene-specifikt format

1. Vælg Export (Eksportér) > Manual Export (Manuel eksport).

Dialogboksen Browse For Folder (Gennemse for mappe) vises.

2. I dialogboksen Browse For Folder (Gennemse for mappe) angives en mappeplacering, hvor de
eksporterede Seegene-formaterede Excel (.xlsx)-filer skal gemmes.

Analyser eksporteres i flere Excel-projektmappefiler med en regnearkfane for analysedata pr. fil.

3. Klik på OK for at gemme de eksporterede filer.
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Vinduet Data Analysis (Dataanalyse) i CFX Maestro Dx Software, Security Editionn indeholder flere faner
til visning af data. Dette kapitel beskriver disse faner i detaljer.

Tip: Du kan vælge, hvilke faner der skal vises i vinduet Data Analysis (Dataanalyse), i menuen View
(Vis). Det tilpassede layout gemmes med datafilen.
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Fanen Quantification (Kvantifikation)
Brug dataene på fanen Quantification (Kvantifikation) til at indstille betingelserne for dataanalysen,
herunder baselineindstillinger for individuelle brønde og tærskelindstillinger. Fanen Quantification
(Kvantifikation) viser data i fire visninger:

n Diagrammet Amplification (Amplifikation) – viser relative fluorescensenheder (RFU'er) for hver brønd
ved hver cyklus. Hver kurvelinje på diagrammet repræsenterer data fra en enkelt fluorofor i én brønd.

n Standard curve (Standardkurve) – vises kun, hvis kørslen omfatter brønde, der er angivet som
prøvetype standard (Std). Standardkurven viser tærskelcyklussen plottet mod log af startmængden.
Beskrivelsen viser reaktionseffektivitet (E) for hver fluorofor i brøndene med en standardprøvetype.

n Well selector (Brøndvælger) – vælger brøndene med de fluorescensdata, der skal vises.

n Regneark – viser et regneark med data, der er indsamlet i de valgte brønde.

Valgmuligheder for fluorofor
For at vise fluorofordata i diagrammer og regneark på fanen Quantification (Kvantifikation) skal du vælge
fluoroforen/fluoroforerne under diagrammet Amplification (Amplifikation). For at skjule fluorofordataene i
dataanalysevinduet skal du fjerne markeringen i det tilhørende afkrydsningsfelt.
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Dialogboksen Trace Styles (Kurvelinjelayout)
Du kan bruge dialogboksen Trace Styles (Kurvelinjelayout) til at tilpasse visningen af kurvelinjer i
amplifikations- og smeltekurvediagrammer på fanerne Quantification (Kvantifikation) og Melt Curve
(Smeltekurve). Du kan derefter gennemgå ændringerne i brøndvælgeren, som vises i dialogboksen Trace
Styles (Kurvelinjelayout).

Sådan justeres kurvelinjelayout

1. Vælg kun én fluorofor under diagrammet Amplification (Amplifikation).

2. For at åbne dialogboksen Trace Styles (Kurvelinjelayout) skal du gøre et af følgende:

n Klik på Trace Styles (Kurvelinjelayout) i diagrammet Amplification (Amplifikation).

n Vælg Settings > Trace Styles (Indstillinger > Kurvelinjelayout) på menulinjen Data Analysis
(Dataanalyse).

n Højreklik på en kurvelinje, og vælg Trace Styles (Kurvelinjelayout).

Dialogboksen Trace Styles (Kurvelinjelayout) åbnes.

3. I dialogboksen Trace Styles (Kurvelinjelayout) skal du vælge et specifikt sæt brønde i brøndvælgeren
i den nederste rude. Alternativt kan du vælge brønde, som indeholder én prøvetype, i rullemenuen i
kolonnenWells (Brønde).

4. Gør et af følgende:
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n For at vælge en farve til de valgte brønde skal du klikke på feltet i kolonnen Color (Farve).

n For at tildele et symbol til de valgte brønde skal du vælge et symbol på rullelisten Symbol.

n For at farve brøndene hurtigt efter knapbetegnelsen skal du klikke på den relevante
hurtigindstilling:

o Random byWell (Vilkårlig efter brønd)

o Random by Replicate (Vilkårlig efter replikat)

o Use Fluor Colors (Anvend fluorfarver)

o Use Target Colors (Anvend målsekvensfarver)

o Use Sample Colors (Anvend prøvefarver)

n For at tildele nye brøndbetegnelser skal du vælge enten Sample Type (Prøvetype), Target
Name (Navn på målsekvens), Sample Name (Prøvenavn) eller Symbol.

Funktionen Log Scale (Logaritmisk Skala)
Vælg Log Scale (Logaritmisk skala) under diagrammet Amplification (Amplifikation) for at vise
fluorescenskurvelinjerne på en semilogaritmisk skala:

Tip: For at forstørre et vilkårligt område i diagrammet skal du trække på tværs af det ønskede
område. For at vende tilbage til fuld visning skal du højreklikke på diagrammet og vælge Set Scale to
Default (Indstil skala til standard).
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Standardkurvediagram
Softwaren opretter et Standard Curve-diagram (Standardkurvediagram) på fanen Quantification
(Kvantifikation), hvis dataene omfatter prøvetyper defineret som Std (Standard) for mindst én fluorofor i
kørslen.

Diagrammet Standard Curve (Standardkurve) indeholder følgende oplysninger:

n Navnet på hver af kurverne (fluoroforen eller målsekvensen (target).

n Farven på hver fluorofor eller hver målsekvens (target).

n Reaktionseffektivitet (E). Disse statistiske oplysninger kan anvendes til at optimere en
multiplexreaktion og udligne data til standardkurven.

Bemærk: Reaktionseffektiviteten beskriver, hvor meget der bliver produceret af målsekvensen
(target) i hver af protokollens cyklusser. En effektivitet på 100 % angiver, at målsekvensen
(target) fordobles med hver cyklus.

n Bestemmelseskoefficient, R2 (anført som R^2). Disse statistiske oplysninger kan anvendes til at
bestemme, hvor korrekt linjen beskriver dataene (tilpasningsgrad).

n Slope (Hældning)

n y-skæringspunkt
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Menupunkter for Amplification Chart (Amplifikationsdiagram)
Ud over de fælles genvejsmenupunkter (se Fælles genvejsmenupunkter for diagrammer på side 210) er
der andre genvejsmenupunkter, der kun er tilgængelige i diagrammet Amplification (Amplifikation). De
vises i Tabel 17.

Menupunkt Funktion

Well XX (Brønd XX), Fluor
Target (fluormålsekvens)

Viser kun denne brønd, fjerner denne brønd fra visningen, indstiller farve
for denne kurvelinje eller udelader brønden fra analyse.

Selected Traces (Valgte
kurvelinjer)

Viser kun disse brønde, fjerner disse brønde fra visningen, indstiller farve
for disse kurvelinjer eller udelader disse brønde fra analyse.

Show Threshold Values
(Vis tærskelværdier)

Viser tærskelværdien for hver amplifikationskurve på diagrammet.

Trace Styles
(Kurvelinjelayout)

Åbner vinduet Trace Styles (Kurvelinjelayout), hvor kurvelinjelayoutet, der
vises på fanerne Quantification (Kvantifikation) og Melt Curve
(Smeltekurve), kan ændres.

Baseline Thresholds
(Baselinetærskler)

Åbner vinduet Baseline Thresholds (Baselinetærskler), hvor du kan
ændre baseline eller tærskler for hver fluorofor (ændringerne kan ses i
diagrammet Amplification (Amplifikation) på fanen Quantification
(Kvantifikation)).

Tabel 17. Menupunkter for Amplification (Amplifikation) ved højre- og venstreklik

Fanen Quantification (Kvantifikation) i regneark
Tabel 18 definerer de data, der vises i regnearket på fanen Quantification (Kvantifikation).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Target (Målsekvens) Navn på den målsekvens (target), der er indlæst i brøndene i Plate
Editor (Pladeeditor)

Content (Indhold) En kombination af Sample Type (Prøvetyp) (påkrævet) og Replicate #
(Replikatnummer) (valgfrit) indlæst i Plate Editor (Pladeeditor)

Tabel 18. Indholdet på fanen Quantification (Kvantifikation) i regnearket
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Oplysninger Beskrivelse

Sample (Prøve) Sample Name (Prøvenavn) indlæst i brøndene i Plate Editor
(Pladeeditor)

Cq Kvantifikationscyklus for hver kurvelinje

Ændring af data for målsekvens (target), indhold eller prøver

Du kan ændre dataene i kolonnerne Target (Målsekvens), Content (Indhold) og Sample (Prøve) ved at
redigere pladefilen med Plate Editor (Pladeeditor) – også selv om eksperimentet er blevet kørt.

Sådan ændres dataene i kolonnerne Target (Målsekvens), Content (Indhold) og Sample
(Prøve)

u Klik på Plate Setup (Pladeopsætning), og vælg View/Edit Plate (Vis/rediger plade) for at åbne Plate
Editor (Pladeeditor).
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Fanen Quantification Data (Kvantifikationsdata)
Fanen Quantification Data (Kvantificeringsdata) viser kvantificeringsdataene, der er indsamlet i hver
brønd. CFX Maestro Dx SE viser dataene i fire forskellige regnearkvisninger:

n Results (Resultater) – viser et regneark med dataene. Dette er standardvisningen.

n Standard Curve Results (Standardkurve-resultater) – viser et regneark med standardkurve-dataene.

n Plate (Plade) – viser dataene i hver brønd som et pladeformat.

n RFU – viser RFU-mængder i hver brønd for hver cyklus.

Vælg hvert regneark på rullelisten, som vises neden for fanen Quantification Data (Kvantifikationsdata).

Regnearket Results (Resultater)
Regnearket Results (Resultater) viser data for hver brønd i en plade.

Bemærk: Alle Std. Dev (standardafvigelse)-beregninger gælder for de replikatgrupper, der er tildelt i
brøndene i vinduet Plate Editor (Pladeeditor). Beregningerne udregner gennemsnittet af Cq-værdien
for hver brønd i replikatgruppen.

Tabel 19 definerer de data, der vises i regnearket Results (Resultater).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Tabel 19. Indhold i regnearket Results (Resultater)
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Oplysninger Beskrivelse

Target (Målsekvens) Navn på amplifikationsmålsekvensen (target) (gen)

Content (Indhold) Prøvetype og replikatnummer

Sample (Prøve) Beskrivelse af prøven

Biological Set Name (Navn på
biologisk sæt)

Navnet på det biologiske sæt

Cq Kvantifikationscyklus

CqMean (Cq-middelværdi) Middelværdien for kvantifikationscyklussen for replikatgruppen

Cq Std. Dev (Cq-
standardafvigelse)

Standardafvigelse for kvantifikationscyklussen for replikatgruppen

Starting Quantity (SQ)
(Startmængde (SQ))

Anslået startmængde for målsekvensen (target)

Log Starting Quantity (Log af
startmængde)

Log af startmængden

SQMean (SQ-middelværdi) Middelværdi for startmængden

SQ Std. Dev (Cq-
standardafvigelse)

Standardafvigelse for startmængden på tværs af replikater

Tabel 19. Indhold i regnearket Results (Resultater), fortsat
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Regnearket Standard Curve Results (Standardkurve-resultater)
Regnearket Standard Curve Results (Standardkurve-resultater) viser de beregnede standardkurve-
parametre.

Tabel 20 definer de data, der vises i regnearket Standard Curve Results (Standardkurve-resultater).

Oplysninger Beskrivelse

Fluor (eller Target (Målsekvens)) Detekteret fluorofor (eller målsekvens (target))

Efficiency % (Effektivitet %) Reaktionseffektivitet

Slope (Hældning) Standardkurvens hældning

Y-intercept (Y-skæringspunkt) Punkt, hvor kurven skærer y-aksen

R^2 Bestemmelseskoefficient

Tabel 20. Indhold i regnearket Standard Curve Results (Standardkurve-resultater)
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Regnearket Plate (Plade)
Regnearket Plate (Plade) viser et pladekort med data for én fluorofor ad gangen.

Sådan vises data for en specifik fluorofor

u Klik på dens fane nederst i regnearket.
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Regnearket RFU
Regnearket RFU viser aflæsningerne af relative fluorescensenheder (RFU) for hver brønd indhentet
under hver af kørslens cyklusser. Brøndens nummer vises øverst i hver kolonne, og cyklusnummeret
vises til venstre for hver række.
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Fanen Melt Curve (Smeltekurve)
I forbindelse med DNA-bindende farvestoffer og ikke-spaltbare hybridiseringsprober er fluorescensen
klarest, når de to DNA-strenge hybridiseres. Derfor vil fluorescensen, når temperaturen stiger mod
smeltetemperatur (Tm), falde ved en konstant hastighed (konstant hældning). Ved Tm sker der en
dramatisk reduktion i fluorescens med en mærkbar hældningsændring. Hastigheden af denne ændring
fastlægges ved at plotte negativ først-regression af fluorescens kontra temperatur (-d(RFU)/dT). Den
største ændringshastighed i fluorescens medfører synlige kurvetoppe og repræsenterer Tm for de
dobbeltstrengede DNA-komplekser.

CFX Maestro Dx SE indtegner de RFU-data, der indsamles under en smeltekurve, som en funktion af
temperaturen. Med henblik på analyse af smeltekurvetopdata tildeler softwaren en start- og
sluttemperatur til hver kurvetop ved at flytte tærskellinjen. Bunden af kurvetopområdet er specificeret af
smeltetærskellinjens placering. En valid kurvetop skal have en minimumhøjde i forhold til afstanden
mellem tærskellinjen og højden på den højeste kurvetop.

Fanen Melt Curve (Smeltekurve) viser Tm (smeltetemperaturen) for amplificerede PCR-produkter i fire
visninger:

n Melt Curve (Smeltekurve) – viser realtidsdata for hver fluorofor som RFU'er pr. temperatur for hver
brønd.

n Melt Peak (Smeltekurvetop) – viser den negative regression for RFU-data pr. temperatur for hver
brønd.

n Well selector (Brøndvælger) – viser brønde for at vise eller skjule dataene.

n Regneark med kurvetoppe – viser data indsamlet i den valgte brønd.

Bemærk: Dette regneark viser op til to kurvetoppe for hver kurvelinje. For at se flere kurvetoppe
skal du klikke på fanen Melt Curve Data (Smeltekurvedata).
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Tabel 21 definerer de data, der vises i regnearket Melt Curve (Smeltekurve).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Content (Indhold) En kombination af prøvetype og replikatnummer

Sample (Prøve) Navn på den prøve, der er indlæst i Plate Editor (Pladeeditor)

Melt Temp
(Smeltetemperatur)

Temperaturen på smeltekurvetoppen for hver brønd

Bemærk: Kun de to højeste kurvetoppe vises i regnearket.

Tabel 21. Indhold af regnearket Melt Curve (Smeltekurve)
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Justering af smeltekurvedata
Sådan justeres smeltekurvedata

u Gør et af følgende:

n Klik og træk i tærskelbjælken i diagrammet Melt Peak (Smeltekurvetop) for at medtage eller
udelade kurvetoppe i dataanalysen.

n Vælg Positive i rullemenuen Peaks (Kurvetoppe) for at vise regnearksdata for toppene over
smeltetærskellinjen, eller vælg Negative for at vise regnearksdata for kurvetoppene under
smeltetærskellinjen.

n Åbn vinduet Trace Styles (Kurvelinjelayout) for at ændre farven på kurvelinjerne i diagrammerne
Melt Curve (Smeltekurve) og Melt Peak (Smeltekurvetop).

n Vælg et nummer i vælgeren Step Number (Trinnummer) for at vise data for Melt Curve
(Smeltekurve) i et andet trin i protokollen. Listen viser mere end ét trin, hvis pladen indeholder
pladeaflæsninger i mere end ét smeltekurvetrin.

n Vælg brønde i brøndvælgeren for at fokusere på undersæt af dataene.

n Vælg en brøndgruppe for at vise og analysere et undersæt af brønde på pladen. Vælg hver
enkelt brøndgruppe efter navn i rullemenuenWell Group (Brøndgruppe) på værktøjslinjen.
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Fanen Melt Curve Data (Smeltekurvedata)
Fanen Melt Curve Data (Smeltekurvedata) viser data fra fanen Melt Curve (Smeltekurve) i flere regneark,
der omfatter alle smeltekurvetoppene for hver kurvelinje. CFX Maestro Dx SE har fire valgmuligheder for
regneark til visning af smeltekurvedata:

n Melt Peaks (Smeltekurvetoppe) – viser alle dataene, herunder alle smeltekurvetoppene, for hver
kurvelinje. Dette er standardvisningen.

n Plate (Plade) – viser en visning af dataene og indholdet af hver brønd i pladen.

n RFU – viser RFU-mængderne ved hver temperatur for hver brønd.

n -d(RFU)/dT – viser den negative ændringshastighed for RFU, efterhånden som temperaturen (T)
ændres. Dette er et første regressionsplot for hver brønd i pladen.

Vælg de enkelte regneark på rullelisten, der vises på fanen Melt Curve Data (Smeltekurvedata).

Regnearket Melt Peaks (Smeltekurvetoppe)
Regnearket Melt Peaks (Smeltekurvetoppe) viser alle smeltekurvedata.

Tabel 22 på side 235 definerer de data, der vises i regnearket Melt Peaks (Smeltekurvetoppe).
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Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Content (Indhold) Prøvetype angivet i vinduet Plate Editor (Pladeeditor)

Target (Målsekvens) Amplifikationsmålsekvens (target) (gen)

Sample (Prøve) Prøvenavn angivet i vinduet Plate Editor (Pladeeditor)

Melt Temperature
(Smeltetemperatur)

Smeltetemperaturen for hvert produkt angivet som én kurvetop
(højeste) pr. række i regnearket

Peak Height (Kurvetophøjde) Kurvetoppens højde

Begin Temperature
(Begyndelsestemperatur)

Temperatur ved kurvetoppens begyndelse

End Temperature (Sluttemperatur) Temperatur ved kurvetoppens slutning

Tabel 22. Indhold i Regnearket Melt Peaks (Smeltekurvetoppe)

Regnearket Plate (Plade)
Regnearket Plate (Plade) viser smeltekurvedata i et pladeformat.

Bemærk: Den kurvetop, som softwaren bedømmer, kan justeres ved at justere tærskellinjen i
diagrammet Melt Peak (Smeltekurvetop) på fanen Melt Curve (Smeltekurve).

Tabel 23 på side 236 definerer de data, der vises i regnearket Plate (Plade).
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Oplysninger Beskrivelse

Indhold En kombination af Sample Type (Prøvetype) (påkrævet) og Replicate #
(Replikatnummer) (valgfrit)

Prøve Beskrivelse af prøven

Peak 1 (Kurvetop
1)

Første smeltekurvetop (højeste)

Peak 2 (Kurvetop
2)

Anden smeltetop (lavere)

Tabel 23. Indhold i regnearket Plate (Plade)

Regnearket RFU
Regnearket RFU viser fluorescens for hver brønd i hver cyklus indsamlet under smeltekurven.

Tabel 24 definerer de data, der vises i regnearket RFU.

Oplysninger Beskrivelse

Brøndnummer (A1, A2, A3, A4, A5) Brøndposition i pladen for de isatte brønde

Temperature (Temperatur) Den amplificerede målsekvens' (target)
smeltetemperatur, indtegnet som én brønd pr.
række og flere brønde for flere produkter i
samme brønd

Tabel 24. Indhold i regnearket RFU
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Regnearket -d(RFU)/dT
Regnearket -d(RFU)/dT viser den negative ændringshastighed for RFU, efterhånden som temperaturen
(T) ændres.

Tabel 25 definerer de data, der vises i regnearket -d(RFU)/dT.

Oplysninger Beskrivelse

Brøndnummer (A1, A2, A3, A4, A5) Brøndposition i pladen for de isatte brønde

Temperatur -d(RFU)/dT Negativ ændringshastighed i RFU, efterhånden som
temperaturen (T) ændres

Tabel 25. Indhold i regnearket -d(RFU)/dT i
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Fanen End Point (Endepunkt)
Åbn fanen End Point (Endepunkt) for at analysere endelige relative fluorescensenheder (RFU'er) for
prøvebrøndene. Softwaren sammenligner RFU-niveauer i brønde med ukendte prøver med RFU-
niveauer i brønde med negative kontroller og bedømmer de ukendte som positive eller negative. Positive
prøver har en RFU-værdi, der er større end den gennemsnitlige RFU-værdi i de negative kontroller plus
cut-off-værdien.

For at kunne analysere endepunktsdata skal pladen indeholde negative kontroller; ellers kan softwaren
ikke foretage en bedømmelse.

n Kør protokollen Quantification (Kvantifikation) – opsæt en standardprotokol. Når kørslen er færdig,
skal du åbne vinduet Data Analysis (Dataanalyse), justere indstillingerne for dataanalyse på fanen
Quantification (Kvantifikation) og derefter klikke på fanen End Point (Endepunkt) for at vælge en
endepunktscyklus.

n Kør protokollen End Point Only (Kun endepunkt) – indlæs protokollen End Point Only (Kun
endepunkt) på fanen Plate (Plade) i vinduet Run Setup (Kørselsopsætning), vælg og opret en plade,
og start kørslen

238 | CFX Maestro Dx SE-software



Fanen End Point (Endepunkt)

Fanen End Point (Endepunkt) viser de gennemsnitlige RFU-værdier for at bestemme, ommålsekvensen
(target) blev amplificeret af den sidste (ende-) cyklus. Brug dataene til at bestemme, om der er en specifik
målsekvens (target) tilstede (positiv) i en prøve. Positive målsekvenser (targets) har højere RFU-værdier
end det cut off-niveau, der blev defineret.

Tip: For at oprette en endepunktsprotokol skal du åbne fanen Protocol (Protokol) (vinduet Run Setup
(Kørselsopsætning)) og vælge Run > End Point Only Run (Kør > Kør kun endepunkt).

Når kørslen er færdig, åbnes datafilen på fanen End Point (Endepunkt), som har følgende afsnit:

n Settings (Indstillinger) - justerer indstillingerne for dataanalyse.

n Results (Resultater) - viser resultaterne straks efter indstillingerne er justeret.

n Well Selector (Brøndvælger) - vælger brøndene med de endepunktsdata, der skal vises.

n RFU-regneark - viser ende-RFU indsamlet i de valgte brønde.

Resultatdata
Afsnittet Results (Resultater) viser følgende data:

n Lowest RFU value (Laveste RFU-værdi) – laveste RFU-værdi i dataene

n Highest RFU value (Højeste RFU-værdi) – højeste RFU-værdi i dataene

n Negative Control Average (Gennemsnit for negative kontroller) – gennemsnitlig RFU for de brønde,
som indeholder negative kontroller

n Cut Off Value (Cut-off-værdi) – beregnes ved at tilføje tolerancen (RFU eller procentdel af område
angivet under Settings (Indstillinger)) og gennemsnit for de negative kontroller. Prøver med RFU'er,
der er større end cutoff-værdien, kaldes "Positive". Du kan justere afskæringsværdien ved at ændre
RFU eller Percentage of Range (Procentdel af område)

Cut Off Value (Cut-off-værdi) beregnes ved brug af følgende formel:

Cut-off-værdi = gennemsnit for negative kontroller + tolerance

Vælg en tolerance ved brug af en af disse metoder:

n RFUs (RFU'er) (standard) – vælg denne metode for at anvende en absolut RFU-værdi for
tolerancen. Minimumværdien for RFU-tolerance er 2. Maksimum er den absolutte værdi af den
højeste RFU-værdi minus den absolutte værdi af den laveste RFU-værdi. Standardværdien for RFU-
tolerance er 10 % af det samlede RFU-område.

n Percent of Range (Procentdel af område) – vælg denne metode for at bruge en procentdel af RFU-
området som tolerance. Minimumsprocentdelen af området er 1 %. Maksimumsprocentdelen af
området er 99 %. Standardprocentdelen af området er 10 %.
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Justering af endepunktsdataanalysen
Sådan justeres data på fanen End Point (Endepunkt)

u Gør et af følgende:

n Vælg en fluorofor fra rullelisten.

n Vælg en værdi for End Cycle to Average (Slutcyklus til gennemsnitsberegning) for at indstille
antallet af cyklusser, der skal bruges til at beregne det gennemsnitlige endepunkts-RFU.

n Vælg RFU'er for at vise data i relative fluorescensenheder.

n Vælg Percentage of Range (Procentdel af område) for at vise data som en procentdel af RFU-
område.

n Vælg brønde i brøndvælgeren for at fokusere på undersæt af dataene.

n Vælg en brøndgruppe for at vise og analysere et undersæt af brønde på pladen. Vælg hver
enkelt brøndgruppe efter navn i rullemenuenWell Group (Brøndgruppe) på værktøjslinjen.

RFU-regneark til analyse af endepunkter
Tabel 26 indeholder definitioner af de data, der vises i RFU-regnearket på fanen End Point (Endepunkt).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Content (Indhold) Kombination af prøvetype og replikatnummer

End RFU (Ende-RFU) RFU ved endepunktscyklus

Call (Bedømmelse) Positive (Positiv) eller Negative (Negativ), hvor positive prøver har en RFU-
værdi, der er større end den gennemsnitlige RFU-værdi for de negative
kontroller plus Cut Off Value (Cut-off-værdi)

Sample (Prøve) Sample Name (Prøvenavn) isat i Plate Editor (Pladeeditor)

Tabel 26. RFU-indhold af regneark for endepunkt
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Fanen Allelic Discrimination (Alleldiskrimination)
Fanen Allelic Discrimination (Alleldiskrimination) tildeler genotyper til brønde med ukendte prøver. Disse
data anvendes til at identificere prøver med forskellige genotyper, herunder Allele 1 (Allel 1), Allele 2
(Allel 2), Heterozygote (Heterozygot), No Call (Ingen bedømmelse) eller Undetermined (Ikke fastslået).

Bemærk: Dataene for alleldiskrimination skal komme fra multiplexkørsler med mindst to fluoroforer.
Hver fluorofor identificerer én allel i hver af prøverne.

Alleldiskriminationsanalysen kræver somminimum følgende indhold i brøndene:

n To fluoroforer i hver brønd

n NTC-prøver (ingen skabelonkontrol) til optimeret dataanalyse

CFX Maestro Dx SE indeholder fire valgmuligheder for visning af alleldiskriminationsdata:

n Alleldiskriminationsdiagram – viser data på en graf med RFU for allel 1/allel 2. Hvert af punkterne på
grafen repræsenterer data fra begge fluoroforer i én brønd. Du kan skifte mellem kartesiske og
polære koordinater ved at markere eller fjerne markeringen i afkrydsningsfeltet Polar Coordinates
(Polære koordinater). Cartesian Coordinates (Kartesiske koordinater) repræsenterer RFU for allel 1
på x-aksen og RFU for allel 2 på y-aksen. Polære koordinater repræsenterer vinklen på x-aksen og
afstanden mellem den oprindelige og RFU på y-aksen (median for alle NTC).

n Regneark med brønde - viser alleldiskriminationsdata indsamlet fra hver enkelt brønd på pladen.
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n Brøndvælger - vælger brøndene med de alleldata, der skal vises.

n Panelet Selected Fluorophores (Valgte fluoroforer) - ændrer betegnelserne for x- og y-aksen i
alleldiskriminationsdiagrammet, den cyklus, der skal analyseres, og hvorvidt bedømmelseskortet
skal vises.

Justering af data til alleldiskrimination
Softwaren tildeler automatisk en genotype til brønde med ukendte prøver baseret på NTC-positioner og
de ukendte datapunkters vinkel og afstand fra NTC'erne.

Sådan justeres data til alleldiskrimination

u Gør et af følgende:

n Markér afkrydsningsfeltet i diagrammet Allelic Discrimination (Alleldiskrimination) for at få vist
polære koordinater.

n For at se en anden fluorofor skal du vælge den på rullelisten i panelet Selected Fluorophores
(Valgte fluoroforer).

n For at redigere en bedømmelse skal du trække på tværs af datapunkterne i diagrammet Allelic
Discrimination (Alleldiskrimination) og vælge en mulighed på listen Selected Wells (Valgte
brønde):

o Allele 1

o Allele 2

o Heterozygote (Heterozygot)

o Undetermined (Ikke fastslået)

o No Call (Ingen bedømmelse)

o Auto Call (Automatisk bedømmelse)

Tip: Vælg Auto Call (Automatisk bedømmelse) for at vende tilbage til
standardbedømmelsen.
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Valgmuligheder i diagrammenuen
Ud over de fælles genvejsmenupunkter (se Fælles genvejsmenupunkter for diagrammer på side 210), er
der andre genvejsmenupunkter i diagrammet Allelic Discrimination (Alleldiskrimination). De vises i Tabel
27.

Menupunkt Funktion

Zoom Fokuserer diagramvisningen på det valgte område (ved at klikke og
trække markøren i diagrammet).

Tip: Højreklik og vælg Set Scale to Default (Indstil skala til
standard) for at nulstille zoomniveauet, så alle datapunkter
vises.

Well (Brønd) Valgmulighederne for den valgte brønd er: display only this well (vis
kun denne brønd), remove this well from view (fjern denne brønd fra
visningen), set color for this trace (indstil farve for denne kurvelinje)
eller exclude this well from analysis (udelad denne brønd fra
analyse).

Selected Wells (Valgte brønde) Valgmulighederne for de valgte brønde (valgt ved at klikke og
trække markøren i diagrammet) er: display only these wells (vis kun
disse brønde), remove these wells from view (fjern disse brønde fra
visningen), set color for these traces (indstil farve for disse
kurvelinjer) eller exclude these wells from analysis (udelad disse
brønde fra analyse).

Tabel 27. Valgmuligheder i genvejsmenuerne (højre- og venstreklik) i diagrammet Allelic Discri-
mination (Alleldiskrimination)

Regnearket Allelic Discrimination (Alleldiskrimination)
Tabel 28 definerer de data, der vises i regnearket Allelic Discrimination (Alleldiskrimination).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Sample (Prøve) Beskrivelse af prøvens navn

Tabel 28. Indhold i regnearket Allelic Discrimination (Alleldiskrimination)
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Oplysninger Beskrivelse

Call (Bedømmelse) Identifikation af allelen, herunder automatisk Allele 1 (allel 1), Allele 2
(Allel 2), Heterozygote (Heterozygot), No Call (Ingen bedømmelse)
eller Undetermined (Ikke fastslået)

Type Auto (Automatisk) eller Manual (Manuel); beskriver, hvordan
bedømmelsen blev foretaget. Automatisk betyder, at softwaren foretog
bedømmelsen; Manuel betyder, at brugeren foretog bedømmelsen

RFU1 RFU for Allele1 (Allel 1)

RFU2 RFU for Allele2 (Allel 2)

Tabel 28. Indhold i regnearket Allelic Discrimination (Alleldiskrimination), fortsat
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Fanen Custom Data View (Tilpasset datavisning)
Fanen Custom Data View (Tilpasset datavisning) viser flere faner samtidig i et format, der kan tilpasses.

Rullelisten Load a Preset View (Indlæs en forudindstillet visning) indeholder flere skabeloner for
visningsformat. Den visning, der vises som standard, er afhængig af den fil, der analyseres. Hvis dataene
for eksempel er for en Melt Curve (Smeltekurve), vises standardvisningen Amp+Melt.
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Oprettelse af en tilpasset datavisning
Sådan oprettes en tilpasset datavisning

u Gør et af følgende:

n Vælg en alternativ forudindstillet visning på rullelisten.

n Vælg en anden diagramvisning på rullelisten, der findes øverst i hver individuel rude.

n Rediger antallet af rækker og kolonner på fanen.

n Rediger individuelle rudedimensioner. Træk stregerne i yderkanten i hver rude.

Klik på Save as Preset (Gem som forudindstilling) for at gemme tilpasningen som en forudindstillet
skabelon. Klik på Manage Presets (Administrer forudindstillinger) for at slette, omdøbe eller gendanne
eksisterende forudindstillede visninger.
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Fanen QC (Kvalitetskontrol)
Brug fanen QC (Kvalitetskontrol) til hurtigt at vurdere kvaliteten af de kørte data baseret på de regler, som
er defineret på fanen QC (Kvalitetskontrol) i vinduet User Preferences (Brugerpræferencer).

CFX Maestro Dx SE indeholder fire valgmuligheder for visning af kvalitetskontroldata:

n Diagrammet Amplification (Amplifikation) – viser RFU for hver brønd ved hver cyklus. Hver
kurvelinje på diagrammet repræsenterer data fra en enkelt fluorofor i én brønd.

n Tabellen QC rules (Regler for kvalitetskontrol) – viser de tilgængelige regler for kvalitetskontrol og
de indstillinger, der definerer hver regel. Anvendte regler for kvalitetskontrol er indikeret med en
markering.

n Well selector (Brøndvælger) – vælger brøndene med de fluorescensdata, der skal vises.

n Oversigtsside for kvalitetskontrolregel – viser den valgte regel for kvalitetskontrol og fremhæver
brønde, der ikke opfylder reglen.
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Ændring af kriterier for kvalitetskontrol
Sådan ændres kriterier for QC (Kvalitetskontrol)

u Markér eller fjern markeringen i afkrydsningsfeltet Use (Brug) for at medtage eller udelade reglen i
kvalitetskontrollen.

Udeladelse af brønde, som ikke består QC (Kvalitetskontrol)
CFX Maestro Dx SE viser brønde, som ikke består kriterierne for QC (Kvalitetskontrol), i kolonnen Results
(Resultater) i tabellen med QC-regler og i oversigtsruden.

Sådan udelades brønde, som ikke opfylder kriterierne for QC (Kvalitetskontrol)

u Vælg Exclude Wells (Udelad brønde) for hver af de brønde, der skal udelades.
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Fanen Run Information (Kørselsoplysninger)
Fanen Run Information (Kørselsoplysninger) viser protokollen og andre oplysninger om hver kørsel.
Denne fane kan bruges til følgende:

n Vise protokollen.

n Indtaste eller redigere bemærkninger om kørslen.

n Indtaste eller redigere id eller stregkode for kørslen.

n Vise hændelser, der måtte være opstået under kørslen. Brug disse meddelelser til at fejlfinde en
kørsel.

Tip: Højreklik på protokollen for at kopiere, eksportere eller udskrive den. Højreklik på Notes
(Bemærkninger), ID/Bar Code (Id/stregkode) eller Other panes (Andre ruder) for at fortryde, klippe,
kopiere, indsætte, slette eller vælge teksten.
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Dataanalyserapporter
Rapportdialogboksen viser oplysninger om den aktuelle datafil i vinduet Data Analysis (Dataanalyse). For
at åbne en rapport skal du vælge Tools > Reports (Værktøjer > Rapporter) eller klikke på Reports
(Rapporter) på værktøjslinjen.

Dialogboksen Report (Rapport) består af følgende afsnit:

n Menu og værktøjslinje – indeholder valgmuligheder til at formatere, gemme og udskrive rapporten
eller skabelonen.

n Liste med valgmuligheder (øverst til venstre i dialogboksen) – indeholder valgmuligheder for, hvad
der skal vises i rapporten.

n Rude med valgmuligheder (nederst til venstre i dialogboksen) – indeholder tekstfelter, i hvilke der kan
angives oplysninger om en given valgmulighed.

n Rude med forhåndsvisning (til højre i dialogboksen) – viser en forhåndsvisning af den aktuelle
rapport.
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Kategorier for dataanalyserapporter
Tabel 29 indeholder alle de valgmuligheder, der er tilgængelige i forbindelse med en dataanalyserapport,
afhængigt af datatypen i vinduet Data Analysis (Dataanalyse).

Kategori Valgmulighed Beskrivelse

Sidehoved

Rapportens titel, undertitel og logo

Report Information
(Rapportoplysninger)

Kørselsdato, brugernavn, datafilens
navn, sti til datafilen og den valgte
brøndgruppe

Audit Information
(Revisionsoplysninger)

Yderligere oplysninger, som er
nødvendige i forbindelse med revision,
herunder signaturer

Notes (Bemærkninger) Bemærkninger til datarapporten

Run Setup (Kørselsopsætning)

Run Information
(Kørselsoplysninger)

Kørselsdato, brugernavn, datafilens
navn, sti til datafilen og den valgte
brøndgruppe

Protocol (Protokol) Tekstvisning af protokoltrin og
valgmuligheder

Plate Display (Pladevisning) Pladevisning af oplysningerne i hver
enkelt brønd i pladen

Quantification (Kvantifikation)

Analysis Settings
(Analyseindstillinger)

Dataindsamlingens trinnummer,
analysetilstand og baseline-
subtraktionsmetode

Amplification Chart
(Amplifikationsdiagram)

Amplifikationsdiagram til kørsler, der
omfatter kvantifikationsdata

Standard Curve Chart
(Standardkurvediagram)

Standardkurvediagram

Tabel 29. Kategorier for dataanalyserapporter på listen med valgmuligheder
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Kategori Valgmulighed Beskrivelse

Data Regneark, der oplister dataene i hver
brønd

Gene Expression (Genekspression) – søjlediagram

Analysis Settings
(Analyseindstillinger)

Analysetilstand, diagramdata,
valgmulighed for skalering og
diagramfejl

Chart (Diagram) Kopi af søjlediagrammet

Target Names (Navne på
målsekvenser)

Diagram over navne på målsekvenser

Sample Names (Prøvenavne) Diagram over prøvenavne

Data Regneark, der oplister dataene i hver
brønd

Target Stability (Målsekvensens
stabilitet)

Diagram over stabilitetsværdier for
målsekvensen (target)

Box-and-Whisker Chart
(Boksplot)

Boksplot

Dot Plot Chart (Punktdiagram) Punktdiagram

Gene Expression (Genekspression) - Clustergram (Klyngeoversigt) og Scatter Plot
(Punktdiagram)

Analysis Settings
(Analyseindstillinger)

Indstillinger for hver diagramtype

Chart (Diagram) Kopi af diagrammet

Data Regneark, der oplister data i hver
målsekvens (target)

Genekspression – ANOVA-data

ANOVA Settings (ANOVA-
indstillinger)

P-værditærskel anvendt til analysen

Tabel 29. Kategorier for dataanalyserapporter på listen med valgmuligheder, fortsat
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Kategori Valgmulighed Beskrivelse

ANOVA Results (ANOVA-
resultater)

Tabel med resultaterne fra ANOVA og
Tukeys HSD post-hoc analyse

Melt Curve (Smeltekurve)

Analysis Settings
(Analyseindstillinger)

Smeltetrinnummer og
tærskellinjeindstilling

Melt Curve Chart
(Smeltekurvediagram)

Smeltekurvediagram

Melt Peak Chart
(Smeltekurvetopdiagram)

Smeltekurvetopdiagram

Data Regneark, der oplister dataene i hver
brønd

Allelic Discrimination (Alleldiskrimination)

Analysis Settings
(Analyseindstillinger)

Fluoroforer, cyklusser og viser
bedømmelseskort

Diagrammet Allelic Discrimination
(Alleldiskrimination)

Kopi af diagrammet over
alleldiskrimination

Data Regneark, der oplister dataene i hver
brønd

End Point (Endepunkt)

Analysis Settings
(Analyseindstillinger)

Fluorofor, endecyklusser til gennemsnit,
tilstand, laveste RFU-værdi, højeste
RFU-værdi og cut-off-værdi

Data Regneark, der oplister dataene i hver
brønd

QC Parameters
(Parametre for
kvalitetskontrol)

Data Regneark, der oplister parametrene for
hver enkelt QC-regel

Tabel 29. Kategorier for dataanalyserapporter på listen med valgmuligheder, fortsat

Brugervejledning | 253



Kapitel 11 Detaljerede oplysninger om dataanalyse

Oprettelse af en dataanalyserapport
Du kan gemme rapportens layout som en skabelon, der kan bruges igen til lignende rapporter.

Sådan oprettes en dataanalyserapport

1. Udfør de endelige justeringer af brøndindholdet, valgte brønde, diagrammer og regneark i vinduet
Data Analysis (Dataanalyse), inden rapporten oprettes.

2. Vælg Tools > Reports (Værktøjer > Rapporter) i menuen Data Analysis (Dataanalyse) for at åbne
dialogboksen Report (Rapport).

3. Vælg, hvad der skal medtages i rapporten. Rapporten åbnes med standardvalgmulighederne valgt.
Markér eller fjern markeringen i afkrydsningsfelterne for at ændre hele kategorier eller individuelle
valgmuligheder i en kategori.

Tabel 29 på side 251 angiver de tilgængelige valgmuligheder, der kan vælges til visning.

Bemærk: De data, der vises i rapporten, afhænger af de aktuelle valg på fanerne i vinduet Data
Analysis (Dataanalyse). For eksempel indeholder en kvantifikationskørsel muligvis ikke en
standardkurve, og disse data vises derfor ikke i vinduet Data Analysis (Dataanalyse) eller i
datarapporten.

4. Ændring af rækkefølgen af kategorier og elementer i en rapport. Træk valgmulighederne til den
relative position. Elementers rækkefølge kan kun ændres i den kategori, de tilhører.

5. (Valgfrit) I ruden Report Options (Valgmuligheder for rapport) indtastes information, der er relevant
for den valgte valgmulighed:

n Vælg et undersæt af oplysninger, der skal vises i rapporten.

n Vælg specifikke indstillinger for den valgte valgmulighed.

n Rediger teksten, der skal vises for den valgte valgmulighed.

6. Klik på Update Report (Opdater rapport) for at opdatere Report Preview (Vis rapport) med eventuelle
ændringer.

7. Udskriv eller gem rapporten:

a. Klik på knappen Print Report (Udskriv rapport) i værktøjslinjen for at udskrive den aktuelle
rapport.

b. Vælg File > Save (Fil > Gem) for at gemme rapporten i formatet PDF (Adobe Acrobat Reader),
MHT (Microsoft-dokument) eller MHTML (Microsoft-dokument).

c. Vælg en placering, hvor filen skal gemmes.
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d. Vælg File > Save As (Fil > Gem som) for at gemme rapporten med et nyt navn eller på en ny
placering.

8. (Valgfrit) Opret en skabelonrapport med den information, du ønsker. For at gemme de aktuelle
rapportindstillinger i en skabelon skal du vælge Template > Save (Skabelon > Gem) eller Save As
(Gem som). Indlæs rapportskabelonen, næste gang der skal oprettes en ny rapport.
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Oprettelse af Well Group Reports (Brøndgrupperapporter)
Sådan oprettes en brøndgrupperapport

1. Vælg Tools > Well Group Reports (Værktøjer > Brøndgrupperapporter) i vinduet Data Analysis
(Dataanalyse).

2. Vælg de brøndgrupper, amplifikationstrin og smeltetrin, som skal medtages i rapporten, i
dialogboksenWell Groups Reports (Brøndgrupperapporter).

3. Indtast stien eller naviger til destinationsmappen, hvor rapporten skal gemmes.

4. (Valgfrit) Vælg Choose a Report Template (Vælg en rapportskabelon), og naviger til
skabelonfilmappen.

5. (Valgfrit) Vælg Open Destination Folder (Åbn destinationsmappe) for at åbne mappen og se
rapporterne, når de er blevet genereret.

6. Klik på Create Reports (Opret rapporter).
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Ved at bruge strengt kvalificerede kontroller i reaktionerne kan du anvende CFX Maestro Dx Software,
Security Editionn til at udføre en genekspressionskørsel med henblik på at normalisere de relative
differencer i en målkoncentration blandt prøver. Typisk anvendes ekspressionsniveauer for ét eller flere
referencegener til normalisering af ekspressionsniveauerne for et interessegen. Referencegener tager
højde for isætningsforskelle (loading-forskelle) eller andre variationer i hver enkelt prøve, og deres
ekspressionsniveauer bør ikke ændres i det biologiske system, der undersøges.

Vælg fanen Gene Expression (Genekspression) i vinduet Data Analysis (Dataanalyse) for at evaluere de
relative differencer mellem PCR-reaktioner i to eller flere brønde. Du kan for eksempel evaluere det
relative antal virale genomer eller det relative antal transfekterede sekvenser i en PCR-reaktion. Den
mest almindelige anvendelse af et genekspressionsstudie er til at sammenligne cDNA-koncentrationen i
mere end én reaktion for at estimere niveauerne af steady state-mRNA.

Softwaren beregner det relative ekspressionsniveau for en målsekvens (target) med et af følgende
scenarier:

n Relativt ekspressionsniveau for en målsekvens (target 1) i forhold til en anden målsekvens (target 2).
Det kan for eksempel være mængden af ét gen i forhold til et andet gen i samme prøvebehandling.

n Relativt ekspressionsniveau for en målsekvens i en prøve sammenlignet med den samme
målsekvens under en alternativ prøvebehandling; for eksempel den relative mængde af ét gen i
forhold til sig selv under forskellige tidsmæssige, geografiske eller udviklingsmæssige forhold.

Opsætning af plader til genekspressionsanalyse
For at kunne udføre genekspressionsanalyse skal brøndenes indhold omfatte følgende:

n To eller flere målsekvenser (targets) – de to målsekvenser (targets), som repræsenterer forskellige
amplificerede gener eller sekvenser i prøverne.

n En eller flere referencemålsekvenser (targets) – mindst én målsekvens (target) skal være en
referencemålsekvens (target) for normaliseret ekspression. Tildel alle referencemålsekvenser
(targets) i vinduet Experiment Settings (Eksperimentindstillinger) for at analysere data i tilstanden
Normalized Expression (Normaliseret ekspression) (ΔΔCq). Kørsler, som ikke indeholder en
reference, skal analyseres ved hjælp af tilstanden Relative Expression (Relativ ekspression) (ΔCq).
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n Almindelige prøver – reaktionerne skal omfatte almindelige prøver (der kræves mindst to) for at vise
dataene plottet på fanen Gene Expression (Genekspression). Disse prøver skal repræsentere
forskellige behandlinger eller tilstande for hver af målsekvenserne (targets). Tildel en kontrolprøve
(valgfrit) i vinduet Experiment Settings (Eksperimentindstillinger). Hvis der ikke vælges en kontrol,
anvender softwaren den laveste Cq som kontrol.

Kravene i forbindelse med opsætning af Gene Expression (Genekspression) i Plate Editor (Pladeeditor)
afhænger af, hvorvidt reaktionsindholdet er singleplex PCR, med én fluorofor i reaktionerne, eller
multiplex PCR, med mere end én fluorofor i reaktionerne.

Vejledt pladeopsætning
Hvis pladeopsætningen af en datafil ikke indeholder informationen, der er nødvendig til analysen, og hvis
fanen Gene Expression (Genekspression) er valgt, er det område, der normalt bruges for at vise
søjlediagrammet, i stedet udfyldt med vejledninger til, hvordan denne information udfyldes. For
normaliseret genekspression udfyldes følgende trin:

1. Definer navne for Target (Målsekvens) og Sample (Prøve) ved brug af en af følgende:

n Plate Setup (Pladeopsætning) – åbner vinduet Plate Editor (Pladeeditor).

n Replace Plate File (Udskift pladefil) – åbner browseren Select Plate (Vælg plade), hvor du kan
navigere til en tidligere gemt pladefil, som det aktuelle pladelayout skal erstattes med.

n Replace PrimePCR File (Erstat PrimePCR-filen) – åbner dialogboksen Select PrimePCR file
(Vælg PrimePCR-fil), hvor du kan navigere til en PrimePCR-kørselsfil, der kan anvendes på
pladelayoutet.

2. Vælg en eller flere referencemålsekvenser (targets) og en kontrolprøve i dialogboksen Experiment
Settings (Eksperimentindstillinger).

Hvis pladelayoutet allerede indeholder information ommålsekvens (target) og prøve, er det kun
nødvendigt at udføre det andet trin, der vil være fremhævet med orange. Dette trin skal udføres inden
der kan udføres normaliseret genekspressionsanalyse.

Bemærk: Data for punktdiagram og klyngeoversigt vises kun, hvis alle kravene til normaliseret
genekspressen, der anført under Plate Setup (Pladeopsætning) for Gene Expression Analysis
(Genekspressionsanalyse), er opfyldt.
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Diagrammer for genekspression
CFX Maestro Dx SE-softwaren viser genekspressionsdata i flere forskellige visninger. Tabel 30
indeholder en liste over de diagramvisninger, der kan vælges i softwaren.

Knap Navn Funktion

Grafisk afbildning Viser normaliserede genekspressionsdata i en
af følgende visninger:

n Søjlediagram (standard)

n Boksplot

n Punktdiagram

Klyngeoversigt Viser de normaliserede genekspressionsdata i
et hierarki baseret på graden af lighed for
ekspressionen af forskellige målsekvenser
(targets) og prøver.

Scatter Plot (Punktdiagram) Viser den normaliserede ekspression af
målsekvenser (targets) for en kontrol kontra en
eksperimentel prøve.

ANOVA Viser resultaterne af ensidet ANOVA på
genekspressionsdataene ved hjælp af følgende
R-pakker for at udføre ANOVA og bestemme
Tukey-resultater:

n Companion to Applied Regression (car)

n Least-square means (lsmeans)

Værktøj til valg af
referencegener

(Tilgængeligt på fanen Study Analysis
(Studieanalyse) i vinduet Gene Study
(Genstudie)) Identificerer de testede
referencegener og kategoriserer dem som Ideal
(Ideelle), Acceptable (Acceptable) eller
Unstable (Ustabile) baseret på disses stabilitet.

PrimePCR kontrolanalyse (Tilgængelig på fanen Study Analysis
(Studieanalyse) i vinduet Gene Study
(Genstudie)) Viser resultaterne for de testede
prøver.

Tabel 30. Valgmuligheder for genekspressionsdiagrammer
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Grafisk afbildning

Den relative ekspression af målsekvenser (targets) præsenteres i disse to visninger:

n Diagrammet Gene Expression (Genekspression) – viser real-time PCR-data som et af følgende:

o ΔΔCq – relativ normaliseret ekspression beregnet ved brug af kontrolprøver og referencemålsekvenser
(targets).

o ΔCq – relativ mængde af målsekvensgenet (targetgenet) i en prøve relativt til en kontrolprøve.

SeÆndring og anmærkning af diagramvisningen på side 262 for at få yderligere oplysninger om
visning af data.

n Regneark – viser et regneark med genekspressionsdata.

Tip: Højreklik på et diagram eller regneark for at se valgmulighederne. Vælg View/Edit Plate
(Vis/rediger plade) i rullemenuen Plate Setup (Pladeopsætning) for at åbne Plate Editor
(Pladeeditor) og ændre brøndindholdet i pladen.

Tip: Vælg Sort (Sortér) i genvejsmenuen for at ændre rækkefølgen af navnene på målsekvenser
(targets) og prøver i diagrammet.
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Normaliseret genekspression

For at normalisere data skal du bruge det målte ekspressionsniveau for et eller flere referencegener som
normaliseringsfaktor. Referencegener er målsekvenser (targets), som ikke er reguleret i det biologiske
system i studiet, f.eks. actin,GAPDH eller tubulin.

Sådan opsættes normaliseret genekspressionsanalyse (ΔΔCq)

1. Åbn en datafil (med filtypenavn .pcrd).

2. Gennemgå dataene under Quantification (Kvantifikation) i vinduet Data Analysis (Dataanalyse).
Juster dataene, f.eks. ved at ændre tærsklen og analysetilstanden.

3. Vælg fanen Gene Expression (Genekspression).

4. Klik på Experiment Settings (Eksperimentindstillinger) på fanen Gene Expression (Genekspression).

5. Gør følgende i dialogboksen Experiment Settings (Eksperimentindstillinger):

a. Vælg fanen Samples (Prøver), og vælg en kontrol. Når en kontrol er tildelt, normaliserer CFX Maestro
Dx SE de relative mængder for alle gener efter kontrolmængden, som er indstillet til 1.

b. Vælg fanen Target (Målsekvens), og vælg referencegener. Genekspressionsanalyse kræver én
reference blandt målsekvenserne (targets) i prøverne.

6. Vælg Normalized Expression (Normaliseret ekspression) (ΔΔCq), hvis det ikke allerede er valgt, og
se derefter ekspressionsniveauerne på fanen Gene Expression (Genekspression).

Bemærk: Du kan også bruge Setup Wizard (Guiden Opsætning) til at opsætte pladelayoutet til
normaliseret genekspressionsanalyse.

Relative Quantity (Relativ mængde)

Pr. definition er data for relativ mængde (ΔCq) ikke normaliserede. Denne metode anvendes til
kvantifikation af prøver, som ikke indeholder referencegener (målsekvenser (targets)). Normalt vil
forskere tage udgangspunkt i følgende ved opsætning af kørsler:

n Hver prøve indeholder den sammemængde RNA eller cDNA i hver brønd.

n Enhver varians i mængden af tilsat biologisk prøve vil blive normaliseret efter kørslen ved hjælp af en
metode i dataanalysen, som foregår uden for softwaren. En forsker kan f.eks. vælge at dividere
værdien for relativ mængde med normaliseringsfaktoren, som kan være massen af nukleinsyre tilført
for hver prøve eller antallet af celler, hvorfra nukleinsyren er isoleret.

Sådan køres en analyse af relativ mængde (ΔCq)

u Vælg Relative Quantity (Relativ mængde) (ΔCq) på rullelisten Mode (Tilstand) i højre rude på fanen
Gene Expression (Genekspression).
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Tip: For at sammenligne resultaterne fra andre genekspressionskørsler skal du åbne et nyt
genstudie eller tilføje en datafil til et eksisterende genstudie.

Ændring og anmærkning af diagramvisningen
Du kan bruge kommandoerne i diagrammets genvejsmenu og diagramværktøjerne til dataanalyse til at
ændre diagramvisning, kommentere diagrammer og ændre diagramskærmen. Diagramværktøjslinjen
vises mellem diagrammet og dataanalyseregnearket nederst på skærmen.

Værktøjer på diagramværktøjslinjen

Tip: Se Diagrammer på side 202 for at få oplysninger om de diagramværktøjer, der vises i højre side
af dataanalysediagrammer.

Værktøjslinjen under diagrammerne giver hurtig adgang til anmærkningsværktøjer.

Tabel 31 viser funktionerne for knapperne på diagramværktøjslinjen.

Knap Navn Funktion

Søjlediagram Viser den relative ekspression af målsekvenserne
(targets).

Boksplot Viser data som kvartilområder (se Beregninger for
boksplot på side 303 for at få nærmere oplysninger om
beregninger).

Bemærk: Kun tilgængelig, hvis Analyze Using (Analysér
med) er indstillet til Biological Groups Only (Kun biologiske
grupper).

Punktdiagram Viser de individuelle prøvedatapunkter for hver
målsekvens (target).
Bemærk: Kun tilgængelig, hvis Analyze Using (Analysér
med) er indstillet til Biological Groups Only (Kun biologiske
grupper).

Tilføj pil Tegner en pil på det aktive diagram.

Tabel 31. Diagramværktøjslinje
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Knap Navn Funktion

Tilføj cirkel Tegner en cirkel på det aktive diagram

Tilføj tekst Indsætter et tekstfelt på det aktive diagram, hvor du kan
tilføje tekst til identifikation af interesseelementer i
diagrammet.

Fortryd Fjerner eller tilbagefører den seneste anmærkning på det
aktive diagram.

Annuller Fortryd Tilbagefører den seneste fortryd-handling, der er udført på
det aktive diagram.

Ryd alt Sletter alle anmærkninger på det aktive diagram.

Tabel 31. Diagramværktøjslinje, fortsat

Sortering af data for målsekvens (target), prøve og biologisk gruppe

Bemærk: Denne valgmulighed er kun tilgængelig på diagrammer for genekspression.

Som standard vises listerne Targets (Målsekvenser), Samples (Prøver) og Biological Groups (Biologiske
grupper) i alfabetisk rækkefølge. Brug dialogboksen Sort (Sortér) til at sortere visningen i omvendt
alfabetisk rækkefølge eller til manuelt at flytte en term til en anden placering på listen.

Sådan sorteres data for målsekvens (target), prøve og biologisk gruppe

1. Klik på Sort (Sortér) fra diagramværktøjerne.

Dialogboksen Gene Expression Chart Sorting (Sortering af diagrammet Genekspression) åbnes.

2. Klik på Z-A i dialogboksen for at sortere listen i omvendt alfabetisk rækkefølge.

Brugervejledning | 263



Kapitel 12 Genekspressionsanalyse

3. For at flytte en term manuelt skal du vælge den og klikke på den relevante knap mellem
diagrammerne:

n Klik på pil op eller pil ned for at flytte den valgte term én position.

n Klik på pil op med slutstreg eller pil ned med slutstreg for at flytte den valgte term til toppen eller
bunden af listen.

4. Klik på OK for at gemmeændringerne og gå tilbage til fanen Gene Expression (Genekspression).
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Ændring af farveindstillinger for målsekvens (target), prøve og biologisk gruppe

Brug dialogboksen Color Settings (Farveindstillinger) til at ændre farven på en målsekvens (target), en
prøve eller en biologisk gruppe eller til at fjerne elementet fra grafen.

Sådan ændres farveindstillingerne for en målsekvens (target)

1. Kontrollér, at Sample (Prøve) vises på rullelisten X-Axis (X-akse) i højre rude i dialogboksen Gene
Expression (Genekspression).

2. Vælg Color Settings (Farveindstillinger) i diagramværktøjerne.

Dialogboksen Color Settings (Farveindstillinger) åbnes.

3. For at ændre visningsfarven for en målsekvens (target) skal du klikke på dens farve i kolonnen Color
(Farve).

4. Vælg en ny farve i dialogboksen Color (Farve), der vises, og klik på OK.

5. For at fjerne en målsekvens (target) fra genekspressionsgrafen skal du fjerne markeringen i det
relevante afkrydsningsfelt i kolonnen Show Chart (Vis diagram).

Tip: For at rydde alle målsekvenser (targets) skal du rydde Show Chart (Vis diagram) i
kolonneoverskriften.

6. (Valgfrit) Søjlerne vises som standard med dækkende farver. For at vise søjlerne i gradientfarver skal
du fjerne markeringen i Use Solid Colors (Brug dækkende farver).

7. Klik på OK for at gemmeændringerne og gå tilbage til fanen Gene Expression (Genekspression).

Sådan ændres farveindstillingerne for prøven eller den biologiske gruppe

1. Kontrollér, at Target (Målsekvens) vises på rullelisten X-Axis (X-akse) i højre rude i dialogboksen
Gene Expression (Genekspression).

2. Udfør trinnene i Sådan ændres farveindstillingerne for en målsekvens (target) på side 265.

Ændring af diagramvisningen

Sådan ændres den aktuelle diagramvisning

u Vælg værktøjslinjekommandoen for målsekvensvisningen (targetvisningen).

Bemærk: Fanen Gene Expression (Genekspression) åbnes altid med dataene i
standardsøjlediagramvisningen.
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Udeladelse af ekstreme datapunkter

I punktdiagrammet kan du nemt se ekstreme datapunkter og udelade dem fra analysen.

Sådan udelades ekstreme datapunkter

u Højreklik på det relevante ekstreme datapunkt i punktdiagrammet, og vælg Exclude Well from
Analysis (Udelad brønd fra analyse).

Datapunktet fjernes fra punktdiagrammet, og brønden bliver grå i Well Selector (Brøndvælger) under
Quantification (Kvantifikation).

Sådan medtages et udeladt ekstremt datapunkt

u Højreklik på brønden i Well Selector (Brøndvælger) under Quantification (Kvantifikation), og vælg
Well > Include in Analysis (Brønd > Medtag i analyse).

Visning af detaljerede oplysninger om datapunkter

Sådan vises detaljerede oplysninger om datapunkter

u I boksplottet og punktvisningsdiagrammet skal du placere markøren på et individuelt datapunkt.

Der vises et værktøjstip, som viser prøvens navn og ekspression (relativ mængde eller normaliseret
ekspression, afhængigt af den valgte tilstand).

Anmærkning af diagrammer

Du kan tilføje pile, cirkler og tekst til de enkelte søjlediagramvisninger, så data kan kommunikeres tydeligt.
Anmærkningerne gemmes sammen med søjlediagrammet og vises i den eksporterede og udskrevne fil.
Anmærkninger, der tilføjes på én diagramvisning, tilføjes dog ikke på de andre diagramvisninger.

Sådan tegnes en pil eller en cirkel på diagrammet

1. Klik på det ønskede værktøj i søjlediagrammets værktøjslinje.

2. Klik på søjlediagrammet, og træk markøren på tværs af diagrammet efter behov.
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Sådan tilføjes tekst til diagrammet

1. Klik på Add Text (Tilføj tekst) i søjlediagrammets værktøjslinje.

2. Klik på søjlediagrammet. Der åbnes et tekstfelt der, hvor du klikkede.

3. Tilføj tekst i tekstfeltet.

4. Klik hvor som helst i diagrammet for at forlade tekstfeltet.

Tip: Tryk på Enter for at tilføje flere linjer i tekstfeltet.

Sådan flyttes en anmærkning

1. Hold markøren over anmærkningen. Ikonet ændres til en pegende finger, og anmærkningens kanter
fremhæves.

2. Klik på anmærkningen, og træk den til en anden placering.

3. Slip anmærkningen for at placere den på den nye placering.

Sådan fortrydes en anmærkning

u Klik på Undo (Fortryd).

Den senest tilføjede anmærkning fjernes.

Tip: Du kan fortryde de ti seneste anmærkninger, en ad gangen.

Sådan annulleres fortryd for en anmærkning

u Klik på Redo (Annuller fortryd).

Den senest fjernede anmærkning gendannes.

Tip: Du kan annullere fortryd for de seneste ti anmærkninger, en ad gangen.

Sådan slettes en anmærkning

u Højreklik på anmærkningen, og vælg Delete (Slet).
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Tilpasning af genekspressionsdata
Efter at have valgt analysetilstand, normaliseret ekspression (∆∆Cq) eller relativ mængde (∆Cq) skal du
tilpasse de data, der vises på fanen Gene Expression (Genekspression), ved at ændre valgmulighederne
til højre for diagrammet.

Tip: Standardindstillingerne for genekspressionsdata i dialogboksen User Preferences
(Brugerpræferencer) (se Indstilling af standardparametre for genekspressionsdatafiler på side 91).

Grafdata

Indstil værdien på y-aksen til skalaen Linear (Lineær) for at aktivere valgmulighederne for grafdata.
Valgmulighederne for grafdata gør det muligt at præsentere data i grafen med en af disse valgmuligheder:

n Relative to control (I forhold til kontrol) – grafisk afbildning af data med aksen skaleret fra 0 til 1.
Aktivér denne valgmulighed, hvis du tildeler en kontrol i kørslen, for hurtigt at kunne visualisere op-
og nedregulering af målsekvensen (target).

n Relative to zero (I forhold til nul) – grafisk afbildning af data med startpunkt ved nul.

Analyze Using (Analysér med)

Brug rullemenuen til at vælge, hvordan data skal analyseres og indtegnes. Der er følgende muligheder:

n Samples Only (Kun prøver) – data analyseres og indtegnes for hver enkelt prøve.

n Biological Groups Only (Kun biologiske grupper) – data analyseres og indtegnes for biologiske
grupper. Den ekspression, der vises for den biologiske gruppe, er den geometriske middelværdi for
prøverne i den pågældende gruppe.

n Sample Biological Group (Prøve, biologisk gruppe) – data analyseres og indtegnes for hver prøve
med den biologiske gruppe angivet efter prøvenavnet. De viste P-værdier beregnes på baggrund af
den biologiske gruppe.

n Biological Group Sample (Biologisk gruppe, prøve) – data analyseres og indtegnes for hver prøve
med den biologiske gruppe angivet før prøvenavnet. De viste P-værdier beregnes på baggrund af
den biologiske gruppe.

Brug rullemenuen til at vælge en prøve, der skal bruges til at normalisere Relative Quantity (Relativ
mængde):

Annotate P-Values (Anmærk P-værdier) og P-Value Threshold (Tærskel for P-
værdi)

Hvis Annotate P-Values (Anmærk P-værdier) er valgt, viser softwaren en stjerne (*) i søjlediagrammet
over en målsekvens (target), hvis den tilhørende P-værdi er under den valgte tærskel. Softwaren
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beregner automatisk P-værdien ved at sammenligne prøvens ekspressionsniveau med den valgte
kontrolprøves ekspressionsniveau ved hjælp af en standard-t-test. Området for tærsklen for P-værdi er
0,000-1,000.

Valgmuligheder for x-aksen

Valgmuligheden X-axis (X-akse) giver mulighed for at vælge x-aksedata i diagrammet Gene Expression
(Genekspression):

n Target (Målsekvens) – indtegner navnene på målsekvenserne (targets) på x-aksen.

n Sample (Prøve) – indtegner prøvenavnene på x-aksen.

Valgmuligheder for y-aksen

Valgmuligheden Y-axis (Y-akse) giver mulighed for at få vist diagrammet Gene Expression
(Genekspression) i en af disse tre skaleringer:

n Linear (Lineær) – vælg denne valgmulighed for at få vist en lineær graf.

Tip: Hvis y-aksen indstilles til Linear (Lineær), aktiveres rullelisten Graph Data (Grafdata), hvor
du kan vælge indtegning af data i forhold til kontrol eller i forhold til nul.

n Log 2 – vælg denne valgmulighed for at evaluere prøver på tværs af et stort dynamisk område.

n Log 10 – vælg denne valgmulighed for at evaluere prøver på tværs af et meget stort dynamisk
område.

Valgmuligheder for skalering

Vælg Normalized Gene Expression (Normaliseret genekspression) (ΔΔCq), og indstil til None (Ingen) for
at aktivere valgmulighederne for skalering i diagrammet Gene Expression (Genekspression). Vælg en af
disse valgmuligheder for skalering for at beregne og præsentere data på den måde, som passer bedst til
dit kørselsdesign:

n Unscaled (Ikke-skaleret) – viser ikke-skaleret normaliseret genekspression.

n Highest (Højest) – skalerer den normaliserede genekspression for hver målsekvens (target) ved at
dividere ekspressionsniveauet for hver prøve med det højeste ekspressionsniveau i alle prøverne.

Denne valgmulighed for skalering anvender formlen for skaleret-til-højest.

n Lowest (Lavest) – skalerer den normaliserede genekspression for hver målsekvens (target) ved at
dividere ekspressionsniveauet for hver prøve med det laveste ekspressionsniveau i alle prøverne.

Denne valgmulighed for skalering anvender formlen for skaleret-til-lavest.
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n Average (Gennemsnit) – skalerer den normaliserede genekspression for hver målsekvens (target)
ved at dividere ekspressionsniveauet for hver prøve med den geometriske middelværdi for
ekspressionsniveauerne for alle prøverne.

Denne valgmulighed for skalering anvender formlen for skaleret-til-gennemsnit.

Vælg en mulighed for typen af fejlberegninger (fejllinjer) i diagrammet Gene Expression
(Genekspression):

Multiplikator for fejllinjer i diagrammet

Vælg en multiplikator for fejllinjerne i diagrammet Gene Expression (Genekspression). Vælg et af disse
heltal:

n +/- 1 (standard)

n 2

n 3

Multiplikatortypen ændres, når du vælger fejllinjen:

n SEMs for middelfejlen på middelværdien

n Std Devs for standardafvigelser

Experiment Settings (Eksperimentindstillinger)
Tip: Denne dialogboks er også tilgængelig i Plate Editor (Pladeeditor). SeÆndring af
eksperimentindstillinger på side 152 for yderligere oplysninger.

I dialogboksen Experiment Settings (Eksperimentindstillinger) kan du se eller ændre listen over
målsekvenser (targets), prøver eller biologiske grupper, vælge referencegener, vælge kontroller eller
indstille den genekspressionsanalysegruppe, der skal analyseres, hvis der er tilføjet biologiske grupper til
brøndene.

Sådan åbnes dialogboksen Experiment Settings (Eksperimentindstillinger)

u Klik på Experiment Settings (Eksperimentindstillinger) nederst i højre rude på fanen Graphing
(Grafisk afbildning).

Dialogboksen Experiment Settings (Eksperimentindstillinger) åbnes og viser fanen Targets
(Målsekvenser).
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Sådan justeres indstillinger for Targets (Målsekvenser)

u På fanen Targets (Målsekvenser) skal du gøre et af følgende:

n For at vælge en målsekvens (target) som reference for analyse af genekspressionsdata skal du
vælge dens navn i kolonnen Reference.

n For at ændre farven på målsekvensen (target) skal du klikke på dens celle i kolonnen Color
(Farve) og ændre farven i dialogboksen Color (Farve), der vises.

Farveændringen vises i diagrammerne for Gene Expression (Genekspression).

n For at bruge en tidligere fastlagt effektivitetsværdi skal du fjerne markeringen i afkrydsningsfeltet
for målsekvensen (target) i kolonnen Auto Efficiency (Automatisk effektivitet) og indtaste et tal
for målsekvensens (target) effektivitetsprocent.

Softwaren beregner den relative effektivitet for en målsekvens (target) ved hjælp af Auto
Efficiency (Automatisk effektivitet), hvis dataene for målsekvensen omfatter en standardkurve.

Sådan justeres indstillingerne for Sample (Prøve)

u På fanen Samples (Prøver) skal du gøre et af følgende:

n For at vælge en prøve som kontrol for analyse af genekspressionsdata skal du vælge dens navn
i kolonnen Control (Kontrol).

n For at ændre farven på prøven skal du klikke på den relevante celle i kolonnen Color (Farve) og
ændre farven i dialogboksen Color (Farve), der vises.

Farveændringen vises i diagrammerne for Gene Expression (Genekspression).

n For at vise prøven i diagrammerne for Gene Expression (Genekspression) skal du vælge dette i
kolonnen Show Chart (Vis diagram).

n For at fjerne prøven fra diagrammerne for Gene Expression (Genekspression) skal du fjerne
markeringen i kolonnen Show Chart (Vis diagram).

Tip: Prøvens data forbliver i tabellen Results (Resultater).

Sådan udelades en prøvetype fra analyseberegninger

u Markér det relevante afkrydsningsfelt nederst i dialogboksen Experiment Settings
(Eksperimentindstillinger).

Bemærk: Dette udelader kontroller og/eller standarder fra genekspressionsanalyse.
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Genvejsmenupunkter
Højreklik på genekspressionsdiagrammet for at vælge de elementer, der er vist i Tabel 32.

Element Funktion

Copy (Kopiér) Kopierer diagrammet til udklipsholderen.

Save Image As (Gem billede
som)

Gemmer diagrammet som en billedfil. Indstil billedets opløsning og
dimensioner, og vælg derefter filtypen (PNG, JPG, eller BMP).

Page Setup (Sideopsætning) Vælger en sideopsætning til udskrift.

Print (Udskriv) Udskriver diagrammet.

Set Scale to Default (Indstil skala
til standard)

Show All (Vis alle) viser samtlige data i søjlediagrammet. Scroll Bar
(Rullepanel) viser et rullepanel, hvis der er for mange prøver til, at de
kan vises i rammen med grafen, men opretholder en minimumsbredde
for søjlerne.

Diagramindstillinger Åbner vinduet Chart Settings (Diagramindstillinger) til justering af
grafen.

Sort (Sortér) Sorterer rækkefølgen af prøver og målsekvenser (targets), som vises
på diagrammets x-akse.

Use Corrected Std Devs
(Anvend korrigerede
standardafvigelser)

Beregner fejllinjerne ved hjælp af formlen for korrigeret
standardafvigelse.

Use Solid Bar Colors (Brug
dækkende farver)

Viser søjlerne i diagrammet med dækkende farver.

X-Axis Labels (X-aksens
betegnelser)

Viser x-aksens betegnelser vandret eller skråt.

Tabel 32. Genvejsmenupunkter for genekspression
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Dataregneark
Tabel 33 definerer de data, der vises i tabellen Gene Expression Data (Genekspressionsdata).

Bemærk: Værdierne i tabellen beregnes ud fra graftype og præferencer, som er valgt i højre rude.

Oplysninger Beskrivelse

Target (Målsekvens) Navn på målsekvens (target) (amplificeret gen), som er valgt i vinduet
Experiment Settings (Eksperimentindstillinger).

Biological Group (Biologisk
gruppe)

Sample Biological Group
(Prøve, biologisk gruppe)

Biological Group Sample
(Biologisk gruppe, prøve)

Navn på prøven og/eller den biologiske gruppe, som er valgt i vinduet
Experiment Settings (Eksperimentindstillinger).

Kontrol Navn på kontrollen, som er valgt i vinduet Experiment Settings
(Eksperimentindstillinger). Hvis Analyze Using (Analysér med) er
indstillet til Samples Only (Kun prøver), er Control (Kontrol) den prøve,
som er valgt i vinduet Experiment Settings (Eksperimentindstillinger).
Hvis Biological Groups Only (Kun biologiske grupper), Sample
Biological Group (Prøve, biologisk gruppe) eller Biological Group
Sample (Biologisk gruppe, prøve) er valgt, er kontrollen den biologiske
gruppe, som er valgt i vinduet Experiment Settings
(Eksperimentindstillinger).

Relative Quantity (Relativ
mængde) eller
Expression (Ekspression)

Relativ mængde (ΔCq) eller normaliseret genekspression (ΔΔCq),
afhængigt af den valgte tilstand.

Relative Quantity (Relativ
mængde) eller Expression SEM
(Ekspression SEM) (eller SD)

Middelfejlen på middeltallet (SEM) eller standardafvigelse (SD) for den
relative mængde eller normaliseret ekspression, afhængigt af den
valgte valgmulighed. Kun tilgængelig, hvis Analyze Using (Analysér
med) er indstillet til Samples Only (Kun prøver), Sample Biological
Group (Prøve, biologisk gruppe) eller Biological Group Sample
(Biologisk gruppe, prøve).

Tabel 33. Beskrivelse af oplysninger i regnearket på fanen
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Oplysninger Beskrivelse

Corrected Relative Quantity
(Korrigeret relativ mængde) eller
Expression SEM (Ekspression
SEM) (eller SD)

Korrigeret værdiberegning for SEM eller SD af relativ mængde eller
normaliseret ekspression, afhængigt af den valgte valgmulighed. Kun
tilgængelig, hvis Analyze Using (Analysér med) er indstillet til Samples
Only (Kun prøver), Sample Biological Group (Prøve, biologisk gruppe)
eller Biological Group Sample (Biologisk gruppe, prøve).

Mean Cq (Middelværdi for Cq) Middelværdien for kvantifikationscyklussen (vises ikke, hvis Analyze
Using (Analysér med) er indstillet til Biological Groups Only (Kun
biologiske grupper)).

Cq SEM (eller SD) SEM eller SD af kvantifikationscyklussen afhængigt af den valgte
valgmulighed (vises ikke, hvis Analyze Using (Analysér med) er
indstillet til Biological Groups Only (Kun biologiske grupper)).
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Valgmuligheden Show Details (Vis detaljerede oplysninger)
Tabel 34 definerer, hvilke data der vises, når du vælger Show Details (Vis detaljerede oplysninger) fra
genvejsmenuen i søjlediagrammets regneark.

Oplysninger Beskrivelse

Data Set (Datasæt) Fluorescensdata fra en enkelt fluorofor i datafilen

Relative Quantity (Relativ
mængde)

Beregnet relativ mængde af prøver

Relative Quantity SD (SD for
relativ mængde)

Standardafvigelse for beregning af relativ mængde

Corrected Relative Quantity SD
(SD for korrigeret relativ
mængde)

Beregnet standardafvigelse for den korrigerede relative mængde

Relative Quantity SEM (SEM for
relativ mængde)

Middelfejlen på middelværdien for beregning af relativ mængde

Corrected Relative Quantity
SEM (SEM for korrigeret relativ
mængde)

Beregnet middelfejl på middelværdien for den korrigerede relative
mængde

Relative Quantity(lg) (Relativ
mængde (lg))

Log2 for den relative mængde, der bruges til statistisk analyse

SD RQ(lg) Standardafvigelse for den relative mængde (log2)

SEM Expression(lg) (SEM for
ekspression (lg))

Middelfejlen på middelværdien for ekspressionen (log2)

Unscaled Expression (Ikke-
skaleret ekspression)

Beregnet ikke-skaleret ekspression

Unscaled Expression SD (SD for
ikke-skaleret ekspression)

Beregnet standardafvigelse for den ikke-skalerede ekspression

Corrected Unscaled Expression
SD (SD for korrigeret ikke-
skaleret ekspression)

Beregnet standardafvigelse for den korrigerede ikke-skalerede
ekspression

Tabel 34. Information i søjlediagrammets regneark, hvor der er valgt Show Details (Vis detal-
jerede oplysninger)
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Oplysninger Beskrivelse

Unscaled Expression SEM
(SEM for ikke-skaleret
ekspression)

Beregnet middelfejl på middelværdien for den ikke-skalerede
ekspression

Corrected Unscaled Expression
SEM (SEM for korrigeret ikke-
skaleret ekspression)

Beregnet middelfejl på middelværdien for den korrigerede ikke-
skalerede ekspression

Unscaled Expression(lg) (Ikke-
skaleret ekspression (lg))

Log2 for den ikke-skalerede ekspression

SD Unscaled Expression(lg) (SD
for ikke-skaleret ekspression
(lg))

Standardafvigelse for den ikke-skalerede ekspression (log2)

SEM Unscaled Expression(lg)
(SEM for ikke-skaleret
ekspression (lg))

Middelfejlen på middelværdien for den ikke-skalerede ekspression
(log2)

Expression (Ekspression) Normaliseret genekspression

Corrected Expression SD (SD
for korrigeret ekspression)

Beregnet standardafvigelse for den korrigerede ekspression

Expression SEM (SEM for
ekspression)

Middelfejlen på middelværdien for ekspressionen

Corrected Expression SEM
(SEM for korrigeret ekspression)

Beregnet middelfejl på middelværdien for den korrigerede ekspression

Expression(lg) (Ekspression
(lg))

Log2 for ekspressionen (normaliseret ekspression), der bruges til
statistisk analyse

SD Expression(lg) (SD
ekspression (lg))

Standardafvigelse for ekspressionen (log2)

SEM Expression(lg) (SEM for
ekspression (lg))

Middelfejlen på middelværdien for ekspressionen (log2)

Mean Cq (Middelværdi for Cq) Middelværdien for kvantifikationscyklussen

Tabel 34. Information i søjlediagrammets regneark, hvor der er valgt Show Details (Vis detal-
jerede oplysninger), fortsat
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Oplysninger Beskrivelse

Cq SD Standardafvigelse for kvantifikationscyklussen

Cq SEM Middelfejlen på middelværdien for kvantifikationscyklussen

Tabel 34. Information i søjlediagrammets regneark, hvor der er valgt Show Details (Vis detal-
jerede oplysninger), fortsat
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Klyngeoversigt
Klyngeoversigten viser dataene i et hierarki, baseret på graden af lighed i ekspression for forskellige
målsekvenser (targets) og prøver.

Bemærk: Du skal vælge en reference målsekvens (target) for at kunne vise andre dataplots end
relativ ekspression for søjlediagrammer.

Klyngeoversigtsbilledet viser relativ ekspression for en prøve eller en målsekvens (target) som følger:

n Opregulering (rød) – højere ekspression

n Nedregulering (grøn eller blå) – lavere ekspression

n Ingen regulering (sort)

n Ingen værdi beregnet (sort med et hvidt X)

Jo lysere farven er, desto større er forskellen i relativ ekspression. Hvis der ikke kan beregnes en
normaliseret Cq-værdi, vil firkanten være sort med et hvidt X.

Der findes et dendogram på yderkanten af dataplotningen, der angiver klyngehierarkiet. Målsekvenser
(targets) eller prøver, der har ens ekspressionsmønstre, har tilstødende grene, mens dem der har
mønstre, der ikke ligner hinanden, har større afstand mellem dem.

Indstillinger
Du kan indstille følgende:

n Cluster By (Saml i klynger) – vælg mellem Targets (Målsekvenser), Samples (Prøver), Both (Begge)
eller None (Ingen).

n Size (Størrelse) – justerer billedstørrelsen og ændrer forstørrelsesgraden for diagrammet.

n Split Out Replicates (Opdel replikater) – viser værdier for hvert af de individuelle replikater.

Tip: Du kan ændre farveskemaet for fra standardindstillingen rød/grøn til rød/blå ved at vælge dette
genvejsmenupunkt på af disse diagrammer.

Genvejsmenupunkter
Genvejsmenupunkterne for klyngeoversigten er de samme som for søjlediagrammerne. Se Tabel 32 på
side 272 for de tilgængelige valgmuligheder. Desuden er det muligt at vælge Color Scheme
(Farveskema) for at ændre den nedregulerede ekspression fra standardindstillingen rød/grøn til rød/blå
på diagrammet.

Dataregneark
Regnearket viser værdier for målsekvens (target), prøve og normaliseret ekspression.
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Punktdiagram
Punktdiagrammet viser den normaliserede ekspression af målsekvenser (targets) for en kontrol kontra en
eksperimentel prøve. Linjerne i plottet indikerer tærsklen for foldændring. Datapunkter mellem linjerne indikerer,
at differencen i ekspression for målsekvensen (target) (genet) er ubetydelig mellem prøverne. Datapunkter uden
for linjerne overskrider tærsklen for foldændring og kan være interessante.

Plotbilledet viser følgende ændringer i ekspression af målsekvensen (target) baseret på tærsklen for
foldændring:

n Opregulering (rød cirkel) – relativt højere ekspression

n Nedregulering (grøn eller blå cirkel) – relativt lavere ekspression

n Ingen ændring (sort cirkel)

Klik og træk i tærskellinjen for at justere værdien af tærsklen for foldændring.

Indstillinger
Du kan indstille følgende:

n Control Sample (Kontrolprøve)

n Experimental Sample (Eksperimentel prøve)

n Fold Change Threshold (Tærskel for foldændring). Når værdien for foldændring forøges eller
formindskes, flytter tærskellinjerne i plottet sig tilsvarende.

Genvejsmenupunkter
Genvejsmenupunkterne for punktdiagrammer er de samme som for søjlediagrammet. Se Tabel 32 på
side 272 for de tilgængelige valgmuligheder. Vælg desuden Symbol for at ændre det symbol, der
anvendes i plottet fra standardcirklen til et af følgende:

n Triangle (Trekant)

n Cross (Kryds)

n Square (Firkant)

n Diamond (Rombe)

Dataregneark
Regnearket viser værdierne for målsekvensen (target) og normaliseret ekspression for kontrol og
eksperimentelle prøver. Det angiver også, ommålsekvenser (targets) er op- eller nedregulerede,
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sammenlignet med målsekvensreguleringen.
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Regnearket Results (Resultater)
Regnearket Results (Resultater) opsummerer dataene fra alle diagrammerne. Tabel 35 definerer de data,
der vises i regnearket Results (Resultater).

Oplysninger Beskrivelse

Target (Målsekvens) Navnet på målsekvensen (target) (amplificeret gen)

Sample (Prøve) Prøvens navn

Mean Cq (Middelværdi for Cq) Middelværdien for kvantifikationscyklussen

Mean Efficiency Corrected Cq
(Middelværdi for
effektivitetskorrigeret Cq)

Middelværdien for kvantifikationscyklussen efter justering af
reaktionseffektivitet

Normaliseret ekspression Ekspression af målsekvens (target) normaliseret til en
referencemålsekvens (target) (ΔΔCq)

Relative Normalized Expression
(Relativ normaliseret
ekspression)

Normaliseret ekspression i forhold til en kontrolprøve, også kaldet Fold
Change (Foldændring)

Regulation (Regulering) Ændring i ekspressionen i forhold til en kontrolprøve

Compared to Regulation
Threshold (Sammenlignet med
reguleringstærskel)

Op- eller nedregulering af en eksperimentel prøve baseret på
tærskelindstillingen

Tabel 35. Oplysninger på fanen Results (Resultater)

Bemærk: Data for replikater findes kun i regnearket på dataanalysefanerne, for hvilke Split Out
Replicates (Opdel replikater) er markeret (dvs. Clustergram (Klyngeoversigt)). Der kan være
uoverensstemmelser i ekspressionsdata i genekspressionsanalyseregnearkene, hvis ”none” (ingen)
vælges som kontrolprøve på søjlediagrammet.
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Genstudie
Opret et genstudie for at sammenligne genekspressionsdata fra et eller flere real-time PCR-
eksperimenter ved brug af en kalibrator mellem kørsler for at normalisere eksperimenterne i forhold til
hinanden. Opret et genstudie ved at tilføje data fra en eller flere datafiler (.pcrd-filtypenavn) til genstudiet.
Softwaren grupperer dem i en enkelt fil (.mgxd-filtypenavn).

Bemærk: Det maksimale antal prøver, som kan analyseres i et genstudie, er begrænset af
computerens RAM-størrelse og virtuelle hukommelse.

Kalibrering mellem kørsler
Kalibreringer mellem kørsler forsøges kørt automatisk i hvert enkelt genstudie for hver enkelt målsekvens
(target) med henblik på normalisering af variationer mellem kørsler mellem målsekvens er (targets), der
analyseres i separate real-time PCR-kørsler (dvs. forskellige .pcrd-filer, der genereres fra forskellige
plader).

For at softwaren skal kunne genkende en prøve som en kalibrator mellem kørsler skal den have samme
navn på målsekvens (target), prøvenavn og, hvis det anvendes, navn på biologisk sæt på alle plader, der
sammenlignes.

Bemærk: Genstudiet skal indeholde mindst én kalibratorprøve, der kan bruges til at udføre
kalibrering mellem kørsler. Målsekvenser (targets) uden relevante kalibratorprøver behandles uden
korrektion i genstudiet (anbefales ikke).

Kalibratorer mellem kørsler kan anvendes på to måder:

n Per target (Pr. målsekvens) – forskellige PCR-primere kan have forskellige effektiviteter. Som
standard anvendes kalibratoren mellem kørsler på alle brønde på samme plade, som har samme
navn på målsekvens (target), for eksempel Cq genereret med samme analyse.

n Entire study (Hele studiet) – brugeren vælger én kalibrator mellem kørsler, som anvendes på hele
genstudiet.
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Dialogboksen Gene Study (Genstudie)

Dialogboksen Gene Study (Genstudie) indeholder to faner:

n Fanen Study Setup (Studieopsætning) – administrerer kørslerne i genstudiet.

Vigtigt: Dataene i den oprindelige fil bliver ikke ændret af, at der tilføjes eller fjernes datafiler fra
genstudiet.

n Fanen Study Analysis (Studieanalyse) – viser genekspressionsdataene for de kombinerede kørsler.

Fanen Study Setup (Studieopsætning)
Tabel 36 definerer de data, som vises på fanen Study Setup (Studieopsætning).

Kolonnetitel Beskrivelse

File Name (Filnavn) Navn på kørselsdatafilen (.pcrd-filtypenavn)

File Folder (Filmappe) Mappe som lagrer datafilen for hver kørsel i genstudiet

Date Created (Dato for
oprettelse)

Dato hvor kørselsdataene blev indsamlet

Tabel 36. Fanen Study Setup (Studieopsætning) i dialogboksen Gene Study (Genstudie)
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Kolonnetitel Beskrivelse

Well Group Name
(Brøndgruppenavn)

Navn på den brøndgruppe, som blev valgt, da filen blev tilføjet til
genstudiet

Tip: For at analysere én brøndgruppe i genstudiet skal du vælge
den pågældende brøndgruppe i vinduet Data Analysis
(Dataanalyse), inden dataene importeres til genstudiet.

Step (Trin) Protokoltrin som omfatter den plade, der blev læst for at indsamle real-
time PCR-data

Run Type (Kørselstype) Enten brugerdefineret eller PrimePCR-kørsel

Protocol Edited (Protokol
redigeret)

Angiver, hvis det er valgt, at protokollen, der blev brugt til en
PrimePCR-kørsel, blev redigeret

View Plate (Vis plade) Åbner et pladekort over pladen med dataene i hver af de kørsler, som
er medtaget i genstudiet

Tabel 36. Fanen Study Setup (Studieopsætning) i dialogboksen Gene Study (Genstudie), fort-
sat

Klargøring af et genstudie
Sådan klargøres et genstudie

1. Før du importerer data til et genstudie, skal følgende udføres i vinduet Data Analysis (Dataanalyse):

n Kontrollér, at prøver med samme indhold har samme navn. I et genstudie forudsætter softwaren,
at brønde med samme Target Name (Navn på målsekvens) eller Sample Name (Prøvenavn)
indeholder de samme prøver.

n Tilpas baseline og tærskel (Cq) på fanen Quantification (Kvantifikation) for at optimere dataene i
hver kørsel.

n Vælg den brøndgruppe, der skal medtages i genstudiet.

For at få vist data fra én brøndgruppe i genstudiet, skal den relevante gruppe vælges, før
datafilen importeres.

Fanen Study Setup (Studieopsætning) viser en liste over alle kørslerne i genstudiet.

2. Vælg fanen Study Setup (Studieopsætning) i dialogboksen Gene Study (Genstudie).

3. Klik på Add Data Files (Tilføj datafiler) for at vælge en fil fra et browservindue.

Tip: For hurtigt at tilføje kørsler i et genstudie skal du trække datafilerne (med filtypenavnet
.pcrd) til dialogboksen Study Setup (Studieopsætning).
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4. CFX Maestro Dx SE udfører automatisk genstudieanalysen, når du tilføjer datafiler. Vælg fanen
Study Analysis (Studieanalyse) for at se resultaterne.

Sådan fjernes kørsler fra genstudiet

u Vælg én eller flere filer på listen, og klik på Remove (Fjern).

Sådan tilføjes bemærkninger om genstudiet

u Skriv bemærkninger om filer og analyser i tekstboksen Notes (Bemærkninger).

Fanen Study Analysis (Studieanalyse)
Fanen Study Analysis (Studieanalyse) viser data fra alle kørslerne i genstudiet. Valgmulighederne for
dataanalyse i forbindelse med genekspression er de samme som dem, der gælder for en enkelt datafil,
med følgende undtagelser:

n For søjlediagrammer vises kalibreringsværdierne mellem kørsler (hvis de beregnes), når der klikkes
på Inter-run Calibration (Kalibrering mellem kørsler).

Bemærk: Det er kun følgende prøvetyper, der kan anvendes som kalibrator mellem kørsler:

o Unknown (Ukendt)

o Standard

o Positive Control (Positiv kontrol)

Prøvetyperne Negative control (Negativ kontrol), NTC (ingen skabelonkontrol) og NRT (ingen revers
transkriptasekontrol) kan ikke anvendes som kalibrator mellem kørsler.

n Værktøjet Reference Gene Selection (Valg af referencegen) identificerer de testede referencegener
og kategoriserer dem som Ideal (Ideelle), Acceptable (Acceptable) eller Unstable (Ustabile) baseret
på disses stabilitet:

o Ideelle referencegener er stabile og er et udtryk for minimale variationer på tværs af de testede
prøver.

o Acceptable referencegener er ikke ideelt stabile og er et udtryk for moderat variation på tværs af
de testede prøver. Sådanne referencegener bør kun anvendes til analyse, hvis der ikke er
ideelle referencegener.

o Ustabile referencegener er et udtryk for overdreven variation på tværs af de testede prøver. Det
anbefales at udelade disse gener fra analyserne.

n Værktøjet PrimePCR Analysis Controls (Prime PCR analysekontrol) viser resultaterne af de testede
prøver i en tabel:
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o Fanen Summary (Oversigt) viser en oversigt over alle testede prøver. Prøver, som bestod alle
kontrolanalyserne, vises med grønt. Prøver, som fejlede i en eller flere af kontrolanalyserne,
vises med gult.

o Fanen PCR viser resultaterne af den positive PCR-kontrolanalyse. Denne analyse registrerer
hæmning eller problemer med eksperimentet, som påvirker genekspressionen.

o Fanen RT viser resultaterne af revers transkriptase-kontrolanalysen. Denne analyse evaluerer
RT-ydelsen kvalitativt og identificerer prøver, hvor det er sandsynligt, at RT-ydelsen vil
kompromittere genekspressionen.

o Fanen gDNA viser resultaterne af DNA-kontamination-kontrolanalysen. Denne analyse
bestemmer, hvorvidt der er genomisk DNA (gDNA) til stede i en prøve på et niveau, der kan
påvirke qPCR-resultaterne.

o Fanen RQ viser resultaterne af RNA-kvalitetsanalyserne (RQ1 og RQ2). Disse analyser
vurderer kvalitativt, hvorvidt RNA-integriteten eventuelt kan påvirke genekspressionen negativt.

Kategorier af genstudierapporter
Brug dialogboksen Gene Study Report (Genstudierapport) til at arrangere data fra et genstudie i en
rapport. Tabel 37 indeholder en liste over alle de tilgængelige valgmuligheder for en genstudierapport.

Kategori Valgmulighed Beskrivelse

Sidehoved

Rapportens titel, undertitel og logo

Report Information
(Rapportoplysninger)

Dato, brugernavn, datafilens navn, sti til datafilen
og den valgte brøndgruppe

Gene Study File List (Liste
over filer til genstudiet)

Liste over alle datafiler i genstudiet

Notes (Bemærkninger) Bemærkninger til datarapporten

Study Analysis (Studieanalyse): Søjlediagram

Analysis Settings
(Analyseindstillinger)

Liste over de valgte analyseparametre

Chart (Diagram) Genekspressionssøjlediagram, der viser dataene

Tabel 37. Kategorier til brug i genstudierapporter
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Kategori Valgmulighed Beskrivelse

Target Names (Navne på
målsekvenser)

Liste over målsekvenserne (targets) i genstudiet

Sample Names
(Prøvenavne)

Liste over prøverne i genstudiet

Data Regneark, der viser dataene

Target Stability
(Målsekvensens stabilitet)

Stabilitetsdata for målsekvens (target)

Inter-run Calibration
(Kalibrering mellem kørsler)

Data vedr. kalibrering mellem kørsler

Box-and-Whisker Chart
(Boksplot)

Boksplot over genekspressionen

Dot-Plot Chart
(Punktvisningsdiagram)

Punktvisningsdiagram over genekspressionen

Study Analysis (Studieanalyse): Clustergram (Klyngeoversigt) og Scatter Plot
(Punktdiagram)

Analysis Settings
(Analyseindstillinger)

Indstillinger for hver diagramtype

Chart (Diagram) Genekspressionsdiagram, der viser dataene

Data Regneark, der oplister data i hver målsekvens
(target)

Study Analysis (Studieanalyse): ANOVA-
data

ANOVA Settings (ANOVA-
indstillinger)

P-værditærskel anvendt til analysen

ANOVA Results (ANOVA-
resultater)

Tabel med resultaterne fra ANOVA og Tukeys
HSD post-hoc analyse

Tabel 37. Kategorier til brug i genstudierapporter, fortsat
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Kategori Valgmulighed Beskrivelse

Shapiro-Wilk-
normalitetstest

Biologisk gruppe, antal, P-værdi og enhver fejl,
som måtte opstå for hver af målsekvenserne
(targets) i analysen

ANOVA Errors (ANOVA-
fejl)

Fejl, der identificeres under ANOVA-
beregningerne

Tabel 37. Kategorier til brug i genstudierapporter, fortsat
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Genstudie

Oprettelse af en genstudierapport
Sådan oprettes en genstudierapport

1. Tilpas genstudierapportens data og diagrammer efter behov, inden rapporten oprettes.

2. Vælg Tools > Reports (Værktøjer > Rapporter) i menuen Gene Study (Genstudie) for at åbne
dialogboksen Report (Rapport).

3. Vælg, hvad der skal medtages i rapporten. Rapporten åbnes med standardvalgmulighederne valgt.
Markér eller fjern markeringen i afkrydsningsfelterne for at ændre hele kategorier eller individuelle
valgmuligheder i en kategori.

Kategorier af genstudierapporter på side 286 angiver de tilgængelige valgmuligheder for visning.

4. Ændring af rækkefølgen af kategorier og elementer i en rapport. Træk valgmulighederne til den
ønskede position. Elementers rækkefølge kan kun ændres i den kategori, de tilhører.

5. Klik på Update Report (Opdater rapport) for at opdatere Report Preview (Vis rapport) med eventuelle
ændringer.

6. Udskriv eller gem rapporten. Klik på knappen Print Report (Udskriv rapport) i værktøjslinjen for at
udskrive den aktuelle rapport. Vælg File > Save (Fil > Gem) for at gemme rapporten i formatet PDF
(Adobe Acrobat Reader) og vælg en placering, hvor filen skal gemmes. Vælg File > Save As (Fil >
Gem som) for at gemme rapporten med et nyt navn eller på en ny placering.

7. (Valgfrit) Opret en skabelonrapport med den information, du ønsker. For at gemme de aktuelle
rapportindstillinger i en skabelon skal du vælge Template > Save (Skabelon > Gem) eller Save As
(Gem som). Indlæs rapportskabelonen, næste gang der skal oprettes en ny rapport.
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Tillæg A Dataanalyseberegninger
CFX Maestro Dx Software, Security Editionn beregner formler automatisk og viser resultaterne på
fanerne Data Analysis (Dataanalyse). Dette tillæg forklarer i detaljer, hvordan CFX Maestro Dx SE
beregner formlerne.

Reaktionseffektivitet
Evidens tyder på, at brug af en nøjagtig måling af effektivitet for hver primer og probe vil give mere
nøjagtige resultater, når genekspressionsdata analyseres. Standardværdien for effektivitet anvendt i
beregninger af genekspression er 100 %. For at evaluere reaktionseffektiviteten skal der genereres en
standardkurve ved brug af serielle fortyndinger af en repræsentativ prøve over et relevant dynamisk
område, hvorefter effektiviteten for efterfølgende genekspressionsanalyse registreres. Hvis kørslen
omfatter en standardkurve, beregner softwaren automatisk effektiviteten og viser den under Standard
Curve (Standardkurve) på fanen Quantification (Kvantifikation), når Auto Efficiency (Automatisk
effektivitet) er markeret på fanen Targets (Målsekvenser) i vinduet Experiment Settings
(Eksperimentindstillinger).

Effektiviteten (E) i effektivitetsformlen henviser til ”effektiviteter” som beskrevet af Pfaffl (2001) og
Vandesompele et al. (2002). I disse publikationer svarer en effektivitet på 2 (perfekt fordobling for hver
cyklus) til 100 % effektivitet i denne software. Du kan vælge at konvertere effektivitetsberegningerne til
dem, der anvendes i softwaren, ved at anvende følgende matematiske forhold:

n E = (% effektivitet * 0,01) + 1

n % effektivitet = (E – 1) * 100

Relative Quantity (Relativ mængde)
Formlen for relativ mængde (ΔCq) for enhver prøve (GOI) er:

Bemærk: Denne formel anvendes til at beregne den relative mængde, når der ikke er nogen
defineret kontrolprøve .

Hvor:
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n E = effektivitet af primer og probesæt. Denne effektivitet beregnes med formlen
(% Effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n C q (min) = gennemsnitlig Cq for prøven med det laveste gennemsnitlige Cq for GOI

n C q (sample) = gennemsnitligt Cq for prøven

n GOI = interessegen (én målsekvens (target))

Relativ mængde, når der er valgt en kontrol
Når der tildeles en kontrolprøve eller biologisk gruppe, beregnes den relative mængde (RQ) for enhver
prøve med et interessegen (GOI) med denne formel:

Hvor:

n E = effektivitet af primer og probesæt. Denne effektivitet beregnes med formlen
(% Effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n Cq (control) = gennemsnitligt Cq for kontrolprøven

n Cq (sample) = gennemsnitligt Cq for alle prøver med et GOI

n GOI = interessegen (én målsekvens (target))

Standardafvigelse for relativ mængde
Vigtigt: Denne beregning gælder kun, når Analyze Using (Analysér med) er indstillet til Samples
Only (Kun prøver), Sample Biological Group (Prøve, biologisk gruppe) eller Biological Group Sample
(Biologisk gruppe, prøve).

Formlen for standardafvigelse for relativ mængde er

Hvor:

n SD Relative Quantity = Standardafvigelse for relativ mængde

n SD CqGOI prøve = Standardafvigelse for Cq for prøven (GOI)

n Relative Quantity = Relativ mængde af prøven

n E = effektivitet af primer og probesæt. Denne effektivitet beregnes med formlen
(% Effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2
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Effektivitetskorrigeret Cq (CqE)

n GOI = interessegen (én målsekvens (target))

Effektivitetskorrigeret Cq (CqE)
Formlen for effektivitetskorrigeret Cq er

Hvor:

n E = Effektivitet

Middelværdi for effektivitetskorrigeret Cq (MCqE)
Formlen for middelværdi for effektivitetskorrigeret Cq er

Hvor:

n CqE = effektivitetskorrigeret Cq

n n = antallet af replikater
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Normaliseret ekspression
Normaliseret ekspression (ΔΔCq) er den relative mængde af målsekvensen (target) (genet) normaliseret
til mængderne af referencemålsekvenserne (gener eller sekvenser) i det biologiske system. For at vælge
referencemålsekvenser (targets) skal du åbne vinduet Experiment Settings (Eksperimentindstillinger) og
klikke på referencekolonnen for hver målsekvens (target), som tjener som et referencegen.

Formlen for normaliseret ekspression, som bruger den beregnede relative mængde (RQ), er

Hvor:

n RQ = Relativ mængde af en prøve

n Ref = Referencemålsekvens (target) i en kørsel, som omfatter en eller flere referencemålsekvenser i
hver prøve

n GOI = interessegen (én målsekvens (target))

Under forudsætning af at referencemålsekvenserne (targets) ikke ændrer deres ekspressionsniveauer i
det biologiske system, tager beregningen af normaliseret ekspression højde for isætningsforskelle eller
variationer i celletal, der måtte forekomme i prøverne.
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Normaliseret ekspression, når en kontrol er valgt

Ekspression og relativ mængde for biologiske grupper
Hvis Analyze Using (Analysér med) er indstillet til Biological Groups Only (Kun biologiske grupper), viser
softwaren den gennemsnitlige ekspression (normaliseret ekspression eller relativ mængde, afhængigt af
den valgte tilstand) for prøverne i den biologiske gruppe. Da ekspression typisk er log-normalfordelt,
beregnes gennemsnittet af ekspressionen ved hjælp af den geometriske middelværdi:

Hvor:

n Exp1, Exp2, Expn = relativ mængde eller normaliseret ekspression for prøver i den biologiske gruppe

n n = antal prøver i den biologiske gruppe

Normaliseret ekspression, når en kontrol er valgt
Når du vælger en kontrolprøve i vinduet Experiment Settings (Eksperimentindstillinger), indstiller
softwaren ekspressionsniveauet for kontrolprøven til 1. I denne situation normaliserer softwaren de
relative mængder for al ekspression af målsekvens (target) (gen) til kontrolmængden (en værdi på 1).
Denne normaliserede ekspression svarer til den ikke-skalerede normaliserede ekspressionsanalyse, når
der er valgt en kontrol.

Bemærk: Dette kaldes også relativ normaliseret ekspression (RNE) og foldændring.
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Standardafvigelse for normaliseret ekspression
Genskalering af værdien for normaliseret ekspression sker ved at dividere standardafvigelsen for den
normaliserede ekspression med den normaliserede ekspresionsværdi for det højeste eller laveste
individuelle ekspressionsniveau, afhængigt af den valgte skalering. Formlen for standardafvigelse (SD)
for normaliseringsfaktoren er

Hvor:

n RQ = Relativ mængde af en prøve

n SD = Standardafvigelse

n NF = Normaliseringsfaktor

n Ref = Referencemålsekvens (target)

n n = Antallet af referencemålsekvenser (targets)

Når en kontrolprøve tildeles, er det ikke nødvendigt at køre denne genskaleringsfunktion på
standardafvigelsen, som vist i nedenstående formel:

Hvor:

n NE = Normaliseret ekspression

n RQ = Relativ mængde af en prøve

n SD = Standardafvigelse

n GOI = interessegen (én målsekvens (target))
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Normaliseret ekspression skaleret til højeste ekspressionsniveau

Normaliseret ekspression skaleret til højeste
ekspressionsniveau

Når kørslen ikke omfatter kontroller, skaleres den normaliserede ekspression (NE) for hver målsekvens
(target) (gen) ved at dividere ekspressionsniveauet for hver prøve med det højeste ekspressionsniveau i
alle prøverne. Softwaren indstiller det højeste ekspressionsniveau til en værdi på 1 og omskalerer alle
prøveekspressionsniveauerne. Formlen for højeste skalering er

Hvor:

n GOI = interessegen (målsekvens (target))

Normaliseret ekspression skaleret til laveste
ekspressionsniveau

Når kørslen ikke omfatter kontroller, skaleres den normaliserede ekspression (NE) for hver målsekvens
(target) (gen) ved at dividere ekspressionsniveauet for hver prøve med det laveste ekspressionsniveau i
alle prøverne. Softwaren indstiller det laveste ekspressionsniveau til en værdi på 1 og omskalerer alle
prøveekspressionsniveauerne. Formlen for den laveste skalering er

Hvor:

n GOI = interessegen (målsekvens (target))

Normaliseret ekspression skaleret til gennemsnitligt
ekspressionsniveau

Når kørslen ikke omfatter kontroller, skaleres den normaliserede ekspression (NE) for hver målsekvens
(target) (gen) ved at dividere ekspressionsniveauet for hver prøve med geometriske middelværdi for
ekspressionsniveau for alle prøverne. Softwaren indstiller det gennemsnitlige ekspressionsniveau til en
værdi på 1 og omskalerer alle prøveekspressionsniveauerne. Formlen for gennemsnitlig skalering er

Hvor:

n GOI = interessegen (målsekvens (target))
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n GM = Geometrisk middelværdi for normaliseret ekspression i alle prøver
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Standardafvigelse for skaleret normaliseret ekspression
Genskalering af værdien for skaleret normaliseret ekspression (NE) sker ved at dividere
standardafvigelsen (SD) for den normaliserede ekspression med den normaliserede ekspressionsværdi
for det højeste (MAX) eller laveste (MIN) ekspressionsniveau, afhængigt af den valgte skalering.

Bemærk: Når en kontrolprøve tildeles, er det ikke nødvendigt at køre denne genskaleringsfunktion
på standardafvigelsen.

Beregningen for denne formel er

Hvor:

n NE = Normaliseret ekspression

n SD = Standardafvigelse

n GOI = interessegen (målsekvens (target))

n MAX = Højeste ekspressionsniveau

n MIN = Laveste ekspressionsniveau
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Fejllinjer for standardafvigelse (lg) og standardfejl på
middelværdien (lg)

Ud over brugen af konfidensintervaller kan der vises fejllinjer for biologiske grupper, baseret på
standardafvigelsen eller middelfejlen på middelværdien i log2 for ekspressionen. Fejllinjerne beregnes
som følger:

RQ nedre fejllinje = 2RQ(lg)-SD RQ(lg) eller 2RQ(lg)-SEM RQ(lg)

RQ øvre fejllinje = 2RQ(lg)+SD RQ(lg) eller 2RQ(lg)+SEM RQ(lg)

Hvor:

n RQ(lg) = log2 for den relative mængde for den biologiske gruppe

n SD RQ(lg) = standardafvigelse for den relative mængde (log2)

n SEM RQ(lg) = middelfejl på middelværdien for den relative mængde (log2)

Exp. Nedre fejllinje = 2Exp.(lg)-SD Exp.(lg) eller 2Exp.(lg)-SEM Exp.(lg)

Exp. Øvre fejllinje = 2Exp.(lg)+SD Exp.(lg) eller 2Exp.(lg)+SEM Exp.(lg)

Hvor:

n Exp.(lg) = log2 for ekspressionen (normaliseret ekspression) for den biologiske gruppe

n SD RQ(lg) = standardafvigelse for ekspression (log2)

n SEM RQ(lg) = middelfejl på middelværdien for ekspressionen (log2)
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Foldændring

Foldændring
Foldændring er et mål af stigning eller fald i ekspressionen af en målsekvens (target) for en
eksperimentprøve kontra en kontrolprøve eller biologisk gruppe og bestemmes som følger:

Hvis ekspression (eksperimentel) > Ekspression (kontrol):

Hvis ekspression (eksperimentel) < Ekspression (kontrol):

Bemærk: Ved grafisk afbildning er ekspressionen baseret på enten den relative mængde eller
normaliseret ekspression, afhængigt af den valgte tilstand (se Grafisk afbildning på side 260). Ved
Scatter Plot (Punktdiagram), og Clustergram (Klyngeoversigt) beregnes foldændring altid fra den
normaliserede ekspression.
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Formler for korrigerede værdier
Vigtigt: Disse beregninger gælder kun, når Analyze Using (Analysér med) er indstillet til Samples
Only (Kun prøver), Sample Biological Group (Prøve, biologisk gruppe) eller Biological Group Sample
(Biologisk gruppe, prøve).

Der ses kun en forskel mellem de korrigerede værdier og de ikke-korrigerede værdier, hvis
standardkurven oprettes som en del af real-time PCR-kørslen. Softwaren anvender tre ligninger til at
bestemme propageringen af fejl:

n Standardfejl

n Standardfejl for normaliseret ekspression

n Standardfejl for normaliseret interessegen (målsekvens (target))

Formlen for standardfejl er

Hvor:

n n = Antallet af referencemålsekvenser (targets) (gener)

n SD = Standardafvigelse

Formlen for standardfejl for normaliseringsfaktoren i normaliseret ekspression er

Hvor:

n n = Antallet af referencemålsekvenser (targets)

n SE = Standardfejl

n NF = Normaliseringsfaktor

n RQ = Relativ mængde

Formlen for standardfejl for normaliseret interessegen (GOI) er

Hvor:

n SE = Standardfejl
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Beregning af konfidensinterval til analyse af biologisk gruppe

n GOI = interessegen (én målsekvens (target))

n NF = Normaliseringsfaktor

n n = Antallet af referencemålsekvenser (targets)

Beregning af konfidensinterval til analyse af biologisk gruppe
Når der udføres analyse af biologisk gruppe (Analyze Using (Analysér med) er indstillet til Biological
Groups Only (Kun biologiske grupper)), beregnes konfidensintervallerne for relativ mængde og relativ
normaliseret ekspression.

Konfidensintervallerne beregnes i log-skala baseret på t-fordeling ved hjælp af følgende formel:

Hvor:

n = Middelekspression for log-skala-ekspressionsniveauerne for prøverne i den biologiske gruppe

n SD = standardafvigelse for log-skala-ekspressionsniveauerne for prøverne i den biologiske gruppe

n n = antallet af prøver i den biologiske gruppe

n t = opnået fra t-fordelingen baseret på frihedsgrad og alfaniveau

Bemærk: Alfaniveauet kan indstilles ved hjælp af feltet P-value threshold (Tærskel for P-værdi)
på fanen Graphing (Grafisk afbildning).

Efter beregning af konfidensintervallerne konverteres de til lineær skala, hvorefter de vises i datatabellen
Gene Expression (Genekspression) og søjlediagrammet på fanen Graphing (Grafisk afbildning).

Beregninger for boksplot
Boksplottet viser fordelingen af ekspressionsværdierne i en biologisk gruppe ved at indtegne data som
kvartiler. De 1. og 3. kvartiler er repræsenteret af henholdsvis de nederste og øverste grænser i boksen.
Medianen vises som en ubrudt linje på tværs af boksen. De rette linjer repræsenterer de mindste og
største ikke-ekstreme værdier i datasættet. Ekstremer er værdier, som overstiger det 1. og 3. kvartil med
1,5 gange det interkvartile område.

Bemærk: Hvis den biologiske gruppe kun indeholder én prøve, vises dette som en enkelt cirkel, som
indikerer et enkelt datapunkt.

Det følgende boksplot viser, hvordan dataene er repræsenteret.
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1. Ekstrem. Denne ekstrems værdi er > Q3 + (1,5 x [Q3 - Q1]).

Bemærk: Placer markøren over cirklen for at få vist et værktøjstip, som viser prøvens
navn og oplysninger om relativ mængde eller normaliseret ekspression afhængigt af den
valgte tilstand.

2. Afgrænsning af største ikke-ekstrem

3. Øvre/3. kvartil (Q3). 75 % af ekspressionsværdierne er mindre end Q3.

4. Median, eller midterste værdi, for de rangordnede ekspressionsværdier

5. Nedre/1. kvartil (Q1). 25 % af ekspressionsværdierne er mindre end Q1.

6. Afgrænsning af mindste ikke-ekstrem

7. Ekstrem. Denne ekstrems værdi er < Q1 - (1,5 x [Q3 - Q1]).

FORKLARING
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Tillæg B Revisionsspor
CFX Maestro Dx Software, Security Editionn opretter revisionsspor for data- og genstudiefiler
(henholdsvis .prcd- og .mgxd-filer). Ændringer eller handlinger, der er udført på sikrede data og/eller
genstudiefiler, registreres i filens revisionsspor, når filen gemmes. CFX Maestro Dx SE opretter et separat
revisionsspor for hver fil.

Du kan vælge File > Save As (Fil > Gem som) for at gemme sikre underskrevne eller ikke-underskrevne
data og genstudiefiler i en anden mappe eller med et andet navn. Den nye fil overtager revisionssporet fra
den oprindelige fil. Revisionssporet for den nye fil omfatter også Gem som-aktiviteten. Ændringer eller
handlinger, der er udført på den nye fil, registreres i dens eget revisionsspor. Den originale fil bevarer sit
revisionsspor, hvor yderligere aktivitet registeres.

Reviderbare hændelser på side 307 viser de reviderbare hændelser, som softwaren registrerer.

Visning af revisionsspor
Hvert revisionsspor viser følgende oplysninger:

n Revisionsoverskrift

o File version (Filversion) — den gemte version af filen

o Date (Dato) — datoen for den aktuelle reviderbare hændelse

o User (Bruger) —Windows-domænet og brugernavnet for den indloggede bruger

o Comment (Kommentar) — den senest gemte kommentar

o Signature (Underskrift) — den elektroniske signatur fra den seneste person, der underskrev filen

o Signature reason (Underskriftårsag) — årsagen til underskriften

o Application (Program)— CFX Maestro Dx SE

o Application version (Programversion) — den aktuelle version af CFX Maestro Dx SE

o Full user (Brugernavn) — den indloggede brugers fulde navn

o Machine (Maskine) — den computer, som CFX Maestro Dx SE er installeret på.

n Oplysninger om revisionsændring

o Object (Objekt) — det emne, der blev ændret (det reviderede emne)
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o Old value (Gammel værdi) — den tidligere værdi

o New value (Ny værdi) — den nye værdi

o Description (Beskrivelse) — beskrivelsen af ændringen

Sådan kan du se revisionssporet

u I den åbne data- eller genstudiefil skal du vælge View > Audit (Vis > Revisionsspor). Filens
revisionsspor vises.

Som standard sorteres dataene efter dato og klokkeslæt, og alle hændelser vises i den udvidede
visning. Du kan filtrere visningen efter brugernavn og objekt og skjule den udvidede visning, så du let
kan sortere efter ethvert overskriftsfelt. Du kan også se revisionssporet som html-rapport.

Sådan sorteres efter brugernavn

u Vælg den ønskede bruger fra rullelisten User Name (Brugernavn).

Sådan sorteres efter objekt

u Vælg det ønskede objekt fra rullelisten Object (Objekt).

Sådan skjules den fulde hændelsesbeskrivelse

u Klik på Collapse All (Skjul alle).

Sådan sorteres data i tabellen med ændringsoplysninger

u Klik på diamantsymbolet i datakolonneoverskriften for at udføre en stigende sortering (’A til Z’,
’mindste til højeste antal’ eller ’tidligst til senest’).
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Sådan udskrives revisionssporet

1. Klik på HTML-rapport for at få vist revisionssporet i en webbrowser.

2. Når du er i dit browservindue, skal du gøre et af følgende:

n Vælg File > Print (Fil > Udskriv).

n Højreklik på rapporten, og vælg Print (Udskriv).

Reviderbare hændelser
CFX Maestro Dx SE registrerer følgende reviderbare hændelser i data- og genstudiefiler.

Reviderbare hændelser under kørslen

n Run Start Time (Kørsels starttid)

n Run Time Plate edits (Kørselstid for pladeredigeringer)

n Run Time Protocol edits (Kørselstid for protokolredigeringer)

n Run End Time (Kørsels sluttid)

Reviderbare hændelser, når en datafil oprettes

n Data file created (Datafil oprettet)

n Interpolerede pladeaflæsninger tilføjet af systemet

Reviderbare hændelser, når en datafil er gemt

n Generel (Generelt)

o Name (Navn)

o Signing (Underskrift)

o Plate Setup (Pladeopsætning)

o Display Wells (Vis brønde)

o Analyzed fluorophores (Analyserede fluoroforer)

o Plate edits (Pladeredigeringer)

o Analysis mode (Analysetilstand)

o PCR Active Well Group (PCR-aktiv brøndgruppe)
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n Fanen Quantification (Kvantifikation)

o Active step (Aktivt trin)

o Settings (Indstillinger) - C q Determination mode (Bestemmelsestilstand)

o Settings (Indstillinger) > Baseline Setting (Baselineindstilling)

o Drift correction applied (Korrektion for afvigelse anvendt)

o Settings > Cycles to Analyze (Indstillinger > Cyklusser til analyse)

o Settings > Analysis Mode (Indstillinger > Analysetilstand)

o Settings > Baseline Setting (Indstillinger > Baselineindstilling)

n Fanen Melt Curve (Smeltekurve)

o Active step (Aktivt trin)

o Peak type displayed (Viste toppunktstype)

o Peak analysis threshold (Tærskel for toppunktsanalyse)

n Fanen End Point (Slutpunkt)

o Active fluorophore/target (Aktiv fluorofor/målsekvens)

o End cycles to average (Slutcyklusser til gennemsnit)

o Tolerance calculation method (Metode til beregning af tolerance)

o Percentage of range (Procentdel af område)

n Fanen Allelic Discrimination (Alleldiskrimination)

o X- and Y-axis fluorophore (Fluorofor for X- og Y-akse)

o Select cycle number (Vælg cyklusantal)

o View call map (Se bedømmelseskort)

n Fanen Gene Expression (Genekspression) — All plots (Alle plot)

o Experiment Settings— Target reference (Eksperimentindstillinger —Målsekvensreference)

o Experiment Settings— Sample control (Eksperimentindstillinger — Prøvekontrol)

o Experiment Settings— Auto efficiency (Eksperimentindstillinger — Automatisk effektivitet)

o Experiment Settings— Efficiency (Eksperimentindstillinger — Effektivitet)
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n Fanen Gene Expression (Genekspression) —Graphing (Grafisk afbildning)

o Analysis mode (Analysetilstand)

o Graph data (Grafdata)

o X-axis (X-akse)

o Y-axis (Y-akse)

o Scaling option (Valgmulighed for skalering)

o Error bar (Fejllinje)

o Error bar multiplier (Multiplikator for fejllinje)

o P-Value Threshold (Tærskel for P-værdi)

n Fanen Gene Expression (Genekspression) — Clustergram (Klyngeoversigt)

o Cluster By (Saml efter)

o Split out replicates (Opdel replikater)

n Fanen Gene Expression (Genekspression) — Scatter Plot (Punktdiagram)

o Control Biological Group (Biologisk kontrolgruppe)

o Experimental Biological Group (Biologisk eksperimentgruppe)

o Fold Change Threshold (Tærskel for foldændring)

n Fanen Gene Expression (Genekspression) - ANOVA

o P-Value Threshold (Tærskel for P-værdi)

n Plate Setup— View/Edit Plate (Pladeopsætning— Vis/rediger plade

o Settings— PlateType (Indstillinger — Pladetype)

o Settings— Units (Indstillinger — Enheder)

o Editing Tools — Flip Plate (Redigeringsværktøjer — Vend plade)

o Well groups (Brøndgrupper)

o Plate fluorophores (Pladefluoroforer)

n Plate Setup— Replace Plate and Apply PrimePCR File (Pladeopsætning— Udskift plade og anvend
PrimePCR-fil)

o Plate Setup Import (Import af pladeopsætning)
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Audit Changes for Gene Study Files (Revisionsændringer for genstudiefiler)

Generel (Generelt)

n Navn

n Fanen Study Setup (Studieopsætning)

o Add/Remove data files /(Tilføj/fjern datafiler)

n Fanen Study Analysis (Studieanalyse)
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Tillæg C LIMS-integration
CFX Maestro Dx Software, Security Editionn kan konfigureres til brug sammen med et
laboratorieinformationsstyringssystem (LIMS eller Laboratory Information Management System). LIMS-
integration kræver CFX Maestro Dx SE pladeopsætningsoplysninger genereret af LIMS-platformen (en
LIMS-fil, *.plrn), en protokolfil oprettet ved brug af CFX Maestro Dx SE (*.prcl), en defineret
dataeksportdestination samt et defineret eksportformat.

Når kørslen er afsluttet, genererer CFX Maestro Dx SE en datafil (.pcrd) og gemmer den i en defineret
dataeksportmappe. CFX Maestro Dx SE kan også oprette en LIMS-kompatibel datafil i .csv-format og
gemme den på samme sted.

Oprettelse af LIMS-kompatible datafiler
Dette tillæg indeholder oplysninger om opsætning af CFX Maestro Dx SEet til oprettelse, lagring og
eksport af LIMS-kompatible datafiler.

Opsætning af valgmuligheder for LIMS-mappen og for dataeksport
Som standard gemmer CFX Maestro Dx SE LIMS-protokoller, filer og dataeksportfiler i denne mappe:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Du kan konfigurere CFX Maestro Dx SE til at gemme filerne i en anden mappe, og du kan ændre
eksportindstillingerne for LIMS-data.

Sådan opsættes en LIMS-mappe og valgmuligheder for dataeksport

1. Vælg Tools > Options (Værktøjer > Valgmuligheder) i startvinduet.

2. I dialogboksen Options (Valgmuligheder) skal du vælge Data Export Settings (Indstillinger for
dataeksport).

Brugervejledning | 311



Tillæg C LIMS-integration

3. (Valgfrit) Vælg Automatically export LIMS data at end of run (Eksportér LIMS-data automatisk ved
afslutning af kørslen).

Softwaren eksporter automatisk LIMS-data efter hver kørsel og gemmer dem på den specificerede
placering.

4. For at ændre standardindstillingerne for eksport af LIMS-data skal du klikke på LIMS Data Export
Settings (Indstillinger for eksport af LIMS-data).

Vigtigt: Det er kun LIMS-data, der er eksporteret som en .csv-fil, der kan importeres tilbage i
CFX Maestro Dx SE.

5. I dialogboksen LIMS Data Export Format Settings (Indstillinger for eksportformat for LIMS-data) skal
du vælge de ønskede eksportindstillinger og klikke på OK.

6. I dialogboksen Options (Valgmuligheder) skal du navigere til og vælge en standardmappe, hvor
LIMS-datafilerne skal gemmes. Du kan vælge en forskellig placering for hver filtype:

n Protocol (Protokol)

n LIMS file (LIMS-fil)

n Data export (Dataeksport)
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7. Klik på OK for at gemmeændringerne og lukke dialogboksen Options (Valgmuligheder).

Oprettelse af en LIMS-protokol
For at starte en LIMS-kørsel skal du oprette en CFX Maestro Dx SE protokolfil (*.prcl) og gemme den i
LIMS-protokolmappen.

Se Kapitel 7, Oprettelse af protokoller for yderligere oplysninger.

Oprettelse af en LIMS-fil
En LIMS-fil (*.plrn) indeholder detaljerede oplysninger om opsætning af pladen og protokollens filnavn.
Filen genereres af dit interne LIMS. CFX Maestro Dx SE bruger LIMS-filen til at oprette en pladefil, der
skal bruges sammen med en protokolfil.

CFX Maestro Dx SE indeholder skabelonfiler til pladeimport, der kan redigeres med henblik på at oprette
tilpassede LIMS-pladefiler.

Tip: Denne opgave skal udføres af en LIMS-specialist.

Sådan oprettes en LIMS-fil

1. I startvinduet skal du vælge View > Show > LIMS File Folder (Vis > Vis > LIMS-filmappe).

2. Åbn LIMS-skabelonmappen, og vælg en .cvs-fil, der skal importeres til det interne LIMS.

3. Rediger skabelonfilen ved at udfylde de påkrævede felter i Tabel 38.

4. Gør et af følgende:

n For at gemme dine ændringer til fremtidig brug skal du gemme filen som en .csv-fil.

n For at gemme dine ændringer og bruge filen med det samme skal du gemme filen med
filtypenavnet .plrn.

n Gem skabelonen med filtypenavnet .plrn i LIMS-filmappen.

Vigtigt: CFX Maestro Dx SE kan kun åbne .plrn-filen. Du skal gemme .csv-filen som .plrn, før du
kan starte LIMS-kørslen.
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Kolonne Række Beskrivelse Indhold Formål

A 1 Plate Header
(Pladetitel)

Må ikke redigeres Foruddefineret

A,B,C 2 Field/Data/Instruction
(Felt/data/instruktion)

Må ikke redigeres Foruddefineret

B 3 Version Må ikke redigeres Foruddefineret

B 4 Plate Size
(Pladestørrelse)

Må ikke redigeres Foruddefineret

B 5 Plate Type (Pladetype) Indtast “BRWhite” (BR
hvid), “BR Clear” (BR klar)
eller anden kalibreret
pladetype

Påkrævet

B 6 Scan Mode
(Scanningstilstand)

Indtast “SYBR/FAMOnly:”
(Kun SYBR/FAM:), “All
Channels” (Alle kanaler)
eller “FRET”

Påkrævet

B 7 Units (Enheder) Indtast et af følgende:
“copy number”
(kopinummer), “fold
dilution” (fold-fortynding),
“micromoles” (mikromol),
“nanomoles” (nanomol),
“picomoles” (pikomol),
“femtomoles” (femtomol),
“attomoles” (attomol),
“milligrams” (milligram),
“micrograms”
(mikrogram), “nanograms”
(nanogram), “picograms”
(pikogram), “femtograms”
(femtogram), “attograms”
(attogram) eller “percent”
(procent)

Påkrævet

Tabel 38. Definition indholdet i LIMS .csv-filen
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Kolonne Række Beskrivelse Indhold Formål

B 8 Run ID (Kørsels-id) Indtast en kort beskrivelse,
eller indlæs en stregkode,
der identificerer denne
kørsel (maks. 30 tegn;
kommaer er ikke tilladt)

Valgfrit

B 9 Kørselsnoter Indtast beskrivelsen af
kørslen

Valgfrit

B 10 Run Protocol
(Kørselsprotokol)

Indtast protokollens
filnavn, nøjagtigt som
angivet.

Påkrævet

A 11 Data File (Datafil) Indtast datafilens navn Valgfrit

A 12-15 TBD/Empty (Til
fremtidig brug/tom)

Må ikke redigeres Foruddefineret

A 16 Plate Data (Pladedata) Må ikke redigeres Foruddefineret

A 17-113 Well Position
(Brøndposition)

Må ikke redigeres Foruddefineret

B-G Ch1 Dye (Kanal 1-
farve), Ch2 Dye (Kanal
2-farve), Ch3 Dye
(Kanal 3-farve), Ch4
Dye (Kanal 4-farve),
Ch5 Dye (Kanal 5-
farve), FRET

Indtast et kalibreret
farvenavn (for eksempel
"FAM") for hver kanal, der
er i brug

Påkrævet

H Sample Type
(Prøvetype)

Indtast en af de følgende
prøvetyper: “Unknown”
(Ukendt), “Standard”,
“Positive Control” (Positiv
kontrol), “Negative
Control” (Negativ kontrol),
“NTC” eller “NRT”

Påkrævet

Tabel 38. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

I Sample Name
(Prøvenavn)

Indtast prøvenavn Valgfrit

J-O CH1 Target (Kanal 1-
målsekvens), CH2
Target (Kanal 2-
målsekvens), CH3
Target (Kanal 3-
målsekvens), CH4
Target (Kanal 4-
målsekvens), CH5
Target (Kanal 5-
målsekvens), FRET
Target (FRET-
målsekvens)

Indtast navnet på
målsekvensen (target) for
hver kanal, der er i brug

Valgfrit

P Samlingens navn Indtast navnet på det
biologiske sæt

Valgfrit

Q Replicate (Replikat) Indtast et positivt heltal for
hvert sæt replikater.
Værdien må ikke være nul.

Valgfrit

R-W CH1 Quantity (Kanal 1-
mængde), CH2
Quantity (Kanal 2-
mængde), CH3
Quantity (Kanal 3-
mængde), CH4
Quantity (Kanal 4-
mængde), CH5
Quantity (Kanal 5-
mængde), FRET
Quantity (FRET
kvantitet)

Indtast mængdeværdier
for eventuelle standarder.
Indtast koncentration i
decimalformat.

Påkrævet for alle
standarder

Tabel 38. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

X Well Note
(Brøndbemærkning)

Indtast en
brøndbemærkning (maks.
20 tegn)

Bemærk: Selvom
CFX Maestro Dx SE
har en
tegnbegrænsning på
20 tegn, når du
indtaster noter i Well
Note
(Brøndbemærkning)
via softwaren, kan
feltet Well Note
(Brøndbemærkning)
indeholde op til 500
tegn, hvis det er
inkluderet i en
importeret .plrn-fil.
CFX Maestro Dx SE
viser dog kun de
første 20 tegn. Den
eksporterede .pcrd-fil
indeholder alle
tegnene i feltet Well
Note
(Brøndbemærkning) -
ingen data går tabt.

Valgfrit

Tabel 38. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

Y-AD Ch1Well Color (Kanal
1-brøndfarve), Ch2
Well Color (Kanal 2-
brøndfarve), Ch3Well
Color (Kanal 3-
brøndfarve), Ch4Well
Color (Kanal 4-
brøndfarve), Ch5Well
Color (Kanal 5-
brøndfarve), FRET
Well Color (FRET-
brøndfarve)

Indtast en brugerdefineret
farve for kurvelinjelayout i
et 32 bit (argb)
heltalsdecimalformat

Valgfrit

Tabel 38. Definition indholdet i LIMS .csv-filen, fortsat

Start af en LIMS-kørsel
Sådan startes en LIMS-kørsel

1. Gør et af følgende for at åbne en LIMS .plrn-fil:

n Vælg View > Show > LIMS File Folder (Vis > Vis > LIMS-filmappe) i startvinduet.

n Vælg File > Open > LIMS File (Fil > Åbn > LIMS-fil) i startvinduet, og åbn den ønskede .plrn-fil.

Filen åbnes på fanen Start Run (Start kørsel) i Run Setup wizard (Guiden Kørselsopsætning). Fanen
Start Run (Start kørsel) viser oplysninger om eksperimentet, der skal køres. Den viser også den eller
de tilsluttede instrumentblokke, som eksperimentet kan køres på.

2. Vælg et instrument på fanen Start Run (Start kørsel), og klik på Start Run (Start kørsel).
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Eksport af data til et LIMS
Når kørslen afsluttes, genererer CFX Maestro Dx SE en datafil (.pcrd) og gemmer den på den definerede
mappeplacering til dataeksport.

Sådan eksporteres datafilen til et LIMS

u Åbn .pcrd-filen og vælg Export > Export to LIMS Folder (Eksportér > Eksportér til LIMS-mappe).

Tip: Hvis Automatically Export Data after Run (Eksportér automatisk data efter kørsel) vælges i
LIMS-valgmulighederne, genererer CFX Maestro Dx SE en LIMS-kompatibel datafil i .csv-format og
gemmer den i den sammemappe.
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Tillæg D Fejlfinding i CFX Maestro Dx Software,
Security Editionn

Dette tillæg indeholder forslag til fejlfinding af problemer, som du kan støde på under opgraderingen eller
kørslen af CFX Maestro Dx Software, Security Editionn.

Hvidlistning af filer og mapper i CFX Maestro Dx Software,
Security Editionn

Din IT-afdeling har muligvis implementeret meget stramme softwaresikkerhedsforanstaltninger med
henblik på beskyttelse mod vira og malware. Disse foranstaltninger kan påvirke den tid, det tager at
opgradere eller køre CFX Maestro Dx SE.

For at forbedre ydeevnen for CFX Maestro Dx SE, anbefaler Bio-Rad, at din IT-afdeling hvidlister
følgende filer og mapper i firewall-indstillingerne i den antivirussoftware, der er installeret på CFX Maestro
Dx SE-computeren:

Mapper

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Filer

n Alle .exe-filer i mappen C:\Program Files (x86)\Bio-Rad\CFX _MDx

n R.exe og Rscript.exe (findes i mappen C:\Program Files (x86)\Bio-Rad\CFX_MDx\ R\
R-3.3.1\ bin)
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Programlogfil
Inden en ny kørsel påbegyndes, starter CFX Opus Dx-systemet en selvdiagnosticeringstest for at
kontrollere, at kørslen foregår inden for specifikationerne. Resultaterne af denne softwaretest kan ses i
Run Log (Kørselslog) og i Application Log (Programlogfil). Hvis du bemærker et problem i et eller flere
eksperimenter, skal du åbne og køre programlogfilen for at finde frem til, hvor problemet er opstået.

CFX Maestro Dx SE Dx sporer oplysninger om et instruments tilstand under en kørsel i Application Log
(Programlogfil). Brug disse logfiler til at spore hændelser, som opstår på instrumenter og i softwaren og i
forbindelse med fejlfinding.

Sådan åbnes programlogfilen

u Vælg View > Application Log (Vis > Programlogfil) i startvinduet.

Hvis du vil have vist programlogfilen som en HTML-fil, skal du klikke på knappen HTML Report
(HTML-rapport).
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Hentning af program- og firmwarelogfiler
Program- og firmwarelogfilerne indeholder oplysninger, der beskriver handlinger udført under brugen af
softwaren og udførelsen af kørsler. Disse logfiler registrerer også software- eller firmwarefejl, der opstår
under driften af softwaren eller instrumentet.

Sådan får du adgang til program- og firmwarelogfilerne:

1. I ruden Detected Instruments (Registrerede instrumenter) skal du højreklikke på instrumentet.

2. Vælg Retrieve Log Files (Hent logfiler).

3. I dialogboksen Browse for Folder (Søg efter mappe) skal du vælge den destinationsmappe på dit
netværk eller et lokalt drev, hvor du vil gemme logfilerne.

Bemærk: Mappen hedder "Logs."

4. Klik på OK for at gemme filerne.

Vigtigt: Hvis du gemmer en logfil med samme filnavn som en eksisterende logfil, overskrives
den eksisterende logfil.

Fejlfinding
Normalt kan kommunikationsproblemer mellem software og instrument løses ved at genstarte
computeren og systemet. Sørg for at gemme igangværende arbejde, før du genstarter.

Bemærk: Kontrollér, at computeren har tilstrækkeligt med RAM og ledig diskplads. Minimum RAM er
4 GB, og minimum harddiskplads er 128 GB.

Strømsvigt
Hvis der opstår strømsvigt, lukker instrumentet og computeren ned. Hvis strømsvigtet er kortvarigt,
genoptager instrumentet kørsel af en protokol, men strømsvigtet noteres i programlogfilen. Afhængigt af
computerens indstillinger og varigheden af strømsvigtet vil instrumentet og softwaren forsøge at
fortsætte, afhængigt af protokoltrinnet:

n Hvis protokollen er i et trin uden pladeaflæsning, fortsætter protokollen kørslen, så snart instrumentet
igen tilføres strøm.

n Hvis protokollen er i et trin med en pladeaflæsning, venter instrumentet på, at softwaren genstarter
og genoptager kommunikationen for at indsamle dataene. I denne situation fortsætter protokollen
kun, hvis softwaren ikke blev lukket ned af computeren. Protokollen starter igen, når computeren og
softwaren starter igen.
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Overførsel af filer til CFX Maestro Dx SE-computeren
Du kan overføre data og logfiler, der findes på instrumentet, til harddisken på en tilsluttet CFX Maestro Dx
SE-computer.

Tip: Alle filer i real-time-datamappen på instrumentbasen overføres til computeren.

Bemærk: Du kan kun overføre logfiler fra CFX Opus Dx-instrumenter. Alle logfiler på instrumentet
overføres til computeren.

Sådan hentes filer fra instrumentet

1. Højreklik på det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter) i
startvinduet, og vælg Retrieve Log Files (Hent logfiler).

2. Vælg en mappeplacering, hvor de hentede filer skal gemmes.

3. Klik på OK.

Manuel installation af CFX Maestro Dx Software, Security Editionn
Sådan installeres CFX Maestro Dx SE manuelt

1. Om nødvendigt frakobles alle tilsluttede instrumenter fra computeren.

Find og frakobl instrumentets USB-kabel fra computeren med CFX Maestro Dx SE installeret. Den
ende, der er tilsluttet til instrumentet, behøver ikke at blive frakoblet.

2. Log på computeren med CFX Maestro Dx SE installeret med administratorrettigheder.

3. Tilslut CFX Maestro Dx SEs USB-drev til computerens USB-indgang.

4. Naviger til og åbn CFX Maestro Dx SE USB-drevet i Windows Stifinder.

5. CFX Maestro Dx SE installeres ved at åbne CFX-mappen og dobbeltklikke på CFXMaestro Dx
Setup.exe.

6. Følg vejledningen på skærmen for at installere softwaren.

Efter fuldførelsen vises velkomstskærmen for Bio-Rad CFX Maestro Dx Software, Security Editionn
på computerskærmen, og Bio-Rad CFX Maestro Dx Software, Security Editionikonet vises på
skrivebordet.

7. Du kan sikkert skubbe USB’en ud og starte CFX Maestro Dx SE.
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Geninstallation af drivere
Sådan geninstalleres instrumentdriverne

u Vælg Tools > Reinstall Instrument Drivers (Værktøjer > Geninstaller instrumentdrivere) i startvinduet.

Bemærk: Hvis der er problemer med softwarekommunikationen med et real-time-system, når
driverne er geninstalleret, og USB-forbindelsen er kontrolleret, skal du kontakte Bio-Rads tekniske
support.
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Tillæg E Bio-Rad Free and Open-Source Notices
for PCR Products

This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.

Brugervejledning | 327



Tillæg E Bio-Rad Free and Open-Source Notices for PCR Products

Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Standard Open License Text

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Meddelelse om Minpack copyright (1999) University of Chicago. Alle rettigheder forbeholdes.

Videredistribution og brug i kildeform og binær form, med eller uden modifikation, er tilladt, hvis følgende
betingelser er opfyldt:

1. Videredistributioner af kildekode skal bevare meddelelsen om copyright, denne liste med betingelser
og den følgende ansvarsfraskrivelse.

2. Videredistributioner i binær form skal gengive ovenstående meddelelse om copyright, denne liste
med betingelser og den følgende ansvarsfraskrivelse i dokumentationen og/eller i andet materiale,
der måtte være inkluderet i distribueringen.

3. Eventuel slutbrugerdokumentation, der medtages i videredistributionen, skal indeholde følgende
anerkendelse:

“Dette produkt omfatter software udviklet af University of Chicago som operatør af Argonne National
Laboratory.”
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